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Installation and maintenance of licenses

Online activation of  a license
O n l i n e  a c t i v a t i o n  o f   a  l i c e n s e

In order to use EasySIGN software, you need to obtain at least one license. Licenses can be bought from a reseller
and at our web shop.  A license is provided as a ticket. A ticket is a 29 character long string consisting of 5 groups of
alphanumerical characters separated by hyphens, for example: "ABC01- ABC01- ABC01- ABC01- ABC01".

Your computer needs to have an internet connection in order to activate the license.

If you plan to activate a license offline (so your system is not connected to the internet), please consult "Offline
activation" first.

Once you have acquired a ticket, you can activate it by means of the license manager wizard. The license manager
wizard is shown the first time you start EasySIGN. You can also bring it up by selecting the menu "Help > Licensing
options". This will bring up a dialog showing all available licenses.

From here you can bring up the wizard by clicking the button "License Manager...":
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Press "Next" in order to start the activation process.

Here you have two options

1 I have a Product Voucher.
If you bought the license from a reseller your software box could contain a Product Voucher that will
look like the image below.
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You can use the number on this Product Voucher to obtain the ticket for the license you have bought.
You would use this option if you haven't got a ticket yet. If you want to use this option, select it and
press 'Next' to continue.

2 I have a ticket.
If you already have a ticket you would use this option. If you want to use this option, select it and press
'Next' to continue.

I have a Product Voucher

Press the button 'Activate Product Voucher' (1). This will open a browser and the web page where you can activate
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your Product Voucher.
When you have activated your 'Product Voucher' and received your ticket (by email), press next to continue.

I have a ticket

Ticket based license activations are supported by (1) and (2). Offline activation is possible with (3) the latter is
described in section "Offline activation". The two choices in (1) and (2) tell EasySIGN how the newly installed
license will be bound. 

1 The license will be bound to your pc. This means that you can only use the software on that pc.

2 The license will be bound to a dongle. You can use the software on any computer that you connect with
this dongle. In order to be able to choose this option you need to have a dongle. A dongle can be
acquired from your reseller or at the web shop.

Pick the choice that is appropriate for you and press "Next".



10 EasySIGN

Here you can enter the ticket. By default the full textbox is selected allowing you to simply cut and paste the ticket.
Be careful to avoid leading and trailing white space characters.

Once you have verified that the ticket has been entered correctly, press "Next".
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The installation of a new license can take a while, so please be patient. Upon success you will see the above depicted
message. When you restart EasySIGN your newly added license will be activated. If your license could not be
installed consult section "Troubleshooting" for help.

Offline activation
O f f l i n e  a c t i v a t i o n

If the computer on which you want to use EasySIGN is not connected to the internet, you can choose for an offline
activation. Please be aware that an additional cost may be involved in an offline activation process. 
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On page 2 of the license manager choose "Offline activation (not recommended)" (3) and press "Next".

Choose the second option "I don’t have a license file yet" and press "Next".
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The choice between (1) and (2) tells EasySIGN how the newly installed license will be bound. 

1 The license will be bound to a dongle. You can use the software on any computer that you connect with
this dongle. In order to be able to choose this option you need to have a dongle. A dongle can be
acquired from your reseller or at the web shop.

2 The license will be bound to your pc. This means that you can only use the software on that pc.

In addition to the mentioned choice, you also need to specify a filename. This filename will be used by the license
manager in order to generate a file that will contain information with respect to the choice you made on this page. The
filename will typically be called "context.WibuCmRaC". Once you have made your choice, and provided a valid
filename, press "Next".
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You need to send the file generated to EasySIGN. This can be done by email, for example on another computer that
has an internet connection and e-mail, or by sending us an USB stick containing the generated file. Together with this
file, you need to specify which license you require. If you are not sure which license would be best for your purposes,
you can contact us trough the contact page on our website. Make sure you provide us with a return address.

When we receive the context file in good order we will generate a so-called license file and ship it back to you. The
license file will typically be called "update.WibuCmRaU". In order to install this file, you need to start the license
manager again.
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Select "Offline activation (not recommended)" (1) and press "Next". 

Select "I already have a license file" (1) and press "Next".  

Here you need to provide a filename. This is the name of the file that EasySIGN shipped to you. Select it and press
"Next".
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Upon success you will see the above displayed message. When you restart EasySIGN your newly added license will
be activated. If your license could not be installed consult section "Troubleshooting" for help.

Understanding and using the License dialog
U n d e r s t a n d i n g  a n d  u s i n g  t h e  L i c e n s e  d i a l o g

The license dialog provides an overview of all valid licenses (with the possible exception of the build license) on your
system. Select the menu "Help > Licensing options" to show this dialog.

Each entry in the listbox (1) window represents a license visible on your system. If a license is visible in this dialog, it
means it is considered to be valid. One exception to this rule is the build license:

A build license limits the build version of the software that can be used.  This is done by comparing the build date of
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the software with the expiration date of the build license. If the build date is too new, so it is newer than the expiration
date of the build license, then the build license is said to be invalid. The user will be informed of this fact at startup
after which all licenses will be disabled. Do not confuse a build date with the current date: A build license with an
expiration date in the past is still valid as long as the build date is in the past of the expiration date of the build
license. 
A build license is derived from a support license. All web shop products come with some support. The expiration date
of the support license is identical to the expiration date of the build license. In the example above the build license is
visible as the first entry in the listbox. It is valid since its expiration date of June 26 2010 is more recent than the build
date of May 1sth 2010.

The license dialog has 4 buttons

2 Close. With this you can simply dismiss the license dialog.

3 License manager wizard. With this you can bring up the license manager wizard as described in previous
sections.

4 Ticket manager. This dialog is used to extend subscriptions as will be described in the next section.

5 Web shop. This will open a web browser with a link to our web shop for your convenience.

In the lower left corner a checkbox (6) is visible. Licenses that are invalid will be collected and shown to you at
startup by an invalid license dialog (see "Understanding and using the expired license dialog"). Uncheck this
box if you do not wish to be informed of expired licenses.

Understanding and using  the Ticket Manager
U n d e r s t a n d i n g  a n d  u s i n g   t h e  T i c k e t  M a n a g e r

Licenses are said to have recently expired if their expiration date is within 30 days of the current date. These licenses,
although technically invalid, are still considered to be valid by the software: they are in a so-called grace period of 30
days. A grace period of 30 days will provide you with ample time to continue any subscription you might have without
losing the functionality of the software. 

The ticket manager presents you with a list of licenses that are within a grace period of their expiration date. If these
licenses are part of a running subscription, then they can be extended by means of this manager.



18 EasySIGN

In listbox (1) you will see an overview of all licenses that recently expired. In the above shown example we see that
two licenses have expired: "Support complimentary" and "Master subscription".  In listbox (2) you are presented with
a list of tickets that have been installed in the past. Selecting one or more licenses in listbox (1) results in the
selection of all relevant tickets in listbox (2). Textboxes (3) and (4) provide you with more information with respect to
a selected license and ticket respectively. Once you are confident that the right ticket(s) has/have been selected, you
can extend your subscription by pressing "Renew" (6). In textbox (5) you will be notified whether the extension was
successful or not. The next example shows a successful extension:

Notice that the licenses in listbox (1) are updated to reflect the new status after the successful extension. You do not
need to restart the software in this case.

The button "Remove" (7) can be used to remove tickets from listbox (2). You can use this to remove old tickets that
you will not extend. It is perfectly safe to remove a ticket. Removing a ticket does not result in the loss of licenses,
nor does it result in the cancellation of any subscriptions you might have. If you remove a ticket of a running
subscription by accident, you can use the license wizard to enter it again. The license wizard itself can be activated
from this dialog by pressing the button "License wizard" (8). You can also enter the web shop by pressing the button
"Online webshop" (9).

Understanding and using the expired license dialog
U n d e r s t a n d i n g  a n d  u s i n g  t h e  e x p i r e d  l i c e n s e  d i a l o g

Licenses that are expired, and which are no longer within a grace period of the current date, will no longer be
considered to be valid by the software. The software will collect these licenses and report them to you in an expired
license dialog.
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Each entry in listbox (1) of this dialog represents an invalid license. If you do not intend to extend the expired license
and you also do not want to see this dialog each time you start the software, you can suppress it by one of the
following two methods:

1 Notice that there is a checkbox (2) in the lower left corner of the dialog. By checking this checkbox you
prevent the software from reporting expired licenses to you. You can turn this checkbox off again by
selecting the appropriate checkbox on the "License dialog".

2 (recommended) You can select the license that is expired and explicitly hide it by pressing button
"Hide" (3).  This will make sure that the tool will no longer  warn you about this specific license. The hide
action is license and date specific: if you install a newer license that also expires, the tool will once more
warn you about this expired license until you hide this license as well.

Troubleshooting
T r o u b l e s h o o t i n g

In this section you will find the most common issues that can occur during activation of your license.

EasySIGN does not start. I just see a dialog with an error message
EasySIGN software is protected by an anti-piracy shield. This shield will only start EasySIGN if certain conditions are
met. The error message you see is most likely generated by this shield. Here are the most common failures you
might encounter:

EasySIGN communicates with a separate license server that runs locally on each machine on which EasySIGN
software is installed. This license server, named CodeMeter server, must be running as a service. If the CodeMeter
server somehow got terminated, it will not restart automatically as a service. Rebooting your system should restart
the CodeMeter server as a service.



20 EasySIGN

The version of the CodeMeter server running  on your system is outdated. This could happen if you e.g.  install
software that is using an older version of CodeMeter. Re-installing EasySIGN should fix this problem.

Axprotector itself requires a license. This license is shipped with the software. It is installed the first time you start the
software. The license itself is persistent to uninstalling and re-installing EasySIGN. So, losing this license is very
unlikely. However, if this license does somehow get deleted, it cannot be installed a second time. Therefore, in
addition to the original license, we ship one backup license with our software in case the original license gets deleted.
If this license also gets deleted you need to contact us in order to acquire a new one.

The shield itself was not able to provide more information about the problem. If you contact EasySIGN have the
following information available: The serial number of your software "Windows Start button > EasySIGN VX > Tools >
ContainerID" or in the software itself select the menu "Help > Container ID". We will also ask you to email us the
resulting file generated by a tool called VersionInfo ("Windows Start button > EasySIGN VX > Tools > VersionInfo"):
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If you see this message, or a message similar to this, your installation of EasySIGN software is corrupt due to missing
DLL files. Reinstall the software.

I cannot bring up the license manager
The license manager is a standalone executable that resides in the same directory in which EasySIGN is installed. It is
named "LicenseManager.exe". If this executable is missing, you need to re-install EasySIGN.

The license manager generates the following error:

Could  no t conta ct the  e x te rna l lice nse  se rv e r
Make sure your computer is connected to the internet. If your computer is connected to a proxy, make sure that the
default (login) credentials allow access to this proxy. Contact your IT department to make sure that this is set up
correctly.

Com m unica tion with  the  e x te rna l lice nse  se rv e r  fa ile d
This is caused by a communication failure between the license server and the license manager. Make sure your
internet connection is setup properly.

Your  ticke t is  no t v a lid
Make sure that your ticket is correct. It is easy to make a mistake if you are manually typing in the ticket. If possible,
try to cut and paste the ticket in order to avoid mistakes.

T he  products  in  th is  ticke t a re  no t com pa tib le  with  y our  ins ta lla tion. T he  m ost like ly  ca use  is  tha t y our
insta lla tion a lre a dy  conta ins  a ll the  products  cov e re d  by  th is  ticke t.
EasySIGN does not allow you to install the same product (license) twice or more on the same computer, or the same
dongle. This is done for your protection. Installing a license twice does not add any additional functionality, nor does it
allow you to start the software multiple times. Make sure that you are installing the ticket on the appropriate
computer, or on the appropriate dongle.

Your  ticke t ha s  a lre a dy  be e n a ctiv a te d
The ticket has already been activated before. You cannot activate it again, unless it is part of a subscription. If case of
the latter, you are trying to activate it too soon; you have to wait until the licenses contained by the ticket enter their
grace periods. The ticket manager (see "Understanding and using the Ticket Manager") will warn you when this
happens.

Unknown e rro r
This is most likely caused by an intermittent communication failure between the license server and the license
manager. Make sure your internet connection is setup properly.
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Could  no t find  a ny  dong le . Ple a se  v e r ify  tha t y our  dong le  is  conne cte d .
You must have selected "I have a ticket and a dongle" on page 2 of the license wizard. The license wizard could not
detect any dongle on this computer.
Important:
Please be aware that you cannot reuse the dongle of version 5 and earlier.

T he re  a re  m ultip le  dong le s  a tta che d  to  y our  sy ste m . T he  lice nse  m a na ge r  re quire s  tha t only  one  dong le
is  a tta che d  to  y our  sy ste m . R e m ov e  a ll dong le s , e x ce pt fo r  the  dong le  on which y ou wish to  ins ta ll the
lice nse .
You cannot have more than one dongle connected to the system during the installation of a new license. You can have
multiple dongles connected during normal operations, but only if at most one of these dongles contains EasySIGN
licenses.

Som e  file s  a re  m iss ing: <lis t o f m iss ing  file s>.
Please reinstall the application.
The license manager detected a corrupt installation of your software. Please re-install EasySIGN.

T he re  is  a  prob le m  with  y our  Code Me te r  se rv ice . Ple a se  re boot y our  com pute r .
The license manager detected a problem with your local CodeMeter license service. Please reboot your computer in
order to reset this service.

EasySIGN starts, but I get a warning/error message.
T he  re le a se  da te  o f the  progra m : <da te 1> is  ne we r  tha n the  e x p ira tion da te  o f y our  build   lice nse :
<da te 2> [E200]
The build date of the executable is too new. You do not have the rights to run this executable. You can either revert to
an older version of the software, or you can buy additional maintenance in the web shop. The setup of our software
normally prevents you from running into this problem, since it verifies that your build license (derived from
maintenance) allows you to run the software. However there are a couple of scenarios in which you can still manage
to trigger this problem. For example, you might have  installed a TryBuy license, after which you upgraded to a newer
version of the software. The TryBuy licenses are only temporarily available to you, and at the end of the TryBuy
period these licenses are deleted.

Only  one  dong le  ca n be  bound  to  the  Ea sy SIGN so ftwa re  on th is  com pute r . Ple a se  re m ov e  the  e x tra
dong le  (s).
You can have multiple dongles connected to your computer, but only one of these dongles may contains EasySIGN
licenses.

I just installed a new license by means of a ticket, and now all my licenses are gone.
Unless you installed a Move license, your licenses are most likely still available on your computer. Reboot your
computer. If the problem persists, contact EasySIGN and have your serial number readily available.

EasySIGN

Einführung

Willkommen bei EasySIGN.

EasySIGN Konventionen
E a s y S I G N  K o n v e n t i o n e n

Wichtig ist es die Terminologie dieser Gebrauchsanweisung zu kennen, bevor Sie anfangen, mit EasySIGN zu
arbeiten.

Menü
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 Das Menü ist die horizontale Zeile oben auf der Benutzeroberfläche und enthält Befehle wie z.B. "Datei" und
"Bearbeiten". Klicken Sie auf einen dieser Befehle. Nun erscheint ein Untermenü (Dropdown-Menü), woraus Sie dann
Befehle wie z.B. "Neu" "Speichern" usw. auswählen können. Durch jede Auswahl eines solchen Befehls wird eine
Handlung ausgelöst.

PopUp-Menü

 Auch dieses ist tatsächlich ein "Menü", welches jedoch erst angezeigt wird, wenn Sie mit der rechten Maustaste auf
ein Objekt oder auf das Arbeitsblatt klicken.

Cursor

 Mit dem Cursor ist der auf dem Schirm zu sehende "Pfeil" gemeint, der durch die Mausbewegungen gesteuert wird.

Dialog

 Ein Dialog ist ein Fenster, in dem Einstellungen verändert werden können.

Arbeitsblatt
 Auf dem Arbeitsblatt erstellen Sie Ihren Entwurf oder Ihre Zeichnung. Es ist der Mittelpunkt des Programmes.

Arbeitsfenster
 Das ist das gesamte Fenster, welches sich innerhalb der Lineale und Schiebebalken befindet. Es umfaßt sowohl das
Arbeitsblatt als auch den Raum darum.
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Schaltflächen

 Wenn Sie “OK” anklicken sollen, ist damit gemeint, daß Sie mit der linken Maustaste auf die “OK”-Schaltfläche klicken
sollen.

Optionen

 Eine Option ist im Dialog aktiviert, wenn vor der Option im Kontrollkästchen eine Markierung steht, oder wenn der
Kreis vor der Option schwarz ist.

Tastatur

 Müssen Sie beispielsweise einen Befehl über die Tastatur eingeben, dann bedeutet z.B. “Strg+S”, daß Sie zuerst die
Steuerungstaste betätigen und diese dann gedrückt halten. Drücken Sie dann auf “S”.

Maus

 EasySIGN verwendet beide Maustasten und geht davon aus, daß die linke Maustaste als primäre Maustaste
eingestellt ist.

Der Kundendienst
D e r  K u n d e n d i e n s t

 Bei Fragen zu EasySIGN lesen Sie am besten dieses Handbuch. Wurde die Lösung auch dann noch nicht gefunden,

wenden Sie sich bitte an Ihren Händler.

 Bleiben Sie, während Sie den Händler anrufen, am besten vor dem Computer sitzen und halten Sie alle
erforderlichen Unterlagen bereit. Außerdem müssen Sie folgende Fragen beantworten können:
 "Wie lautet die Seriennummer Ihrer EasySIGN - Version?"
 "Welche Programmversion haben Sie?"
 Fehlermeldungen, die auf dem Bildschirm erscheinen, bitte wörtlich aufschreiben oder mit der Tasten "Alt+Druck"
eine Bitmap-Abbildung vom Dialog mit der betreffenden Fehlermeldung anfertigen.
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 "Womit waren Sie selbst gerade beschäftigt, und was geschah beim Auftreten des Problems außerdem?
 "Haben Sie selbst versucht, das Problem zu lösen? Wenn ja, wie?"
 "Welche Windows-Version verwenden Sie?"
 "Welches Ausgabegerät ist an Ihrem System angeschlossen?"
 "Befinden sich in Ihrem Computer noch besondere Karten? Wenn ja, welche?"

Die EasySIGN-Benutzeroberfläche
D i e  E a s y S I G N - B e n u t z e r o b e r f l ä c h e

Nach dem Programmstart erscheint die nachfolgend abgebildete Benutzeroberfläche. Im Folgenden werden die
wichtigsten Teilaspekte beschrieben.

1 Titelleiste
Hier befindet sich der Name des Programms und danach der Name der momentan geöffneten Datei. Der
Titelbalken enthält außerdem einige Schaltflächen.

2 Menüleiste
 Der Menüleiste enthält die Namen der einzelnen Menüs. Davon enthält jedes wiederum mehrere Folgemenüs

mit Programmbefehlen.

3 Symbolleiste
 Diese enthält die gebräuchlichsten Menübefehle, die so durch das Drücken einer Schaltfläche zu Ihrer direkten

Verfügung stehen.
 Diese Leiste kann (wie jede andere Leiste auf dieser Höhe) festgehalten und aus dem Menü gezogen werden.
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Das Programm enthält mehrere dieser "schwebenden Symbolleisten". Letztere heißen deshalb "schwebend"
weil bei ihrer Benutzung jede Anwendung, anders als Dialoge, noch immer auf der Arbeitsfläche ausgeführt
werden kann.

4 Werkzeugpalette
 Diese enthält die gebräuchlichsten Anwendungen. Zu deren Aktivierung braucht man nur die dazugehörige

Schaltfläche anzuklicken. Die Tabulatortaste dient dem schnellen Umschalten zwischen dem zuletzt gewählten
Symbol und der Gesamtauswahl (dem Pfeil).

5 Lineale
 Diese befinden sich links oben im Arbeitsfenster des Programms. Die Lineale verschaffen Ihnen einen Eindruck

von Platz und Größe der Objekte auf der Arbeitsfläche

6 Bildlaufleisten
Am rechten Unterrand der Arbeitsfläche sind zwei  Bildlaufleisten sichtbar. Mit ihnen kann die Arbeitsfläche
waagrecht und senkrecht über das Bild verschoben werden..
Das Verschieben des Bildes ist auch durch Betätigen der Leertaste möglich. Der Mauscursor ändert sich
daraufhin wie folgt.

Durch erneutes Bewegen der Maus (mit eingedrückter Leer- und linker Maustaste) kann man nun auch die
Arbeitsfläche verschieben.

7 Statuszeile
Diese befindet sich am unteren Rand der Benutzeroberfläche und enthält Informationen zum gewählten Objekt.

8 Arbeitsblatt
Die weiße Fläche auf dem Bildschirm ist das Arbeitsblatt. Dieses wird durch ein Rechteck dargestellt, an dessen
beiden Seite sich eine Randlochung befindet. Diese Randlochung gibt an, in welcher Richtung das Medium durch
das Ausgabegerät läuft.

Die Arbeit mit EasySIGN

EasySIGN installieren

Das Installieren von EasySIGN ist sogar für unerfahrene Benutzer ein einfach und problemlos auszuführender
Vorgang. Siehe dazu das Installationshandbuch.

EasySIGN löschen 

Um EasySIGN von Ihrem System zu entfernen, wählen Sie aus der Programmgruppe von EasySIGN (im Windows-
Menü "Start", "Programme") den Befehl "EasySIGN Uninstall".

EasySIGN starten

Nach Ausführung des Programms "Setup" zeigt das Windows-Startmenü eine Programmgruppe mit dem Namen
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"EasySIGN". Diese Programmgruppe enthält unter anderem das EasySIGN - Symbol. Sie starten EasySIGN, indem
Sie auf dieses Symbol klicken.

Interface

EasySIGN Application Look
E a s y S I G N  A p p l i c a t i o n  L o o k

The first time you run the software it will be using the default Application look. This look is highly optimized to be as
less distractive as possible. It uses a neutral color and easy to recognize icons. 

If however you feel more comfortable with a different look this is very easy to change.
Select the menu 'Vie w > App lica tion Look > x x x' where 'xxx' stands for a long list of different looks to choose
from. No restart is necessary so just select them one by one until you find the one you like best.
 
The last selected look is the one the software will be using with each new session until you change the look again.   

MDI tabs
M D I  t a b s

The first time you run the software it will be using MDI tabs.

MDI tabs have several advantages over old style MDI windows.
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1 Very easy navigation between documents.

2 Preview of every worksheet in the Windows 7 taskbar. 

3 Context menu with several useful options.

Manage the MDI tabs
To manage the MDI tabs right click on an empty space of the worksheet and select the command 'Interface'.

This will open the same dialog as if you would have chosen the menu 'Vie w > Se ttings'.



29EasySIGN

1 Switch the tabs on or off.

2 Choose if and where you want a close button on the tabs.
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3 Choose the style of the tabs.

4 Tabs on top or on bottom.

5 Every tab its own color.
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6 Document icons displayed on tabs.

7 Document menu.

8 Drag tabs to a different location.

9 Each tab has its own context menu.

Customize toolbars
C u s t o m i z e  t o o l b a r s

You can customize existing toolbars and even create your own.

Right click on the menu and select from the context menu the command 'Customize'.
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This will open the following dialog.

1 Make sure that you have the 'Toolbars' tab selected.

2 Existing toolbars.

3 Reset the selected toolbar to its original state.

4 Reset all toolbars to their original state. this will also delete any custom toolbar.

5 Create a new toolbar.

6 Rename a toolbar. Only possible on your own toolbars.

7 Delete a toolbar. Only possible on your own toolbars.

Click on 'New...' (5).

Give the new toolbar a name
and click on 'OK'.
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This will create a small empty
new toolbar.

Click on the tab
'Commands' (1). From the
'Categories' list (2) on the left
select the menu you want to
use. From the 'Commands'
list (3).

On the right drag the
commands you want to use to
the new toolbar.

When you are done close this
dialog.

Your new toolbar is ready to
use.
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Create tools
C r e a t e  t o o l s

You can create links to other software (tools) which are automatically displayed in a menu.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.

Make sure that you have the 'Tools' (1) tab selected and click on the button for a new entry (2). 
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Enter 'Notepad' in the field that appears (3).

Enter the path and name of the executable in the 'Command' field (4), or use the browse button (5) to browse to the
executable. When you are done click on 'Close' (6).
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Select the menu 'File  > T oo ls  > x x x' where 'xxx' stands for the tool you have added.

Customize shortcut keys
C u s t o m i z e  s h o r t c u t  k e y s

You can create your own Shortcut Keys and they will even appear in the menus.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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1 Make sure that you have the 'Keyboard' tab selected.

2 Category, here is where you select the menu.

3 Accelerator, make sure this is set to default.

4 Commands, the commands in the menu you have selected under 'category' (1).

5 Current keys, the current assigned key (if any) to the command you have selected under
'Commands' (4).

6 Assign the shortcut Key you have typed in the field 'Press new Shortcut Key' (9).

7 Remove a Shortcut Key.

8 Reset all shortcut Keys to their default values.

9 Type/Press the Shortcut Key as you will use it.

Example
Let's add a Shortcut Key to the command 'Quick connect' from the 'Arrange' menu.

As you can see in the menu, there is no Shortcut Key assigned to this
command.

Select from 'Category' (2) the menu 'Arrange'.
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Select from 'Commands' (4) the command 'Quick Connect'.

Set your cursor in the field 'Press new Shortcut Key' (9). Press and hold on
your keyboard the Control key and then the '1'.

The button 'Assign' is now enabled, click on it to assign the new Shortcut
Key.

The new Shortcut Key is now assigned to 'Quick Connect'. Press 'C lose' to
close this dialog.

If you now go to the command 'Quick connect' from the 'Arrange' menu
you can see that the new Shortcut Key is also added to the menu.

Menu behavior
M e n u  b e h a v i o r

You can customize the menu behavior to your liking.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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1 Make sure that you have the 'Menu' tab selected.

2 Make sure that 'Design doc' is selected.

3 Select the menu animation you want.

4 Check this if you want the menu to have shadows.

5 Use the 'Reset' button to reset all menu's to their original state.

Manage menu items
M a n a g e  m e n u  i t e m s

You can add or remove new commands to the existing menus, rearrange them and even create new menus.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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Make sure that you have the 'Commands' tab (1) selected.

Rearrange menu items
Now that this dialog is open you can start rearranging the menus. 

The image shows the current order of the top level menu items. Click on the 'File' menu and drag it behind the 'Help'
menu. 

The menu looks now like above. Drag every menu item to a different position.

Let's stop here and try something else.

Click on the 'Text' menu to open it and
select the command 'Case'.
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Drag the command 'Case' to the menu
'Arrange' and hold it above the menu
'Arrange' until this menu opens (don't let
go of your mouse button yet).

When the menu 'Arrange' opens drag the
command 'Case' just above the
command 'Group'. As you can see you
can even move commands from one
menu to another.

You can also drag commands from the dialog to the menus.

Under 'Categories' select
'Arrange' and under
'Commands' select and drag
'Group' to the 'Text' menu.

Create your own menu
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In the dialog select under
'Categories' the item 'New
menu' (1).
 

Under 'Commands' select and
drag the command 'New
menu' (1) to the right of the
main menu, just after
'Text' (remember, we have
rearranged all the menu
items).
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Right click on the new menu
item and select the command
'Button Appearance...' (1).

In the field 'Button text' enter
a name for the menu item.

Start selecting menus in the
Categories (1) list and drag
commands from the
'Commands' (2) list to the
new menu.
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In no time you have created
your own 'Favorites' menu.

If you want to reset the
menus to their original state
just select the tab 'Menu' (1)
and press the button 'Reset' (
2).

Associate mouse double-click
A s s o c i a t e  m o u s e  d o u b l e - c l i c k

You can associate a mouse double-click on an empty space on the worksheet to a certain menu command.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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1 Make sure that you have the 'Mouse' tab selected.

2 Make sure 'Worksheet' is selected.

3 Check the option 'Associate double-click event with'.

4 Choose the command of your liking (in our case this is 'FileOpen').

5 Click on 'Close' to close the dialog.

If you now double click on an empty space of the worksheet the File Open dialog will open.

Large icons
L a r g e  i c o n s

If desired you can change the size of the icons from all the toolbars.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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1 Make sure that you have the 'Options' tab selected.

2 Check the option 'Large icons'.

3 Click on 'Close' to close the dialog.

On top the toolbox with standard
icons and on the bottom the
toolbox with large icons.

Arrange Interface
A r r a n g e  I n t e r f a c e

You can arrange the interface completely to your liking. Menu, Toolbars, Dockers etc. can be made floating, dragged
to a different docking location, closed or put in 'Auto hide' mode.
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If you for example want the Object manager and Color docker both visible at the same time just drag one of them
into the other. An advanced docker helper Wil help you getting them on the right place.

If you want the dockers hidden but instantly
accessible when you hover the mouse over
them, just put them in auto hide mode. Click on
the 'Auto hide button' (1).
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The dockers will hide themselves on the side
they were docked.

If you want to make them visible again, just
hover your mouse over the icons. If your mouse
leaves the dockers they will hide themselves
again.

Just play around to get comfortable with all the possibilities with the interface, you will be pleasant surprised.

Ribbon
R i b b o n

The first time you run the software it will be using menus. If you are a user that likes Ribbons like e.g. in Microsoft
Word™ you can easily change the interface to a Ribbon interface.

To change to the Ribbon interface right click on an empty space of the worksheet and select the command 'Interface'.

This will open the same dialog as if you would have chosen the menu 'Vie w > Se ttings'.
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Make sure that the tab 'Interface' (1) is selected and check the option 'use Ribbon interface (needs restart)' (2).

Click on 'OK' to accept the changes and restart the software.

The interface of EasySIGN is now a Ribbon interface that basically works the same as the Microsoft Word™ Ribbon.
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If for example you select the 'Effects' tab you have all the effects instantly at your disposal.

The same goes for the tab 'Text'.

Selecting the tab 'Create' gives you access to the drawing tools, import, export, Compatibility, insert objects etc.
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Just have a good look around and see what works for you, the Menu interface or the Ribbon interface.

Die Arbeit beginnen und beenden
D i e  A r b e i t  b e g i n n e n  u n d  b e e n d e n  

Ein neues Arbeitsblatt entwerfen
Das Programm beginnt bei jedem Start mit einem neuen, leeren Arbeitsblatt. Da es sich dabei um eine MDI
(Mehrfachdokumenten-Darstellung) handelt, können mehrere Arbeitsblätter gleichzeitig geöffnet sein. 

Vorhandene Datei öffnen

Zum Öffnen einer bereits vorhandenen Datei  wählen Sie im Menü "Datei" den Befehl "Öffnen". Damit wird ein Dialog
zur Suche nach der gewünschten Datei geöffnet. Hier können Sie Ihre Wahl treffen.

Befehle rückgängig machen

Das Programm registriert die während einer Sitzung vorgenommenen Anpassungen. Die Behebung von Fehlern oder
die Änderung eines aktuellen Befehls ist mit Hilfe von "Rückgängig" aus dem Menü "Bearbeiten" möglich. Folgende
Anpassungen sind allerdings nicht mehr rückgängig zu machen:

 einige Dateibearbeitungen wie zum Beispiel "Öffnen" und "Speichern";
 eine Auswahl aus einem Objekt;
 eine Bildänderung (wie "Zoomen" usw.);
 das Anbringen von Hilfslinien und Ändern bestimmter Einstellungen;
 das Bearbeiten von Rasterlinien;
 das Versetzen bestimmter Paßkreuze.

Mit "Datei, Allgemeine Einstellungen" unter der Registerkarte "Allgemein" kann die gewünschte Anzahl der benötigten
Schritte zur "Rückgängig" eingegeben werden.

Sofort nach dem Befehl "Rückgängig" wird "Wiederherstellen" aktiviert. Mit dieser Option können Sie die zuletzt
Rückgängig gemachte Aktion wiederherstellen.

Rückgängig

Tastenkombination "STRG+Z"

Wiederherstellen

Tastenkombination "STRG+A"

Bevorzugte Einstellungen vornehmen

Die Befehle “Allgemeine Einstellungen” im Menü “Datei” und “Einstellungen” im Menü "Bild" dienen der Festlegung
einzelner, globaler Einstellungen. Mit diesen Befehlen paßt man u.a. die Eigenschaften des Arbeitsblattes an, stellt die
Eigenschaften des Gitters ein, bestimmt die vom Programm zu verwendende globale Maßeinheit u.v.m.

EasySIGN beenden

Mit dem Befehl "Beenden" aus dem Menü "Datei" wird die aktuelle EasySIGN-Sitzung beendet.

Ansicht des Arbeitsblatts

EasySIGN verfügt über drei verschiedene Modi zur Ansicht Ihrer Arbeit.

Umriß Ansicht 
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Diese Option zeigt alle Objekte auf dem Arbeitsblatt als Linien, ohne Füllungen und Umrisse. Das markieren der
Objekten ist ausschließlich möglich durch Klicken auf den Rand des Objekts.

Normal Ansicht

Die Objekte werden in guter Qualität, inkl. Füllungen und Umrisse, dargestellt. Das Objekt kann markiert werden
durch anklicken eine beliebige Stelle innerhalb des Objektes.

Hohe Qualität

Durch diese Option werden alle Objekte in der bestmöglichen Qualität dargestellt. Markiert wird selbstverständlich wie
in normal Ansicht.

Fenster aktualisieren 

Sind Reste früherer Bearbeitungen auf der Benutzeroberfläche zurückgeblieben, kann man diese durch die Auswahl
des Befehls "Aktualisieren" im Menü "Fenster" erneut zeichnen.
Das Befehl “Aktualisieren” im Menü “Fenster” zeichnet die Benutzeroberfläche neu, so daß Reste früherer Bearbeitung
beseitigt werden.

Abkürzungstaste - Taste "F5"

Arbeitsfenster verschieben

Bildlaufleiste
Mit den waagrechten und senkrechten Bildlaufleisten am Rand der Benutzeroberfläche können Sie jene Teile Ihrer
Zeichnung betrachten, die außerhalb des aktuellen Ansichts liegen.

Die Bildlaufpfeile
Klicken Sie den entsprechenden Bildlaufpfeil zum schrittweisen Verschieben des Fensters in die gewünschte Richtung
an.

Die Bildlaufleisten
Klicken Sie zum Verschieben des Fensters in die gewünschte Richtung auf die Bildlaufleiste selber (in größeren
Schritte).

Das Bildlauffeld
Das Bildlauffeld läßt sich in zwei Richtungen verschieben. 

Ziehen
Um das Arbeitsblatt zu verschieben, können Sie auch die Leertaste betätigen und gedrückt halten. Der Cursor ändert
sich dann wie folgt:

Klicken Sie das Arbeitsblatt an während Sie die Leertaste gedrückt halten, und schieben Sie es an die gewünschte
Stelle. Lassen Sie danach zunächst die Leertaste und dann die Maustaste los.

Zoomwerkzeug
Z o o m w e r k z e u g

Wenn Sie eine der verfügbaren Zoomoptionen verwenden wollen, klicken Sie  folgende Schaltfläche auf der
Werkzeugpalette an.

Es erscheint ein Folgemenü mit diesen Optionen:
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Vergrößern
Nach der Wahl dieser Option ändert sich der Cursor folgendermaßen:

Sie können nun das gewünschte Gebiet vergrößern, indem Sie ein Rechteck um das jeweilige Gebiet ziehen.

Verkleinern
Nach der Wahl dieser Option ändert sich der Cursor folgendermaßen:

Zum Verkleinern klicken Sie einmal auf das Arbeitsblatt. Die angeklickte Stelle wird dabei zur Fenstermitte hin
verschoben.

Alles
Diese Option vergrößert alle Objekte auf dem Arbeitsblatt, ungeachtet dessen, ob diese ausgewählt wurden oder
nicht.

Markierung
Diese Option vergrößert nur markierte Objekte.

Seite
Diese Option vergrößert nur das Arbeitsblatt.

Vorherige
Mit dieser Option kehren Sie zur vorherige Ansicht zurück.

Objekte positionieren und ändern

Allgemeines
A l l g e m e i n e s

Das Verschieben, Kopieren (Duplizieren) und Löschen von Objekten gehört zu den Basisfunktionen jedes Programms.
In EasySIGN kann dies, wie die meisten Befehle, auf zwei Arten ausgeführt werden. Einerseits durch Ziehen der
Maus, andererseits durch die Eingabe numerischer Werte in ein Dialogfenster. Manche Befehle sind auch anhand von
Tastenkombinationen (oder Schnelltasten) ausführbar, wie z.B. das Löschen von Objekten mit “Entf” oder das
Verdoppeln mit der Tastenkombination "STRG+D".

Mit dem Befehl "Verdoppeln" im Menü "Bearbeiten" lassen sich Objekte kopieren. Damit erhält man die genaue Kopie
eines Objekts. Sie können dies auch erreichen, indem Sie das Objekt mit der Maus ziehen und kurz vor Sie die linke
Maustaste loslassen, einmal mit der rechten Maustaste klicken. Das Programm macht dann ein Duplikat des Objekts.
Die gerade beschriebene Methode kann auch zum Anbringen einer Hilfslinie im Duplikat verwendet werden.

Die magnetischen Eigenschaften von Hilfslinien, Knotenpunkten und einem Gitter dienen der schnellen und genauen
Positionierung von Objekten. Diese äußerst genaue Funktion macht das starke Vergrößern von Objekten zur genauen
Ausrichtung überflüssig. 

Beim Zusammenstellen komplizierter Entwürfe kann man Objekte noch nach vielen weiteren Methoden ordnen, so
zum Beispiel durch Zentrieren, Gruppieren und durch Nutzung von Ebenen.
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Objekte verschieben
O b j e k t e  v e r s c h i e b e n  

Verschieben mit der Maus 
Das Verschieben mit der Maus funktioniert bei der Arbeit im Umrißmodus genau wie in Farbe, mit einem kleinen
Unterschied. Bei der Arbeit im Umrißmodus ist das Objekt immer an einem seiner Ränder zu markieren, bei der
Arbeit in Farbe kann es hingegen an jeder beliebigen Stelle angeklickt werden. Nachfolgend sprechen wir
ausschließlich von “Markieren des Objekts” und überlassen es Ihnen ob Sie im Umrißmodus oder den  Farbmodus
bevorzugen. Für beide Bildschirmmodi gilt, daß bei Berührung eines der Knotenpunkte mit der Maus ein rotes
Kästchen erscheint. Dies als Hinweis auf die Möglichkeit, das Objekt mittels dieses Knotenpunktes zu markieren oder
zu positionieren 

Positionieren Sie das Markierwerkzeug über das zu verschiebende Objekt. 

Klicken Sie das entsprechende Objekt an, und lassen Sie die Maustaste gedrückt.

Die Maus dorthin bewegen, wohin das Objekt verschoben werden soll. Ungeachtet der Form des Objekts bildet diese
während des Ziehens einen blauen Rahmen zur aktuellen Darstellung der Begrenzungslinien des darunterliegendes
Objekts. Der Mauscursor nimmt der Form eines Kreuz an,  das Objekt kann jetzt in beliebigen Richtung verschoben
werden.
Beim erreichen der gewünschte Position wird der Maustaste losgelassen.

Beim Verschieben mit gehaltener Steuerungstaste, erfolgt die Verschiebung des Objekts auf einer (je nach
Bewegungsrichtung) horizontalen oder vertikalen Linie.

Verschieben mit numerischen Werten 

Tastenkombination "ALT+F7"

 Markieren Sie das numerisch zu verschiebende Objekt .

Klicken einmal mit der rechten Maustaste  auf das Objekt. Es erscheint ein PopUp-Menü.



55EasySIGN

In diesem PopUp-Menü wählen Sie den Befehl “Ändern” aus. Daraufhin erscheint ein Folgemenü. Daraus wählen Sie
“Position”.

Der Verschiebungsdialog enthält mehrere Eingabemöglichkeiten.

Position (1)
In diesem Fach befinden sich die horizontale( X) und die vertikale Position (Y) des markierten Objekts.

Ursprung (2)
Die Schaltflächen in diesem Fach geben den Ursprung des Objekts an. Im obigen Dialog ist die Schaltfläche links
unten aktiviert. In den Feldern X und Y stehen die Werte 100, 100. Das heißt, die linke, untere Ecke des Objekts liegt
100 Einheiten vom linken Rand der Arbeitsfläche sowie 100 Einheiten von deren Unterrand entfernt.

Original behalten (3)
Bei der Aktivierung dieser Option erfolgt die Verschiebung des Objekts, wobei das Original an der ursprünglichen
Stelle verbleibt.

Relativ Verschieben (4)
Bei der Wahl dieser Option ändern sich die Werte in den Feldern X und Y, die aktuellen Position wird auf 0,0 gesetzt.
Im folgenden Beispiel wird von einem Objekt ausgegangen, das 50 Einheiten breit und 50 Einheiten hoch ist und sich
links unten auf der Seite am Nullpunkt befindet.

1 Wählen Sie die Optionen "Original behalten" und "Relativ Verschieben" aus.
2 Klicken Sie die Schaltfläche "Rechts oben" in der Gruppe "Ursprung" an.

3 Geben Sie für X und Y den Wert "50" ein.
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4 Klicken Sie auf die Schaltfläche “Übernehmen”.
5 Das Ergebnis sieht folgendermaßen aus.

Das Objekt ist insgesamt 50 Einheiten nach oben sowie nach rechts verschoben worden, das Original ist hinterlassen,
d.h. an der ursprünglichen Stelle belassen worden.

Schließen
Diese Schaltfläche schließt den Dialog.

Übernehmen
Ist diese Schaltfläche aktiv, werden mit ihr die vorgenommenen Einstellungen ausgeführt.

Verschieben mit Hilfe der Pfeiltasten 
Im Menü “Allgemeine Einstellungen” bestimmt man im dazugehörigen Dialog unter “Allgemein” den Abstand, über den
das Objekt mit Hilfe der Pfeiltasten verschoben werden soll.

 

Tips
T i p s

Rüttelnde Bewegungen während beim Verschieben mit der Maus
In dem Fall ist wahrscheinlich die magnetische Eigenschaft des Gitters aktiviert. Schalten Sie diese bitte zur

Vermeidung dieses Problems  die magnetische Eigenschaft des Gitters aus.

Nur horizontal oder vertikal verschieben
Dazu benutzt man beim Verschieben die Steuerungstaste Diese halten Sie beim Verschiebungsvorgang mit der Maus
gedrückt. Wegen der einschränkenden Funktion dieser Taste müssen Sie bei der Verschiebung über eine Horizontale
oder Vertikale erst die Maustaste loszulassen und danach die Steuerungstaste. 

Verschieben mit Hilfe von ausgewählten Knotenpunkten
Steht man mit dem Mauscursor über dem Knotenpunkt eines Objekts, kann dieses markiert werden. Bei aktivierter
Option “Magnetische Knotenpunkte " ist dies eine einfache Art der direkten Aneinanderreihung von Objekten ohne
dabei magnetischer Hilfslinien zu verwenden.

Objekte drehen
O b j e k t e  d r e h e n  

Drehen mit der Maus
Markieren Sie ein Objekt durch einmaliges Anklicken. Nachdem das Objekt ausgewählt wurde, erscheinen 8
Markierpunkte.

Klicken Sie nun das Objekt erneut mit der Maus an.
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Die Markierpunkte sehen jetzt anders aus. Zum Drehen nur die Hebel an den Eckpunkten des Objekts verwenden.

Das Drehen erfolgt durch Bewegung in die dazu vorgesehene Richtung bei gleichzeitig gedrückt gehaltener linker
Maustaste.

Während der Drehung bleibt das Objekt sichtbar und gibt eine blaue Linie mit dessen Umrissen die neue Position
wieder.

Nach dem Loslassen der Maustaste ist das Objekt gedreht.

Rotationsachse von Objekten
Die Anzeige der Rotationsachse eines Objekts erfolgt immer durch dieses Symbol.

Das Symbol kann mit der Maus an jede beliebige Stelle auf der Arbeitsfläche verschoben werden. Die Rotationsachse
legt jenen Punkt fest, um den die Drehung eines Objekts erfolgen soll. 

Versetzen der Rotationsachse
Zur Anzeige der Drehungshebel zweimal auf ein nicht gewähltes Objekt klicken.

Den Cursor über die Rotationsachse halten. Sobald sich dieser in ein Kreuz verändert hat, kann mit der Verschiebung
begonnen werden.

Nun können Sie die Rotationsachse an jede beliebige Stelle auf dem Arbeitsblatt verschieben.
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Bei der Drehung des Objekts wird deutlich, daß diese um jenen Punkt erfolgt, wo sich die Rotationsachse jetzt
befindet.

Durch Ziehen der Rotationsachse mit der “Steuerungstaste” verschiebt man diese wieder genau in die Mitte des
Objekts.

Drehen mit Hilfe numerischer Werte 

Tastenkombination "ALT+F8"

 Wählen Sie das numerisch zu drehende Objekt aus.

 Nachdem Sie das Objekt ausgewählt haben einmal mit der rechten Maustaste klicken. Es erscheint ein PopUp-Menü.
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 Im PopUp-Menü wählen Sie den Befehle "Ändern" aus. Daraufhin erscheint ein Folgemenü. Aus diesem wählen Sie
“Drehen”.

Drehung (1)
 Hier befindet sich ein Eingabefeld für die bei der Drehbewegung zu berücksichtigende Gradanzahl.
 Außerdem befinden sich in diesem Feld zwei Kontrollkreise. Damit legen Sie die Richtung, in der das Objekt gedreht
werden soll, fest.

Ursprung (2)
 Die Schaltflächen in diesem Feld geben die Rotationsachse des Objekts an.

Das Behalten des Originals (3)
 Bei der Aktivierung dieser Option erfolgt die Drehung des Objekts mit Behalten des Originals.

Besondere Drehungen
Die Plazierung der Rotationsachse verbunden mit dem Rotationsdialog ermöglicht noch mehr Kontrolle über den
Drehvorgang. Durch Verschiebung der Rotationsachse und Laden des Dialogs kann man Objekte in einem sich
wiederholenden Muster anordnen.

Beispiel
 Doppelklicken Sie auf ein Objekt zur Anzeige der Rotationshebel.

 Verschieben Sie die Rotationsachse.
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 Laden Sie nun mit Hilfe PopUp-Menüs den Rotationsdialog.

 Bei "Ursprung" (2), wo sich erneut die Schaltflächen zur Verlegung der Rotationsachse an einen Eckpunkt oder auf
eine Seite des Objekts befinden, erscheint nun folgendes Symbol.

 Geben Sie nun bei “Drehung” "30 Grad" ein, und aktivieren Sie die Option "Original behalten" (3). Danach klicken Sie
zwölfmal die Schaltfläche “Übernehmen” an.

Sie haben nun auf eine einfache Art eine Komposition geschaffen, mit einem Objekt an jeder Stelle, wo sich
gewöhnlich die Ziffern einer Uhr befinden würden.
Anstelle des mehrmaligen Anklickens der Schaltfläche “Übernehmen” ist auch eine Drehbewegung mit dem Dialog
oder der Maus und danach die Wahl des Befehls “Wiederholen” im Menü “Bearbeiten” bzw. die Verwendung der
Tastenkombination “Steuerung +R" möglich.

Objekte neigen
O b j e k t e  n e i g e n

Neigen mit der Maus
Wählen Sie ein Objekt durch einmaliges Anklicken aus. Nachdem Sie das Objekt ausgewählt haben, erscheinen um
das Objekt 8 Markierhandgriffe.

Klicken Sie das Objekt nun erneut mit der Maus an.

 

Die Markierhandgriffe. sind verändert. Verwenden Sie zum Neigen nur die seitlichen Handgriffe des Objekts.
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Das Neigen eines Objekts erfolgt durch Bewegen der Maus in eine der vom momentan verwendeten Handgriff
vorgegebene Richtung.

Neigen mit Hilfe numerischer Werte 

Tastenkombination "ALT+F11"

Wählen Sie das numerisch zu neigende Objekt aus.

Nachdem Sie das Objekt markiert haben, klicken Sie einmal auf die rechte Maustaste. Es erscheint ein PopUp-Menü.

In diesem PopUp-Menü wählen Sie den Befehl "Ändern" aus. Danach erscheint ein Folgemenü. Aus diesem wählen Sie
“Neigen”.
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Ecke (1)
In dieser befindet sich ein Eingabefeld für die Gradanzahl, die das Objekt abgeschrägt werden kann. Außerdem
enthält das Feld zwei Kontrollkreise. Mit deren Hilfe wird die zum Neigen des Objekts gewünschte Richtung festgelegt.

Ursprung (2)
Die Schaltflächen in diesem Feld beziehen sich auf den Ursprung (bzw. die Achse), der (die) beim Neigen als
Ankerpunkt dienen. Die folgenden Abbildungen zeigen den Unterschied zwischen den einzelnen Ankerpunkten.

Ausgangslage

Ursprung Ergebnis

  

  

  

Original behalten(3)
Bei Aktivierung dieser Option wird das Objekt mit Behalten des Originals abgeschrägt.

Objekte spiegeln
O b j e k t e  s p i e g e l n  

Spiegeln mit der Maus
Wählen Sie ein Objekt durch einmaliges Anklicken aus. Nachdem Sie das Objekt markiert haben, erscheinen um das
Objekt 8 Markierhandgriffe.
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Zum Spiegeln des Objekts können Sie jeden beliebigen Markierhandgriff verwenden.

Nun die linke Maustaste betätigen und den Cursor nach rechts bewegen. Zum einfachen Spiegeln des Objekts ohne
gleichzeitiges Verformen dient die “Steuerungstaste”. Dies hat eingeschränkte Funktionen und sorgt für die
Beschränkung der Bewegung auf Schritte von nicht mehr als 100%iger Objektgröße.

Wenn Sie während des Spiegelns die rechte Maustaste einmal betätigen, wird automatisch ein Original des Objekts
hinterlassen

Spiegeln mit Hilfe eines Dialogs

Tastenkombination "ALT+F10"

Wählen Sie das zu spiegelnde Objekt aus.

Nachdem Sie das Objekt markiert haben, klicken Sie einmal auf die rechte Maustaste. Es erscheint ein PopUp-Menü.
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Aus dem PopUp-Menü den Befehl "Ändern" wählen. Danach erscheint ein Folgemenü. In diesem wählen Sie
“Spiegeln”.

Spiegeln (1)
Hier befinden sich zwei Kontrollkästchen. Bei Aktivierung des obersten Kontrollkästchens erfolgt die Spiegelung des
Objekts in der Waagrechten. Bei Wahl der untersten Option kommt es zur Spiegelung des Objekts in der
Senkrechten. Auch die gleichzeitige Verwendung beider Optionen ist möglich.

Ursprung (2)
Die Schaltflächen in diesem Feld beziehen sich auf den Ursprung (bzw. die Achse), der (die) beim Spiegeln als
Ankerpunkt dient. Die folgenden Abbildungen zeigen den Unterschied zwischen den einzelnen Ankerpunkten. In den
unten gezeigten Beispielen wurde sowohl die Option "Horizontal" als auch "Vertikal" aktiviert. Außerdem war auch
“Original behalten” (3) aktiviert. Das Objekt mit den Markierhebeln ist das gespiegelte Objekt.

Die Ausgangslage

Ursprung Ergebnis
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Vergrößern, Verkleinern und Verformen von Objekten nach Maßstab
V e r g r ö ß e r n ,  V e r k l e i n e r n  u n d  V e r f o r m e n  v o n  O b j e k t e n  n a c h  M a ß s t a b

Vergrößern, Verkleinern und Verformen nach Maßstab mit der Maus
Wählen Sie das Objekt aus, indem Sie einmal darauf klicken.

Die eingekreisten Markierhebel in der folgenden Abbildung dienen dem Vergrößern und Verkleinern.

Durch Wegbewegen des Cursors vom Objekt wird das Objekt vom Cursor vergrößert.
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Durch Hinbewegen des Cursurs zum Objekt wird das Objekt vom Cursor verkleinert.

Bei gleichzeitiger Betätigung der “Umschaltetaste” beim Vergrößern oder Verkleinern des Objekts wird von der Mitte
aus der Maßstab genommen.

 

Wurde während des Vergrößerns die “Steuerungstaste” betätigt, kommt zur Aufnahme des Maßstabs mit gleichzeitiger
Verdoppelung der Größe bei jedem Schritt.

 

Die eingekreisten Markierhebel in der folgenden Abbildung dienen dem Verformen.

Ebenso wie für das Nehmen des Maßstabs gilt auch beim Verformen von Objekten die Verwendung der
“Umschaltetaste” zum Verformen von der Mitte aus und die Benutzung der “Steuerungstaste” zum Verformen in
Schritten von 100 Prozent.

Vergrößern, Verkleinern und Verformen nach Maßstab mit Hilfe numerischer Werte 

Tastenkombination "ALT+F9"

Wählen Sie das zur numerischen Aufnahme des Maßstabs (bzw. zum Verformen) vorgesehene Objekt aus.
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Nachdem Sie das Objekt markiert haben, klicken Sie einmal auf die rechte Maustaste. Es erscheint ein PopUp-Menü.

In diesem PopUp-Menü wählen Sie Befehl "Ändern" aus. Daraufhin erscheint ein Folgemenü. Aus diesem wählen Sie
“Größe...”.

Größe (1)
In diesem Feld befinden sich die horizontalen (X) und vertikalen (Y) Werte für das Format des gewählten Objekts.

Ursprung (2)
Die Schaltflächen in diesem Feld beziehen sich auf den Ursprung des Objekts.

Original behalten (3)
Die Aktivierung dieser Option führt zur Aufnahme des Maßstabs (bzw. der Verformung) eines Objekts, wobei das
Original an der ursprünglichen Stelle belassen wird.

Proportional (4)
Ist diese Option aktiv, kann nur der Maßstab eines Objekts genommen werden. Jeder unter “X” eingetragene Wert
beeinflußt jenen unter “Y” und umgekehrt.

Numerisch (5)
Ist diese Option aktiv, enthalten die Felder “X” und “Y” die tatsächlichen Maße des Objekts.

Beispiele in verschiedenen Maßstäben
Das mit Markierhebeln umgebene Objekt stellt das Endergebnis dar.
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Ausgangslage

Ursprung Ergebnis
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Transformationsassistent
T r a n s f o r m a t i o n s a s s i s t e n t

Der Transformationsassistent hilft Ihnen beim Anwenden der im Programm verfügbaren Transformationen. Sie
können in diesem verschiebbaren Dialogfeld Transformationen wie Positionierung, Drehung usw. durchführen. Geben
Sie beispielsweise eine Zahl für die horizontale Positionierung ein, und wenden Sie den Effekt an, indem Sie auf die
EINGABETASTE drücken. Sie können dieses Dialogfeld über das Menü Ansicht > Transformationsassistent
anzeigen oder verbergen:

Durch Ziehen an den Ecken können Sie Form und Aussehen dieses Dialogfeldes ändern.

Die Optionen des Transformationsassistenten

Position

Horizontal

Vertikal

Größe

Horizontal

Vertikal

Neigen

Horizontal
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Vertikal

Drehen

Beide
Richtungen

Sie können einen negativen oder einen positiven Wert eingeben und so eine Drehung in beide Richtungen vornehmen.

Spiegeln

Horizontal

Vertikal

Verankerungspun
kt

Eine Änderung des Verankerungspunktes beeinflusst folgende Optionen:
Position
Größe
Neigen
Drehen
Spiegeln
Wenn Sie den Verankerungspunkt nach unten links verschieben, verwendet die Transformation diesen Punkt als
Verankerungspunkt:

In dem oben stehenden Beispiel befindet sich der Verankerungspunkt unten links. Die Drehung wird entlang der
Begrenzungen des Objekts vorgenommen. Denken Sie daran, dass sich die Begrenzungen eines Objekts nach einer
Drehung ändern. Die Drehung kann daher zu unerwarteten Ergebnissen führen, wenn eine zweite Drehung
vorgenommen wird:

In dem oben stehenden Beispiel stellt das rote Feld die ursprüngliche Position des Objekts dar. Das blaue Feld stellt
die Begrenzungen des Objekts und der gelbe Punkt den Drehpunkt dar. Sie sehen, dass sich nach jeder Drehung die
Begrenzungen des Objekts ändern. Gleichzeitig ändert sich auch die Position des Drehpunktes. Im Kapitel “Objekt
drehen” finden Sie Informationen zur Funktionsweise eines Drehpunktes. 

Proportion
al

Mit dieser Option werden die folgenden Felder proportional in Abhängigkeit gestellt:
Horizontale und vertikale Position 
Horizontale und vertikale Größe

Prozen
t
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Wenn Sie diese Option wählen, werden in den Feldern für Größe statt der tatsächlichen Werte Prozentangaben
verwendet, die im Verhältnis zum Ausgangsobjekt stehen.

Relati
v

Wenn Sie diese Option wählen, werden Objekte relativ zur aktuellen Position verschoben.

Original
beibehalten

Bei jeder Transformation (außer Anordnung) wird ein Duplikat beibehalten.

Anordnung

Eins nach vorne

Ganz nach
vorne

Eins nach hinten
 

Ganz nach
hinten

Objekte duplizieren
O b j e k t e  d u p l i z i e r e n

Objekte können mit dem Befehl “Duplizieren” verdoppelt werden oder mit Hilfe von “Ausschneiden”, “Kopieren” und
“Einfügen”. Dabei spielt der interne Zwischenspeicher von EasySIGN eine Rolle.

Eine Kopie des Objekts im internen Zwischenspeicher plazieren:

 Tastenkombination "STRG+C"

1 Wählen Sie das zu kopierende Objekt aus.
2 Wählen Sie im Menü “Bearbeiten” den Befehl “Kopieren” (oder die gleichnamige Schaltfläche der

“Symbolleiste”).

Ausschneiden und Versetzen eines Objekts in den internen Zwischenspeicher:

 Tastenkombination "STRG+X"

1 Wählen Sie das auszuschneidende Objekt aus.
2 Wählen Sie im Menü “Bearbeiten” den Befehl “Ausschneiden” (oder die gleichnamige Schaltfläche der

“Symbolleiste”). Das Objekt verschwindet im internen Zwischenspeicher.

Einfügen von Objekten aus dem internen Zwischenspeicher in das Arbeitsblatt:

 Tastenkombination "STRG+V"

Wählen Sie im Menü “Bearbeiten” den Befehl “Einfügen” (oder die gleichnamige Schaltfläche der
“Symbolleiste”).

Duplizieren

Tastenkombination "STRG+D"

Mit dem Befehl “Duplizieren” aus dem Menü “Bearbeiten” erstellt man eine Kopie der markierten Objekte.

Duplizieren  ohne Verschiebung 

Schnelltaste "NUM-LOCK+"

Mit diesem Befehl aus dem Menü “Bearbeiten” wird eine Kopie des Objekts genau über dem Original plaziert.
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Objekte löschen
O b j e k t e  l ö s c h e n  

Schnelltaste "ENTF"

Soll ein Objekt von der Arbeitsfläche gelöscht werden, wählen Sie aus dem Menü "Bearbeiten" den Befehl "Löschen"
oder Sie verwenden die Schnelltaste "ENTF".

Objekte ausrichten
O b j e k t e  a u s r i c h t e n  

Mit den einzelnen Befehlen aus der Menüzeile "Objekte ausrichten" können Sie alle Objekte ausrichten, in der Größe
angleichen oder auf der Seite zentrieren.

Achtung
Für alle Befehle dieser Menüzeile (außer für das Zentrieren auf der Seite) gilt, daß das zuletzt markierte Objekt die
Ausrichtung des anderen Objekts bestimmt. Mit anderen Worten: Das zuletzt markierte Objekt ändert seinen Platz
nicht.

 Plazieren Sie nun bitte zwei Objekte auf das Arbeitsblatt.

 Wählen Sie das erste der auszurichtenden Objekte aus.

 Wählen Sie das letzte der auszurichtenden Objekte aus.

 Klicken Sie auf die Schaltfläche "Links ausrichten" in der "Ausrichtungspalette”

 Klicken Sie auf die Schaltfläche "Übernehmen" in der "Ausrichtungspalette".

 Damit haben Sie das zuerst markierte Objekt links vom zuletzt markierte Objekt ausgerichtet.



74 EasySIGN

 

Ausrichtungsbefehle
A u s r i c h t u n g s b e f e h l e

Der folgende Abschnitt erklärt die einzelnen Ausrichtungsbefehle sowie deren Kombinationsmöglichkeiten.

Platz in der Menüzeile

Die einzelnen Befehle

A Linksbündig ausrichten

B Vertikal zentrieren

C Rechtsbündig ausrichten

D Nach oben ausrichten

E Horizontal zentrieren

F Nach unten ausrichten

G Alle markierten Objekte in Seite Mitte
ausrichten.

H Alle markierten Objekte gleich breit machen.

I Alle markierten Objekte gleich hoch machen.

J Den (die) ausgewählten Befehle(e)
übernehmen.

Befehlskombinationen

Ausgangslage

Kombination Ergebnis
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Alle angeführten Kombinationen lassen sich auch zusammen mit folgenden Befehlen verwenden:

Alle markierten Objekte gleich breit
machen.

Alle markierten Objekte gleich hoch
machen.

Diese zwei Befehle können sowohl einzeln mit den Ausrichtungsbefehlen verwendet werden, als auch gleichzeitig, wie
zum Beispiel die folgende Kombination.

Verteilen (Abstand gleichmäßig)
V e r t e i l e n  ( A b s t a n d  g l e i c h m ä ß i g )

Die Verteilungsoptionen ermöglichen es, Objekte so anzuordnen, dass die Entfernungen zwischen ihnen gleich sind. Sie können die Entfernung

zwischen den Objekten von der Software berechnen lassen oder diesen Wert selbst festlegen.

Automatisches Berechnen der Entfernung

Diese Optionen sind auf der Symbolleiste zum Ausrichten von Objekten zu finden. Es ist  auch möglich, sie im Menü "Anordnen" über die Option

"Abstand gleichmäßig" aufzurufen und dabei einen Wert für die Entfernung anzugeben.

A : Horizontal verteilen
Markieren Sie die zu verteilenden Objekte, und klicken Sie dann auf der Ausrichtungssymbolleiste auf die gewünschte Option. Nach dem Klicken auf

die Schaltfläche "Eingabe" der Symbolleiste werden die Objekte horizontal verteilt . Die beiden äußersten Objekte verbleiben an ihren Positionen

und fungieren so als Anker. Dies bedeutet, dass die anderen Objekte relativ zu den festen Objekten angeordnet werden. 

 

Optio
n

Ergebnis
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1

2

3

4

B: Vertikal verteilen
Diese Option funktioniert genauso wie die Option "Horizontal verteilen", außer dass alle Objekte vertikal verteilt  werden.

Sie können die horizontale und vertikale Verteilung gleichzeitig anwenden. Es empfiehlt sich jedoch, die beiden Verteilungen einzeln durchzuführen.

Außerdem können Sie die Verteilungsoptionen mit den Ausrichtungsoptionen kombinieren. Bei dieser Kombination verbleibt das zuletzt markierte

Objekt an seiner Position und fungiert als Anker.

C : Textausrichtungsoptionen
Klicken Sie auf der Ausrichtungssymbolleiste auf die Schaltfläche "C", um das Dialogfeld "Abmessungseinstellungen für Textausrichtung" zu öffnen.

Eine ausführliche Beschreibung finden Sie im Kapitel "Textausrichtungsoptionen". 

Entfernung angeben

Diese Option steht zur Verfügung, wenn Sie im Menü "Anordnen" auf "Gleichmäßiger Abstand" und dann auf
"Verteilen" klicken.

1 Horizontal ausrichten

Optionen von links nach rechts:

Keine Ausrichtung.

Entfernung zwischen linker Seite und linker Seite.

Entfernung zwischen Mitte und Mitte.

Entfernung zwischen rechter Seite und rechter Seite.

Entfernung zwischen rechter Seite und linker Seite des nächsten Objekts.

2 Entfernung angeben

Bei Bedarf können Sie eine benutzerdefinierte horizontale Entfernung zwischen den Objekten
angeben.
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3 Vertikal verteilen

Optionen von links nach rechts:

Keine Verteilung.

Entfernung zwischen unterer Seite und unterer Seite.

Entfernung zwischen Mitte und Mitte.

Entfernung zwischen oberer Seite und oberer Seite.

Entfernung zwischen oberer Seite und unterer Seite des nächsten Objekts.

4 Entfernung angeben

Bei Bedarf können Sie eine benutzerdefinierte vertikale Entfernung zwischen den Objekten
angeben.

Textausrichtungsoptionen
T e x t a u s r i c h t u n g s o p t i o n e n

Aufgrund der Komplexität von Textobjekten und der unterschiedlichen Meinungen hinsichtlich der richtigen Methode zum Ausrichten dieser

Objekte gibt es mehrere Textausrichtungsoptionen. Klicken Sie im Menü "Ansicht" auf "Einstellungen" und dann auf der Registerkarte "Text" auf

die Schaltfläche "Textabmessungen…".

1 Ausrichten von Text mit Leerraum

2 Ausrichten von Text ohne Leerraum

3 Ausrichten von Text auf der Grundlinie

Sie können jede beliebige Kombination aus diesen Optionen auswählen. Die in diesem Dialogfeld vorgenommenen Einstellungen gelten für das

gesamte Softwarepaket.    
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A Hellgrauer Bereich

Dies ist der "Leerraum" eines Textes.

B Dunkelgrauer Bereich

Dies ist die Vektorform oder Kurve eines Textes (Option: "ohne Leerraum").

C Knoten (winzige Quadrate)

Ursprungspunkte der verschiedenen Zeichen.

D Orangefarbene Linie

Grundlinie, verläuft durch die Ursprungspunke der verschiedenen Zeichen.

Nachstehend finden Sie einige Beispiele mit unterschiedlichen Einstellungen.

Wenn Sie Text typografisch (und visuell) korrekt ausrichten möchten, aktivieren Sie die unten wiedergegebene Optionskombination.
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Wenn die einzige Textausrichtungsoption in den Versionen vor Version 5 für Ihre Anforderungen ausreichte, aktivieren Sie die unten

wiedergegebene Optionskombination.

Lineale
L i n e a l e

Die horizontalen und vertikalen Lineale von EasySIGN befinden sich oben und links auf der Arbeitsfläche. Ihre
Abbildung erfolgt entsprechend der gewählten Maßeinheit.

 

Gitter
G i t t e r

Das Gitter ist ein sich auf der Seite befindendes Punkteraster. Bei aktivierter Option "Magnetisches Gitter" sorgt
dieses für die Beschränkung aller mit der Maus vorgenommenen Verschiebungen auf ein Vielfaches des
Gitterabstands.

 

Hilfslinien
H i l f s l i n i e n

Sie können auf zwei Arten Hilfslinien zu einem Arbeitsblatt, welches bisher keine enthielt, hinzufügen.

 1 Halten Sie den Mauscursor über das Lineal setzen, und klicken Sie mit der rechten Maustaste.
 Nun erscheint ein PopUp-Menü.

 In diesem PopUp-Menü der Hilfslinien befinden sich folgende Befehle:
 Verbergen/Zeigen
 Gittereinstellungen

 Hilfslinieneigenschaften
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 Beim Anklicken von "Hilfslinieneigenschaften" mit der Maus erscheint dieser Dialog.

 Der Dialog selbst ist unterteilt in 3 "Registerkarten" (1). Die erste Registerkarte dient der Arbeit mit
waagrechten Hilfslinien, die zweite mit senkrechten und die dritte mit diagonalen.

 Der linke Dialogteil gibt den Platz der Hilfslinien in numerischer Form wieder (2). Befinden sich hier mehrere
Hilfslinien, sind die Eigenschaften einer jeden durch Anklicken ihres numerischen Werts änderbar. Der Wert der
ausgewählten Hilfslinie erscheint dann im Textfenster nebenan (3). 

Hilfslinien löschen
Wählen Sie die Hilfslinie aus (2). Klicken Sie dann auf die Schaltfläche "Löschen" (6).

Hilfslinien verschieben
Wählen Sie die Hilfslinie aus (2). Geben Sie dann den neuen Wert ein (3), und klicken Sie auf die Schaltfläche
"Verschieben" (5).

Hilfslinien hinzufügen
Geben Sie einen Wert ein (3). Klicken Sie dann auf die Schaltfläche "Hinzufügen" (4).

2. Halten Sie den Mauscursor über das Lineal und ziehen Sie die  Hilfslinie in das Arbeitsblatt.

Hilfslinien bearbeiten
Zum Bearbeiten von Hilfslinien auf einer Arbeitsfläche halten Sie die Maus über die betreffende Hilfslinie. Klicken Sie
diese mit der rechten Maustaste an. Daraufhin erscheint ein PopUp-Menü.

In diesem PopUp-Menü der Hilfslinien befinden sich folgende Befehle:
Löschen
Magnetische Hilfslinien
Nach vorne/Nach hinten
Sichtbar/Unsichtbar
Eigenschaften
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Löschen
Diese Option dient der Entfernung der ausgewählten Hilfslinie. Diese kann man auch durch Zurückziehen in ein Lineal
löschen.

Magnetische Hilfslinien
Durch An- oder Ausschalten dieser Option plaziert man Objekte magnetisch an den Hilfslinien.

Nach vorne/Nach hinten
Diese Option sorgt für die Plazierung der Hilfslinien vor oder hinter den Objekten auf der Arbeitsfläche.

Sichtbar/Unsichtbar
Diese Option dient dem Verbergen aller Hilfslinien auf der Arbeitsfläche, ohne sie zu löschen. Wenn Sie die Hilfslinien
erneut sichtbar machen wollen, halten Sie den Mauscursor über eines der Lineale und lädt mit der rechten Maustaste
den Dialog "Hilfslinieneinstellungen". Hier aktivieren Sie dann die Option "Hilfslinien zeigen".

Einstellungen
Hiermit wird der Dialog "Hilfslinieneinstellungen" aktiviert. 

Diagonale Hilfslinien
Will man diagonale Hilfslinien haben, ist dies auf zwei Arten möglich:

1 Laden Sie den Hilfsliniendialog laden und geben Sie die horizontalen und vertikalen sowie die Eckwerte
numerisch in die Registerkarte "Kursive Hilfslinien" ein.

2 Ziehen Sie die Hilfslinie aus einem der Lineale und plazieren Sie sie. Danach wählen Sie dieselbe Linie mit der
Maus aus und betätigen gleichzeitig die Umschaltetaste. Durch Ziehen der Maus legen Sie dann die Ecke der
Hilfslinie manuell fest.

Magnetische Eigenschaften
Die wichtigste Eigenschaft der Hilfslinien ist es, daß diese magnetisch sein können. Da dies manchmal beim Plazieren
unerwünschte Nebeneffekte haben kann, ist die magnetische Eigenschaft ein- und ausschaltbar. Das geschieht durch
das Laden eines PopUp-Menüs mit Hilfe der rechten Maustaste und An- oder Ausschalten der Option "Magnetische
Hilfslinien.

Das magnetische Festklicken (Einschnappen)
Objekte, die im Ganzen verschoben werden, schnappen immer auf die Markierhandgriffe ein. 
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Soll ein unregelmäßig geformtes Objekt gegen eine Hilfslinie geschoben werden, können Sie auch einen der
Knotenpunkte des Objekts auf der Hilfslinie einschnappen lassen.

Dabei wird so vorgegangen:
Bewegen Sie den Mauscursor über ein Objekt. Sobald ein Knotenpunkt gefunden wurde, erscheint ein rotes Kästchen.

Nachdem der Knotenpunkt gefunden wurde, klicken Sie das Kästchen mit der Maus an. Jetzt können Sie diesen Punkt
auf einer Hilfslinie oder der Kreuzung mehrerer Hilfslinien einschnappen lassen.

Ferner können Sie auf diese Objekt - Knotenpunkte die Hilfslinien selber einschnappen lassen.

Beispiel
Auf Ihrem Arbeitsblatt befindet sich ein Objekt, an dem andere Objekte links anschließen sollen.

Hierzu ziehen Sie eine Hilfslinie aus einem Lineal.

Bewegen Sie die Hilfslinie so lange links über das Objekt, bis ein rotes Kästchen erscheint, danach lassen Sie die
Hilfslinie los. Diese befindet sich dann genau an der linken Seite des Objekts.
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Tips
T i p s

Doppelte Hilfslinien plazieren
Ziehen Sie aus der Kreuzung der beide Lineale zwei Hilfslinien gleichzeitig. Dies ist eine einfache Art der schnellen
Plazierung von Hilfslinien an der Ecke eines Objekts.

Objekte gruppieren und Gruppierung aufheben
O b j e k t e  g r u p p i e r e n  u n d  G r u p p i e r u n g  a u f h e b e n  

Objekte Gruppieren

Tastenkombination "STRG+G"

Mit dem Befehl "Gruppieren" im Menü "Anordnen" verriegeln Sie die Ausrichtung von Objekten zueinander. 

Gruppierung aufheben

Tastenkombination "STRG+U"

Mit dem Befehl " Gruppierung aufheben " im Menü "Ordnen" trennt man die Objekte einer Gruppe wieder
voneinander.

Aufheben mehrerer Gruppierungen
A u f h e b e n  m e h r e r e r  G r u p p i e r u n g e n

Sind in einer Auswahl mehrere Gruppen oder ineinander verschachtelte Gruppen vorhanden, können Sie den Befehl
"Anordnen", "Gruppierung aufheben" oder die Tastenkombination "STRG+U" mehrmals nacheinander verwenden, bis
alle Gruppen der Auswahl aufgehoben sind. Auf diese Weise müssen Sie nicht die erste Gruppe der Auswahl
aufgehoben haben und die nächste Gruppe auswählen, bevor Sie den Befehl "Gruppierung aufheben" erneut
verwenden können.

Objekte kombinieren und Kombination aufheben
O b j e k t e  k o m b i n i e r e n  u n d  K o m b i n a t i o n  a u f h e b e n

Kombinieren

Tastenkombination "STRG+L"

Mit dem Befehl "Kombinieren" im Menü "Anordnen" kombiniert man zwei (oder mehrere) Objekten derselben Art
miteinander.. Kombinieren ist eingreifender als Gruppieren, da so zwei selbständige Objekte zu einem verschmolzen
werden. 

Buchstaben sind häufig kombinierte Objekte. Der Form des Buchstaben “b” besteht zum Beispiel aus einer Außen-
und einer Innenkontur. Da die Umrisse kombiniert sind, ist nur der Buchstabe gefüllt, das Loch jedoch transparent. 

Bei der Kombination vektorischer Objekte mit verschiedenen Farben sowie Linienstilen, erhält das kombinierte
Endobjekt die Farbe des zuletzt markiertes Objekts.

Angenommen, aus den folgenden Mitteln soll der Buchstabe "b" entstehen. In dem Fall muß die Sichtbarkeit des
gezeigten Balkens durch die Öffnung des Buchstabens hin erreicht werden.
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Die Plazierung des Objekts links über der Außenkontur von ""b" führt zu folgendem Ergebnis.

Der Buchstabe "b" besteht noch immer aus zwei verschiedenfarbigen Objekten, und der Balken ist nicht durch das
Objekt hin sichtbar.

Erhält das zuoberst liegende Objekt auch dieselbe Farbe wie der Hintergrund, sieht das Ergebnis zwar einem echten
"b" ähnlicher, der Buchstabe besteht allerdings noch immer aus zwei verschiedenfarbigen Objekten. 

Nach dem Kombinieren sieht das Objekt dann so aus.

Kombination aufheben

Tastenkombination "STRG+K"

Kombination aufheben ist das Rückgängigmachen von Objektkombinationen.

Intelligentes Zerlegen
I n t e l l i g e n t e s  Z e r l e g e n

Ein aus mehreren kombinierten Objekten bestehendes Objekt können Sie mit dem Befehl "Kombination aufheben"
wieder in einzelne Objekte zerlegen.

Wie die Abbildung zeigt, war es nach dem Zerlegen von Objekten, z. B. Text, bisher notwendig, jedes einzelne Objekt
erneut zu kombinieren, damit die Buchstaben wieder richtig angezeigt wurden. Mit dem Befehl "Anordnen",
"Intelligentes Zerlegen" geschieht dies nun automatisch.

Original

Nach Ausführen des Befehls "Anordnen", "Kombination aufheben"
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Nach Ausführen des Befehls "Anordnen", "Intelligentes Zerlegen" 

Anordnen von Objekten
A n o r d n e n  v o n  O b j e k t e n

Mit den Befehlen des Menüs "Anordnen, Anordnung" ändern Sie die Reihenfolge beim Stapeln von Objekten. Diese
bestimmt die Lage eines Objekts vor- oder hinter- einander. 

Nach vorne

Dieser Befehl setzt das ausgewählte Objekt um einen Platz in der Reihenfolge nach vorne.
In den Vordergrund

Dieser Befehl setzt das ausgewählte Objekt gänzlich in den Vordergrund.

Nach hinten 

Dieser Befehl setzt das ausgewählte Objekt um einen Platz in der Reihenfolge nach hinten.
In den Hintergrund

Dieser Befehl setzt das ausgewählte Objekt gänzlich in den Hintergrund.
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Erweiterte Stapelreihenfolge in Version 4
E r w e i t e r t e  S t a p e l r e i h e n f o l g e  i n  V e r s i o n  4

Klicken Sie im Menü "Anordnen" auf "Anordnung" und anschließend auf "Auswahl umkehren", um die
Stapelreihenfolge aller ausgewählten Objekte umzukehren.

Sie können ein Objekt direkt an eine beliebige Stelle der Stapelreihenfolge platzieren. Wählen Sie das Objekt, das Sie
innerhalb der Stapelreihenfolge verschieben möchten. Klicken Sie anschließend im Menü "Anordnen" auf "Anordnung"
und dann auf "In den Vordergrund" oder "In den Hintergrund". Der Mauszeiger nimmt eine andere Form an. Wählen
Sie anschließend das Objekt, vor oder hinter dem das markierte Objekt positioniert werden soll.

Objekte vervielfältigen
O b j e k t e  v e r v i e l f ä l t i g e n

Mit diesem Befehl stellt man mehrere Kopien gleichzeitig her. Er dient der Einstellung der Anzahl der zu
verfertigenden Kopien in waagrechter und senkrechter Richtung. Auch die Größe des Zwischenraums (der Abstand
zwischen dem maximalen Umfang der zu erzeugenden Kopien) ist anzugeben.
Dazu verwenden Sie den Befehl "Vervielfältigen" aus dem Menü "Anordnen".
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In die Felder unter (1) kann die Anzahl der gewünschten horizontalen und vertikalen Kopien eingetragen werden, in
die Feldern unter (2) der Abstand zwischen den Kopien.

Vervielfältigen, Kreis
V e r v i e l f ä l t i g e n ,  K r e i s

Dieser Befehl ermöglicht das Erstellen mehrerer Kopien, die kreisförmig angeordnet werden. Wählen Sie mindestens
ein Objekt aus, und klicken Sie im Menü "Anordnen" auf "Vervielfältigen". Wählen Sie im Dialog die Registerkarte
"Kreis" aus. 

In diesem Dialog wird der aktuelle Mittelpunkt des ausgewählten Objektes unter "Mittelpunkt" angezeigt. In diesen
Feldern wird die Position des ausgewählten Objektes auf dem Arbeitsblatt dargestellt. Unter "Radius" (2) können Sie
den Radius der Kreisform eingeben. Beim Öffnen des Dialogs wird in diesem Feld eine Zahl angezeigt, die auf der
Größe des ausgewählten Objektes beruht. Der Radius wird aus dem Mittelpunkt des ausgewählten Objektes und dem
Mittelpunkt der kreisförmigen Anordnung der Objekte nach der Vervielfältigung berechnet.

Unter "Winkel" finden Sie die folgenden Einstellungen.

Anfang:
Geben Sie hier den Anfangspunkt des kreisförmigen Objektes ein. Bei diesen Einstellungen können Sie sich auf die
Abbildung rechts unten im Dialog beziehen. 

Ende:
Geben Sie hier den Endpunkt des kreisförmigen Objektes ein. Wenn Sie im Feld "Anfang" 0 Grad, im Feld "Ende" 180
Grad und im Feld "Schritte" 6 eingeben, können Sie ein aus 7 Objekten bestehendes kreisförmiges Objekt mit einer
Drehung der einzelnen Objekte um je 30 Grad erstellen. 
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Wenn Sie im Feld "Anfang" 0 Grad, im Feld "Ende" 330 Grad und im Feld "Schritte" 11 eingeben, können Sie ein aus
12 Objekten bestehendes kreisförmiges Objekt mit einer Drehung der einzelnen Objekte um je 30 Grad erstellen.

In den beiden Abbildungen oben ist "A" das Originalobjekt und "B" eine Kopie dieses Objektes. Die übrigen Objekte
sind das Resultat der Zahl, die Sie im Feld "Schritte" eingegeben haben. Das Originalobjekt selbst bildet keinen Teil
der kreisförmigen Anordnung.

Schritte:
Geben Sie hier die Anzahl von Schritten ein, die in dem resultierenden kreisförmigen Objekt verwendet werden
sollen.

Jeder Schritt:
Die Felder "Ende" und "Schritte" werden deaktiviert, wenn dieses Feld aktiviert wird. Die Zahl, die Sie vorher unter
"Ende" eingegeben haben, wird jedes Mal neu berechnet, wenn das Feld "Jeder Schritt" angepasst wird.

Richtung:
Sie können hier die Richtung der Drehung eingeben.

Mit der Option "Objekt drehen" (4) können Sie festlegen, ob die Achse des Objektes bei der Drehung unverändert
bleibt oder gedreht wird.

Bei "A" wurde die Option "Objekt drehen" aktiviert, bei "B" nicht.

Sperren des Drehpunktes
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Es besteht die Möglichkeit, den Drehpunkt zu sperren, so dass das Originalobjekt nicht den Mittelpunkt, sondern einen
Teil des kreisförmigen Objektes bildet. Hierzu wählen Sie das Objekt erneut aus und wechseln in den Drehmodus. Sie
können nun den Drehmittelpunkt an die gewünschte Position ziehen. Anschließend können Sie auf den Dialog
zugreifen. Darin sind die Optionen "Mittelpunkt" und "Radius" deaktiviert, da Sie diese bereits im Arbeitsblatt
festgelegt haben. Wenn Sie so vorgehen, wird das Originalobjekt immer als Teil des kreisförmigen Objektes
verwendet und nicht als Mittelpunkt. 

Vervielfältigen, Spirale
V e r v i e l f ä l t i g e n ,  S p i r a l e

Dieser Befehl ermöglicht das Erstellen mehrerer Kopien, die spiralförmig angeordnet werden. Wählen Sie mindestens
ein Objekt aus, und klicken Sie im Menü "Anordnen" auf "Vervielfältigen". Wählen Sie im Dialog die Registerkarte
"Spirale" aus. 

In diesem Dialog wird der aktuelle Mittelpunkt des ausgewählten Objektes unter "Mittelpunkt" angezeigt. In diesen
Feldern wird die Position des ausgewählten Objektes auf dem Arbeitsblatt dargestellt. Unter "Radius" (2) können Sie
den Anfangs- und Endradius der Spiralform eingeben. Beim Öffnen des Dialogs wird in diesen Feldern eine Zahl
angezeigt, die auf der Größe des ausgewählten Objektes beruht. Der Radius wird aus dem Mittelpunkt des
ausgewählten Objektes und dem Mittelpunkt der spiralförmigen Anordnung der Objekte nach der Vervielfältigung
berechnet.
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Unter "Winkel" finden Sie die folgenden Einstellungen.

Anfang:
Geben Sie hier den Anfangspunkt des spiralförmigen Objektes ein.

Ende:
Geben Sie hier den Endpunkt des spiralförmigen Objektes ein. Wenn Sie im Feld "Anfang" 0 Grad, im Feld "Ende" 360
Grad und im Feld "Schritte" 12 eingeben, können Sie ein aus 13 Objekten bestehendes spiralförmiges Objekt mit
einer Drehung der einzelnen Objekte um je 30 Grad erstellen. 

Wenn Sie im Feld "Anfang" 0 Grad, im Feld "Ende" 720 Grad und im Feld "Schritte" 24 eingeben, können Sie ein aus
25 Objekten bestehendes spiralförmiges Objekt mit einer Drehung der einzelnen Objekte um je 30 Grad erstellen.

In den beiden Abbildungen oben ist "A" das Originalobjekt und "B" eine Kopie dieses Objektes. Die übrigen Objekte
sind das Resultat der Zahl, die Sie im Feld "Schritte" eingegeben haben. Das Originalobjekt selbst bildet keinen Teil
der spiralförmigen Anordnung.

Schritte:
Geben Sie hier die Anzahl von Schritten ein, die in dem resultierenden spiralförmigen Objekt verwendet werden
sollen.

Jeder Schritt:
Die Felder "Ende" und "Schritte" werden deaktiviert, wenn dieses Feld aktiviert wird. Die Zahl, die Sie vorher unter
"Schritte" und "Ende" eingegeben haben, wird jedes Mal erneut berechnet, wenn das Feld "Jeder Schritt" angepasst
wird.

Richtung:
Sie können hier die Richtung der Drehung eingeben.

Mit der Option "Objekt drehen" (4) können Sie festlegen, ob die Achse des Objektes bei der Drehung unverändert
bleibt oder gedreht wird.
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Bei "A" wurde die Option "Objekt drehen" aktiviert, bei "B" nicht.

Sperren des Drehpunktes

Es besteht die Möglichkeit, den Drehpunkt zu sperren, so dass das Originalobjekt nicht den Mittelpunkt, sondern einen
Teil des spiralförmigen Objektes bildet. Hierzu wählen Sie das Objekt erneut aus und wechseln in den Drehmodus. Sie
können nun den Drehmittelpunkt an die gewünschte Position ziehen. Anschließend können Sie auf den Dialog
zugreifen. Darin sind die Optionen "Mittelpunkt" und "Radius" deaktiviert, da Sie diese bereits im Arbeitsblatt
festgelegt haben. Wenn Sie so vorgehen, wird das Originalobjekt immer als Teil des spiralförmigen Objektes
verwendet und nicht als Mittelpunkt. 

Erweitertes Vervielfältigen
E r w e i t e r t e s  V e r v i e l f ä l t i g e n

Ab Version 5 wurde die Funktion zum Vervielfältigen erweitert , damit die Kopien jederzeit  noch geändert werden können. Dieses Verfahren wird als

"Step and repeat" (Schritt  und Wiederholung) bezeichnet. In EasySIGN bedeutet es, dass die Kopien über die Anwendung dieser Option hinaus

bearbeitbar bleiben. Wenn ein Arbeitsblatt  gespeichert und später erneut geöffnet wird, können Sie die Anzahl der Kopien mithilfe des

Ziehwerkzeugs noch ändern. Durch Aktivieren der Optionen des Objekts können andere Parameter, wie z. B. derjenige für den Abstand zwischen

Kopien, geändert werden.
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Arbeitsablauf
Markieren Sie die Objekte, die vervielfältigt werden sollen. Klicken Sie im Menü "Anordnen" auf "Vervielfältigen".

Passen Sie die Parameter nach Bedarf an, und aktivieren Sie die Option "Modifizierbar". Klicken Sie dann auf "OK".

In dem nun aktiven Ziehwerkzeug-Modus können Sie den Ziehpunkt mithilfe des Ziehwerkzeugs beliebig verschieben, um die gewünschte Anzahl

von Kopien zu erstellen.
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Wenn Sie den Abstand zwischen Kopien oder andere Parameter über das Dialogfeld bearbeiten möchten, klicken Sie im Kontextmenü auf

"Eigenschaften".

Meß-/Korrekturfunktionen
M e ß - / K o r r e k t u r f u n k t i o n e n

Diese dienen der Messung und Korrektur von Abstand (Länge) und Winkel.

Zur Anpassung von ein oder mehreren Objekten wählen Sie das letzte Objekt zuerst aus. Danach wählen Sie im Menü
"Anordnen" den Befehl "Abmessen und Skalieren" gewählt.

Drehen, z.B. anhand von Meß-/Korrekturfunktionen
Nach dem Scannen und Vektorisieren stehen Objekte meist schief auf dem Bildschirm. Mit Hilfe der Meß-/
Korrekturfunktionen können Sie ein solches Objekt auf einfache Art gerade ausrichten. Dazu wählen Sie zunächst das
Objekt aus und danach die Meß-/Korrekturfunktion. Nun suchen Sie zwei horizontal auf dem Objekt liegende Punkte
aus und ziehen dann mit gedrückt gehaltener Maustaste eine gestrichelte Linie zwischen den beiden Punkten. 

Nach dem Loslassen der Maus erscheint folgender Dialog:
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Wenn Sie unter "Ecke" (2) "0" eingeben, wird das Objekt gerade ausgerichtet.

Mit diesem Dialog paßt man auch die Größe von Objekten an (1). Dies ist eine gute Methode zum der Länge nach
Anpassen schräger Seiten. Nach der Wahl mehrerer Objekte ist richtiges Messen oft unmöglich, da die äußersten
Objekte nicht immer genau auf einer Linie liegen. Deshalb hat EasySIGN "unsichtbare Handgriffe". Das heißt, gleich
hinter den gezeichneten Handgriffen befinden sich Punkte, auf die die Maus automatisch einschnappt. Diese Punkte
geben die genaue Breite und Höhe der Objekte an.

Quick Sizing
Q u i c k  S i z i n g

Sie können häufig verwendete Größen in EasySIGN speichern und bei erneutem Bedarf anwenden. Klicken Sie im
Menü "Anordnen" auf "Transformationen" und anschließend auf "Quick Sizing".
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1 Die Liste der verfügbaren Größen.
2 Neue Größe hinzufügen.

3 Eine ausgewählte Größe ändern.
4 Eine ausgewählte Größe löschen.

Um eine Größe auszuwählen, wählen Sie diese in der Liste aus und klicken auf OK.

Platzieren von Objekten auf einem Pfad
P l a t z i e r e n  v o n  O b j e k t e n  a u f  e i n e m  P f a d

Es ist möglich, ein beliebiges Objekt (einschließlich Gruppen, Effekten und Bitmaps) auf einem offenen oder
geschlossenen Vektorpfad zu platzieren. 
Hierzu müssen Sie zuerst die Objekte markieren, die Sie auf einem Pfad platzieren möchten.

Klicken Sie anschließend im Menü "Anordnen" auf "Objekte auf Pfad" und dann auf den gewünschten Pfad.



96 EasySIGN

Sobald sich die Objekte auf einem Pfad befinden, können Sie im Kontextmenü auf "Objekte mit Pfad drehen" klicken.

Mit STRG+KLICKEN können Sie Objekte auf einem Pfad markieren und ändern. Der Pfad selbst lässt sich anpassen,
indem er im Objekt-Manager ausgewählt und dann geändert wird.

Beispiel
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Allgemeine Funktionalität

Area and Length
A r e a  a n d  L e n g t h

Usage:
Select one or more objects on the worksheet.
Select menu : View > Area and Length.

The following results are available in this dialog:

Area
Represents the area of the selected object. When more than one object is selected the silhouette of the objects
represents the area that will be calculated. 
Consider the following example.

One object, width 100mm, height 100mm.
Result:

Two objects like the one above. 
Result:
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The same objects as above but now overlapping. 
Result:

Area contour
Represents the area of the selected object ignoring any "holes". When more than one object is selected the outline of
the objects represents the area that will be calculated.
Consider the following example.

One object, width 100mm, height 100mm with a hole in it (width 50mm, height 50mm).
Result:

Two objects like the one above.
Result:

The same objects as above but now overlapping. 
Result:

Area extends
Represents the area of the extends of the selected object(s). The extends of an object or objects is the smallest
rectangle that can enclose the object(s).
Consider the following example.

Two objects, the red rectangle around these objects represent the selection extend.  
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Length
This is the length of all lines that are visible when viewing your worksheet in color mode. Layers, fills and no fills and
stacking order are considered when calculating the length. Using this method will make sure that non visible lines will
not be calculated. 
Consider the following example.

Two overlapping objects, both have a fill.
Result:

Same as above but the bottom object has no fill, the result will be the same as the result
above. 

Same as above but now the overlapping (top) object has no fill.
Result:

Length wireframe
As the name already implies this is the length of the selected object(s) as you would view them in wireframe mode.
So all the visible lines in wireframe will be calculated.
Consider the following example.

Four overlapping objects which all have a fill. Below that the same objects but shown in
wireframe.
Result:
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Options

Treat as one vinyl
color

This option is for clarity and will not trigger a recalculation. It just hides the "Area"
and "Area contour" values leaving only the "Area Extends".
  

Include line width. This option will recalculate the area but now including the line width.

Wireframe for length This option is for clarity and will not trigger a recalculation. It just hides the
"Length" leaving only the "Length Wireframe".

Aufrufen des zuletzt ausgewählten Werkzeugs
A u f r u f e n  d e s  z u l e t z t  a u s g e w ä h l t e n  W e r k z e u g s

Vor Version 4 von EasySIGN konnte das zuletzt ausgewählte Werkzeug mit der TABULATORTASTE aufgerufen
werden. Diese Funktion wird jetzt von der ESC-Taste übernommen, weil die TABULATORTASTE jetzt in Textblöcken
verwendet wird. Das erste Element im Kontextmenü der Objekte ist die Option "Vorheriges Werkzeug", die die gleiche
Funktion wie die ESC-Taste ausführt. 
Es ist nicht mehr erforderlich, zuerst das Auswahlwerkzeug auszuwählen, bevor Sie einen Spezialeffekt zu einem
soeben erstellten Objekt hinzufügen. Sie können beispielsweise ein Rechteck erstellen und ohne Werkzeugwechsel
einen Effekt anwenden.

Kontextmenü (das über die rechte Maustaste aufgerufen wird)
K o n t e x t m e n ü  ( d a s  ü b e r  d i e  r e c h t e  M a u s t a s t e  a u f g e r u f e n  w i r d )

Das Kontextmenü wurde seit Version 4 von EasySIGN geändert. Es ist nicht mehr erforderlich, zuerst das
Auswahlwerkzeug auszuwählen, bevor Sie das Kontextmenü aufrufen.

Zentriert einfügen
Z e n t r i e r t  e i n f ü g e n

Wenn Sie ein Objekt einfügen, das Sie in EasySIGN kopiert haben wird dies immer mit den ursprünglichen
Koordinaten eingefügt. Dies ist eine wichtige Funktion. In einigen Fällen ist diese Funktion jedoch nicht anwendbar.
Dies ist beispielsweise der Fall, wenn Sie einen anderen Bereich als den Bereich vergrößert haben, in dem das Objekt
kopiert wurde.

Wenn Sie im Menü "Bearbeiten" auf "Zentriert einfügen" (oder auf die entsprechenden Befehle im Kontextmenü)
klicken, wird das Objekt mittig in die aktuelle Ansicht eingefügt.

Spezielles Kopieren
S p e z i e l l e s  K o p i e r e n

Mit dieser Funktion können Sie das gesamte Arbeitsblatt  oder eine Markierung davon in die Zwischenablage kopieren. Anschließend können Sie

diese Kopie in eine E-Mail-Vorlage, Arbeitsbeschreibung, Rechnung usw. einfügen.

Klicken Sie im Menü "Bearbeiten" auf "Spezielles Kopieren" und dann auf "Als Bitmap in die Zwischenablage". Mit diesem Befehl wird ein

Dialogfeld geöffnet, in dem Sie den Farbraum sowie die Größe und Auflösung der Bitmap angeben können.

Vektorpfade in Bitmaps
V e k t o r p f a d e  i n  B i t m a p s

PSD-Dateien (das systemeigene Photoshop™-Format) und andere Dateien können Vektorpfade enthalten. Wenn diese Art von Bitmaps von 

EasySIGN importiert  wird, werden die zugehörigen Vektorpfade mit der Bitmap gruppiert. Die DVD "LIBRARIES" (Bibliotheken) enthält  den

Ordner "\BITMAP\Masked\Fonts\Chrome005\", in dem jeder Bitmap ein Vektorpfad zugeordnet ist . Sie können diesen Pfad als Schnittform
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verwenden.

Alpha-Channels in Bitmaps
A l p h a - C h a n n e l s  i n  B i t m a p s

Wie einige andere Dateitypen können auch PSD-, PNG- und TIFF-Dateien neben normalen Bitmap-Informationen Alpha-Channel-Informationen

enthalten.

Bei dem so genannten 'Alpha-Channel' handelt es sich um eine Graustufenmaske, die es EasySIGN ermöglicht, diese
Bitmap-Art transparent oder maskiert zu verarbeiten. Zum gegenwärtigen Zeitpunkt kann von EasySIGN nur das
Format TIFF als CMYK zusammen mit einem Alpha-Channel importiert werden. PSD- und PNG-Dateien müssen RGB-
Dateien sein. Sie können diese jedoch im Anschluss an den Import in CMYK konvertieren. Weitere Informationen zu
Transparenz und dem Verfahren zu deren Anwendung finden Sie unter dem entsprechenden Thema.

Vorschauen in Windows Explorer
V o r s c h a u e n  i n  W i n d o w s  E x p l o r e r

Von jedem durch EasySIGN unterstützten Dateiformat wird in Windows Explorer eine Vorschau angezeigt. Dies bedeutet, dass nicht nur

Arbeitsblätter, sondern auch ClipArt- und Vorlagendateien angezeigt werden.

Hervorhebung (heller Spot) in radialen Farbverlauffüllungen
H e r v o r h e b u n g  ( h e l l e r  S p o t )  i n  r a d i a l e n  F a r b v e r l a u f f ü l l u n g e n

Radiale Farbverlauffüllungen in EasySIGN unterstützen eine so genannte "Hervorhebung". 

A Markieren Sie ein Objekt, und wenden Sie darauf eine radiale Farbverlauffüllung an.

B Klicken Sie auf das Werkzeug zum Anpassen von Farbverlauffüllungen, und bewegen Sie den Cursor über den letzten

Knoten. 

C Drücken Sie die rechte Maustaste, und klicken Sie im Kontextmenü auf die Option "Markierung ein/aus".

D Ein Knoten, der die Position des hellen Spots angibt, wird angezeigt.

E Verschieben Sie den hellen Spot nach Bedarf.

F Vergleichen Sie die Farbverlauffüllung mit der in Schritt  "A" angewendeten Füllung.

Verschmelzen von Bitmaps
V e r s c h m e l z e n  v o n  B i t m a p s

Ab Version 5 können auch Bitmaps verschmolzen werden. Der dafür erforderliche Arbeitsablauf ist  mit demjenigen für Vektorobjekte identisch.

Das folgende kurze Beispiel soll dies erläutern.

Originalobjekte: eine Bitmap und Text.
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Markieren Sie zuerst die Bitmap und dann den Text. Klicken Sie anschließend im Menü "Bearbeiten" auf "Verschmelzen" und dann auf "Zuletzt

ausgewählte Maske".

Mit STRG+KLICKEN oder mithilfe des Objekt-Managers können Text und Bitmap noch wie zuvor bearbeitet werden.

Sie können auch mehrere Verschmelzungen anwenden.

Wenn Ihre Lizenz es zulässt, können auf die Verschmelzungen und die Bitmap zusätzliche Effekte angewendet werden.

Offene Pfade
O f f e n e  P f a d e

Beim Importieren von Vektordateien (z. B. von Arbeitsblättern mit der Erweiterung .AI) in EasySIGN geschieht es gelegentlich, dass nicht alle

Formen wie erwartet geschlossen werden. Dies trifft  insbesondere bei der Verwendung von Software zu, die über keine aktuellen Exportfilter

verfügt. Die manuelle Behebung dieses Fehlers kann sehr mühsam sein, wenn jede Form im Job einzeln überprüft werden muss.



103EasySIGN

In EasySIGN wurde ein neues, sehr präzises Verfahren implementiert , das den Fehler mit optimalen Ergebnissen behebt.

Arbeitsablauf
Markieren Sie alle zu überprüfenden Objekte. Klicken Sie anschließend im Menü "Bearbeiten" auf "Offene Pfade auswählen". Wenn kein Pfad

ausgewählt wird, sind alle Objekte im Arbeitsblatt  bereits geschlossen. Falls jedoch Pfade ausgewählt bleiben, können Sie auf die Option "Anordnen"

und dann auf "Offene Pfade schließen" klicken. Damit werden alle offenen Pfade in der aktiven Auswahl geschlossen. Anders als beim

automatischen Schließen der Arbeitsblätter während des Imports können Sie das Endergebnis bei dieser Vorgehensweise vollständig kontrollieren.

Objekte sperren

Wählen Sie die Objekte, die Sie sperren möchten.

Klicken Sie im Menü "Anordnen" auf "Auswahl sperren" oder auf die entsprechenden Befehle im Kontextmenü für das
Objekt. Die Auswahlpunkte des Objekts nehmen die Form kleiner Vorhängeschlösser an, und das Objekt wird
gesperrt. Wenn Sie dieses Objekt auswählen, werden die Vorhängeschlösser angezeigt, um zu signalisieren, dass es
sich um ein gesperrtes Objekt handelt.

Gesperrte Objekte können nicht versehentlich verschoben oder bearbeitet werden. Es ist besonders beim
Nachzeichnen von Bitmaps einfacher, das Bitmapbild vorübergehend zu sperren, als mit gesperrten Ebenen zu
arbeiten.

Um ein Objekt freizugeben, klicken Sie im Menü "Anordnen" auf "Auswahl freigeben" oder auf die entsprechenden
Befehle im Kontextmenü. Sie können auch alle Objekte eines Arbeitsblatts freigeben. Klicken Sie hierzu im Menü
"Anordnen" auf "Alle Objekte freigeben".

Einige Eigenschaften gesperrter Objekte
1 Wenn Ihr Arbeitsblatt gesperrte Objekte enthält, werden über den Befehl "Alle auswählen" im Menü

"Bearbeiten" nur Objekte ausgewählt, die nicht gesperrt sind.
2 Gesperrte Objekte können gedruckt oder geplottet werden. Wenn Sie bestimmte Objekte nicht drucken oder

plotten möchten, müssen Sie mit Ebenen arbeiten.
3 Gesperrte Objekte können nicht über eine Bereichsauswahl ausgewählt werden. Sie können mehrere gesperrte

Objekte über die UMSCHALTTASTE auswählen.
4 Gesperrte und freigegebene Objekte können nicht gemeinsam ausgewählt werden.
5 Gesperrten Objekten können keine Transformationen oder Spezialeffekte zugewiesen werden.
6 Da ein gesperrtes Objekt markiert werden kann, können Sie auch Befehle wie "Passkreuze einfügen"

ausführen.
7 Es werden auch alle Umgestaltungen und Bearbeitungsfunktionen im Objekt-Manager blockiert, wenn Sie ein

Objekt gesperrt haben.
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Nach Grösse auswählen

Sie können im Handumdrehen Objekte aus Ihrem Arbeitsblatt entfernen, die bestimmten Größenkriterien
entsprechen. In der Regel ist dies ein zeitaufwendiger Vorgang, der jedoch notwendig ist, weil beispielsweise nach
einer Vektorumwandlung zahlreiche Objekte für das Plotten zu groß sein können. Sie brauchen diesen Vorgang nicht
manuell auszuführen. Klicken Sie stattdessen im Menü "Bearbeiten" auf "Markieren nach" und anschließend auf
"Größe".

Dieses Dialogfeld hat zwei Modi, einen einfachen (siehe oben) und einen erweiterten Modus (siehe unten).

1 Hier können Sie die Maximalgröße der auszuwählenden Objekte festlegen.
2 Wenn Sie diese Option aktivieren, wird eine bereits aktive Auswahl zusammen mit der neuen Auswahl

ausgewählt.
3 Schließt das Dialogfeld.
4 Klicken Sie auf diese Schaltfläche, wenn das Ergebnis ausgewählt werden soll.
5 Klicken Sie auf diese Schaltfläche, wenn das Ergebnis gelöscht werden soll.
6 Wenn Sie in diesem Dialogfeld eine Auswahl gelöscht haben, können Sie diesen Vorgang hier rückgängig

machen.
7 Diese Option aktiviert den erweiterten Modus.

1 Hier können Sie die Minimal- und Maximalgröße für die Breite und Höhe festlegen.
7 Diese Option aktiviert wieder den Normalmodus.

Objekte von oben auswählen

Diese Funktion wählt identische Objekte aus, die genau übereinander platziert werden. Die einzelnen Objekte werden
im Arbeitsblatt nicht angezeigt. Derartige Situationen treten auf, wenn Sie die gleichen Objekte mehrfach an
derselben Stelle übereinander eingefügt oder eine Datei importiert haben, in der die Füllung und die Linienart eines
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Objekts als separate Formen exportiert wurden.

Klicken Sie im Menü "Bearbeiten" auf "Objekte von oben auswählen".

Bitmaps
B i t m a p s

1-Bit-Bitmaps

1-Bit-Bitmaps (schwarzweiß) können jetzt mit Hilfe der Farbpalette eingefärbt werden. Diese Farben lassen sich auch
ausdrucken. 

A Original-Bitmap
B Klicken Sie in der Farbpalette mit der linken Maustaste (Füllfarbe) auf das gelbe Farbfeld und mit der rechten

Maustaste (Linienfarbe) auf das rote Farbfeld.
C In umgekehrter Reíhenfolge wie oben.

Mit der Farbfunktion für Füll- und Linienfarben können Sie einer 1-Bit-Bitmap auch eine Farbe zuweisen, die nicht in
der Farbpalette vorhanden ist.

Manchmal ist es zeitsparender, eine gescannte 1-Bit-Bitmap direkt für den Druck zu verwenden, als sie zuerst in eine
Vektorgrafik umzuwandeln. Außerdem kann es beim Vektorisieren hilfreich sein, unter die zu vektorisierende Bitmap
ein Duplikat mit einer Kontrastfarbe zu legen, um die resultierende Vektorgrafik mit dem Original vergleichen zu
können.

Anzeige einer Bitmap

Es stehen Ihnen jetzt vier verschiedene Anzeigeoptionen für Bitmaps in Umrissansicht zur Verfügung.

A Rahmen
B Einfache Graustufen
C Graustufen
D Original

Sie finden diese Einstellungen im Menü "Ansicht" unter "Qualität".
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Helligkeit und Kontrast

Diese Methode funktioniert folgendermaßen. Wählen Sie eine Bitmap aus, auf die Sie dann mit der rechten Maustaste
klicken. Wählen Sie anschließend im PopUp-Menü die Option "Helligkeit und Kontrast einstellen".

1 Helligkeit
 Hiermit läßt sich die Helligkeit einer Bitmap stärker hervorheben.

2 Der Kontrast
 Erscheint eine Bitmap zu trüb, kann durch die Vergrößerung dieses Werts der Unterschied zwischen den

dunklen und hellen Partien stärker hervorgehoben werden.
3 Gamma
 Dieses Bildlauffeld paßt die Helligkeit der mittleren Farben der Farbpalette an.

4 Die Sättigung
 Die Sättigung ist die Stärke oder Reinheit der Farbe.

5 RGB Einstellungen
 Erscheint eine Bitmap zu rot, grün oder blau, kann der Wert mit dem dazugehörigen Bildlauffeld berichtigt

werden.
6 Schließen
 Mit dieser Schaltfläche schließen Sie den Dialog.

7 Ausführen
 Mit dieser Schaltfläche wenden Sie die Änderungen aus dem Dialog auf die Bitmap an.

8 Wiederherstellen
 Mit dieser Schaltfläche setzen Sie den jeweiligen Dialog wieder auf die Grundeinstellungen zurück. 

9 Variationen
 Mit dieser Schaltfläche öffnen Sie den Variationsdialog (siehe die nachfolgende Beschreibung).

10 Grafik
 In der Grafik wird eine Abbildung der geänderten Farbkurve dargestellt.
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Die Variationen

Mit den "Variationen" paßt man den Farbabgleich, den Kontrast, die Sättigung usw. einer Bitmaß visuell an.

1 Die Vorschau (aktuelles Beispiel)
 Diese zwei Miniaturabbildungen über dem Dialogfenster zeigen das Original und eine Vorschau auf die

vorgenommenen Änderungen.
2 Horizontal
 Hier können Sie wählen, welche Filteroption Sie horizontal im Dialog anzeigen lassen wollen.

3 Vertikal
 Hier können Sie wählen, welche Filteroption Sie vertikal im Dialog anzeigen lassen wollen.

4 Schrittgröße
 Hier ist die für die Änderungen gewünschte Schrittgröße einstellbar. Je höher der Wert, desto deutlicher ist die

Änderung sichtbar.
5 Horizontale Anzeige
 Hier werden die horizontalen Bildlauffenster wiedergegeben.

6 Vertikale Anzeige
 Hier werden die vertikalen Bildlauffenster wiedergegeben.

7 Grenze zeigen
 Das Einschalten dieser Option bietet eine Vorschau auf jene Gebiete einer Abbildung, die nach Ausführung der

Änderungen möglicherweise einen Farbverlust erleiden werden.
8 OK
 Mit dieser Taste werden alle Änderungen auf die originale Bitmap übertragen und der Dialog geschlossen.

9 Abbrechen
 Diese Schaltfläche schließt den Dialog ohne Durchführung eventueller Änderungen.

10 Zurücksetzen
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 Mit dieser Schaltfläche werden alle Einstellungen wieder zurückgesetzt.

Vorgehensweise
Angenommen, Sie haben unter "Horizontal" die Option Helligkeit und unter "Vertikal" die Option Kontrast gewählt. Um
eine Änderung vorzunehmen, klicken Sie einfach jeweils eine der nachfolgenden Miniaturabbildungen an.

Spezialeffekte

Auf jede importierte oder eingescannte Bitmap können Sie auch die Spezialeffekte anwenden. Hierzu aktivieren Sie
mit der rechten Maustaste das Menü einer Bitmap und wählen dort die Option "Spezialeffekte" aus. Daraufhin
erscheint ein Folgemenü mit den zur Verfügung stehenden Spezialeffekten.

Der Spezialeffektdialog umfaßt die folgenden Optionen.
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1 Im linken Fenster steht immer das Original. Setzt man die Maus über das Fenster, ändert sich diese in eine
"Hand", mit der die Abbildung im Fenster verschoben und andere Teile der Bitmap betrachtet werden können.

2 Das Vorschaufenster (aktuelles Beispiel). 
3 Mit dieser Schaltfläche rufen Sie das Beispiel der Vorschau auf.
4 Wenn die Option "Auto Vorschau" eingeschaltet ist wird jede Änderung aus dem Dialog direkt gezeigt.
5 Mit diesem Bildlauffeld oder durch Eingabe eines Werts in das Fach daneben wird der Effekt auf dem Original

vergrößert oder verkleinert.
6 "Fortschritt", hier erscheint die Angabe, wie weit die Anwendung des Effekts bereits fortgeschritten ist.
7 "OK", mit dieser Schaltfläche werden alle vorgenommenen Einstellungen auf die Bitmap angewendet und der

Dialog geschlossen.
8 "Schließen", mit dieser Schaltfläche wird der Dialog geschlossen.
9 "Übernehmen", mit dieser Schaltfläche werden alle vorgenommenen Einstellungen auf die Bitmap angewendet.

In Bitmap umwandeln

Dieser benutzerfreundliche Befehl wandelt die auf dem Arbeitsblatt ausgewählten Objekte in ein Bitmapbild um.
Wählen Sie die gewünschten Objekte, und klicken Sie im Menü "Bearbeiten" auf "Umwandeln in" und anschließend auf
"Bitmap".

1 Hier können Sie unter anderem den Farbraum, beispielsweise RGB, und die Option "Schwarzweiß" auswählen.
2 Hier können Sie die Größe festlegen.
3 Hier können Sie die Auflösung festlegen.

Nachdem Sie die Einstellungen angewendet haben, werden alle ausgewählten Objekte im Arbeitsblatt zu einem
einzelnen Bitmapbild umgewandelt.
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Bitmapmodus

Sie können mit diesem Befehl ein Bitmap in einen anderen Modus umwandeln. Wählen Sie die gewünschten Bitmaps,
und klicken Sie anschließend im Menü "Bitmap" auf "Modus". Wählen Sie dann den Farbraum, in den das Bitmap
konvertiert werden soll. Sie können beispielsweise den Farbraum RGB in CMYK (und umgekehrt) umwandeln.

Mit Ebenen arbeiten

Was ist eine Ebene?
Beim Öffnen eines neuen Dokuments erscheint ein weißer Hintergrund  auf dem das  Arbeitsblatt angedeutet ist. Auf
Dieses  können Sie zum Beispiel einzelne Bitmaps importieren, um damit einen Entwurf oder eine Komposition zu
erstellen. Bei der Arbeit mit Dutzenden von Bitmaps erspart Ihnen die Verwendung von Ebenen Zeit und Mühe.

Angenommen, Sie arbeiten mit ungefähr 60 Bitmaps. Der Aufbau einer Bitmap auf der Benutzeroberfläche kostet
trotz der Schnelligkeit des Programmes Zeit. Durch die Verwendung von Ebenen kann eine Komposition zur
Beschleunigung des Bildschirmaufbaus verborgen werden.

Ebenen erstellen 
Im Menü "Bild" den Befehl "Ebenen" auswählen.

Der Ebenenmanager enthält beim ersten Öffnen immer die Standardebenen. Diese können nicht gelöscht werden. Sie
sind folgendermaßen bezeichnet:

1 Hauptebene
2 Hilfslinienebene
3 Paßkreuzebene

Beim Öffnen des Fensters ist zuerst immer die Hauptebene aktiviert. Die Hilfslinienebene und die Paßkreuzebene kann
man nach Bedarf auswählen, ihre Reihenfolge bezüglich der anderen Ebenen verändern und alle sonst noch
verfügbaren Einstellungen daran vornehmen. Diese Ebenen können jedoch nicht aktiviert werden.

Schaltfläche Funktion

Hiermit öffnen Sie einen Dialog, um eine neue Ebene
hinzuzufügen.

In diesem Dialog finden Sie folgende Einstellungsmöglichkeiten.
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Der Name (1)
Hier geben Sie den für die Ebene vorgesehenen Namen ein. Diesen sollten Sie sich gut merken können.

Optionen der Ebenen (2)

Sichtbar (3)
Mit dieser Option wird festgelegt, ob eine Ebene gezeigt wird.

Gesperrt (4)
Kein einziges Objekt dieser Ebene kann nach dem Sperren verschoben oder bearbeitet werden.

Ausdrucken (5)
Mit dieser Option wird festgelegt, ob eine Ebene gedruckt werden darf.

Plotten (6)
Mit dieser Option wird festgelegt, ob eine Ebene geplottet werden darf.

Öffnet einen Dialog, in dem die Eigenschaften der gewählten Ebene festgelegt werden
können.

Die gewählte Ebene löschen.

Die gewählte Ebene ein Stufe nach oben versetzen.

Die gewählte Ebene ein Stufe nach unten versetzen.

Die markierten Objekte in eine Ebene nach Wahl          verschieben.

Die markierten Objekte in eine Ebene nach Wahl kopieren.

Der mögliche Status einer Ebene
Die folgenden Zeichnungen verdeutlichen den möglichen Status einer Ebene.

Ausgewählt

Die Eigenschaften ausgewählter Ebenen kann man mit Hilfe der Schaltflächen des Dialogs bearbeiten.

Ebenen werden durch Anklicken ausgewählt.

Aktiv

"Aktiv" bedeutet, daß zum Beispiel eine importierte Zeichnung in die aktive Ebene gesetzt wird. Die aktive Ebene wird
durch einen Punkt gekennzeichnet.
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Die Ebenen werden durch Doppelklick aktiviert.

Aktiv und ausgewählt

Add a plotter

To add a plotter select the menu 'File > Device Setup > 'Add Plotter Wizard...'.

Select from the dropdown for drivers (1) the desired device. Click 'Next'.
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Select from the dropdown for Ports (1) the Port your device has been connected to. Click 'Next'.

How this page will look depends on the selected Port from the previous page. On this page make your settings
according the manual supplied with your device.
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To finish the installation of your device, click 'Finish'.

Plotter-Einstellungen

Select the menu 'File > Device Setup > Open...'. The following Window will become visible.

On the left open the folder 'Plotter Settings' and click on 'Plot Setting 0'. On the right the available plotter settings will
become visible.
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A Sortieren und optimieren

 

1 Nicht sortieren
 Das Plotten des Entwurf erfolgt in der Reihenfolge in den man gezeichnet hat.
2 Geschwindigkeit
 Die einzelnen Gegenstände werden sortiert, so daß so schnell wie möglich geplottet wird.
3 Folientransport
 Durch diesen Sortiervorgang werden die Folien so wenig wie möglich transportiert. Dies fördert die

Plotgenauigkeit, geht aber auf Kosten der Geschwindigkeit.
4 Randlochung
 Bei Plottern mit Randlochung berücksichtigt EasySIGN die Eigenschaften dieser Plotter.
5 Innen zuerst
 Die Innenseite eines kombinierten Objekts, z.B. der Buchstaben "O", wird zuerst geschnitten. Hierdurch wird

die Plotqualität von Kleinbuchstaben erhöht. Weiterhin ist für das Fräsen, bei dem Formen frei werden, diese
Funktion erforderlich.

6 Schleppmesser
 Die Plotdaten wird für die Einsatz von ein Plotter mit Schleppmesser optimiert, Fehler / Ungenauigkeiten

werden hierdurch auf ein Minimum beschränkt.  
7 Ecken einschneiden
 Der Plotter wird in die Ecke und bei geschlossene Formen (beim Anfang / Endpunkt) etwas weiter

durchschneiden, hiermit wird das Entgittern erleichtert. Wie weit durchgeschnitten wird, können Sie hier
eingeben.  

8 OK
 Führt die vorgenommenen Änderungen durch und schließt den Dialog.
9 Abbrechen
 Schließt den Dialog ohne Änderungen.

B Plotoptionen
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1 Qualität
 Die Schnittgenauigkeit der Kurven. Eine höhere Genauigkeit geht auf Kosten der Geschwindigkeit ("Qualität 80"

ist meistens die beste Wahl).
2 Entgitterungshilfen schneiden
 Wenn Entgitterungshilfen auf dem Arbeitsblatt verwendet werden, kann hier eingegeben werden, ob diese

standardmäßig geplottet werden sollen oder nicht.
3 Relativ Plotten
 Die linke untere Ecke Ihrer Zeichnung ist gleich dem Nullpunkt Ihres Plotters. Ist diese Funktion ausgeschaltet

(= Absolut Plotten) denn werden die X/Y Koordinaten wie auf den Bildschirm bei Plotten berücksichtigt.

4 Anfangspunkt hinter dem Plot
 Das Messer wird nach dem Plotten hinter den Plot positioniert, gleichzeitig wird hier der neue Nullpunkt gesetzt.

Hier kann man auch den Wert für den Abstand eingeben. Nicht auf jedem Plotter ist diese Option möglich.
5 Zusätzliche Kopien
 Hier aktiviert man, ob und wie viele zusätzliche Kopien für jede Zeichnung erstellt werden sollen.
6 Mehrmals Schneiden
 Hier aktiviert man, ob der Plotter jede Schnittlinie mehrmals schneiden soll und wenn ja, wie häufig. Diese

Option ist vor allem für schweres Material nützlich, das normalerweise nicht auf einmal durchtrennt werden
kann.

7 Folie abschneiden
 Diese Option sorgt dafür, daß der Plotter nach jedem Auftrag das Material von der Rolle abschneidet. Sie steht

nur zur Verfügung, wenn der Plotter diese Funktion unterstützt.
8 OK
 Führt die vorgenommenen Änderungen durch und schließt den Dialog.
9 Abbrechen
 Schließt den Dialog ohne Änderungen.

 Plottereinstellungen

1 Geschwindigkeit
 Hiermit stellt man die Plottergeschwindigkeit ein, was sich vor allem auf gerade Linien auswirkt.
2 Beschleunigung
 Hier wird eingestellt wie schnell der Plotter auf maximale Geschwindigkeit kommt, also beschleunigt.
3 Offset
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 Nur notwendig für Plotter mit Schleppmesser. Für diese Geräte ist ein Korrekturwert nötig um genau Schneiden
zu können. Diese Wert können Sie hier eingeben.

4 Der Messerdruck
 Bestimmt mit wieviel Druck der Plotter schneiden soll.
5 Stiftnummer
 Unterstützt Ihr Plotter mehrere Stifte oder Messer, können Sie hier bestimmen welche verwendet werden soll.
6 OK
 Führt die vorgenommenen Änderungen durch und schließt den Dialog.
7 Abbrechen
 Schließt den Dialog ohne Änderungen.

D Device Specific

 How this dialog will look is dependent on the selected plotter driver.

Die meisten Plotter unterstützten nicht alle hier möglichen Einstellungen. Erscheint eine von ihnen grau, unterstützt Ihr
Plotter diese Funktion nicht. Vielleicht läßt sich der betreffende Wert am Plotter selber einstellen. Lesen Sie dazu bitte
das Handbuch zu Ihrem Plotter.

Wenn Sie das Häkchens bei "Standardeinstellungen" entfernen, wird die Standardeinstellung des Plotters verwendet. 

CMS (Color Management System)

CMS Allgemein
C M S  A l l g e m e i n

EasySIGN wird mit einem erweiterten Color Management System geliefert. Nach der Installation von EasySIGN wird
CMS standardmäßig aktiviert.

Was ist CMS?
Beim Arbeiten mit Farben ist eine einheitliche Farbdarstellung auf verschiedenen Geräten, wie Monitoren und
Druckern, entscheidend. Diese Geräte müssen farbmetrische Informationen austauschen können, um ein
vorhersehbares Endresultat zu erzielen.

Farben werden vom menschlichen Auge subjektiv wahrgenommen. Jedes Gerät innerhalb eines Produktionsprozesses
verfügt über einen anderen Farbbereich. So kann ein Monitor möglicherweise Farben anzeigen, die Ihr Drucker nicht
wiedergeben kann. CMS sorgt dafür, dass Ihr Monitor nur Farben anzeigt, die der Drucker auch wiedergeben kann.

Der Farbbereich, den ein Gerät wiedergeben kann wird als Farbpalette bezeichnet. Ein Monitor besitzt eine andere
Farbpalette als ein Vollfarbdrucker. Das bedeutet, dass ein Arbeitsblatt Farben enthalten kann, die auf einem Monitor
ordnungsgemäß angezeigt, auf einem Ausgabegerät aber nicht wiedergegeben werden können. Ein weiteres Problem
liegt darin, dass auch die Farbpalette verschiedener Drucker unterschiedlich sein kann. Selbst bei gleichen
Druckermodellen desselben Herstellers können Unterschiede auftreten. Eine genaue Farbdarstellung ist nur dann zu
erreichen, wenn die unterschiedlichen Farbpaletten aller eingesetzten Geräte berücksichtigt werden.

Mithilfe von CMS werden die Unterschiede zwischen den Geräten eines Produktionsprozesses minimiert.

Was ist ein Profil?
Ein Profil ist eine Datei, die die farbmetrischen Eigenschaften eines Geräts, etwa eines Vollfarbdruckers, beschreibt.
Farbprofile haben in der Regel das Dateiformat ICC (International Color Consortium) oder ICM (Image Color
Matching). EasySIGN unterstützt beide Formate sowie das eigene interne Format, das nahtlos an ICC- und ICM-Profile
anknüpft. Mit diesem internen Format können Sie ICC- und ICM-Profile ganz nach Ihrem Bedarf und Geschmack
anpassen, wozu ansonsten teure und komplizierte Software erforderlich wäre.

Wie installiere ich ein Profil?
Wenn Sie über ein Profil eines anderen Anbieters verfügen, können Sie dieses in EasySIGN installieren, indem Sie es
in den Ordner “\EasySIGN\Shared\Profiles\” kopieren. Sie können das Profil auch für alle Programme installieren,

indem Sie mit der rechten Maustaste auf die Datei klicken und ‘Installieren’ wählen.

Was bedeutet "Darstellungsansatz"?
Über die Option Darstellungsansatz können Sie auswählen, nach welcher Methode EasySIGN Farben konvertieren soll,
damit sie in die Farbpalette verschiedener Geräte passen. Das größte Problem besteht darin, dass einige Farben auf
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einem Monitor angezeigt, vom Drucker jedoch nicht wiedergegeben werden können. Sie können zwischen vier
verschiedenen Methoden wählen:

1 Perzeptiv

Alle Farben aus der Farbpalette eines Geräts werden in eine andere Farbpalette skaliert, wobei
die Beziehung zwischen den einzelnen Farben intakt bleibt. Diese Methode wird für die
Reproduktion gescannter oder importierter Bitmaps empfohlen.

2 Relativ farbmetrisch

Diese Methode lässt Farben unverändert, die in beide Farbpaletten passen. Farben, die
außerhalb der Farbpalette des Ausgabegeräts liegen, werden entsprechend angepasst, wobei
Helligkeit und Farbe zu Lasten der Sättigung erhalten bleiben. Diese Methode empfiehlt sich,
wenn es auf eine genaue Farbdarstellung ankommt, zum Beispiel beim Drucken von
Spotfarben.

3 Sättigung

Skaliert die ursprüngliche Farbpalette in die Zielfarbpalette unter Wahrung der relativen
Sättigung anstelle des Farbtons. Bei der Skalierung in eine kleinere Farbpalette können sich
Farbtöne somit verschieben. Dieser Darstellungsansatz ist in erster Linie für Geschäftsgrafiken
vorgesehen, bei denen leuchtende gesättigte Farben wichtiger sind als die genaue Beziehung
zwischen den Farben.

4 Absolut farbmetrisch

Die absolut farbmetrische Darstellung gibt Farben innerhalb der Farbpalette exakt wieder und
weist Farben außerhalb der Farbpalette jeweils dem unmittelbar nächsten reproduzierbaren
Farbton auf Kosten der Sättigung und möglicherweise der Helligkeit zu. Diese Methode
berücksichtigt auch die Papierfarbe beim Drucken.

Einstellungen
Wählen Sie das Menü „Datei, Einstellungen“, und klicken Sie auf die Registerkarte „Farbmanagement“.

1 Farbmanagement aktivieren
Hier legen Sie fest, ob das Farbmanagement für jedes neu erstellte Arbeitsblatt aktiviert
werden soll.

2 Monitor
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Hier legen Sie fest, ob EasySIGN das Monitorprofil des Systems (gemäß Windows) oder ein
anderes, benutzerdefiniertes Profil verwenden soll.

3 Richtlinien für Bitmap-Import
Hier legen Sie das Farbmanagement für den Bitmap-Import fest.

Benutzereingabe
Beim Import fragt EasySIGN nach der gewünschten Vorgehensweise.

Kein Farbmanagement
Bitmaps werden ohne Farbmanagement importiert, auch wenn ein Profil integriert ist.

Dokument-Voreinstell. verw.
Die Einstellungen des Dokuments gelten auch für dieses Bitmap.

Integriertes Profil verw.
Besitzt das Bitmap ein integriertes Profil, so wird dieses verwendet; ansonsten gelten die
Dokument-Einstellungen.

Einstellungen
Wählen Sie das Menü „Ansicht, Einstellungen“, und klicken Sie auf die Registerkarte „Farbmanagement“:

1 Farbmanagement aktivieren
Das Farbmanagement wird so ein- oder ausgeschaltet.

2 Bitmap-Profil

RGB
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Wählen Sie hier das für RGB (24-Bit) Bitmaps verwendete Profil.

CMYK
Wählen Sie hier das für CMYK-Bitmaps verwendete Profil.

Ansatz
Wählt den Darstellungsansatz für Bitmaps aus.

3 Vektorprofil

RGB
Hier legen Sie das für Vektoren mit einem RGB Füll-/Stiftstil verwendete Profil fest.

CMYK
Hier legen Sie das für Vektoren mit einem CMYK Füll-/Stiftstil verwendete Profil fest.

Ansatz
Wählt den Darstellungsansatz für Vektordaten aus.

4 Als Standard definieren
Wenn diese Option markiert ist, kommen die aktuellen Einstellungen auch beim Erstellen eines
neuen Dokuments zur Anwendung.

5 Zurücksetzen
Stellt die Standardwerte in diesem Dialogfeld wieder her.

CMS-Anzeige und -Export
C M S - A n z e i g e  u n d  - E x p o r t

Das Farbmanagementsystem (Color Management System – CMS) in EasySIGN wurde erweitert, damit es noch
intuitiver eingesetzt werden kann.

Anzeigeeinstellungen
Im Dialogfeld mit den Einstellungen für das Farbmanagement (klicken Sie zum Aufrufen im Menü "Datei" auf
"Einstellungen" und dann neben die Registerkarte "Farbmanagement") wurde eine neue Option hinzugefügt:

RGB als CMYK verwalten

Wenn Sie diese Option aktivieren, werden RGB-Farben auf dem Bildschirm so angezeigt, wie sie z. B. auf einem
Desktopdrucker ausgegeben werden. Die Option war in früheren Versionen nur im Rahmen einer Drucklizenz
verfügbar (Farbkorrektur).

Bei DEAKTIVIERTER Option:



121EasySIGN

Bei AKTIVIERTER Option:

Bei Verwendung dieser Option dauert der Aufbau der Bildschirmanzeige länger, weil die Software mehrere zusätzliche
Berechnungen durchführen muss.

CMS-Export
Damit Sie das Farbmanagement besser steuern können, enthält das Dialogfeld mit den Einstellungen (klicken Sie zum
Aufrufen im Menü "Datei" auf "Einstellungen") nun die zusätzliche Registerkarte "Farbmanagement – Ausgabe". Auf
dieser Registerkarte stehen Ihnen folgende Einstellungen zur Verfügung:

Beim Exportieren

Farben
exportieren
als:

Wenn diese Option aktiv ist, werden alle Farben als CMYK oder RGB exportiert.
Andernfalls werden die Farben unverändert exportiert. Diese Einstellung gilt nur beim
Export von Vektorformaten, z. B. AI, EPS und PDF.

Falls Sie in den Farbmanagementeinstellungen die Option "RGB als CMYK verwalten"
aktiviert haben, sollten Sie aus Konsistenzgründen die Option "Farben exportieren als"
aktivieren und "CMYK" wählen.

Bei der Umwandlung von RGB in CMYK oder umgekehrt erfolgt das Farbmanagement
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mit den ausgewählten Profilen. Wenn das Farbmanagement ausgeschaltet ist, wird
eine andere Umwandlung verwendet.

Beim Drucken auf PostScript-Druckern

Farben
exportieren
als:

Wenn diese Option aktiv ist, werden alle Farben als CMYK oder RGB an den Drucker
gesendet. Andernfalls werden alle Farben entsprechend ihrem Entwurf im Arbeitsblatt
gesendet.

Falls Sie in den Farbmanagementeinstellungen die Option "RGB als CMYK verwalten"
aktiviert haben, sollten Sie aus Konsistenzgründen die Option "Farben exportieren als"
aktivieren und "CMYK" wählen.

Bei der Umwandlung von RGB in CMYK oder umgekehrt erfolgt das Farbmanagement
mit den ausgewählten Profilen. Wenn das Farbmanagement ausgeschaltet ist, wird
eine andere Umwandlung verwendet.

Beim Drucken auf 'EasySIGN Print Server'

Farben
exportieren
als:

Wenn diese Option aktiv ist, werden alle Farben als CMYK oder RGB an EasySIGN
Print Server gesendet. Andernfalls werden alle Farben entsprechend ihrem Entwurf im
Arbeitsblatt gesendet.

Weil der EasySIGN Print Server ein gegenüber EasySIGN wesentlich erweitertes
Farbmanagementsystem bereitstellt, sollten Sie diese Option nicht verwenden und das
Farbmanagement stattdessen den EasySIGN Print Server überlassen.

Bei der Umwandlung von RGB in CMYK oder umgekehrt erfolgt das Farbmanagement
mit den ausgewählten Profilen. Wenn das Farbmanagement ausgeschaltet ist, wird
eine andere Umwandlung verwendet. 

Produktionsmanager

Die Ausgabe in EasySIGN wird vom Produktionsmanager verarbeitet. Wenn Sie einen Auftrag von EasySIGN senden,
wird der Produktionsmanager (falls dieser nicht bereits geöffnet ist) automatisch geöffnet, und der Auftrag wird mit
dem aktuellen Status angezeigt. Wenn Sie einen Auftrag speichern und später verwenden möchten, müssen Sie im
Ausgabedialogfeld von EasySIGN. die Option "Auftrag in Produktionsmanager anhalten" aktivieren. Der Auftrag wird
nach der Ausführung im Produktionsmanager gehalten. Sie haben dann genügend Zeit, den Auftrag zu speichern.

Sie können mit dem Produktionsmanager verschiedene Ausgabegeräte gleichzeitig ausführen.
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1 Menü.
2 Symbolleiste.

Öffnet einen zuvor gespeicherten Auftrag. Sie müssen sicherstellen, dass ein Auftrag mit dem
Ausgabegerät geöffnet wird, das ausgewählt war, als Sie den Auftrag gespeichert haben. Wenn
Sie einen Auftrag in einem anderen Ausgabegerät öffnen, führt dies zu unvorhersehbaren
Ergebnissen. Es empfiehlt sich, den Namen des Ausgabegeräts in den Dateinamen für den
Auftrag aufzunehmen. 

Speichert einen ausgewählten Auftrag in eine Datei. Auf diese Weise brauchen Sie nicht zu
warten, bis ein wiederholt ausgeführter Auftrag von EasySIGN erneut berechnet wird. Sie
brauchen lediglich die Datei zu öffnen und zu aktivieren. Die Datei für einen Auftrag kann unter
Umständen sehr umfangreich sein. Entfernen Sie deshalb derartige Dateien, wenn diese von
Ihnen nicht mehr benötigt werden.

Aktiviert einen ausgewählten Auftrag, der angehalten wurde.

Hält einen ausgewählten, aktiven Auftrag an.

Stoppt einen ausgewählten, aktiven Auftrag.

Entfernt einen ausgewählten Auftrag.

Behält einen abgeschlossenen Auftrag im Produktionsmanager bei.

Über diese Schaltflächen können Sie die Priorität der Aufträge steuern. Sie können Aufträge
innerhalb der Liste nach oben und unten verschieben. Der jeweils erste Auftrag der Liste wird
zuerst gesendet.

3 Verfügbare Ausgabegeräte und Aufträge.
Es wird für jedes installierte Gerät in EasySIGN ein Symbol hinzugefügt. Unter diesen Symbolen werden die
jeweils aktiven Aufträge angezeigt.

4 Der Status eines ausgewählten Auftrags.
Hier werden alle Eigenschaften, beispielsweise die Geschwindigkeit, Größe und Anfangszeit, eines ausgewählten
Auftrags angezeigt.

Über das erste Menü in der Menüleiste stehen Ihnen folgende zusätzliche Optionen zur Verfügung:
1 Alles anhalten.
2 Alle Aufträge entfernen.

Sie können den Produktionsmanager nicht schließen, wenn dieser noch Aufträge enthält. Es ist hierbei nicht von
Bedeutung, ob die Aufträge aktiviert oder deaktiviert sind. Sie können mit diesem Befehl den
Produktionsmanager leeren. Hierbei gehen alle aktiven oder nicht abgeschlossenen Aufträge verloren.
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3 Einstellungen

1 Diese Option stellt sicher, dass ein Auftrag nur dann an das Ausgabegerät gesendet wird, wenn EasySIGN die
vollständige Ausgabe berechnen kann.

2 Diese Option stellt sicher, dass nicht der interne SPOOLER, sondern der Windows™-SPOOLER verwendet wird.
3 Hier können Sie mehrere Ordner für temporäre Dateien festlegen. Wenn kein Ordner angegeben ist, wird der

temporäre Standardordner von Windows™ verwendet.

Drucken unter Windows

Nachdem Sie "Windows drucken..." im Menü "Datei" ausgewählt haben, erscheint der Standarddruckerdialog von
Windows. Der einzige Unterschied zu dem gewohnten Bild ist, daß einige Funktionen hinzugefügt wurden. Unter dem
Dialog finden sich mehrere Zusatzoptionen, die hier noch detailliert beschrieben werden.

Alles
Diese Option druckt alles aus, was sich auf Ihrem Arbeitsblatt befindet.

Markierung
Diese Option druckt nur die momentan auf dem Arbeitsblatt markierten Objekte aus.

Maßstab
Hier wird eingetragen, wie groß das Arbeitsblatt gedruckt werden soll.

An Seite anpassen
Dasjenige was Sie Drucken wollen wird an das Papierformat des Druckers angepaßt.

Kacheln
Wenn Sie diese Option aktivieren, wird Ihr gesamtes Arbeitsblatt automatisch in einzelne Kacheln verteilt, die dann
mit einer Überlappung von 5 mm auf jeder Seite ausgedruckt werden.

Umriß drucken
Nur die Kontur der Zeichnung ohne  Füllung wird gedruckt.
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Optisches Positionierungssystem (OPOS)

Sie können in EasySIGN eine Print & Cut-Kombination Ihres Druckers und Plotters erstellen. EasySIGN unterstützt
vordefinierte und benutzerdefinierte optische Positionierungssysteme. 

Vordefinierte Systeme werden vom Hersteller des Plotters zur Verfügung gestellt. Wenn Sie ein vordefiniertes System
auswählen, verwendet EasySIGN automatisch die Spezifikationen des Herstellers. Wenn Sie ein benutzerdefiniertes
System verwenden, gelten keine speziellen Einschränkungen.

System aktivieren
Klicken Sie im Menü "Ansicht" auf "Einstellungen" und anschließend auf die Registerkarte "Passkreuze".

1 Passkreuze anzeigen oder ausblenden.
2 Passkreuze auf Seite sperren.

Wenn Sie diese Option aktiviert haben, werden die Passkreuze bei jeder Änderung der Seitengröße oder
Ausrichtung neu berechnet.

3 Hier wählen Sie das gewünschte System.
4 Hier legen Sie die Maße für die Passkreuze fest. 

Wenn Sie ein vordefiniertes System ausgewählt haben, richtet sich die Größe der Passkreuze nach den vom
Hersteller angegebenen Einschränkungen.

System verwenden
Das Arbeitsblatt muss Objekte enthalten, die geplottet und gedruckt werden können.
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OPOS-System aktivieren. (Klicken Sie hierzu im Menü "Ansicht" auf "Einstellungen" und anschließend auf
"Passkreuze".)

Anschließend wählen Sie nur die zu druckenden Objekte. Klicken Sie im Menü "Datei" auf "Großformat drucken".
Aktivieren Sie im Dialogfeld "Drucken" die Optionen "Nur Markierung" und "Print & Cut-Passkreuze anzeigen". Klicken
Sie anschließend auf "Drucken".
Entnehmen Sie nach dem Druck des Arbeitsblatts das Material aus dem Drucker, und legen Sie es in den Plotter ein.
Jedes Plottermodell hat ein eigenes OPOS-System. Weitere Informationen hierzu finden Sie in der Dokumentation für
Ihren Plotter.

Wählen Sie im Arbeitsblatt das zu plottende Objekt, und klicken Sie anschließend im Menü "Datei" auf "Plotten".
Aktivieren Sie in dem Dialogfeld die Optionen "Nur Markierung" und "Anordnungsplotting". Klicken Sie anschließend
auf "Plotten".

Platzieren Sie jetzt den Plotterkopf über das erste Passkreuz, und führen Sie gegebenenfalls die Schritte im
Bedienfeld des Plotters aus. 

Passkreuze verschieben
Sie können die Passkreuze mit dem Werkzeug zur Aufteilung verschieben.

Warnung
Verschieben Sie zwischen dem Druck- und Plotvorgang keine Objekte auf dem Arbeitsblatt. Dies kann zu
unerwarteten Ergebnissen führen.

Das Maskieren

Das Maskieren ist ein Verfahren zum Ausschneiden von Bitmaps und Vektoren mit Hilfe anderer Vektoren und ohne
Änderungen am Original vorzunehmen. Wurde zum Beispiel eine Bitmap über eine andere gelegt, sind immer die
rechteckigen Begrenzungshilfen zu berücksichtigen. Sollen nun die zwei nachfolgenden Fotos so bearbeitet werden,
daß das Gesicht des Mannes sich glaubwürdig vom Hintergrund abhebt, ist dies nur mit Hilfe des Maskiervorgangs zu
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erreichen. Masken kann man allerdings nicht plotten, sondern nur drucken (mit Ausnahme von Print & Cut).

Versucht man dieses ohne die Option Maskieren, bleiben immer die geraden Trennlinien der Bitmaps wie nachfolgend
dargestellt zu sehen.

Damit das Bild des Mannes sich realistisch vom Hintergrund abhebt, muß eine den Konturen des Gesichts folgende
Linie gezeichnet werden.

Nach dem Zeichnen der benötigten Linienkontur ist zu beachten, daß nur die Bitmap ausgewählt wurde. Nun kann aus
dem Menü "Anordnen" die Option "Maskieren" und danach der Befehl "In Maske plazieren" gewählt werden. Daraufhin
ändert der Cursor seine Form, und Sie können jetzt das Objekt, welches als Maske dienen soll, auswählen. Alles, was
sich außerhalb der Maske befindet, wird nicht länger angezeigt (oder gedruckt).

Wird nun das obige Objekt über das andere Foto gelegt, sieht das Ergebnis folgendermaßen aus.

Die Zeichenfunktionen

Linien / Beziers zeichnen
L i n i e n  /  B e z i e r s  z e i c h n e n  

So gut wie jede Form kann mit diesem "digitalen Bleistift" erzeugt werden. Die Verwendung ist allerdings etwas
schwieriger als die eines gewöhnlichen Bleistifts. Dem stehen jedoch deutliche Vorteile gegenüber. Beim Zeichnen mit
einem gewöhnlichen Bleistift bestimmt nämlich die Geübtheit Ihrer Hand das fließende Aussehen von Krümmungen.
Der digitale Bleistift ist die geübte Hand. Sie brauchen nur die Form zu bestimmen.
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Die Verwendung

Aus der Symbolleiste die "Linien / Beziers zeichnen" wählen. Der Cursor ändert sich folgendermaßen.

Nun klicken Sie mit dem Cursor an einer beliebigen Stelle auf das Arbeitsblatt (1), lassen Sie die Maustaste los, und
bewegen Sie die Maus an eine andere Stelle auf dem Arbeitsblatt (2). Diese wieder mit dem Cursor anklicken sowie
danach zum Abbruch der Linie einmal mit der rechten Maustaste (3). Sie haben nun auf dem Arbeitsblatt eine rechte
Linie hinterlassen. Soll diese genau horizontal oder vertikal verlaufen (mit dazwischenliegenden Abständen von 15
Grad), müssen Sie, während Sie die Maus bewegen, die STRG-Taste gedrückt halten.

Die Ausführung einer gebogenen Linien (Bezier) erscheint etwas komplizierter, doch ist auch diese Methode nach
mehrmaligem Üben sehr logisch und leicht ausführbar.
Hierzu klicken Sie einmal auf die Arbeitsfläche (1), halten die Maustaste gedrückt und ziehen die Maus ein kurzes
Stück (2) an eine andere Stelle. Danach lassen Sie die Maustaste los und bewegen die Maus an eine weitere Stelle auf
dem Arbeitsblatt. Dort klicken Sie zum Abschließen der Bearbeitung (3) einmal mit der linken Maustaste oder zum
Abbrechen der Linie einmal mit der rechten Maustaste. Somit haben sie eine Bezier erzeugt.

Hier können natürlich nicht alle möglichen Situationen behandelt werden. Diese zwei grundsätzlichen Methoden
machen jedoch so gut wie jede bestehende Form realisierbar. Sie werden entdecken, daß diese Art zu zeichnen
schneller und einfacher ist als jede andere manuelle Methode, wenn Sie sich folgende Dinge merken:

1 Das Anklicken und sofortige Loslassen der Maustaste führt nach einer Bewegung zu geraden Linien.
2 Das Anklicken und Weiterbewegen mit eingedrückter Maustaste führt nach der zweiten Bewegung zu

gekrümmten Linien.
3 Zum Abbrechen (Beenden) von Linien einmal auf die rechte Maustaste klicken.

Freihand zeichnen (skizzieren)
F r e i h a n d  z e i c h n e n  ( s k i z z i e r e n )

Diese funktioniert wie ein echter Bleistift. Jede Bewegung der Maus erscheint auch auf dem Arbeitsblatt.

Die Verwendung

Wählen Sie aus der Symbolleiste die "Skizzierfunktion". Der Cursor ändert sich folgendermaßen.

Klicken Sie jetzt mit dem Cursor an eine beliebige Stelle auf dem Arbeitsblatt. Beginnen Sie zu zeichnen. Das
Ergebnis dieser Zeichenmethode muß wahrscheinlich öfters mit der Funktion ”Knoten bearbeiten” zur Entfernung von
Ungenauigkeiten der Mausbewegung bearbeitet werden.
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Rechtecke zeichen
R e c h t e c k e  z e i c h e n

Mit der Funktion ”Rechtecke zeichnen” erstellen Sie auf einfache Art Rechtecke oder Quadrate. Ein Rechteck ist in
EasySIGN ein Objekt mit besonderen Eigenschaften. Das heißt, es ist mehr als ein Vektor, der zum Beispiel mit der
Funktion "Linien zeichnen" erstellt wird. Bei Rechtecken können ferner mit der Funktion ”Knoten bearbeiten” oder mit
Hilfe der Dialog "Eigenschaften" die Ecken abgerundet und das Aussehen verändert werden.

Verwendung

Wählen Sie aus der Symbolleiste die "Rechtecke zeichnen". Der Cursor ändert sich folgendermaßen.

Klicken Sie hierzu einmal auf das Arbeitsblatt (1). Halten Sie die Maustaste gedrückt, und bewegen Sie die Maus ohne
weiter. Nach dem Loslassen des Mauscursors bleibt auf der Arbeitsfläche ein Rechteck stehen(2). Tut man nun
dasselbe wie unter (1) und (2),jedoch mit Verwendung der STRG-Taste, erzeugt man mit derselben Bewegung ein
Quadrat (3). Wird beim Ziehen mit der Maus die Umschaltetaste eingedrückt, erfolgt das Zeichnen des Rechtecks vom
Zentrum ausgehend.

Nach dem Zeichnen eines Rechtecks können mit der Funktion ”Knoten bearbeiten” oder anhand eines Dialogs die
Eigenschaften angepaßt werden. Dazu wählt man das Rechteck aus und klickt einmal auf die rechte Maustaste. Aus
dem daraufhin erscheinenden PopUp-Menü den Befehl "Eigenschaften" wählen, worauf der folgende Dialog erscheint.
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Der Dialog enthält folgende Einstellungen:
1/2 zur Festlegung von Länge und Höhe des Rechtecks;

3 zur Festlegung der Größe der Ecken;
4 zur Festlegung des Aussehens der Ecken,
5 der Schaltfläche "Schließen", schließt den Dialog ohne Änderungen
6 mit  "Übernehmen" werden die Änderungen durchgeführt, wobei das Fenster aber nicht geschlossen wird.

Außerdem kann man mit der Funktion ”Knoten bearbeiten” die Ecken und das Aussehen ändern.

Dazu die Funktion ”Knoten bearbeiten” auswählen.

Das Äußere des Rechtecks ändert sich damit (1). Es erscheinen acht Knotenpunkte. Wählen Sie jetzt einen der
Knotenpunkte an den Ecken des Objekts aus. Klicken Sie darauf, und halten Sie die Maustaste gedrückt. Bewegen Sie
jetzt die Maus an der Linie des Rechtecks (2) entlang. Damit werden die Ecken abgerundet. 
Bei der Verformung eines Rechtecks mit der Markierfunktion kommt es auch zur Verformung der Ecken. Die
Verformung mit der Funktion ”Knoten bearbeiten” (3) beeinflußt hingegen nur die Horizontalen und Vertikalen des
Rechtecks, läßt die Ecken aber unberührt.

Kreise / Ellipse zeichnen
K r e i s e  /  E l l i p s e  z e i c h n e n

Mit der Funktion Kreise / Ellipse zeichnen kann man Ellipsen oder Kreise auf schnelle, einfache Art anfertigen. Auch
Ellipsen sind, genau wie Rechtecke, in EasySIGN Objekte mit besonderen Eigenschaften.

Die Verwendung

Wählen Sie aus der Symbolleiste der Funktion "Kreise / Ellipse zeichnen".  Der Cursor ändert sich folgendermaßen.

Im Übrigen ist diese Zeichenmethode mit der für Rechtecke identisch, außer daß jetzt Kreise und Ellipsen anstelle von
Quadraten und Rechtecken gezeichnet werden.
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Beim Zeichnen von Kreisen halten Sie während des Ziehens die Steuerungstaste gedrückt.

Vor der Wahl der Funktion ”Knoten bearbeiten” muß der Kreis bereits markiert sein. Bewegen Sie die Maus jetzt so
am Kreis entlang, bleiben Sie aber beim ziehen immer innerhalb des Kreises.

Damit haben Sie ein "Tortenstück" gezeichnet. Wiederholen Sie dies jetzt, bleiben Sie jedoch mit der Ziehfunktion
außerhalb des Kreises (Genauer zu betrachten in der Umriß-Modus!).

Jetzt haben Sie einen "Bogen" gezeichnet (Genauer zu betrachten in der Umriß-Modus!).

Zeichnen Sie jetzt einen neuen Kreis, und wählen Sie diesen mit der der Funktion ”Knoten bearbeiten” aus. Dabei
klicken Sie auf den untersten Knotenpunkt und ziehen diesen nach oben. Wählen Sie dann den rechten Knotenpunkt
aus und ziehen Sie diesen nach links.

So werden aus Kreisen Ellipsen. Soll die Ellipse wieder ein Kreis werden, drückt man die Umschalttaste ein und wählt
den rechten oder untersten Knotenpunkt aus. Durch erneutes Bewegen der Maus ändert sich das Objekt wieder in
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einen Kreis und es kann gleichzeitig unten in der Statuszeile die aktuelle Größe gesehen werden. Gleichzeitig
horizontal und vertikal ändern ist möglich mit der Steuerungstaste. Durch ziehen mit gehaltener Steuerungstaste
bleiben also die Proportionen erhalten.

Wie beim Rechteck sind diese Eigenschaften auch mit einem Dialog einstellbar. Dazu mit der rechten Maustaste den
Kreis anklicken und zum Laden des Dialogs den Menüposten "Eigenschaften" auswählen.

Sterne zeichen
S t e r n e  z e i c h e n

Auch die Form von Sternen kann man mit der Funktion ”Knoten bearbeiten” oder durch Anklicken des Objekts mit der
rechten Maustaste mit der Option "Eigenschaften" ändern. Diese Bearbeitungsmethode öffnet einen Dialog zur
numerischen Festlegung der Eigenschaften des Objekts.

Die Verwendung

Wählen Sie aus der Symbolleiste der Funktion "Sterne zeichnen" aus. Der Cursor ändert sich folgendermaßen.

Plazieren Sie den Cursor daraufhin über das Arbeitsblatt. Zeichnen Sie den Stern mit einer ziehenden Bewegung,
wobei Sie die linke Maustaste gedrückt halten.

Wählen Sie dann der Funktion ”Knoten bearbeiten”, und bewegen Sie den Knotenpunkt rechts oben drehend um den
Stern.

Hierdurch vergrößert man die Anzahl der Sternspitzen. Indem Sie die Maus in die entgegengesetzte Richtung
bewegen, wird die Anzahl der Sternpunkte verkleinert. Bewegen Sie anschließend den Knotenpunkt rechts von der
Mitte auf die Außenseite des Sterns zu.
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So wird das Kreisinnere angepaßt. Jetzt wählen Sie den Knotenpunkt mitte links und bewegen die Maus auf den
Mittelpunkt des Sterns zu.

Damit wird das Äußere des Kreises angepaßt. Beide Methoden dienen sowohl zur Vergrößerung als zur Verkleinerung
des Radius.

Polygone zeichnen
P o l y g o n e  z e i c h n e n

Auch Polygone werden, wie alle übrigen Objekte, in EasySIGN mit der Maus und über einen Dialog bearbeitet.

Verwendung

Wenn Sie aus der Symbolleiste die Funktion "Polygone zeichnen" wählen, ändert der Cursor sich folgendermaßen.

Das Zeichnen mit dieser Funktion und ihre Eigenschaften ist gleich der Funktion "Sterne zeichnen".

Pfeil zeichen
P f e i l  z e i c h e n

Wie alle anderen Objekte können Pfeile in EasySIGN jederzeit mit der Maus und dem Dialog bearbeitet werden.

Verwendung

Wenn Sie aus der Symbolleiste der Funktion "Pfeile zeichnen" wählen, ändert sich der Cursor folgendermaßen.

Das Zeichnen mit dieser Funktion und ihre Eigenschaften unterscheiden sich nicht von den anderen EasySIGN-
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Objekten. Die Anzahl der Steuerungsknotenpunkte für das Objekt "Pfeil" ist allerdings größer.

A Diesen Punkt bewegt man zur Anpassung der Pfeilspitze von links nach rechts.
B Diesen Punkt bewegt man zur Anpassung des Vorsprungs der Pfeilspitze in alle Richtungen. Die Verwendung

der Umschaltetaste beim Ziehen führt zur Mitnahme von Punkt "C" über dieselbe Entfernung und Richtung.
C Diesen Punkt bewegt man zur Festlegung der vorderen Pfeilbreite sowie der Einkerbung der Pfeilspitze in alle

Richtungen. Die Verwendung der Umschaltetaste beim Ziehen führt zur Mitnahme von Punkt "B" über dieselbe
Entfernung und Richtung.

D Dieser Punkt hat Einfluß auf die hintere Pfeillänge. Die Verwendung der Umschaltetaste beim Ziehen führt zur
Mitnahme von Punkt "C" über dieselbe Entfernung und Richtung.

E Dieser Punkt legt die Einkerbung des Pfeilschwanzes fest.
F Dieser Punkt bietet die Möglichkeit den Pfeil beim Knoten bearbeiten zu verschieben.

Spiralwerkzeug
S p i r a l w e r k z e u g

Sie können mit dem Spiralwerkzeug normale und spezielle Spiralen zeichnen.

Verwendung

Wählen Sie das Spiralwerkzeug aus der Werkzeugpalette, und zeichnen Sie eine Spirale mit der Maus. Wenn Sie die
STRG-Taste während des Zeichnens gedrückt halten, ist der X- mit dem Y-Radius identisch.

Nachdem Sie die Spirale gezeichnet haben, können Sie mit der Ziehfunktion unter anderem die Anzahl der Windungen
anpassen.



135EasySIGN

Sie können im Dialogfeld für die Eigenschaften der Spirale der Form den letzten Schliff verleihen. Wählen Sie eine
Spirale, und klicken Sie anschließend im Kontextmenü auf "Eigenschaften".

1 Die X- und Y-Position auf dem Arbeitsblatt. 

2 Anfangs- und Endwinkel.

3 Der horizontale, vertikale und innere Radius der Spirale. 

4 Die Anzahl der Windungen. 

5 Richtung 

6 Typ

Konstante

Exponentiell

7 Form
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Hier können Sie die unterschiedlichen oberen und unteren Formen zu einer neuen Spiralform zusammenführen.

Vektorpinsel
V e k t o r p i n s e l

Der Vektorpinsel ist ein nützliches Werkzeug für die Vektorretusche.

Verwendung

Wählen Sie den Vektorpinsel in der Hilfsmittelpalette. Der Mauszeiger nimmt eine andere Form an, und es wird
folgende Hilfsmittelpalette angezeigt.

Hier können Sie die Breite und Form der Pinselspitze festlegen. Sie können mit der Maus eine Vektorform wie mit
einem richtigen Pinsel zeichnen. Sie können die gezeichneten Objekte mit anderen Objekten verschmelzen, die Sie
retuschieren möchten.

Wenn Sie klicken und anschließend den Mauszeiger ziehen, können Sie gerade Linien zeichnen. Wenn Sie hierbei die
STRG-Taste gedrückt halten, können Sie die Linien in einem Winkel von 15 Grad zeichnen. 
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Vektorradiergummi
V e k t o r r a d i e r g u m m i

Der Vektorradiergummi ist ein Werkzeug zum Bearbeiten von offenen und geschlossenen Vektorformen.

Verwendung

Wählen Sie zuerst die gewünschten Objekte, auf die Sie den Radiergummi anwenden möchten. Wählen Sie
anschließend den Vektorradiergummi in der Werkzeugpalette. Der Mauszeiger nimmt eine andere Form an, und es
wird folgende Hilfsmittelpalette angezeigt: 

Hier können Sie die Breite und Form des Radiergummis festlegen. Sie können mit der Maus Bestandteile der
ausgewählten Objekte radieren.

Sie können den Radiergummi bei beliebigen Objekten (einschließlich Textobjekte), Gruppen und komplexen Effekten
verwenden. Wenn Sie jedoch den Radiergummi anwenden, werden die Objekte alle in Kurven umgewandelt. Sie
können den Radiergummi sogar bei Bitmaps anwenden. Die tatsächlichen Bitmapdaten werden nicht geändert, das
Bitmap wird jedoch in einem Container maskiert.

Wenn Sie klicken und anschließend den Mauszeiger ziehen, können Sie gerade Linien zeichnen. Wenn Sie hierbei die
STRG-Taste gedrückt halten, können Sie die Linien in einem Winkel von 15 Grad zeichnen.



138 EasySIGN

Knoten bearbeiten

Knoten bearbeiten
K n o t e n  b e a r b e i t e n

Alle Vektorobjekte in  EasySIGN bestehen aus Basiselementen, hier Strecken genannt. So ist eine Linie / Kurve das
Segment einer Strecke zwischen zwei Knotenpunkten.

Mit der Funktion ”Knoten bearbeiten” ändert man die Streckenmerkmale sowie die Knotenpunkte und damit die Form
eines Objekts. So werden u.a. gerade Linien zu Kurven, die daraufhin jede beliebige Form erhalten können.

Zur Änderung der Form eines Objekts mit der Ziehfunktion, muß dieses in Kurven umgesetzt sein. Diese Option
gehört zum Menü "Bearbeiten, Umwandeln, zu Kurven". Für gezeichnete Gegenstände ist dies nicht notwendig, da
diese sofort als Kurven gezeichnet werden. Rechtecke, Kreise u.ä. sind jedoch in Kurven zu verwandeln. Bei
gruppierten Objekte muß erst die Gruppierung aufgehoben werden.

Das Symbol für die Funktion ”Knoten bearbeiten” steht auf der Symbolleiste und sieht so aus.

Nach der Wahl der Funktion ”Knoten bearbeiten” erscheint folgendes Schwebefenster.

Dieses enthält die Optionen:

Knoten hinzufügen
K n o t e n  h i n z u f ü g e n

Wählen Sie die Option aus dem Fenster. Der Cursor ändert sich damit in der Form und bekommt seitlich ein "+". An
jeden, mit dem Cursor angeklickten Punkt auf der Linie wird ein zusätzlicher Knotenpunkt hinzugefügt. Nach der Wahl
zweier Knotenpunkte erfolgt die Hinzufügung eines Knotenpunkts in der Mitte der Kurve. Sobald Sie mit dem
Hinzufügen fertig sind, kann man diesen Modus durch einmaliges Anklicken der Arbeitsfläche verlassen.

Knoten löschen
K n o t e n  l ö s c h e n

Wählen Sie den oder die zu entfernenden Knoten mit Hilfe dieser Option aus.

Formen öffnen
F o r m e n  ö f f n e n

Diese Option aus dem Fenster wählen. Der Cursor ändert seine Form mit einer  seitlichen  ”Schere” als Symbol. Jede
von diesem Cursor angeklickte Linie oder Kurve wird aufgeschnitten. Sind Sie mit dem Schneiden fertig verlassen Sie
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den Modus durch einmaliges Klicken auf das Arbeitsblatt.

Kurve in Linie umwandeln
K u r v e  i n  L i n i e  u m w a n d e l n

Wählen Sie zunächst aus dem Fenster die in eine Linie umzusetzende Kurve und danach diese Option.

Linie un Kurve umwandeln
L i n i e  u n  K u r v e  u m w a n d e l n

Wählen Sie zunächst aus dem Fenster die in eine Kurve umzusetzende Linie und danach diese Option..

Knoten verbinden
K n o t e n  v e r b i n d e n

Wählen Sie zunächst aus dem Fenster die zu schließenden Knotenpunkte und danach diese Option. Wurden mehr als
zwei Knotenpunkte ausgewählt, kommt es zur Verbindung der am nächsten beieinanderliegenden Knotenpunkte. Nach
der Wahl von zwei Knotenpunkten bestimmt der zuletzt ausgewählte die Position. Dies heißt, wurden mit Hilfe der
Umschaltetaste zwei Knotenpunkte markiert, bleibt der zuletzt gewählte auf seinem Platz stehen und wird der zuerst
gewählte auf diese Stelle bewegt. 
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Knoten brechen
K n o t e n  b r e c h e n

Wählen Sie zunächst aus dem Fenster die zu brechenden Knoten und danach diese Option.

Scharfe Knoten
S c h a r f e  K n o t e n

Wählen Sie zunächst aus dem Fenster die zu schärfenden Knoten und danach diese Option. Bei einem scharfen
Knoten wird nur der mit der Maus zu bearbeitende Steuerhebel verändert, während der danebenliegende Hebel
unbeeinflußt bleibt.

Glatte Knoten
G l a t t e  K n o t e n

Wählen Sie zunächst aus dem Fenster die zu glättenden Knoten und danach diese Option. Bei glatten Knoten wirkt
sich auch jede mit dem Steuerhebel des Knotenpunkts vorgenommene Anpassung sowohl auf den bearbeiteten als
auch auf den danebenliegenden Steuerhebel aus. Letzterer ändert sich allerdings nur, wenn der Winkel des
bearbeiteten Steuerhebels verändert wurde. Anpassungen bezüglich der Länge des bearbeiteten Hebels wirken sich
auf den danebenliegenden nicht aus.
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Symmetrische Knoten
S y m m e t r i s c h e  K n o t e n

Wählen Sie zunächst aus dem Fenster die symmetrisch zu machenden Knotenpunkte und danach diese Option. Bei
symmetrischen Knotenpunkten hat jede Bewegung des bearbeiteten Steuerhebels Auswirkungen auf den
danebenliegenden. Dieser Hebel ändert sich damit sowohl bei am Winkel des bearbeiteten Steuerhebels
vorgenommenen Anpassungen als auch bei Anpassungen bezüglich dessen Länge. Die Hebel sind deshalb immer
gleich lang.

Knoten horizontal ausrichten
K n o t e n  h o r i z o n t a l  a u s r i c h t e n

Diese Option richtet alle markierte Knoten horizontal aus.
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Knoten vertikal ausrichten
K n o t e n  v e r t i k a l  a u s r i c h t e n

Diese Option richtet alle markierte Knoten vertikal aus.

Knoten auf einer Linie ausrichten
K n o t e n  a u f  e i n e r  L i n i e  a u s r i c h t e n

Diese Option richtet alle markierte Knoten auf einer Linie aus. 

Rechter Winkel
R e c h t e r  W i n k e l

Die rechtwinklig zu machenden Knotenpunkte markieren und dann diese Option anklicken.
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Durch Linien ersetzen
D u r c h  L i n i e n  e r s e t z e n

Macht alle markierten Linien und Kurven zwischen erstem und letztem Knotenpunkt zu einer geraden Linie.

Im Kreisbogen
I m  K r e i s b o g e n

Wählen Sie diese Option aus dem Fenster. Der Cursor ändert seine  Form mit einem seitlichen ”Bogen” als Symbol.
Mit dieser Option kann aus jeder beliebige Linie ein Bogen entstehen, aus diesem Bogen ein anderer usw.

Ecken abrunden
E c k e n  a b r u n d e n

Mit Hilfe dieser Funktion können alle Eckpunkte, die zwischen zwei geraden Linien liegen, abgerundet werden.
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Einstellungen
E i n s t e l l u n g e n

Nach der Wahl dieser Schaltfläche erscheint ein Dialog, in dem folgende Einstellungen für das Knoten bearbeiten
vorgenommen werden können.

1 Zuletzt ausgewählt.
 Diese Option sorgt dafür, daß der zuletzt gewählte Knoten bei der Verbindung von Knoten die Position

bestimmt.

 

2 Mitte
 Durch diese Option findet die Verbindung genau in der Mitte der markierten Knoten statt.  

 

3 Mit Linie
 Durch diese Option findet die Verbindung der markierten Knoten mittels eine Linie statt.
 

Quick Connect

Eine einzigartige und sehr schnelle Zeichenmethode. Sie brauchen jetzt keine Hilfslinien mehr zu verwenden, weil Sie
über ein einziges Menüelement Linien bearbeiten sowie Knoten hinzufügen und verbinden können. 
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Um die Linien in der obigen Abbildung zu einem geschlossenen Objekt zu verbinden, mussten früher Knoten an den
Schnittpunkten der Linien hinzugefügt, die Linien entfernt und anschließend die überlappenden Knoten geschlossen
werden. Jetzt brauchen Sie nur noch die Linien auszuwählen und anschließend im Menü "Anordnen" auf "Quick
Connect" zu klicken, um ein geschlossenes Objekt zu erhalten (siehe unten).

Mit Quick Connect kann auch eine Kombination aus geschlossenen und offenen Objekten erstellt werden.

Nachdem Sie Quick Connect auf die oben angezeigten Objekte angewendet haben, erhalten Sie folgende Ergebnisse:

Wenn Sie Linien strategisch platzieren, werden die Ergebnisse sogar noch schneller als durch das Verschmelzen oder
Stempeln von Objekten angezeigt. 
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Experimentieren Sie mit "Quick Connect", um herauszufinden, wie diese Funktion in unterschiedlichen Situationen
ausgeführt wird. Sie werden bemerken, dass die meisten Zeichnungen zehn Mal so schnell wie früher erstellt werden
können.

Aufteilen

Was ist Aufteilen und wozu wird es eingesetzt ? 

Auch Großformatdrucker können nicht in jedem Format arbeiten. Jedes Gerät verfügt über ein Höchstformat. Hinzu
kommt, daß z.B. Drucker mit einer Materialbreite von 900 mm oft nur 880 mm von dieser Breite effektiv ausnutzen.

Wie geht man vor?
Bei Großformatdruckern die mit Rollen arbeiten, wird die Länge des Drucks in den meisten Fällen nur durch die
Abmessung des Materials begrenzt. Hier sind oft nur Probleme in der Breite zu erwarten. Um mit der Ausgabe nicht
eingeschränkt zu sein, bietet Ihnen EasySIGN die Möglichkeit das Arbeitsblatt horizontal und vertikal (mit oder ohne
Überlappung) aufzuteilen. Diese Aufteilung können Sie selbst auf dem Bildschirm vornehmen. Diese Aufteilungen
werden dann beim Drucken automatisch berücksichtigt.  Auch können Sie beim Drucken bestimmen welche Aufteilung
Sie drucken wollen. Um dies anschaulicher zu machen, erstellen wir nun einen fiktiven Auftrag, bei dessen Ausgabe
das Format, welches vom Drucker verarbeitet werden kann, überschritten wird.

Wir gehen bei diesem Beispiel von einem Auftrag mit einem 3000 mm hohen und 4500 mm langen Ausgabeformat
aus, während die effektive Breite des Druckers 700 mm ist.
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Aufteilungslinien mit der Maus anbringen
Die zur Bestimmen der Aufteilung benötigten Linien lassen sich auf zwei Arten anbringen, mit der Maus oder durch
numerische Eingabe in einen Dialog. Beim Anbringen von Aufteilungslinien mit der Maus geht man folgendermaßen
vor. Wählen Sie zunächst aus der Symbolleiste die Funktion "Aufteilen" aus.

Bei der Aktivierung dieser Funktion ändert sich der Cursor folgendermaßen.

Wird, wie im aktuellen Beispiel, eine senkrecht stehende Seite verwendet, erzeugt jedes Anklicken des Arbeitsblattes
eine horizontale Aufteilungslinie (eine Aufteilungslinie in Laufrichtung des Papiers). Zur Plazierung einer senkrechten
Aufteilungslinie halten Sie die Umschalttaste während Sie auf das Arbeitsblatt klicken. Abgesehen davon, daß
Aufteilungslinien horizontal oder vertikal sein können, können die Überlappungen auch noch negativ oder positiv sein.
Die Funktion "Aufteilen" verläßt man durch Anklicken einer anderen Funktion oder durch Betätigen der Tabulatortaste.

Aufteilungslinien anhand eines Dialoges anbringen
Wählen Sie im Menü "Datei" die Option "Aufteilung einrichten..." aus. Danach erscheint folgender Dialog.

Hier teilt man durch Einstellen der ”maximalen Größe der Aufteilung”, das Arbeitsblatt  in ”Kacheln” ein. Beim
Aufteilen steht ”horizontal" stets für den Papiereinzug (die Laufrichtung) der Seite.
Geben Sie in das Feld "Horizontales Maß" (1) die maximale Aufteilungsgröße ein (in diesem Fall gleich der
Seitenlänge). Weil hier keine Teilungslinien notwendig sind (wir arbeiten von der Rolle), geben Sie die Seitenlänge
oder eine größeres Maß ein. Tragen Sie bei "Vertikales Maß" (2) 600 Einheiten ein. Die "Horizontale Überlappung" (3)
ergibt zwar vertikale Linien, legt aber die Überlappung der horizontalen Aufteilung fest  Die "Vertikale
Überlappung" (3) ergibt zwar horizontale Linien, legt aber die Überlappung der vertikalen Aufteilung fest. Tragen Sie
deshalb bei "Vertikale Überlappung" 100 Einheiten ein. Die hier verwendete Überlappung ist übrigens nicht
wirklichkeitsgetreu, sondern übergroß, da hierdurch die Aufteilung eines Arbeitsblattes besser verdeutlicht wird. 
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Vielleicht fragen Sie sich jetzt, wieso bei einer effektiven Druckbreite von 700 mm nur 600 mm benutzt werden. Die
Erklärung ist sehr einfach: Zu jeder Breitenangabe muß die Gesamtüberlappung addiert werden.

Negative und positive Überlappungen
Positive Überlappungen werden bei der Ausführung von Aufträgen verwendet, die größer sind als der effektive
Druckbereich und aus diesem Grund Aufteilungen zur Anpassung der einzelnen Teile miteinander erforderlich
machen. Aufteilungslinien mit einer positiven Überlappung legen das total Maß der Aufteilung fest. Bei der Verteilung
eines Ausdrucks über verschiedene, harmonikaförmige Aufteilungen benötigt man allerdings in der einen Ecke eine
positive Überlappung und in der anderen eine negative.

A Der Eckpunkt  "A" faltet sich nach innen. Das heißt, hier ist ein Teil der Zeichnung nicht mehr sichtbar. Man
benötigt also eine negative Überlappung. Bei negative Überlappungen wird eine Bahn aus dem Ausdruck
weggelassen, während bei positiven Überlappungen dem Ausdruck eine Bahn hinzugefügt wird. 

Horizontal Vertikal

 

Negative Überlappungen werden mit Hilfe dunkelgrauer, durchlaufender Linien wiedergegeben.

B Der Eckpunkt "B" faltet sich nach außen. Das heißt, hier muß, soll der Ausdruck nicht durch eine Naht
unterbrochen werden, eine positive Überlappung angebracht werden.

Horizontal Vertikal

Positive Überlappungen werden mit Hilfe von zwei dunkelgrauen, gestrichelten Linien außen und einer durchgehenden,
hellgrauen Linie innen wiedergegeben.
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A Das Original.
B Das Ergebnis einer negativen Überlappung.

C/D Das Ergebnis einer positiven Überlappung.

Platzbestimmung der Aufteilungen
Die folgenden Bilder verdeutlichen, wie das Programm die Stelle und die Größe von Aufteilungen erfaßt.

Das folgende Bild ist die Unterseite einer vertikalen Seite von 3000 mm Breite und 4500 mm Höhe (der Seite aus
unserem Beispiel).

Befinden Sie sich nun mit dem Cursor über der linken Linie, und klicken Sie dabei auf die rechte Maustaste, erscheint
ein PopUp-Menü. Wählen Sie daraus die Option "Eigenschaften der Teilungslinie" aus, worauf dieser Dialog erscheint.

Da sich rechts die Null-Linie des Druckers befindet, liegt die Mitte der ausgewählten Teilungslinie bei 2400 mm. Dies
ist die Entfernung der Null-Linie vom Drucker bis zur Mitte der Teilungslinie. Die Teilungslinie erscheint horizontal, da
die Horizontale der Druckernull-Linie entspricht.

Erstellen von Druckseiten zum Plotten
E r s t e l l e n  v o n  D r u c k s e i t e n  z u m  P l o t t e n

Sie können Druckseiten erstellen, wenn das Objekt, das Sie plotten möchten, größer als die Ausgabe Ihres Plotters
ist. Angenommen, Ihr Entwurf ist 180 cm x 180 cm groß, und Ihr Plotter unterstützt nur Vinyl bis zu einer Breite von
100 cm. Dies bedeutet, dass Sie Ihren Entwurf so plotten müssen, dass Sie zwei getrennte Teile von jeweils 90 cm
Breite erhalten.

Passen Sie zuerst die Seitengröße an die Größe Ihres Entwurfs an, wählen Sie dann Ihren Entwurf aus, und lesen Sie
in der Statuszeile die tatsächliche Größe ab, oder verwenden Sie das Werkzeug zum Abmessen und Skalieren.
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Weisen Sie diese Maße der Seitengröße zu (Menü: Ansicht > Einstellungen > Seite), um sicherzustellen, dass der
Entwurf auf der Seite zentriert wird. Nun können Sie Ihrem Arbeitsblatt die Aufteilungslinien hinzufügen: 

Die Aufteilung richtet sich nach der Größe des Arbeitsblattes. Wenn Sie daher die Seitengröße nicht an den Entwurf
anpassen, werden die freien Stellen auf Ihrem Arbeitsblatt bei der Aufteilung einbezogen. Damit würden Sie
kostbares Vinyl verschwenden:

Im oben genannten Fall würde der Plotter folgendes Ergebnis produzieren. Die schwarzen Pfeile kennzeichnen das
verschwendete Vinyl:

Am besten werden Sie mit der Funktionsweise des Aufteilens vertraut, wenn Sie probeweise kleinere Arbeitsblätter
plotten.  

Aufteilungslinien für das Plotten hinzufügen 
Wählen Sie in der Hilfsmittelpalette das Werkzeug zur Aufteilung:

Wenn dieses Werkzeug gewählt wurde, sieht der Cursor folgendermaßen aus:
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Klicken Sie auf dem Arbeitsblatt an die Stelle, an der die Aufteilungslinie eingefügt werden soll. 

Eine Aufteilungslinie zeigt immer in dieselbe Richtung wie der Einzug des Arbeitsblattes. Wenn die Aufteilungslinie im
rechten Winkel zur Einzugsrichtung gesetzt werden soll, klicken Sie bei gedrückter UMSCHALTTASTE auf das
Werkzeug zur Aufteilung. Sobald Sie eine Aufteilungslinie platziert haben, können Sie deren Eigenschaften ändern,
indem Sie mit der rechten Maustaste auf die Aufteilungslinie klicken. Wählen Sie im Kontextmenü die Option 
Eigenschaften. In dem angezeigten Dialogfeld können Sie dann die genaue Position und die Überlappung dieser
Aufteilungslinie definieren:

Plotten
Sie haben die Möglichkeit, entweder alle Druckseiten auf einmal oder eine nach der anderen zu plotten. Wenn Sie nur
eine einzelne Seite drucken möchten, aktivieren Sie diese Option und geben die Nummer der Druckseite an. Diese
Nummern können Sie bei aktiviertem Aufteilungsmodus (wenn das Werkzeug zur Aufteilung aktiviert ist) auf dem
Arbeitsblatt sehen.

Das Scannen

Mit welcher Auflösung scannt man?
M i t  w e l c h e r  A u f l ö s u n g  s c a n n t  m a n ?

Es ist ratsam, die folgende Faustregel anzuwenden: Eine Bitmap sollte bei einer 1 : 1 Anwendung 72 DPI haben (Dots
per inch = Pixel pro Zoll).  Wenn Sie also eine Bitmaß von 500 x 700 mm Größe drucken wollen, soll diese Bitmap
eine Auflösung von 72 DPI für diese Größe haben. Enthält die Bitmap viele Details, kann es sogar ratsam sein die
Auflösung zu verdoppeln.
Ein Drucker hat als Ausgabe nur eine begrenzte DPI-Zahl. Alles, was über seinem Leistungsvermögen liegt, bleibt
unberücksichtigt. Wohl beeinflußt wird allerdings die Zeit zum berechnen der Druckdaten. Bitmaps mit 72 DPI können
zum gleichen Ergebnis führen wie Bitmaps mit 2400 DPI, jedoch mit dem Unterschied, daß Bitmaps mit 2400 DPI viel
mehr Platz auf der Festplatte belegen und der Rechenzeit sich um das Zehnfache erhöht. Und dieses für ein kaum
besseres Ergebnis. Soll die Auflösung erhöht werden, geschieht dies am besten schrittweise oder durch Verdopplung,
jedoch nicht gleich durch eine Verzehnfachung. 
Beim Offsetdruck arbeitet man mit Filmen, diese werden von Druckern mit 2400 DPI erstellt, Tintenstrahldrucker
verfügen derzeit über 180 bis 720 DPI (1440). Bei diesen Druckern wird bei einer 1:1 Anwendung (meistens A4) eine
Auflösung von 300 DPI benutzt, bei einer Rasterung von 150 LPI (Lines per inch = Linien pro Zoll). Warum sollten Sie
dann Ihren Drucker für ein Foto auf 2400 DPI einstellen?

Zur Vereinfachung verfügt EasySIGN über einen "Assistent" zum Scannen, der die optimale Auflösung vorschlägt. 

Hierzu wählen Sie im Menü "Datei" den Befehl "Scannen", aus dem Untermenü den Befehl "Assistent...". Der folgende
Dialog wird aufgerufen.
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Mitten im Dialog befindet sich die Schaltfläche "Quelle auswählen" (1). Wenn Sie diese anklicken, erscheint ein Dialog,
in welchem alle in Ihrem System installierten Scanner aufgeführt sind. Wählen Sie hieraus den gewünschten Scanner
und klicken Sie dann auf "Weiter" (2) .

Geben Sie in dieses Fenster die Breite und die Höhe des im Scanner befindlichen Originals ein (1). Klicken Sie dann
auf die Schaltfläche "Weiter" (2).
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Geben Sie in dieses Fenster die Größe ein, mit der das Original ausgedruckt werden soll (1). Klicken Sie dann auf die
Schaltfläche "Weiter" (2).

In diesem Fenster wird die empfohlene Auflösung (1) angezeigt. Wenn Sie die Option "Übernehmen" (2) anklicken,
wird der Standarddialog des Scanners geöffnet. Geben Sie den empfohlenen Wert ein. Wir können Ihnen den Scan-
Dialog hier leider nicht zeigen, da er für jeden Scanner unterschiedlich ist. Sie finden jedoch weitere Informationen
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zur Verwendung des Scan-Dialogs im Handbuch zu Ihrem Scanner.

Die Farbzuordnung

Farben verwenden
F a r b e n  v e r w e n d e n  

Unten auf der Benutzeroberfläche von EasySIGN befindet sich üblicherweise die aktuelle Farbpalette. Ist dies bei
Ihnen nicht der Fall, kann aus dem Menü "Bild" der Befehl "Farbpalette" gewählt werden.

Diese Farbpalette schwebt, das heißt, man kann sie verschieben, sowie vergrößern und verkleinern.

Um eine Farbe einem Objekt zuzuordnen, markieren Sie dieses Objekt und klicken dann auf die entsprechende Farbe
aus der Farbpalette. Sobald Sie sich mit dem Cursor über einem Farbfeld befinden, erscheint in der Statuszeile der
Name der Farbe unter dem Cursor. Durch einmaliges Anklicken der Farbe mit der linken Maustaste wird diese der
Füllung des Objekts zugeordnet. Durch einmaliges Anklicken der Farbe mit der rechten Maustaste wird die Farbe dem
Umriß des Objekts zugeordnet. Um die Füllung eines Objekts zu entfernen, klicken Sie mit der linken Maustaste auf
das erste Kästchen der Farbpalatte (Kästchen mit Kreuz). Um den Umriß zu entfernen, klicken Sie mit der rechten
Maustaste auf das erste Kästchen der Farbpalatte (Kästchen mit Kreuz).

Zur Farbänderung oder zum Mischen einer neuen Farbe müssen Sie zunächst ein Objekt markieren und danach die
Funktion ”Füllung” aus der Symbolleiste wählen.

Nach der Wahl dieser Option erscheint folgender Dialog.
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1 Farbmodell
 Hier kann das gewünschte Farbmodell ausgewählt werden, EasySIGN verfügt über eine breite Auswahl an

Farbmodellen, wie zum Beispiel: 

RGB : Rot, Grün und Blau

CMYK : Zyan, Magenta, Gelb und Schwarz

Grauwerte : Zusammengesetzt aus Schwarzschattierungen

HSB : Farbe, Sättigung und Helligkeit

Punktfarbe
n

: Von den Druckerherstellern festgelegte
Vollfachfarben.

CMYKOrGr : Zyan, Magenta, Gelb, Schwarz, Orange und Grün

CMYKLiCLi
M

: Zyan, Magenta, Gelb, Schwarz, Hellzyan und Hell-
Lila

2 Die visuelle Wiedergabe des gewählten Farbmodells kann mit den Schiebereglern in den Balken (A) oder durch
die Eingabe eines Werts in ein Textfeld (B) beeinflußt werden. Das Ergebnis erscheint dann auf der Mischfläche
(7).

 

3 Feste Farbpalette
 Wurde diese Option aktiviert, sehen die Farbbalken wie auf der obigen Abbildung aus. Sie können Ihren

Wünschen entsprechend gemischt werden. Sind Sie sich nicht sicher, zu welchen Mischwerten z.B. rot und grün
führen, kann die Option ”Feste Farbpalette” auch ausgeschaltet werden. Nun zeigen die Farbbalken auf welche
Seite man zur Erzeugung einer bestimmten Farbe schieben muß. Jede Bewegung in einem der Schieberegler
führt zur gesamten Überarbeitung aller Balken.

 

4 Die Schaltfläche 'Schließen" beendet den Dialog
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5 Die Schaltfläche "Ausführen" überträgt die Farbe aus dem Dialog auf das ausgewählte Objekt.
6 Die Schaltfläche "Hinzufügen' öffnet einen Dialog zur Hinzufügung der aktuellen Farbe an Ihre Palette.

 

Zur Hinzufügung der Farbe an die Tabelle muß die Farbe in Feld (1) einen Namen erhalten. Anschließend klicken Sie
auf "OK".

Der Standard
Jedes in EasySIGN gezeichnete Objekt erhält eine Standardfüllung, einen Linienstil und eine Linienfarbe. Sie können
diesen Standard selbst bestimmen. Dazu klicken Sie einfach auf eine der Farben auf dem Farbbalken oder mischen
eine Farbe im Farbdialog, ohne daß ein Objekt festgelegt wurde. Dasselbe Verfahren gilt auch beim Mischen von
Standard-Linienfarben.

Farbpalette und Folienarchive verwalten
F a r b p a l e t t e  u n d  F o l i e n a r c h i v e  v e r w a l t e n

Zur Umbenennung, Entfernung oder Änderung von Farben aus der Farbpalette bzw. zum hinzufügen einer Farbe aus
dem Archiv zu der Farbpalette, müssen Sie  aus der Symbolleiste die Funktion ”Füllung” wählen.

Nach der Wahl dieser Funktion erscheint folgender Dialog.
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1 Nach der Wahl einer Farbe aus der Liste (2) erscheint deren Name im Eingabefeld (1); dort kann er auch
verändert werden.

2 Diese Liste dient dem Sortieren, Wählen, Umbenennen oder Löschen von Farben.
3 Auch befinden sich hier die Befehle zur Bearbeitung der Farben (7): 

Option zur alphabetischen Darstellung der Liste.

Diese Option verschiebt die markierte Farbe zum Anfang der
Liste.

Diese Option verschiebt die markierte Farbe einen Platz nach
oben. 

Diese Option verschiebt die markierte Farbe einen Platz nach
unten.

Diese Option verschiebt die markierte Farbe zum Ende der
Liste.

Option zur Entfernung der markierten Farbe

4 Die Schaltfläche  "OK" speichert alle Änderungen und beendet den Dialog.
5 Die Schaltfläche "Abbrechen" schließt den Dialog ohne Änderungen zu speichern.
6 Die Schaltfläche "Bibliothek" öffnet den folgenden Dialog.
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1 Wählen Sie aus dieser Liste den Namen des gewünschten Archivs.
2 Diese Liste zeigt die Farbnamen oder Produktnummern des ausgewählten Archivs an. Hier können mehrere

Folienfarben gleichzeitig gewählt werden.
3 Die Schaltfläche "OK" überträgt alle markierten Folienfarben aus der Liste in die Farbpalette.
4 Die Schaltfläche "Abbrechen" schließt den Dialog, ohne Änderungen vorzunehmen.
7 Die Schaltfläche "Ändern" öffnet den Standard-Farbdialog zur Änderung der Eigenschaften einer Farbe.

Markieren nach Farbe
M a r k i e r e n  n a c h  F a r b e

Der Befehl "Markieren nach Farbe" im Menü "Bearbeiten" ruft ein Dialogfeld auf, in dem alle Objekte einer
bestimmten Farbe gleichzeitig ausgewählt werden können.



159EasySIGN

1 Liste mit allen Füllfarben im Arbeitsblatt.
2 Liste mit allen Linienfarben im Arbeitsblatt.
3 Fügt die ausgewählten Linien- und Füllfarben der Auswahlliste hinzu (4). 
4 Die Auswahlliste.
5 Löscht das ausgewählte Element aus der Auswahlliste.
7 Die Schaltfläche "Auswählen" stellt sicher, dass nur die Objekte im Arbeitsblatt ausgewählt werden, deren

Farbe der Farbe entspricht, die Sie angegeben haben.
8 Die Schaltfläche "Auswahl aufheben" stellt sicher, dass die Auswahl der Objekte im Arbeitsblatt aufgehoben

wird, deren Farbe der Farbe entspricht, die Sie angegeben haben.

Auswahl nach Objekt
A u s w a h l  n a c h  O b j e k t

Der Befehl "Auswahl nach Objekt" im Menü "Bearbeiten" öffnet einen Dialog, der im Übrigen genauso funktioniert wie
der Vorangegangene, außer daß hier alle Objekten eines bestimmten Typs gleichzeitig ausgewählt werden können.

Schnelles Auswählen von Objekten mit einem ähnlichen Füllstil
S c h n e l l e s  A u s w ä h l e n  v o n  O b j e k t e n  m i t  e i n e m  ä h n l i c h e n  F ü l l s t i l

Wählen Sie ein Objekt, und klicken Sie anschließend im Kontextmenü auf "Markieren nach" und "Ähnlicher Füllstil". Es
werden alle Objekte mit dem gleichen Füllstil ausgewählt. Die Objektauswahl erfolgt nicht nach Farbwerten, sondern
nach dem Namen der Farbe.
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Schnelles Auswählen von Objekten mit einer ähnlichen Linienfarbe
S c h n e l l e s  A u s w ä h l e n  v o n  O b j e k t e n  m i t  e i n e r  ä h n l i c h e n  L i n i e n f a r b e

Wählen Sie ein Objekt, und klicken Sie anschließend im Kontextmenü auf "Markieren nach" und "Ähnliche
Linienfarbe". Es werden alle Objekte mit der gleichen Linienfarbe ausgewählt. Die Auswahl erfolgt nicht nach
Farbwerten, sondern nach dem Namen der Farbe.

Schnelle Auswahl ähnlicher Objekte
S c h n e l l e  A u s w a h l  ä h n l i c h e r  O b j e k t e

Wählen Sie ein Objekt, und klicken Sie anschließend im Kontextmenü auf "Markieren nach" und "Ähnliche Objekte".
Es werden alle identischen Objekte ausgewählt. 

Registrierungsfarbe
R e g i s t r i e r u n g s f a r b e

Was bedeutet "Registrierungsfarbe"?

Die Registrierungsfarbe ist ein eigener Farbraum. Bei dieser Farbe handelt es sich eigentlich nicht um eine Farbe,
sondern um eine Eigenschaft. Ein Objekt, das diese Eigenschaft besitzt, wird beim Farbauszug (Farbtrennung)
zusammen mit jeder anderen Farbe gedruckt bzw. geplottet. Die Eigenschaft "Registrierungsfarbe" ist für das
Verhalten von Passkreuzen verantwortlich. Sie können diese Eigenschaft über die Farbfunktionen für Linien- oder
Füllstile oder über die Farbpalette zuweisen. Die Registrierungsfarbe wird in der Farbpalette als schwarzes Feld mit
weißem "R" angezeigt.

Sie können eine beliebige Farbe als Registrierungsfarbe festlegen, um den Unterschied zwischen Registrierungsfarbe
und normalen Farben auf dem Arbeitsblatt kenntlich zu machen. Der Registrierungsfarbe kann über das Menü "Datei",
"Einstellungen" und die Registerkarte "Allgemein" eine Standardfarbe zugewiesen werden. Jedes neue Objekt mit
Registrierungsfarbe wird in dieser Farbe angezeigt. Diese Einstellungen haben keine Auswirkung auf bereits
vorhandene Objekte mit der Eigenschaft "Registrierungsfarbe". Sie können das Erscheinungsbild von Objekten mit
dieser Eigenschaft über die Farbfunktionen für Linien- oder Füllstile ändern.

In der Abbildung oben ist "A" das Objekt mit der Eigenschaft ‘Registrierungsfarbe’ und Rot die dieser Eigenschaft
zugewiesene Farbe.

1 Farbauszug in Rot
2 Farbauszug in Grün
3 Farbauszug in Blau

Die Registrierungsfarbe ist in jedem Farbauszug automatisch enthalten.
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Messen von Farben
M e s s e n  v o n  F a r b e n

In EasySIGN können Sie Farben mithilfe eines Densitometers in die Software eingeben. Dies ist  eine optimale Möglichkeit zum Erstellen einer

eigenen Farbbibliothek! 

Einstellungen
Klicken Sie im Menü "Datei" auf "Einstellungen" und dann im geöffneten Dialogfeld auf die Registerkarte "Densitometer".

1 Klicken Sie auf die Option "Ja, Ich will einen Densitomesser benützen von der Marke".

2 Wählen Sie im Kombinationsfeld die Herstellermarke des Densitometers aus.

3 Wählen Sie den Anschluss aus, mit dem das Densitometer verbunden ist . Wenn Sie im Kombinationsfeld ein

Densitometer mit USB-Verbindung gewählt haben, ist  diese Option nicht verfügbar. Verwenden Sie keine

automatischen Densitometer, die mehrere Farben in einem Durchgang messen, sondern stattdessen ein Gerät zum

Messen von jeweils nur einer Farbe.

4 Klicken Sie auf diese Schaltfläche, um zu ermitteln, ob das Densitometer erkannt wird. Dieser Vorgang kann einige

Zeit in Anspruch nehmen. Warten Sie, bis die Meldung angezeigt wird, dass das Densitometer erkannt wurde.

5 Wählen Sie den Farbraum aus, in dem die gemessenen Farben gespeichert werden müssen (CMYK oder RGB).

Wenn die Farben gedruckt werden sollen, empfiehlt sich die Wahl des CMYK-Farbraums.

6 Hier können Sie das gewünschte Profil für den CMYK- und RGB-Farbraum auswählen. Wenn Sie über einen

Drucker und ein (ICC von ICM-)Profil dafür verfügen, wählen Sie dieses Profil aus. Auf diese Weise kommen die

gemessenen Farben dem Druckergebnis sehr nahe. Falls Sie entweder über keinen Drucker oder aber über mehrere

Drucker verfügen, wählen Sie das Profil "Standard-CMYK" und das Profil "Standard-RGB".

Klicken Sie auf "Übernehmen", um die festgelegten Einstellungen zu speichern, und schließen Sie das Dialogfeld.

Verfahren
Klicken Sie auf der Symbolleiste auf den "Farbeimer" und dann auf das Symbol für "Farbmanagement".
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Das folgende Dialogfeld wird geöffnet.

Wenn Sie die neuen Farben in einer eigenen Tabelle speichern möchten, müssen Sie zuerst in der Gruppe "Tabelle" auf die Schaltfläche "Neu" (2)

klicken und dann eine neue Tabelle erstellen. Falls dies bereits geschehen ist  oder Sie die gemessenen Farben einer vorhandenen Tabelle hinzufügen

möchten, klicken Sie in der Gruppe "Farbe" auf die Schaltfläche "Abmessen" (1).

Geben Sie den Namen der Farbe ein, und klicken Sie mit dem Densitometer auf die Farbe, die Sie messen möchten. Die Farbe wird in der

Farbvorschau (2) wiedergegeben, und die jeweiligen Farbwerte werden in den Bearbeitungsfeldern angezeigt.

Wenn dieses Symbol zu sehen ist , liegt die gemessene Farbe außerhalb der Farbpalette (Bereich der druckbaren Farben) des Druckers, basierend auf

dem gewählten Profil in den "Einstellungen".  Sie können die Farbe visuell so anpassen, dass sie mit der gemessenen Farbe weitmöglichst

übereinstimmt.

Klicken Sie auf die Schaltfläche "Hinzufügen", um die gemessene Farbe der aktiven Farbtabelle hinzuzufügen. Nachdem Sie die Farbmessung beendet

haben, schließen Sie das Dialogfeld. Vergessen Sie nicht, auf die Schaltfläche "OK" zu klicken, um die Änderungen zu speichern. 
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Farbverlauf
F a r b v e r l a u f

Bei einem Farbverlauf gehen zwei oder mehr Farben schrittweise in die nächste Farbe über. Mit dieser Funktion
können Sie Ihrer Arbeit mehr Farbe und Tiefe geben. Es gibt verschiedene Arten von Farbverläufen.

Linear
Die Füllung erstreckt sich in einer geraden Linie über das Objekt:

Radial
Die Füllung besteht aus konzentrischen Kreisen:

Rechteckig
Die Füllung besteht aus konzentrischen Rechtecken:

Konisch
Die Füllung besteht aus Strahlen, die vom Mittelpunkt des Objekts ausgehen:

Jeder dieser Farbverläufe ist in zwei Typen unterteilt.

Zweifarbig
Diese Füllung besteht nur aus zwei Farben, die ineinander übergehen:

Benutzerdefiniert
Diese Füllung kann aus mehr als zwei Farben bestehen. Sie können beispielsweise einen Verlauf von Rot nach
Orange, nach Gelb, nach Grün usw. verwenden:

Außerdem können Sie Farbverläufe anpassen, indem Sie die Randfüllung oder den Winkel ändern bzw. Farben
hinzufügen oder ändern. Diese Änderungen können Sie im Dialogfeld oder direkt auf dem Bildschirm vornehmen.  

So wenden Sie einen Farbverlauf an
Sie haben hierzu zwei Möglichkeiten.

Dialogfeld “Farbverlauf”
Wählen Sie ein Objekt aus, und klicken Sie in der Werkzeugpalette im Untermenü von Füllungen auf die Schaltfläche
für Farbverläufe.
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Nehmen Sie in diesem Dialogfeld die gewünschten Einstellungen vor, und klicken Sie dann auf OK.

Direkt auf dem Bildschirm
Klicken Sie in der Werkzeugpalette im Untermenü von Füllungen auf die Schaltfläche für direkte Farbverläufe.

Der Cursor ändert sich folgendermaßen:

Wenn Sie mit diesem Werkzeug ein Objekt auswählen und gleichzeitig die Maus verschieben, wenden Sie auf das
Objekt einen Farbverlauf an:

Dialogfeld “Farbverlauf”

Zweifarbig
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1 Typ
 Sie können einen der folgenden Farbverlaufstypen wählen:
  Linear
  Radial
  Rechteckig
  Konisch

2 Mittelpunkt
 Wenn diese Option von einem Farbverlaufstyp unterstützt wird, können Sie den Mittelpunkt der Füllung

anpassen. In der linken Spalte des unten stehenden Bildes ist der Mittelpunkt auf 0 % horizontal und 0 %
vertikal eingestellt; in der rechten Spalte wurden der horizontale und der vertikale Wert auf 25 % gesetzt:

 

3 Optionen

 Winkel
 Mit dieser Option können Sie den Winkel des Farbverlaufs festlegen.

 Schritte
 Mit dieser Option können Sie die Anzahl der Schritte festlegen, die zum Erstellen des Farbverlaufs verwendet

werden sollen. Wenn Sie die Option mit der Schaltfläche hinter dem Eingabefeld entsperren, können Sie für den
aktuellen, aktiven Farbverlauf die Anzahl der Schritte festlegen. Wenn Sie die Option sperren, wird die Anzahl
der Schritte aus den Globaleinstellungen unter Datei > Einstellungen > Allgemein > Farbverlauffüllung
Schritte übernommen.

 Randfüllung
 Mit dieser Einstellung wird der Bereich festgelegt, den Anfangs- und Endfarbe unverändert bleiben, bevor der

tatsächliche Farbverlauf beginnt.

 Spezialeffekte
 Wenn diese Option aktiviert ist, können Sie einen gewöhnlichen Farbverlauf in einen Spezialeffekt umwandeln.

Ein gewöhnlicher rechteckiger Farbverlauf sieht folgendermaßen aus:  

 

 Wenn die Option Spezialeffekte aktiviert und ein Winkel von 6 Grad angewandt wurde, sieht derselbe
Farbverlauf dann folgendermaßen aus: 
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4 Farbverlauf
 Hier können Sie zwischen Zweifarbig und Benutzerdefiniert wählen.  

5 Von/Nach
 Hier können Sie die Anfangs- und Endfarbe des Farbverlaufs wählen. Wenn Sie auf eine der Schaltflächen

klicken, wird das folgende Menü angezeigt:
 

 

 Wählen Sie eines der Farbquadrate aus, um diese Farbe als neue Anfangs- oder Endfarbe festzulegen: 
 

 

 Wenn Sie auf das schwarze Quadrat mit dem Buchstaben “C” klicken, wird ein Dialogfeld geöffnet, in dem Sie
eine benutzerdefinierte Farbe erstellen können.

6 Mittelpunkt
 Hier können Sie den Mittelpunkt des Farbverlaufs festlegen:
 

 

7 Regenbogen
 Klicken Sie auf eine dieser Schaltflächen, um die Richtung der Anfangs- und Endfarbe festzulegen. In dem

unten stehenden Beispiel stellt das linke Bild in einem Farbraum den “kürzesten” Weg von einer Farbe zur
anderen dar, das rechte Bild den “längsten” Weg: 

 

 

8 Bevorzugte
 Diese Liste enthält eine Sammlung vordefinierter Farbverläufe. Sie können Ihren eigenen Farbverlauf

hinzufügen, indem Sie einen Namen eingeben und auf die Schaltfläche mit dem Pluszeichen (+) klicken. Um
einen Eintrag zu löschen, wählen Sie ihn aus und klicken auf die Schaltfläche mit dem Minuszeichen (-). 
Benutzerdefiniert
Wenn Sie Benutzerdefiniert wählen, ändert sich das Dialogfeld:
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1 Position
 Diese Option gibt die Position der ausgewählten Farbe innerhalb des Farbverlaufs an.  

2 Aktuell
 Hier sehen Sie, welche Farbe momentan ausgewählt ist.  

A Die Anfangsfarbe.
B Eine der möglichen Farbpositionen im Farbverlauf.
C Die Endfarbe.

Wenn Sie auf die weiße Fläche zwischen “A” und “B” doppelklicken oder unter (1) einen neuen Wert eingeben, können
Sie eine neue Farbposition hinzufügen. Um eine Position (1) numerisch hinzuzufügen, müssen Sie sicherstellen, dass
keine vorhandene Position ausgewählt ist, sonst würden Sie diese Position nur verschieben, anstatt eine neue
hinzuzufügen. Sie heben die Auswahl einer Position auf, indem Sie einmal auf die weiße Fläche zwischen “A” und “B”
klicken.

 

Die neu hinzugefügte Position hat die gleiche Farbe wie die Position im unten stehenden Farbverlauf. Wenn Sie den
Regler an eine andere Stelle verschieben, ändert sich nur die Position, nicht aber die Farbe. Sie können eine Position
ändern, indem Sie diese Position auswählen und verschieben bzw. die Position auswählen und den Wert im Feld 
Position (1) ändern:

 



168 EasySIGN

Eine Position ist dann ausgewählt, wenn das Dreieck schwarz ist. Sie können eine ausgewählte Position löschen,
indem Sie auf die ENTF-TASTE Ihrer Tastatur drücken.

Um die Anfangs- oder Endfarbe zu ändern, wählen Sie zuerst “A” oder “B” aus und passen dann den Wert im
Farbmenü (2) an. Um die Farbe einer Position zu ändern, wählen Sie diese Position zuerst aus und passen dann den
Wert im Farbmenü (2) an.

Einen Farbverlauf direkt auf dem Bildschirm anpassen
Wählen Sie zuerst ein Objekt mit Farbverlauf aus, und klicken Sie dann in der Werkzeugpalette im Untermenü von 
Füllungen auf das Symbol für direkte Farbverläufe:

Die Steuerpunkte für den Farbverlauf werden angezeigt:

Wenn Sie an einem der äußeren Punkte ziehen, können Sie den Winkel und die Positionen des Farbverlaufs ändern.
Diese Punkte sind “magnetisch” und können an Hilfslinien oder Knoten einrasten:

Mit dem Regler in der Mitte können Sie den Mittelpunkt des Farbverlaufs ändern:
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Wenn eine Position ausgewählt ist, können Sie ihre Eigenschaften ändern. 

Nicht ausgewählt: 

Ausgewählt: 

1 Platzierung
 Sie können auch die Platzierung der äußeren Position numerisch ändern, wenn Sie im Kontextmenü den Befehl

Verschieben wählen: 
 

 

2 Farbe
 Sie können die Farbe einer Position ändern, indem Sie diese Position auswählen und dann auf eine Farbe in der

Farbleiste klicken oder im Kontextmenü die Option Eigenschaften wählen. Wenn Sie Eigenschaften wählen,
wird das Dialogfeld zum Erstellen einer benutzerdefinierten Farbe angezeigt.

3 Löschen
 Jede Position, abgesehen von der Anfangs- und Endposition, kann über das Kontextmenü oder die ENTF-TASTE

auf der Tastatur gelöscht werden. 

4 Positionen hinzufügen
Zum Hinzufügen einer Position platzieren Sie die Maus über der gestrichelten Linie zwischen der Anfangs- und der
Endposition und wählen dann im Kontextmenü die Option Einfügen bzw. doppelklicken auf die gestrichelte Linie.
Sobald sich der Cursor über der gestrichelten Linie befindet, ändert er sein Aussehen:

Durch Doppelklicken können Sie eine Position hinzufügen:
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Um die Farbe der aktuellen Position zu ändern, wählen Sie eine Farbe aus der Farbleiste aus:

Typ des Farbverlaufs ändern
Öffnen Sie das Dialogfeld Farbverlauf, indem Sie in der Werkzeugpalette im Untermenü von Füllungen auf die
Schaltfläche für Farbverläufe klicken:

In diesem Dialogfeld können Sie jetzt den Typ des Farbverlaufs ändern:

Radial
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Wie bei jedem anderen Farbverlaufstyp, können Sie auch hier Positionen hinzufügen sowie deren Platzierung und
Farbe ändern:

Rechteckig

Konisch
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Mit Farbverläufen arbeiten
Mit Hilfe der Steuerpunkte eines Farbverlaufs können Sie fast alle Einstellungen direkt am Bildschirm festlegen, die
auch im Dialogfeld festgelegt werden können:

Das Wechseln zwischen verschiedenen Farbverlaufstypen ist jedoch nur im Dialogfeld möglich:

Fast alle Einstellungen, die Sie im Dialogfeld festlegen können, können Sie auch direkt auf dem Bildschirm ändern:

Farbverläufe für das Schneiden vorbereiten

Sie können einen Farbverlauf für das Schneiden vorbereiten, indem Sie das Objekt auswählen und im Kontextmenü
den Befehl Umwandeln > Bereit zum Schneiden auswählen:
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Wenn Sie im Farbmodus arbeiten, können Sie keinen Unterschied sehen. Nur wenn Sie in den Modus Umriss
wechseln, können Sie sehen, was sich verändert hat. Jeder Schritt im Farbverlauf wird in ein Vektorobjekt
umgewandelt und somit für das Schneiden vorbereitet. Diese Operation ist nur dann sinnvoll, wenn der Farbverlauf
aus einer geringen Anzahl von Schritten besteht. Zu viele Schritte auf verschiedenen Vinylfarben würden zu viel
kosten und sind auch nicht praktisch:

 

 

Musterfüllungen

Bei Musterfüllungen handelt es sich um Bitmap-Dateien, die nahtlos nebeneinander angeordnet werden können, sodass sie eine ununterbrochene,

vollständige Fläche bilden. Im Lieferumfang von EasySIGN sind mehrere Hundert Beispieldateien enthalten. Über 3.400 dieser Füllungen in 27

verschiedenen Kategorien, wie z. B. "Holz", "Metall", "Marmor", "Stein" usw., können von unserer Website unter der folgenden Adresse

heruntergeladen werden: http://www.easysign.com.

Die Musterfüllungen sind im Unterverzeichnis "Shared\TEXTURES\" von EasySIGN gespeichert. 

Anwenden einer Musterfüllung

Musterfüllungen können wie alle anderen Füllungen über den "Farbeimer" in der Symbolleiste angewendet werden. Markieren Sie zuerst das

Vektorobjekt, dem Sie eine Musterfüllung zuweisen möchten, und klicken Sie dann auf das Symbol unter der Symbolleiste.
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Damit wird ein Dialogfeld geöffnet, in dem Sie eine Musterfüllung auswählen können.

1 Mustervorschau

Durch Klicken auf die Schaltfläche "Muster" wird ein Dialogfeld geöffnet, in dem Sie die gewünschte Musterfüllung auswählen können.
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Dies ist  das zuvor angezeigte Standarddialogfeld "Öffnen", dem einige Funktionen hinzugefügt wurden.

1)

Hier können Sie wählen, wie Dateien dargestellt  werden sollen. Klicken Sie auf "Miniaturansichten", um Vorschauen der Bilder anzuzeigen.

2)

Durch Klicken auf die Schaltfläche "+" können Sie das aktuelle Unterverzeichnis der Liste "Favoriten" hinzufügen.

Wenn Sie aus dieser Liste ein Unterverzeichnis auswählen, wird der ausgewählte Speicherort im Dialogfeld automatisch angezeigt. 

2 Versatzursprung

Eine Musterfüllung "beginnt" in der unteren linken Ecke der markierten Objekte. Mit dieser Option können Sie den Ursprung festlegen.

3 Größe

Mit dieser Option können Sie die Größe der Musterfüllung festlegen.

4 Transformationen

Mit dieser Option können Sie die Neigung und Drehung der Musterfüllung festlegen.

Kachel mit O bjekt transformieren
Mit dieser Option wird festgelegt, ob die Musterfüllung die Transformationen des Objekts kopieren soll.

Original
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Objekt transformiert und diese Option deaktiviert

Objekt transformiert und diese Option aktiviert

Ändern einer Musterfüllung mit der Maus

Markieren Sie ein Objekt mit einer Musterfüllung.

Klicken Sie anschließend auf das Werkzeug zum Anpassen der Musterfüllungen (dasselbe Werkzeug wie zum Anpassen von Farbverlauffüllungen).

Nun können Sie Drehung, Anordnung (Ursprung), Skalierung und Neigung mit der Maus anpassen.

Die mit der Maus vorgenommenen Anpassungen werden in das Dialogfeld der Musterfüllung kopiert. Wenn Sie die Transformationen optimieren

möchten, klicken Sie auf das Objekt mit der Musterfüllung und dann auf das Symbol unter der Symbolleiste.

Einige Beispiele für Musterfüllungen
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Die Paßkreuze

In EasySIGN besteht auch die Möglichkeit ,  eine Seite oder Auswahl mit Paßkreuzen zu versehen. Außerdem können
Paßkreuze direkt an jeder gewünschten Stelle eingegeben werden. Paßkreuze werden stets auf einer Spezialebene
abgelegt. Diese Spezialebene kann in bezug auf Sichtbarkeit, Sperrung und Drucken oder Plotten (oder keines von
beiden) eingestellt werden. Da es sich bei den Paßkreuzen um besondere Objekte innerhalb von EasySIGN handelt,
verhalten sie sich auch anders als gewöhnlich. Bei der Plazierung von Paßkreuzen um ein Objekt, das mit
verschiedenen Farben geplottet werden soll, müssen Sie beispielsweise nicht für jede Farbe ein neues Paßkreuz
einfügen. Ungeachtet der Anzahl an Farben auf einem Arbeitsblatt wird stets ein Paßkreuz für jede Farbe geplottet
oder gedruckt.
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Soll ein Paßkreuz an einer beliebigen Stelle plaziert werden, ist in der Symbolleiste das folgende Werkzeug
auszuwählen.

Der Cursor ändert sich dann folgendermaßen.

An jeder Stelle des Arbeitsblattes, die mit dem Cursor angeklickt wird, wird ein Paßkreuz gesetzt.

Durch Anklicken eines Paßkreuzes mit der rechten Maustaste wird ein Menü mit folgenden Optionen aufgerufen.

Löschen : Löscht das sich unter der Maus befindliche Paßkreuz.

Alles löschen : Löscht alle Paßkreuze auf dem aktuellen Arbeitsblatt

Alles
Unsichtbar

: Verbirgt alle Paßkreuze auf dem aktuellen Arbeitsblatt. Diese können Sie mit dem
Ebenendialog wieder sichtbar machen.

Eigenschaften : Öffnet einen Dialog, der folgende Einstellungen ermöglicht.

1 Die Form des Paßkreuzes ändern.
2 Die Größe des Paßkreuzes ändern.
3 Wenn diese Option gewählt wurde, werden die Einstellungen im Dialog auf alle Paßkreuze des Arbeitsblatts

angewendet.

Der nächste Dialog läßt sich mit Hilfe des Menüs "Einfügen, Produktion, Paßkreuz" öffnen.
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Die in diesem Dialog vorgenommene Änderungen gelten als Vorgabe, wenn neue Paßkreuze auf dem Arbeitsblatt
plaziert werden.

1 Hier kann die Form ausgewählt werden.
2 Hier kann die Größe des Paßkreuzes eingegeben werden.
3 Durch Ankreuzen der Option "Um Seite oder Markierung" werden die Optionen im darunterliegenden

Gruppenfenster aktiviert. In diesem können Sie angeben, ob die Paßkreuze um eine Seite oder eine Auswahl
zu plazieren sind.

4 Unter "Ränder" können Sie den gewünschten Abstand zwischen den Paßkreuzen und die Markierung oder Seite
eingeben.

5 Nachdem Sie diese Option aktiviert haben, werden die Werte, die Sie in das erste Feld eingegeben haben,
automatisch auf die Ränder in den anderen drei Feldern angewendet.

Plazieren von Paßkreuzen um eine Seite
Mit dieser Option können Sie nicht nur Paßkreuze um eine Seite herum plazieren, sondern auch die Seitengröße so
einstellen, daß die Paßkreuze gedruckt werden können. Dabei werden auf dem Arbeitsblatt vier zusätzliche Hilfslinien
gezogen, die die ursprüngliche Größe des Arbeitsblatts darstellen. Auf diese Weise werden Sie niemals vergessen,
beim Drucken der Seite die Paßkreuze einzufügen, da die Paßkreuze bereits in dem Seitenformat enthalten sind.

Bearbeiten von Passkreuzen
Das Arbeiten mit Passkreuzen und Schnittzeichen funktioniert im Wesentlichen genauso wie bei früheren Versionen.
Es gibt jedoch einige wichtige neue Funktionen. In Version 3 und höher können Passkreuze mit anderen Objekten
zusammen ausgewählt und verschoben werden. Außerdem ist es möglich, sie in Kurven umzuwandeln und ihre Farbe
anzupassen.

Benutzerdefinierte Passkreuze
Passkreuze besitzen die Eigenschaft "Registrierungsfarbe". Das bedeutet, dass Objekte mit dieser Eigenschaft mit
jedem Farbauszug gedruckt und geplottet werden können. Die Eigenschaft "Registrierungsfarbe" kann auch jedem
anderen Vektorobjekt zugewiesen werden. Das Objekt wird dann ebenfalls mit jedem Farbauszug gedruckt bzw.
geplottet. Wenn Sie die Eigenschaft "Registrierungsfarbe" für ein Passkreuz deaktivieren, wird das Passkreuz nicht
mehr mit jedem Farbauszug gedruckt.

Teilen

Ist das Arbeitsblatt zu groß, um auf einmal ausgeführt werden zu können, weil das Ausgabeformat des Plotters nicht
groß genug ist, kann die Funktion "Teilen" verwendet werden.
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Angenommen, das obige Bild ist für Ihren Plotter zu groß. Dann müssen Sie erst die aufzuteilenden Objekte
markieren und ein Duplikat angelegen, da beim Teilen das Original zerschnitten wird und Eigenschaften der Objekten
verloren gehen (z.B. Text ist nach dem Teilen kein Text mehr).

Nach der Wahl von “Teilen” aus dem Menü "Bearbeiten" ändert sich der Cursor folgendermaßen.

Bewegen Sie diesen jetzt auf der Stelle, an der mit der Teilung begonnen werden soll. Klicken Sie die entsprechende
Stelle einmal an, und ziehen Sie den Cursor über den zuteilenden Abschnitt. Das Teilen kann aus jedem beliebigen
Winkel heraus geschehen. Die Verwendung der Steuertaste hingegen beschränkt diesen auf 15 Grad. Beim Loslassen
der Maustaste nach dem Ziehen erscheint dann folgender Dialog.

1 Überlappung:
 Hier die Größe der Überlappung eingeben.
2 Formen schließen:
 Wenn Sie diese Option aktivieren, werden die Formen nach dem Teilen geschlossen. Bei der Teilung zur

Ausgabe an einen Plotter muß diese Option immer eingeschaltet sein, da ansonsten offene Formen geschnitten
werden.

3 Teilung gruppieren:
 Bei der Teilung eines Objekts ermöglicht z.B. diese Option die sofortige Gruppierung des Ergebnisses. Für

mehrere Objekte gleichzeitig verwendet man die Option jedoch besser nicht, da Gruppierungen die Reihenfolge
der Schichten ändern und dies zu unerwünschte Ergebnisse führen könnte.

4 Die Schaltfläche "OK" führt der Teilung konform der Einstellungen durch, während  "Abbrechen" den Dialog,
ohne daß es zu einer Teilung kommt, schließt.

Nach dem Anklicken von "OK" scheint erst überhaupt nichts zu geschehen. Beim Betrachten in Umrißmodus oder
durch auseinander schieben des Objekts ist jedoch das Ergebnis zu sehen.

Einschneiden

Die Funktion ”Einschneiden” ist abgeleitet von der Funktion ”Teilen”. Durch Verwendung von ”Einschneiden” kann man
ganz schnell einen einstellbaren Einschnitt oder einen Durchschnitt von einem Objekt machen. Dazu wählt man im
Menü "Bearbeiten" den Befehl "Einschneiden" aus. Der Cursor ändert sich dann folgendermaßen.
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Wie beim Teilen dient dieser Cursor dem Ziehen von Linien. Die Funktion erstreckt sich aber nur auf den
einzuschneidenden Teil. Soll das ganze Objekt geschnitten werden, ist die Linie über den gesamten Teil zu ziehen.

Nach dem Loslassen der Maus erscheint folgender Dialog.

Er dient der Einstellung der "Schnittbreite" (1). Klickt man nach dem Einstellen die Schaltfläche "OK" an (2), der
Einschnitt / Durchschnitt wird erstellt. Zur Verdeutlichung des Unterschieds kann man das Ergebnis eine andere Farbe
geben.

Verschmelzen / Stanzen

Dies ist sicher eine der meist verwendeten Funktionen zur Erstellung eines gelungenen Entwurfs. Mit dieser Funktion
können die einzelne Objekte der  kompliziertesten Zeichnungen vor dem Schneiden direkt am Bildschirm vorbereitet
werden.

Verschmelzen
Das Verschmelzen macht aus zwei Objekten eines. Die zu verschmelzenden Objekte markieren und dann aus dem
Menü ”Bearbeiten” der Funktion ”Verschmelzen / Stanzen" und danach den Befehl" Verschmelzen".
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Ausstanzen
Der Befehl "Ausstanzen" dient der Entfernung der Form eines Objekts aus dem darunterliegenden Objekt.

Offen Stanzen
Der Befehl "Offen Ausstanzen" funktioniert genauso, außer das “offene” Formen das Ergebnis dieser Bearbeitung sind.

Zuletzt Markiertes ausstanzen
Gewöhnlich funktioniert das Ausstanzen entsprechend der Stapelreihenfolge. Das oberste Objekt stanzt die
darunterliegenden aus. Mit dieser Option ist die Stelle des Objekts in der Stapelreihenfolge unwichtig. Das zuletzt
markierte Objekt stanzt die anderen markiertenüObjekte aus und wird danach selbst entfernt.

Zuletzt Markiertes maskieren
Durch diese Option wird das zuletzt markierte als Art Maske verwendet, die dann alle umliegenden Objekte ausstanzt.
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Überlappen
Der Befehl "Überlappen" läßt nur die Überlappung stehen. Nach der Wahl mehrerer, überlappen sich nicht alle
Formen, so kommt es hier zu keinem Ergebnis.

Im folgenden Bild überlappen einander nicht alle Formen. Die oberste Form überlappt nur die Mittlere. In diesem Fall
führt die Funktion zu keinem Resultat.

Im folgenden Bild überlappen sich alle Formen und deswegen kommt das gewünschte Ergebnis zustanden.

Knoten hinzufügen
Bei dem Befehl "Knoten hinzufügen" wird ein zusätzlicher Knotenpunkt auf der Stelle gesetzt, wo die Linien
ausgewählter Objekte einander schneiden.
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Fotoplotten

Mit dieser Funktion kann man eine Farb- oder Graustufenbitmap plotten. Dies geschieht anhand von Bahnen
(Streifen), die breiter werden, je dunkler das Foto ist. Die Bahnbreite und die Anzahl der Bahnen sind verstellbar.
Zum Schneiden verwendet man am besten einen Abstand von 1,5 bis 2mm. Das Ergebnis bei diese Einstellung ist gut,
die Linien werden nicht zu schmal und könne deshalb gut entgittert werden. Wenn Sie Fotoplotten wollen, müssen Sie
die dazu vorgesehene Bitmap markieren und diese mit der rechten Maustaste anklicken. Jetzt erscheint ein PopUp-
Menü wovon zwei Optionen, die beim Fotoplotten verwendet werden können.

A Als Fotoplot anzeigen
 Nach der Wahl dieser Option erscheint die ausgewählte Bitmap als Fotoplot mit den aktuellen Einstellungen.

B Fotoplot-Optionen
 Diese Option öffnet einen Dialog zur Anpassung der Einstellungen des Fotoplots.

 

1 Bahnbreite
 Hier kann die Breite der Bahnen, in die das Foto aufgeteilt wird, eingestellt werden.
2 Anzahl der Bahnen
 Hier ist die Anzahl der Bahnen, in die das Foto aufgeteilt wird, einstellbar.
3 Schneidrichtung
 Hier legt man fest, ob die Bahnen horizontal oder vertikal verlaufen sollen.
4 Negativ schneiden
 Diese Option invertiert die Helligkeit des Fotos.
5 Linienstärke
 Mit dieser Option legt man die minimale und maximale Liniensträrke der Bahnen fest. 
6 Die Schaltfläche "OK" führt das Fotoplotten konform der Einstellungen durch, während  "Abbrechen" den Dialog,

ohne daß es zu Fotoplotten kommt, schließt.

Die in diesem Dialog vorgenommenen Einstellungen bleiben behalten und werden auch auf folgende Bitmaps
angewendet.

Der Text

Der Text
D e r  T e x t

Der Text ist ein wichtiges Bestandteil für die Gestaltung Ihrer Entwürfe. Aus genau diesem Grund verfügt EasySIGN
über eine sehr fortschrittliche Textfunktion. Diese unterstützt sogar Text auf Objekten und Pfaden unter Beibehalt
aller Eigenschaften .Die Textfunktion ist sehr einfach zu bedienen, alles kann direkt am Bildschirm bearbeitet und
eingefügt werden.
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Text einfügen
T e x t  e i n f ü g e n

In der Symbolleiste das Symbol für ”Text” auswählen.

Danach erscheint folgender Dialog. Der Cursor ändert sich in ein Textsymbol.

Wenn Sie mit dem Cursor (Textsymbol) auf das Arbeitsblatt klicken, können Sie mit der Texteingabe beginnen. Um
Text von anderen Anwendungen einzufügen, wird die Windows™ Zwischenablage benutzt. Kopieren Sie den Text aus
dem externen Schreibprogramm in die Zwischenablage.  In EasySIGN wählen Sie jetzt  die Funktion ”Text” und
plazieren den Cursor dort, wo der Text, die Sie einfügen wollen, beginnen soll. Die Text wird nun von der
Zwischenablage mit "STRG+V"  in EasySIGN kopiert. Auf diese Weise ist EasySIGN mit fast jedem unter Windows™
laufenden Textverarbeitungs-programm kompatibel.
Zum markieren von Text plazieren Sie den Cursor am Anfang oder am Ende des Textes und bestimmen durch Ziehen
mit gehaltener Maustaste welches Teil des Textes markiert werden soll. Alle in dem Textdialog eingegebenen Befehle
werden jetzt, bei Bedarf, in dem markierten Teil geändert.

Der Textdialog
1 Auswahl der Schriftart
 Hier ist die gewünschte Schriftart auszuwählen. Es wird jede gewählte Schriftart  in der Vorschau so angezeigt,

so daß die endgültige Wahl erleichtert wird.
2 Diese Schaltflächen ändern die Einstellungen Fett oder Kursiv des markierten Textes. Diese Funktionen werden

nur unterstützt wenn die gewählte Schriftart diese Eigenschaften auch enthält.

 

3 Mit diesen Schaltflächen stellt man Schriftzeichen hoch (verkleinert und rechts über dem vorhergehenden
Zeichen) oder nach unten (verkleinert und rechts unter dem vorhergehenden Zeichen).

 

4 Die erste Schaltfläche ändert alle markierten Zeichen in Großbuchstaben. Die zweite Schaltfläche ändert alle
markierten Zeichen in kleine Großbuchstaben (70% der Normalgröße).

 

5 Mit diesen Schaltflächen richtet man Text links- oder rechtsbündig bzw. zentriert aus.
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6 Mit dieser Schaltfläche wird der Text kreisförmig angeordnet. Diese Option wird später in diesem Kapitel
behandelt.

7 Hier kann die Größe des markierten Textes eingegeben werden. Der Zeilenabstand wird hierbei automatisch
angepaßt (8).

 

8 In diesem Feld kann der Zeilenabstand angepaßt werden.

 

9 Die Breite des Abstands zwischen den Wörtern wird in Prozent berechnet. Dabei ist 100 Prozent der Standard.
Im folgenden Beispiel ist der Wortabstand verdoppelt. Diese Anpassung gilt allerdings nur für die Markierung,
nicht für den gesamten Absatz.

 

10 In diesem Feld können Sie den Abstand der markierten Buchstaben / Worte eingeben. Der Standard ist dabei
null Prozent. Jede Änderung des Wertes sorgt für einen größeren oder kleineren Abstand zwischen den
Buchstaben und Textpassagen.

 

11 In diesem Feld legt man die Verzerrung der Zeichen in der Breite des Textes fest (Horizontale Verzerrung).
Damit kann man durch Anpassung der Werte Text schmaler machen oder verbreitern. Der Standardwert ist
dabei 100 Prozent.

 

12 Als Standard definieren
 Alle aktuellen Einstellungen im Texteditor werden als Standardeinstellungen gespeichert.

13 Standard anwenden
 Die Standardeinstellungen werden auf alle Steuerelemente im Texteditor angewandt.

14 Text drehen
 Jedes ausgewählte Zeichen wird gedreht:

15 Text neigen
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 Jedes ausgewählte Zeichen wird geneigt:

Beim Drehen und Neigen dient der Ursprungspunkt des Zeichens auch als Ursprung für die Drehung oder Neigung. 

Text bearbeiten 
Zur erneuten Bearbeitung von Text wählen Sie die Textfunktion aus der Symbolliste und plazieren das Textsymbol
über der zu bearbeitenden Stelle. Oder Sie wählen aus dem PopUp-Menü den Befehl "Text bearbeiten". Mit beiden
Methoden erreichen Sie dasselbe Ziel. Die Vorgangsweise dabei ist jedoch unterschiedlich.

Text mit Farbe gestalten
Zum Gestalten eines ganzen Textblocks müssen Sie zunächst den Textblock markieren. Danach klicken Sie eine der
Farben auf der Farbpalette an oder stellen sich die gewünschte Farbe selbst zusammen.

Sollen ein oder mehrere Zeichen desselben Textes eine andere Farbe erhalten, markieren Sie die betreffenden
Buchstaben mit der Cursor. Danach klicken Sie eine der Farben auf der Farbpalette an oder stellen sich die
gewünschte Farbe selbst zusammen.

Absätze und Tabulator
A b s ä t z e  u n d  T a b u l a t o r

EasySIGN unterstützt die Verwendung von Tabulatoren, nicht nur bei unbearbeitetem Text, sondern auch beim Text
ausgerichtet an Objekten. Mit dieser Option können Sie beispielsweise schnell interessante Preislisten
zusammenstellen. Absätze sind bei Text ausgerichtet an Objekte jedoch nicht möglich, da Absätze aus mehreren
Zeilen bestehen. Text 
ausgerichtet an Objekte besteht immer aus einer Zeile.

Absätze 
Da die aktuelle Version von EasySIGN noch keinen automatischen Zeilenumbruch unterstützt, sind Zeilenumbrüche
innerhalb eines Absatzes von Ihnen selbst vorzunehmen. Dies ist jedoch schon die einzige Einschränkung für Absätze,
ansonsten unterstützt EasySIGN alle Merkmale des Absatzlayouts, wie z.B. das Einrücken von Zeilen. Ein Beispiel für
das Layout von Absätzen sehen Sie im Folgenden.

Geben Sie am Anfang einen Tabulatorsprung und danach einen Bindestrich ein. Geben Sie dann noch einen
Tabulatorsprung sowie einige Textzeilen ein.
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Im Lineal ist ein sogenannter "Tabulatorbalken" zu sehen, der Absatz ist jedoch noch kein richtiger Absatz. Um dies zu
ändern, müssen Sie erst die Bedeutung der einzelnen Teile des Tabulatorbalkens kennen.

A Einrücken der ersten Zeile.

 

 Nachdem der Erstzeileneinzug (Zeichen im Tabulatorbalken) nach rechts verschoben wird, erfolgt die
entsprechende Ausrichtung der ersten Zeile (in diesem Fall einschließlich der Tabulatorsprünge).

B Einrücken von Absätzen.
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 Bei dessen Anpassung durch Schieben nach rechts erfolgt die entsprechende Ausrichtung aller Zeilen außer der
ersten. Diese hängt vom Erstzeileneinzug bei "A" ab. Dieselbe Einstellung ist auch in dem Dialog ”Tab-
Eigenschaften” möglich (rechte Maustaste auf den Tabulatorbalken).

C Markierungen zur Festlegung des Standardabstands für Tabulatorsprünge. Diese Eigenschaft können Sie nur in
dem Dialog ”Tab-Eigenschaften” ändern.

Zur Plazierung eines Tabulatorsprungs im Tabulatorbalken klickt man einfach den Balken mit der Maus an. Der
Tabulatorsprung wird an derselben Stelle hinzugefügt.

Das Zeichen nach dem ersten Tabulatorsprung wird danach ausgerichtet. Zur Änderung der Merkmale
(Ausrichtungsart) eines Tabulatorsprungs klicken Sie diesen mit der rechten Maustaste an. Es erscheint ein PopUp-
Menü. Hier besteht die Möglichkeit, "Links", "Rechts", "Dezimal" oder "Zentriert" direkt auszuwählen. Sie können Ihre
Auswahl dann über "Eigenschaften" im PopUp-Menü aktivieren. Die Verwendung von "Rechts" beeinflußt die Abbildung
dann folgendermaßen. 

Damit der Absatz auch wirklich wie ein Absatz aussieht, muß eine Position vor dem zweiten Tabulatorsprung
angegeben werden. Dieser sollte links ausgerichtet sein, da die Textbreite hier für einen rechts ausgerichteten
Tabulatorsprung zu groß ist.
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Zur Fertigstellung des Ganzen muß nur noch der unterste Zeileneinzug (vor dem Absatz) an dieselbe Stelle versetzt
werden wie der zweite Tabulatorsprung

Tabulatorsprünge entfernen Sie mit dem Befehl "Löschen" aus dem PopUp-Menü durch Wegziehen des
Tabulatorsprungs aus dem Tabulatorbalken.

Beachten Sie dabei bitte, daß die Einstellungen und Ausrichtung für Tabulatorsprünge pro Zeile vorzunehmen sind.

Beispiele für die Ausrichtung von Tabulatorsprüngen
Es gibt vier verschiedene Tabulatorausrichtungen, von denen jede eine eigene Verwendung hat. In den folgenden
Abbildungen wurden alle vier Arten zur besseren Verdeutlichung der Unterschiede auf dasselbe Beispiel angewendet.

Linksbündig ausgerichtete Tabulatorsprünge
Diese erscheinen beinahe ausschließlich am Anfang von eingerückten Absätzen zur Ausrichtung des ersten Satzes
nach dem übrigen Text. Sie eignen sich also nicht für Preislisten, wie dies das folgende Beispiel klar verdeutlicht.

Rechtsbündig ausgerichtete Tabulatorsprünge
Diese werden relativ selten verwendet. Sie sind jedoch für Preislisten mit immer demselben Zeichen oder derselben
Anzahl von Zeichen hinter der Dezimalstelle zu verwenden. Außerdem kommen rechtsbündig ausgerichtete
Tabulatorsprünge nur bei besonderen Layouts vor oder zur rechtsbündigen Ausrichtung des Rufzeichens (meist bei
höheren Zahlen).
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Dezimal ausgerichtete Tabulatorsprünge
Sie gehören zu den am meisten verwendeten Tabulatorsprüngen und sind vor allem in Preislisten unverzichtbar. Was
als Dezimalzeichen benutzt wird, hängt von den "Landeinstellungen" Ihres Windows™ ab. In Europa ist dies meist ein
Komma, in den Vereinigten Staaten allerdings ein Punkt.

Zentrierte Tabulatorsprünge
Auch diese Tabulatorsprünge kommen nur in besonderen Layouts vor. Sie gehören zu den wahrscheinlich am
wenigsten verwendeten. 

Begrenzte Möglichkeiten von Tabulatorsprüngen
Tabulatorsprünge funktionieren nur in linksbündig ausgerichteten Absätzen. Tabulatorsprünge in rechtsbündig
ausgerichtetem oder zentriertem Text werden negiert. 

Eigenschaftendialog im Tabulatorbalken
Dieser Dialog dient der Einstellung der Eigenschaften von Tabulatorsprüngen und Absätzen. Dieser wird durch
Anklicken des Tabulatorlineals mit der rechten Maustaste geladen. 
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1 Tabulatorposition
 Nach der Wahl einer Position aus der Liste (2) der bestehenden Tabulatorsprünge können Sie diese Zahl

verändern und danach mit der Schaltfläche "Verschieben" (8) den Tabulatorsprung an seinen neuen Platz
positionieren.  

2 Diese Liste enthält die Angabe aller anwesenden Tabulatorsprünge im Tabulatorbalken.
3 Art
 Hier kann die Ausrichtung der Tabulatorsprünge aus der folgenden Liste gewählt werden.
4 Hier kann eingegeben werden um welchen Abstand ein Tabulator angelegt werden soll.
5 Hier wird festgelegt, wie weit die erste Zeile eingerückt werden soll. 
6 Hier wird festgelegt, wie weit der Absatz eingerückt werden soll.
7 Hinzufügen
 Wurde unter "Tabulatorposition" (1) eine Zahl eingegeben, dient diese Schaltfläche zum Hinzufügen des

Tabulatorsprungs zur Liste.
8 Verschieben
 Zum Verschieben eines vorhandenen Tabulatorsprungs.
9 Löschen
 Zum Entfernen eines ausgewählten Tabulatorsprungs aus der Liste.

10 Alles löschen
 Dieser Befehl löscht alle Tabulatorsprünge aus der Liste.

11 OK
 Führt alle Änderungen am Tabulatorbalken aus und schließt den Dialog.

12 Abbrechen
 Schließt den Dialog ohne Änderungen.

Rundsatz (Text an Objekt ausrichten)
R u n d s a t z  ( T e x t  a n  O b j e k t  a u s r i c h t e n )

Text läßt sich so steuern, daß er auf dem Bildschirm kreisförmig erscheint. Dazu zeichnen Sie zunächst einen Kreis
(dies kann auch jedes andere ringförmige Objekt sein). Es geht demzufolge nicht um die Form, sondern um die
Eigenschaft des Objekts (dieses muß in diesem Fall ringförmig sein). EasySIGN kann Text an jeder Objekt ausrichten.
Markieren Sie nun den Text den Sie rundsetzen wollen, klicken einmal mit der rechten Maustaste und wählen aus dem
PopUp-Menü den Befehl "Text an Objekt ausrichten".



193EasySIGN

Nachdem Sie die Option "Text an Objekt ausrichten" gewählt haben, klicken Sie mit der Maus auf den Kreis. Der Text
wird jetzt um den Kreis angeordnet.

Nun ist der Kreis "unsichtbar" geworden und bleibt, so lange das Objekt ein "Rundsatz" ist, gemeinsam mit dem Text
stehen. Soll nun der Radius des Objekts verändert werden, wählt man dazu die Funktion ”Knoten bearbeiten” aus der
Symbolleiste. 
Wenn sie auf den Kreis klicken, können Sie den Kreis selber bearbeiten.

Solange die Eigenschaft ”Text an Objekt” besteht, kann man mit der Funktion ”Knoten bearbeiten” den Pfad
bearbeiten und den Text über den Pfad verschieben.

Durch ziehen der vorhandenen Knoten (”Knoten bearbeiten”) können Radius und Form des Kreises ohne Einfluß auf
die Textgröße verändert werden.
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Durch ziehen der z.B. rechten Knoten, unter Verwendung der Steuerungstaste, wird der Kreis in sowohl X als Y
Richtung in der Größe geändert.

Wenn nur der unterste Knoten verschoben wird, so macht man vom Kreis eine  horizontale Ellipse. Die nachfolgende
Verwendung der Steuerungstaste zum Ziehen des linken oder rechten Knoten vergrößert oder verkleinert die Ellipse
in sowohl X als Y Richtung. Drückt man beim Ziehen die Umschalttaste, so wird aus der Ellipse wieder ein Kreis.

Wenn Sie nur den rechten Knoten ziehen, wird die Ellipse senkrecht. Die nachfolgende Verwendung der
Steuerungstaste zum Ziehen des linken oder rechten Knotenpunktes vergrößert oder verkleinert den Radius der
Ellipse ohne Einfluß auf deren Form.

Durch Drehen und nach innen ziehen der obersten Knoten wird der Kreis tortenförmig. Auch hier vergrößert sich der
Radius der Form ohne die Form selbst zu beeinflussen, wenn Sie die Steuertaste beim Ziehen des linken oder rechten
Knotenpunkts verwenden. 
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Zum Schließen der Tortenform plazieren Sie das aufgeschnittene Stück mit Hilfe der Steuerungstaste genau auf dem
anderen "offenen" Stück.

Die ersten Buchstaben können durch verschieben des Steuerungspunktes, auf den Pfad verschoben werden.

Wenn Sie einen anderen Buchstaben verschieben, so wird die Position abhängig von den Einstellungen im Textdialog
erneut berechnet, wenn Sie die Ausrichtung im Textdialog auf mitte/oben stehen haben,

erfolgt Textänderung auf diesen Punkt. 

Im vorigen Beispiel wurde dies extrem angewendet. Diese Vorgangsweise ist vor allem dann nützlich, wenn eine
Stelle, die zur Plazierung vorgesehen wurde, nach eventuellen Anpassungen nicht als solche verloren gehen soll. Ist
die Plazierung für Sie nicht wichtig oder möchten Sie alles manuell durchführen, kann auch die Option "Linksbündig",
"Rechtsbündig" oder "Zentriert" aktiviert werden. Nach der Wahl einer dieser Ausrichtungen bleibt der Text bei jeder
Anpassung auf der gleichen Stelle. 
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Sie können einen Text auf Pfad nicht an seinen Anfangspunkt vorbei ziehen. Text wie den im obigen Bild kann man
nur durch einmaliges Rundziehen in die obere Mitte verschieben.

Text an Strecke (Text an Objekt ausrichten)
T e x t  a n  S t r e c k e  ( T e x t  a n  O b j e k t  a u s r i c h t e n )

Text an Strecke funktioniert im Grunde genommen genauso wie ”Rundsatz”, in beiden Fällen geht es um Text an
Objekt ausrichten. Nur die Schaltflächen zum "Linksbündig", "Zentriert", "Rechtsbündig " oder "Nach unten" Ausrichten
des Textes stehen hier nicht zur Verfügung. Sie zeichnen zunächst eine Strecke und markieren danach den Text mit
der rechten Maustaste. Aktivieren Sie jetzt die Option "Text an Objekt ausrichten" im PopUp-Menü.

Danach markieren Sie  den an der Strecke ausgerichteten Text.

Der Text befindet sich nun auf den Pfad und kann jederzeit mit der Funktion ”Knoten bearbeiten” geändert werden.
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Wird beim Ziehen die Umschaltetaste benutzt, so können Sie Textzeichen aus dem Pfad (Schriftlinie) ziehen. Diese
Option läßt sich auch auf Standard-Textzeilen anwenden.

Pfad bearbeiten
Auch wenn den Text auf ein Pfad können Sie diesem Pfad mit Funktion ”Knoten bearbeiten” (ähnlich wie beim
Rundsatz). Bei jeder Änderung am Pfad paßt Sie die Text an.

Allgemeine Bearbeitung  von Text ausgerichtet an Objekt
A l l g e m e i n e  B e a r b e i t u n g   v o n  T e x t  a u s g e r i c h t e t  a n  O b j e k t

Drehen der Pfadrichtung
Klicken Sie, nach dem markieren, mit der rechten Maustaste den Rundsatz an.
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Wählen Sie im PopUp-Menü den Befehl "Pfadrichtung ändern".

Das gleiche ist auch möglich beim Text an Strecke.

Im obigen Beispiel sind wegen der größeren Deutlichkeit die Pfade ebenfalls gezeichnet. Ansonsten sind diese nur bei
der Funktion ”Knoten bearbeiten” sichtbar.

Buchstaben am Pfad anpassen.
Mit der rechten Maustaste das markierte Objekt anklicken.
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Wählen Sie im PopUp-Menü den Befehl " Buchstaben am Pfad anpassen ".

Die Buchstaben behalten so ihre senkrechte Richtung. Diese Option kann auch auf ”Text an Strecke” angewendet
werden.

Wiederum ist wegen der größeren Deutlichkeit  der Pfad ebenfalls gezeichnet.

Text am Pfad ausrichten 
Standardgemäß befindet sich der Text auf der Basislinie (Pfad). Diese Art der Ausrichtung läßt sich ändern. Hierzu
wählen Sie zunächst das Objekt mit der rechten Maustaste aus. Wählen Sie danach die Option "Unten ausrichten",
"Mitte ausrichten" oder "Oben ausrichten".
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Diese Optionen stehen auch bei ”Text an Strecke” zur Verfügung.

Die Option "Oben ausrichten" scheint zuerst nicht zu stimmen, aber der Schein trügt. Dies kommt daher, daß bei nach
 "Oben ausrichten" immer die Paßform von Sonderzeichen berücksichtigt wird, wie zum Beispiel das große "E" mit
einem Zirkumflex.

Text an Schriftlinie ausrichten
Wenn Sie Buchstaben mit der Funktion ”Knoten bearbeiten” von der Schriftlinie verschoben haben, können Sie mit
diesem Befehl die Buchstaben erneut an der Schriftlinie ausrichten lassen.

Text von Objekt trennen
Mit diesem Befehl bringen Sie den Text in seine ursprüngliche Form zurück

Zeilenabstand und Kerning durch Ziehen anpassen
Z e i l e n a b s t a n d  u n d  K e r n i n g  d u r c h  Z i e h e n  a n p a s s e n

Kerning ziehen
Ausgangssituation:
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Wählen Sie zum Anpassen des Kernings zuerst den Text mit dem Ziehwerkzeug aus. Es werden zwei Steuerpunkte
angezeigt:

Mit dem rechten Steuerpunkt können Sie das Kerning des Textes anpassen:

Ziehen Sie an diesem Steuerpunkt, um das Kerning der Zeichen und Leerräume zu ändern. Wenn Sie während des
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Ziehens die UMSCHALTTASTE gedrückt halten, werden nur die Leerräume zwischen den Wörtern angepasst:

Zum Erhöhen des Kernings ziehen Sie den Steuerpunkt nach rechts und zum Verringern nach links. Sie können das
Kerning sogar dann anpassen, wenn der Text gedreht oder auf andere Weise verzerrt ist:

Zeilenabstand ziehen
Um den Zeilenabstand zu erhöhen, ziehen Sie den linken Steuerpunkt nach unten. Um den Zeilenabstand zu
verringern, ziehen Sie ihn nach oben:
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Zeilenabstand und Kerning auf einem Pfad oder Bogen durch Ziehen anpassen
Z e i l e n a b s t a n d  u n d  K e r n i n g  a u f  e i n e m  P f a d  o d e r  B o g e n  d u r c h  Z i e h e n  a n p a s s e n

Die gleichen Möglichkeiten wie mit normalem Text haben Sie auch, wenn sich der Text auf einem Pfad oder Bogen
befindet. Der Zeilenabstand wird hier allerdings verwendet, um den Abstand zum Pfad oder Bogen festzulegen.

Kerning ziehen
Ohne UMSCHALTTASTE:

Mit UMSCHALTTASTE:

Zeilenabstand ziehen
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Nachdem Sie den Zeilenabstand des Textes angepasst haben, können Sie die Einstellung auch wieder zurücksetzen,
indem Sie aus dem Kontextmenü die Optionen Unten ausrichten, Mitte ausrichten oder Oben ausrichten
wählen.

Zeichen auswählen und bearbeiten
Z e i c h e n  a u s w ä h l e n  u n d  b e a r b e i t e n

Mit Hilfe der Ziehfunktion können Sie gleichzeitig die Farbe von verschiedenen Zeichen an beliebigen Stellen im Text
ändern. Angenommen, Sie möchten die Farbe aller Zahlen in dem unten stehenden Text in Rot ändern. Dazu wenden
Sie die folgende Methode an:

Sie können mit der Ziehfunktion entweder alle Zeichen durch Klicken auf den Ursprungspunkt auswählen oder ein
Auswahlrechteck über die Zeichen ziehen. Sie können dem ausgewählten Zeichen jetzt eine Farbe zuordnen:
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Wenn Sie in früheren Versionen ein Zeichen verschoben haben, wurden auch alle folgenden Zeichen automatisch
verschoben. Es war nicht möglich, nur jeweils einen Buchstaben oder mehrere Buchstaben an verschiedene Stellen im
Text zu verschieben. Dies ist jetzt möglich. Wählen Sie wieder nach der zuvor beschriebenen Methode den Ursprung
des Zeichens aus, das Sie verschieben möchten, und ziehen Sie daran, ohne die Maustaste loszulassen. Der Rest der
Textzeile wird dann gleichzeitig verschoben. Wenn Sie ein Zeichen auswählen, die Maustaste loslassen und dann
erneut auf das Zeichen klicken, wird nur das ausgewählte Zeichen verschoben. Wenn Sie mehrere Zeichen
auswählen, werden alle ausgewählten Zeichen verschoben.

Auf ein Zeichen klicken und ziehen

Mehrere ausgewählte Zeichen
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Auf ein Zeichen klicken, erneut darauf klicken und ziehen

Ausnahmen
Wenn Sie Zeichen in einem Text verschieben, der Tabulatoren enthält, erhalten Sie andere Ergebnisse:

In den oben erwähnten Fällen werden beim Ziehen am Steuerpunkt auch die Zeichen nach dem ausgewählten
Zeichen verschoben:

Der oben stehende Text enthält jedoch Tabulatoren, und das nachfolgende Zeichen wird nur verschoben, wenn die
nächste Tabulatorposition erreicht wird. Das nächste Zeichen wird an die nächste Tabulatorposition verschoben.

Texteinstellungen
T e x t e i n s t e l l u n g e n

Standardeinstellungen für die Größe von hoch- und tiefgestelltem Text usw. finden Sie unter Ansicht >
Einstellungen auf der Registerkarte Text.
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1 Einheiten zum Text immer in Punkt
Die Schriftgröße wird unabhängig von der Globaleinstellung für Einheiten immer in Punkt angegeben.

2 Zeilenabstand mit Schrifthöhe verbinden
Wenn Sie die Schriftgröße der Zeichen im Texteditor ändern, wird der Zeilenabstand automatisch angepasst.

3 Standard-Tababstand
Setzt Tabulatoren automatisch in einem vorgegebenen Abstand. Wenn Sie in einen Text einen Tabulator
einfügen, ohne die Position anzugeben, wird diese Einstellung verwendet.

4 Größe von Kapitälchen
Der Unterschied zwischen normaler Schriftgröße und Kapitälchengröße in Prozent.

5 Position von tiefgestelltem Text
Die Position in Prozent, gemessen von der Grundlinie des Textes an.

6 Größe von tiefgestelltem Text
Die Größe in Prozent, gemessen an der normalen Schrifthöhe.

7 Position von hochgestelltem Text
Die Position in Prozent, gemessen von der Grundlinie des Textes an.

8 Größe von hochgestelltem Text
Die Größe in Prozent, gemessen an der normalen Schrifthöhe.

9 Standard wiederherstellen
Stellt die bei der Erstinstallation der Software festgelegten Standardeinstellungen wieder her.

Die Einstellungen 4 bis 8 gelten für jeden neu eingegebenen Text. Der bereits in vorhandene Arbeitsblätter
eingegebene Text bleibt unverändert.
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Textausrichtung
T e x t a u s r i c h t u n g

Über das Menü Text > Textausrichtung > Vertikal wird jeder ausgewählte Text von oben nach unten anstatt von
links nach rechts ausgerichtet:

Bei vertikalem Text wird jede “neue Zeile” links neben der aktuellen Zeile angezeigt:

Zeichen- und Zeilenabstände können mit dem Texteditor oder der Ziehfunktion festgelegt werden:

Textimport
T e x t i m p o r t

Über das Menü Datei > Importieren können Sie jetzt Dateien mit der Erweiterung TXT importieren. Die
Beschränkung für den Import von künstlerischem Text liegt bei 1000 Zeichen pro Import. Selbst wenn Sie eine
Textdatei mit mehr als 1000 Zeichen importieren, werden nur 1000 Zeichen importiert.

Anpassbares Kerning
A n p a s s b a r e s  K e r n i n g

Kerning ist der Abstand zwischen zwei Zeichen. Sie können diesen Abstand ändern, indem Sie den Ursprungspunkt
mit der Ziehfunktion ziehen.
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Dieses Kerning gilt nur für das jeweils angepasste Zeichen im aktiven Textblock. Sie können dieses Kerning auch in
einer Schriftart speichern. Anschließend wird dieses Kerning auf jeden neu eingegebenen Text in dieser Schriftart
angewendet. Sie haben hierbei ein Kerningpaar gespeichert: den Abstand zwischen zwei Zeichen.

Vorgehensweise

Geben Sie einen Text mit den anzupassenden Kerningpaaren ein, und markieren Sie den Text mit dem
Auswahlwerkzeug.

Klicken Sie anschließend im Menü "Text" auf "Kerning" und anschließend auf "Kerning bearbeiten". Der Objekt-
Manager wird gegebenenfalls aufgerufen, und der Mauszeiger nimmt die Form des Drag & Drop-Cursors an.

Ziehen Sie den Ursprungspunkt eines Zeichens an eine andere Stelle.

Im Objekt-Manager werden der Name der Schriftart, das Kerningpaar und der angepasste Wert angezeigt.
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Wenn Sie auf "Übernehmen" klicken, wird die Änderung in die Kerningtabelle gespeichert.

Wenn Sie jetzt Text neu eingeben, wird nicht das in der Schriftart eingebettete, sondern das angepasste Kerningpaar
verwendet. Die Originalschriftart wird nicht geändert.

 
Übernehmen
Diese Option speichert alle vorgenommenen Korrekturen.

 
Entfernen
Entfernt ein Kerningpaar aus der Kerningtabelle.

 
Alle Kerningpaare aus der Liste entfernen
Löscht den Inhalt der gesamten Kerningtabelle.

 
Wendet Kerning auf ausgewählte Textblöcke an.

 
Wendet Kerning auf den gesamten Text im aktuellen Arbeitsblatt an.
Dies gilt auch für Text in Gruppen und bei Effekten.

Wenn Sie Arbeitsblätter öffnen, die bereits Textblöcke enthalten, werden die angepassten Kerningpaare nicht
automatisch angewendet. Wenn Sie angepasste Kerningpaare auf vorhandene Textblöcke anwenden möchten,
müssen Sie diesen Vorgang manuell ausführen. Klicken Sie hierzu im Menü "Text" auf "Kerning" und anschließend auf
"Kerning zurücksetzen". Bei neu eingegebenem Text werden jetzt automatisch die neuen Kerningpaare zugewiesen.

Aufgeteilter Text
A u f g e t e i l t e r  T e x t

Sie können Text in folgende Bestandteile aufgliedern:

Zeilen
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Wörter

Zeichen

Um einen der obigen Vorgänge auszuführen, klicken Sie im Menü "Text" auf "Aufgeteilter Text".

Text verknüpfen
T e x t  v e r k n ü p f e n

Sie können ausgewählte Zeichen, Wörter oder Zeilen zu einem Textblock verknüpfen. Es werden alle ausgewählten
Textobjekte nacheinander eingefügt. Das zuletzt ausgewählte Textobjekt ist der Platzhalter und wird der erste
Textbestandteil im neuen Textblock. Die Reihenfolge der restlichen ausgewählten Textobjekte entspricht der
Anordnung im Arbeitsblatt. 

In dem Beispiel unten ist der schwarze Buchstabe "A" das zuletzt ausgewählte Objekt.

Um Text zu verbinden, klicken Sie im Menü "Text" auf "Text verknüpfen".
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Rechtschreibprüfung
R e c h t s c h r e i b p r ü f u n g

Optionen für die Rechtschreibprüfung

Wenn Sie die Rechtschreibprüfung zum ersten Mal verwenden, müssen Sie einige Einstellungen vornehmen. Klicken
Sie im Menü "Text" auf "Rechtschreibung" und anschließend auf "Optionen für die Rechtschreibprüfung".

1 Optionen für die Rechtschreibprüfung
Hier können Sie Ausnahmen festlegen. Sie können beispielsweise Wörter in Großbuchstaben ignorieren.

2 Sprache für das Hauptwörterbuch 
Hier können Sie die Sprache auswählen, in der die Rechtschreibprüfung ausgeführt werden soll.

3 Vorschläge
Hier können Sie die Geschwindigkeit und die Genauigkeit der Prüfung festlegen.

Wörterbücher

Sie können Wörterbücher für eine bestimmte Sprache oder für alle Sprachen einrichten. Sie können hier ein
Wörterbuch mit häufig falsch geschriebenen Wörtern erstellen oder Wörter hinzufügen, die in den
Standardwörterbüchern nicht enthalten sind. Klicken Sie im Menü "Text" auf "Rechtschreibung" und anschließend auf
"Wörterbücher anpassen".
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Sie können im Feld "Wörter" (1) ein Wort hinzufügen, bei dem die Rechtschreibprüfung einen bestimmten Vorgang
ausführen soll. Sie können im Feld "Anderes Wort" (2) das gewünschte Ergebnis eingeben. Sie können über die Option
"Vorgang" (3) den Vorgang auswählen, der ausgeführt werden soll, wenn dieses Wort von der Rechtschreibprüfung
erkannt wird. Sie können beispielsweise festlegen, dass das Wort durch ein anderes ersetzt werden soll. Sie können
auch angeben, dass das Wort ignoriert wird. Sie können über die Option "Dateien" (4) das Wörterbuch auswählen,
dem das Wort hinzugefügt werden soll.

Rechtschreibprüfung

Wenn Sie einen bestimmten Text markiert haben, wird die Rechtschreibprüfung nur für diesen Text ausgeführt.
Andernfalls durchsucht die Rechtschreibprüfung das gesamte Dokument.

Klicken Sie im Menü "Text" auf "Rechtschreibung" und anschließend auf "Rechtschreibprüfung". Sie können auch F7
drücken.

Die Rechtschreibfehler werden im Dialogfeld und im Arbeitsblatt markiert.
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1 Hier werden die von der Rechtschreibprüfung ermittelten Rechtschreibfehler angezeigt.
2 Hier wird der Vorschlag angezeigt. Sie können den Vorschlag ändern, indem Sie einen anderen Vorschlag

eingeben oder in der unten angezeigten Liste auswählen.
3 Eine Liste mit Alternativvorschlägen.
4 Der Befehl "Ignorieren" ignoriert den Vorschlag und zeigt den nächsten Rechtschreibfehler an. Wenn alle

anderen Vorkommen dieses Worts auch ignoriert werden sollen, klicken Sie auf die Schaltfläche daneben.
5 Der Befehl "Ändern" ändert die Schreibweise des Worts entsprechend dem Vorschlag. Wenn alle anderen

Vorkommen dieses Worts entsprechend geändert werden sollen, klicken Sie auf die Schaltfläche daneben.
6 Wenn Sie ein angezeigtes Wort in das Wörterbuch aufnehmen möchten (weil es sich nicht um einen

Rechtschreibfehler, sondern nur um ein Wort handelt, das im Wörterbuch nicht vorhanden ist), dann klicken Sie
auf diese Schaltfläche.

7 Wenn Sie im Feld "Ändern in" (2) einen eigenen Vorschlag hinzugefügt haben, können Sie über diese
Schaltfläche weitere vergleichbare Wörter anzeigen.

8 Das aktuelle Wörterbuch.
9 Hier können Sie das Dialogfeld für die Optionen oder das Wörterbuch aufrufen. Sie können dieses Dialogfeld

auch schließen und die Rechtschreibprüfung beenden.

Textstatistiken
T e x t s t a t i s t i k e n

Wenn Sie im Menü "Text" auf "Textstatistiken" klicken, wird ein Dialogfeld aufgerufen, in dem unter anderem die
Anzahl der Wörter, Zeilen und Zeichen in einem Arbeitsblatt angezeigt wird.



215EasySIGN

In diesem Dialogfeld wird die Anzahl folgender Elemente angezeigt:

Textobjekte
Wörter
Einheiten (mit Leerzeichen)
Einheiten (ohne Leerzeichen)
Zeilen

Symbole einfügen
S y m b o l e  e i n f ü g e n

Um Symbole und Sonderzeichen einzufügen, müssen Sie das Caret-Zeichen in einen Textblock einsetzen. Klicken Sie
anschließend im Kontextmenü auf den Befehl "Einfügen" und dann auf "Symbol".

Sie können in diesem Dialogfeld eine Schriftart und das gewünschte Zeichen oder Symbol auswählen. Klicken Sie auf
"OK", um das Symbol einzufügen. Oder klicken Sie auf die Schaltfläche "Einfügen", wenn Sie mehrere Symbole
einfügen möchten.

Text Merge
T e x t  M e r g e

The function Text Merge is an advanced way to automate tedious jobs like creating hundreds of name tags. When you
have a job to create several nametags, container labels, stickers, engraving plates etc. you will normally get a list or
database file to use as a source from your customer. Normally this source would be a .CSV file (semicolon, tab or
comma delimited text), typically a .CSV file would look like this:
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surname;name;occupation
Smith;Ethan;Art Director
Johnson;Emily;Account Executive
Williams;Noah;Marketing manager
Brown;Emma;Sales manager
Jones;Joshua;Graphic designer
García;Madison;Graphic designer
Davis;Liam;Graphic designer
Martínez;Sarah;Graphic designer

The first row would contain the "field" names where as the rest of the file contains the values for that field names. You
could say that a .CSV is a simplified database table. If you would display the sample .CSV file above as a database
table it would look like this:

surname name occupation

Smith Ethan Art Director

Johnson Emily Account Executive

Williams Noah Marketing manager

Brown Emma Sales manager

Jones Joshua Graphic designer

García Madison Graphic designer

Davis Liam Graphic designer

Martínez Sarah Graphic designer

The Text Merge function doesn't stop at text alone, it is possible to use any design containing text, artwork and even
images to create hundreds of different results within minutes. Say for example we have to make some name badges
containing the names of the people from the .CSV example above together with their photo's. This would normally be
a tedious job, especially when there are hundreds of name badges to make instead of the only eight in the sample .
CSV file. 

For implementing the photo's of the people on the name badges we would not only need (of course) their photo's but
we also have to edit the .CSV file to make the software aware of the photo's and where to find these photo's. Their
will also be times you don't receive a .CSV file from you customer and have to create a .CSV file from scratch. For
these reasons we have created a separate software in the "Helpers" range to make these kind of jobs easier.

To find out the best possible way for this workflow and to learn the Text Merge functions we refer to the help file of
the "esHelperCSV" software. The help file of this "Helper" software contains all the information you need to edit and
create .CSV files and how to use them in the EasySIGN Text Merge function.

To get started do the following. In EasySIGN select the menu "File > Run Helpers > esHelperCSV", this will start the
"esHelperCSV" software. 

In the "esHelperCSV" software select the menu "Help > Help" to start the help file and follow the instruction in this
help file to learn about .CSV files and the usage of the EasySIGN Text Merge function.

Schatten

Wie die meisten Effekte in EasySIGN sind Schatten objektorientiert . Solange Sie einen Schatten nicht in Kurven umwandeln (z. B. für detaillierte

Anpassungen), können Sie seine Eigenschaften anpassen oder sogar den gesamten Effekt entfernen, um zu den Originalobjekten zurückzukehren.

Die Eigenschaften eines Schatteneffekts können mithilfe des "Ziehwerkzeugs" oder über das Dialogfeld mit den Eigenschaften angepasst werden. 

Anwenden eines Schattens
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Markieren Sie ein willkürliches Vektorobjekt, einen Text, eine Bitmap, einen Effekt, eine Gruppe oder eine Kombination dieser Objekte.

Perspektivischer Schatten

Klicken Sie im Menü "Effekte" auf "Schattieren" und dann auf den gewünschten Schattentyp. In den nachstehenden Beispielen wird der

perspektivische Schatten verwendet. Das dazu erforderliche Verfahren ist  bei den anderen Schattentypen identisch.

Das Ziehwerkzeug wird aktiv, und auf dem Bildschirm wird eine Vorschau des Schattens angezeigt. Sie können jeden der sichtbaren Knoten mit dem

Ziehwerkzeug anpassen, um die Form zu ändern.

Wenn Sie die ESC-Taste drücken oder in der Werkzeugpalette auf die Schaltfläche "Auswahlfunktion" klicken, wird der Schatten neu berechnet.
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Zum Ändern der Form des perspektivischen Schattens brauchen Sie diesen nicht zu entfernen und einen neuen Schatten aus dem Menü anzuwenden.

Stattdessen können Sie die Eigenschaften eines Schattens über das zugehörige Kontextmenü aufrufen und dann den Schattentyp ändern.

5 Schattentyp
Das Dialogfeld wird mit dem ausgewählten aktuellen Schattentyp geöffnet.

A Normal

Der Schatten wird hinter dem Objekt fortgeführt.
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B Überlappung

Der Schatten wird hinter dem Objekt teilweise fortgeführt.

Die Option "Überlappung" (1) wird aktiv. Sie müssen zuerst eine Entfernung angeben, um die Überlappung sichtbar zu

machen.

C Leerraum

Zwischen dem Original und dem Schatten wird zusätzlicher Leerraum hinzugefügt. Auch bei dieser Option müssen Sie

einen Wert für "Überlappung" (1) eingeben, um das Ergebnis sehen zu können.

D Zusätzlicher Rahmen um Original

Ein zusätzlicher Rahmen wird um das Original hinzugefügt; die Größe des Schattens basiert  auf dem Original.

Auch bei dieser Option müssen Sie einen Wert für "Überlappung" (1) eingeben, um das Ergebnis sehen zu können.

E Zusätzlicher Rahmen um Schatten
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Ein zusätzlicher Rahmen wird um den sich ergebenden Schatten hinzugefügt; die Größe des Schattens basiert  auf dem

Original.

Auch bei dieser Option müssen Sie einen Wert für "Überlappung" (1) eingeben, um das Ergebnis sehen zu können.

4 Hier können Sie den Stiftstil für Original und Schatten anpassen. Wenn Sie den Stil hier (und nicht auf dem Arbeitsblatt)

anpassen, wird er auf alle Originale angewendet.

3 Wenn der ausgewählte Schattentyp einen Fluchtpunkt aufweist, können Sie diesen hier numerisch anpassen.

2 Hier können Sie die Farbe des Stiftstils und des Füllstils der Objekte und des Schattens anpassen. Wenn Sie die Farbe dieser

beiden Stile hier (und nicht auf dem Arbeitsblatt) anpassen, werden die Stile auf alle Originale angewendet.

1 Hier können Sie die T iefe, den Winkel und die Überlappung des ausgewählten Schattens anpassen.

Blockschatten

A

B
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C

D

E

Wurfschatten

A
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B

C

D

E

Fallschatten
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A

B

C

D

E
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Spezialeffekte

EasySIGN verfügt nicht nur über Effekte für Bitmaps, sondern auch für Vektoren. Die kompliziertesten Vektorobjekte
oder Vektorobjektgruppen können in fast jede Form gebracht werden. Sie können die Spezialeffekte auch
übereinander legen, um so immer wieder neue Effekte zu erzeugen. Jeder Effekt kann von einem Objekt wieder
entfernt werden, so daß es seine ursprüngliche Form zurückerhält. Wenn Sie einen Effekt permanent anwenden
wollen, um andere Abläufe oder Verfeinerungen auszuführen, können Sie dies mit Hilfe des Befehls "Zu Kurven" aus
dem Menü "Bearbeiten”, ”Umwandeln” umsetzen. Dieser Befehl verwandelt den Effekt in Kurven, die sich bearbeiten
lassen.

Effekte ausführen 
Wählen Sie einen Text aus oder geben Sie ihn ein. 

Wählen Sie anschließend aus dem Menü "Effekte" den Befehl "Spezialeffekte". EasySIGN setzt den zuletzt
verwendeten Effekt auf das Objekt um und geht in den ”Knoten bearbeiten” Modus über. Das Objekt sieht dann
folgendermaßen aus:

Über dem Objekt befinden sich die Schiebeleisten. Mit diesen können Sie die Form des Objektes interaktiv ändern.

Mit jeder Schiebeleiste kann man einen Teil eines Effektes ändern. Die Zahl der Schiebeleisten hängt von der Art des
Effektes ab.  Der Effekt wird angewendet indem, Sie ”Knoten bearbeiten” verlassen (andere Funktion oder
Tabulatortaste).
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Zur Änderung des Effekts wählen Sie zunächst das betreffende Objekt aus und klicken anschließend mit der rechten
Maustaste darauf. Aus dem nun erscheinenden PopUp-Menü wählen Sie die Option "Eigenschaften".

Nun erscheint folgender Dialog.
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Der Dialog enthält die momentan angewendeten Effekte sowie die entsprechenden Parameter (3) hierfür. In der Liste
auf der linken Seite (1) sind alle verfügbaren Effekte dargestellt. Außerdem befindet sich im Dialog auch ein
Vorschaufenster (2). In diesem werden Ihnen die Einstellungen, die Sie im Dialog ändern, als Beispiel dargestellt.
Jede Änderung eines Parameters erscheint in diesem Fenster in vereinfachter Form. Wenn Sie einen Effekt in seiner
entgültigen Form sehen wollen, müssen Sie auf die Schaltfläche "Übernehmen" (4) klicken. Nun erfolgt die Anwendung
des Effekts auf dem Bildschirm 
Wählen Sie jetzt einen anderen Effekt und klicken Sie erst auf die Schaltfläche "Übernehmen" (4), danach auf
"Schließen" (5).

Das jede andere Transformation nützlicher Bestandteil eines Effekts sein, kann wird durch vertikales Skalieren
angezeigt.

Hierzu wählen Sie die Funktion ”Knoten bearbeiten”, um die Parameter dieses Effektes anzuzeigen.
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Für diesen Effekt ist nur ein Parameter erforderlich. Ziehen Sie die Schiebeleiste (Knoten bearbeiten) bis  das
entsprechende Ergebnis erreicht ist.

Nun kann dieser Effekt wieder durch einen anderen überlagert werden. Hierzu wählen Sie aus dem Menü "Effekte"
erneut den Befehl "Spezialeffekte".
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Jeder angewendete Effekt kann durch den Befehl "Effekt entfernen" (mit der rechten Maustaste) vom Objekt entfernt
werden. Sie können alle Effekte löschen, bis Sie erneut das Originalobjekt vorliegen haben. Wollen Sie einen Effekt
definitiv festlegen, wählen Sie aus dem Menü "Bearbeiten" den Befehl "Umwandeln", ”Zu Kurven”.

Die Maßlinien

Maßlinien sind in EasySIGN vollständig objektorientiert. Jede Änderung in Größe oder Form wird direkt in den Labels
der Maßlinien vorgenommen. Maßlinien werden immer zusammen mit Objekten ausgewählt oder gruppiert. Die
Änderung der Eigenschaften von Maßlinien erfolgt anhand eines Spezialdialogs.

Maßlinien verwenden 
Wählen Sie zunächst ein Objekt und danach die Option "Maßlinien" aus der Symbolleiste.

Der Cursor ändert sich daraufhin folgendermaßen.

Wählen Sie mit dem Cursor nun einen der zu messenden Punkte aus, und klicken Sie mit der Maus darauf. 

Bewegen Sie die Maus (mit noch immer gedrückt gehaltener Maustaste) zum entsprechenden Punkt. Klicken Sie hier
erneut.

Lassen Sie die Maustaste los und ziehen Sie den "Pfeil" auf die für die Maßlinie vorgesehene Entfernung.
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Nach dem Loslassen der Maustaste ist hier eine Maßlinie, die das Maß wiedergibt, in einem sogenannten Label plaziert.

Nachdem Sie die Maßlinie zusammen mit dem Objekt markiert haben, wird das Label bei nachfolgender
Maßstabsänderung automatisch der neuen Maßführung angeglichen und angezeigt. 

Maßlinien ändern 
Änderungen können auch direkt am Bildschirm erfolgen. Dies geschieht mit Hilfe eines Spezialdialogs oder dem Menü
der rechten Maustaste. Zur direkten Änderung von Maßlinien auf dem Bildschirm wählen Sie die Funktion ”Knoten
bearbeiten”. Hiermit können Sie wiederum einen der Steuerungspunkte der Maßlinie auswählen und den jeweiligen
Steuerungspunkt ändern bzw. anpassen.

Wenn Sie einen Steuerungspunkt am Pfeilende verschieben und dabei gleichzeitig die Umschalttaste gedrückt halten,
können Sie Maßlinien diagonal anordnen. 
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Bei schrägen Maßlinien wird auch der Winkel der Linie angezeigt.

Durch Anklicken der markierten Maßlinie mit der rechten Maustaste erscheint ein PopUp-Menü. Dieses enthält
verschiedene, direkte Befehle, wie zum Beispiel den zur Änderung der in der Maßlinie benutzten Einheit oder den
Befehl "Eigenschaften". Mit Hilfe des Befehls “Eigenschaften” kann man den folgenden Dialog aufrufen:

1 Texthöhe
 Hier kann die Höhe des Textes eingegeben werden.
2 Schriftart
3 Fester Text
 Hier legt man fest ob der unter ”Beschriftung” (4) eingegeben Text verwendet werden soll.
4 Beschriftung
 Hier kann man den eigenen Labeltext eingeben.
5 Einheit wie Vorlage
 Die Aktivierung dieser Option bestimmt das der Einheit des Arbeitsblattes verwendet wird.
6 Andere Einheiten
 Wenn nicht die Einheit des Arbeitsblattes verwendet werden soll,  kann hier eine andere Einheit angegeben

werden.
7 Genauigkeit
 Wie genau ein Maß dargestellt wird, kann hier (in Stellen hinter den Komma) festgelegt werden.  
8 Wählen Sie hier aus wie die Pfeile und die Beschriftung aussehen sollen.
9 Beschriftung im Querformat
 Die Beschriftung wird immer horizontal dargestellt, ungeachtet der Winkel der Maßlinien.

10 Beschriftung mit Einheit
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 Bei der Aktivierung dieser Option wird hinter dem Maß die Einheit plaziert
11 Übernehmen

 Die vorgenommenen Einstellungen werden angewendet und direkt auf dem Arbeitsblatt angezeigt.
12 Schließen

 Diese Schaltfläche schließt den Dialog.

Entgitterungshilfen

Durch Entgitterungshilfen vereinfacht man nach dem Schneiden der Folie das Entgittern enorm. Auf dem Bildschirm
können Entgitterungshilfen durch den Text und/oder Zeichnungen laufen, beim Plotten wird jedoch nur bis den Rand
des Objekts geschnitten. Das heißt bei Text, daß der Schnitt nur zwischen den Buchstaben und nicht durch diese
hindurch verläuft. Die Innenkonturen der Buchstaben bleiben selbstverständlich vom Schneidvorgang unberührt.

Entgitterungshilfen hinzufügen 
Dies ist auf zwei Arten möglich. Die erste ist die manuelle, bei der man aus der Symbolleiste die Option
"Entgitterungshilfe” wählt.

Der Cursor ändert sich dann folgendermaßen.

Nun kann, genau wie beim Zeichnen eines Rechtecks, die Entgitterungshilfe um das gewünschte Objekt herum plaziert
werden.

Somit ist das Gitter gezeichnet. Die Entgitterungslinien müssen allerdings noch hinzugefügt werden. Dies geschieht mit
Hilfe der Funktion ”Knoten bearbeiten”. Danach sieht die Entgitterungshilfe folgendermaßen aus.

Mit ”Knoten bearbeiten” können Sie die Gitterlinien aus den verdickten horizontalen und vertikalen Rändern
herausziehen.

Markiereren Sie nochmals die Entgitterungshilfe und wählen die Option "Eigenschaften" aus dem rechten
Maustastenmenü. Der folgende Dialog wird geladen.
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1 Rahmenabstand
 Ein Rahmen wird mit diese Abstand um das Objekt (Objekte) plaziert.
2 Linienabstand
 Ein einstellbarer Sicherheitsabstand zwischen Entgitterungslinie und Objekt (wirkt sich beim Plotten aus).

 Horizontale und Vertikale  Entgitterungslinien
3 Keine
 Es werden keine Entgitterungslinien gezeichnet.
4 Jede
 Um diesen Abstand wird ein Entgitterungslinien hinzugefügt.
5 Individuell einstellbar
 Jede Gitterlinie kann nach dieser Wahl individuell eingestellt werden.
6 Hier wird der Wert eingegeben um den die Individuell einstellbaren Entgitterungslinien geändert werden

(hinzufügen oder verschieben).
7 Hier werden alle vorhandenen Gitterlinien gezeigt.
8 Verschieben
 Verschiebt eine vorhandene Entgitterungslinie auf die Position wie unter (6) eingegeben.
9 Hinzufügen
 Fügt eine Entgitterungslinie hinzu auf die Position wie unter (6) eingegeben.

10 Löschen
 Das Entfernen einer vorhandenen Gitterlinie.

Entgitterungshilfen lassen sich auch mit Hilfe eines Einfügedialogs an markierte Objekte hinzufügen. Wählen Sie hierzu
erst ein Objekt aus und dann in dem Menü "Einfügen", "Produktion" die Option "Markierung mit Entgitterungshilfe
versehen". Der folgende Dialog wird angezeigt.
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1 Rahmenabstand
 Ein Rahmen wird mit diesem Abstand um das Objekt (Objekte) plaziert.
2 Linienabstand
 Ein einstellbarer Sicherheitsabstand zwischen Entgitterungslinie und Objekt (wirkt sich beim Plotten aus).

 Horizontal
3 Keine
 Es werden keine Entgitterungslinien gezeichnet.
4 Jede
 Um diesen Abstand wird eine Entgitterungslinie hinzugefügt.
5 Zwischen den Zeilen
 Bei markierten Texten werden automatisch zwischen allen Zeilen eine Entgitterungslinien plaziert.
6 Durch die Zeilen
 Die Entgitterungslinienen werden durch die Textzeilen gesetzt.
7 Durch Zeilen und dazwischen
 Die gleichzeitige Ausführung von Punkt 5 und 6.

 Vertikal
8 Keine
 Es werden keine Gitterlinien gezeichnet.
9 Jede
 Um diesen Abstand wird eine Entgitterungslinie hinzugefügt.

10 OK
 Führt alle vorgenommenen Einstellungen aus und schließt den Dialog.

11 Abbrechen
 Schließt den Dialog ohne Änderungen.

12 Standardwerte
 Setzt alle Einstellungen im Dialog auf die Standardwerte zurück.

Anpassung an die Entgitterungshilfen
Mit Hilfe der Funktion ”Knoten bearbeiten” lassen sich verschiedene direkte Anpassungen an die Entgitterungshilfen
und Entgitterungslinien vornehmen.

Durch Verschieben des äußersten Kontrollpunktes paßt man den Rahmen an.



234 EasySIGN

Durch Verschieben eines der inneren Kontrollpunkte wird die Größe der Entgitterungshilfe geändert.

Bereits plazierte Gitterlinien lassen sich durch ziehen verschieben. Die Entgitterungslinien können außerdem durch
Zurückziehen in die verdickten Ränder entfernt werden.

Blockschachtelung

Die Blockschachtelung kann im Handumdrehen angewendet werden und ordnet die Objekte so effizient wie möglich
an, um Material zu sparen. Die Blockschachtelung ist objektorientiert. Wenn Sie diesen Effekt angewendet haben,
können Sie anschließend sogar zusätzliche Objekte hinzufügen oder den ursprünglichen Objektmodus
wiederherstellen. 

Klicken Sie im Menü "Effekte" auf "Blockschachtelung", um den Effekt auf einen Bereich ausgewählter Objekte
anzuwenden.
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Um die ausgewählten Objekte wird ein Steuerobjekt angezeigt. Wenn Sie die Steuerpunkte ziehen, werden die
Objekte so effizient wie möglich innerhalb der Bemaßungen (Breite und Höhe) des Steuerobjekts neu angeordnet.

Sie können die Steuerpunkte ziehen, bis die gewünschte Anordnung erreicht ist.
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Wenn Sie mit dem Ergebnis nicht zufrieden sind, klicken Sie im Kontextmenü für den Effekt auf "Eigenschaften". Es
wird ein Dialogfeld aufgerufen, in dem Ihnen folgende Optionen zur Verfügung stehen:

1 Wählen Sie die Richtung, die Sie ändern möchten.
2 Wählen Sie die normale oder optimale Anordnung. Bei der optimalen Anordnung erhalten Sie das beste

Ergebnis. Dieser Vorgang ist jedoch zeitaufwendiger. 
3 Hier können Sie die horizontale oder vertikale Größe festlegen.
4 Hier können Sie den Objektabstand festlegen. In den obigen Abbildungen wurde ein Abstand von 2 mm

verwendet. Für die Abbildung unten wurde der Abstand 0 mm ausgewählt.

5 Hier können Sie festlegen, ob der Text auf Zeilen, Wörter oder Zeichen aufgeteilt werden soll. Sie können auch
festlegen, dass der Text nicht aufgeteilt wird. Der Text wird weiterhin als Text angezeigt. Wenn Sie die
Blockschachtelung deaktivieren, werden die Texteigenschaften wiederhergestellt, die vor der Anwendung des
Effekts aktiv waren.

6 Wenn Sie diese Option auswählen, werden die Objekte gedreht, um ein noch besseres Ergebnis zu erzielen.
Diese Option erbringt das beste Ergebnis, wenn Sie zahlreiche Objekte verwenden, die keinen Abstand
voneinander haben.
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True shape nesting

'True shape nesting' is an automated method of minimizing material usage. ‘True shape nesting’ places objects
together with minimal space between them. Using this functionality is cost efficient and environmental friendly. For
example, the objects on the worksheet below are placed by using the 'Multiply' functionality.

 

Compare this placement to the placement automatically generated with 'True shape nesting' as shown below.
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For some objects the media cost reduction can be even far greater, for example:

Manual or other automated placement
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As you can see 'True shape nesting' saves almost 50% of the media cost.

Workflow

Using 'True shape nesting' is simple and straight forward. Before you can start using 'True shape nesting' you need to
know how to apply the object specifications.

Preparing the objects to be nested

'True shape nesting' requires the objects you want to nest to meet a certain specification. An object ready for 'True
shape nesting' needs to be enclosed in a 'Sticker contour' with the option 'Connect' checked.

Why do you need the option connect checked?
For example see the object below with a 'Sticker contour' applied. For clarity the 'Sticker contour' is represented by a
red line.

At first glance there seems to be noting wrong with this situation but if you want to start the 'True shape nesting', with
50 duplicates of the object, you will get the following error message. 
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Som e objects could not be  p laced. No unique  cutline  de fined fo r 50 objects. 

A unique cutline is a continuous line surrounding each of the objects you want to nest. The object used is one object
that consists of 3 words with spaces between them. The so called 'cutline' consists of tree separated cutline's, one for
each word. You could of course enlarge the distance of the 'Sticker contour' to the object until the lines meet, but that
would not be the best option in this case, see the image below. 

The white space surrounding the object is much larger then was intended (or even required by the customer). It is
much easier and more consistent to let the software try to optimize this object by checking the option 'Connect' in the
'Sticker contour' dialog. Checking this option will give you the following result.

If you think this option will take too much extra space/media after the nesting command, you can also make some
adjustments too the object, for example by quickly closing the gaps between the words.

Remove the 'Sticker contour' from the object (if
any).

Draw some simple shapes to close the gaps, pen
style or color is not important.
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With the new objects still selected, select the
menu 'Ed it > Conv e rt to ' > Line  ty pe  > S ign
Bla nk'. 'Sign Blank' is a line type that isn't
printed or cut, so this is a invisible object for any
kind of output.

Select the original object including the new
objects and group them together.

Select the menu 'Effe cts  > Sticke r  contour'
and apply the 'Sticker contour' to the group.

The actual workflow

You can subdivide the workflow in two scenarios, a scenario in which you have one object that needs to be duplicated
multiple times and then nested and a scenario in which you have many different objects that need to be nested. 

One object multiple times

1 Import or open the object you want to use.

2 Adjust the page size to the size of your media using the menu 'Vie w > Se ttings'. 

3 Prepare the object like described in the chapter above 'Preparing the objects to be nested'.

4 Multiply the objects using the menu 'Arra nge  > Multip ly '. Enter the number of duplications, in the
dialog that opens, and be sure to uncheck the option 'Modifiable'.

5 Place the objects outside the worksheet because 'True shape nesting' is based on the dimensions of the
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worksheet and places the 'nested' objects on the worksheet.

6 Select the objects you want to use for 'True shape nesting'.

7 Select the menu 'Effe cts  > T rue  sha pe  ne sting  > T rue  sha pe  ne sting'. Select the options you want
to use in the dialog that opens.

8 In the 'True shape nesting' dialog press 'OK' to start the nesting.

Multiple objects 

1 Import the different objects you want to use into one worksheet.

2 Adjust the page size to the size of your media using the menu 'Vie w > Se ttings'. Select the tab 'Page'
and adjust the page size accordingly in the dialog that opens.

3 Prepare the objects (if necessary)  like described in the chapter above 'Preparing the objects to be
nested' but do not yet apply the 'Sticker contour'.  We postpone this because it would be very tedious to
apply a 'Sticker contour' to, let's say, 100 objects that need no other preparation.

4 place the objects outside the worksheet because 'True shape nesting' is based on dimensions of the
worksheet and places the 'nested' objects on the worksheet.

6 Select the objects you want to use for 'True shape nesting'.

7 Select the menu 'Effe cts  > T rue  sha pe  ne sting  > Pre pa re  T rue  sha pe  ne sting'. Choose your
settings in the dialog that opens.

8 In the 'Prepare True shape nesting' dialog press 'Apply' to apply a 'Sticker contour' to all selected
objects.

9 Select the menu 'Effe cts  > T rue  sha pe  ne sting  > T rue  sha pe  ne sting'. Select the options you want
to use in the dialog that opens.

10 In the 'True shape nesting' dialog press 'OK' to start the nesting.

Optional
Say you only need the 'Sticker contour' to nest your objects and not to cut them after printing (where the distance of
the 'Sticker contour is not an option but a customer requirement). If you want to change the distance you first have to
remove the 'Sticker contour’ and reapply them using the 'Prepare True shape nesting' dialog again. This is a simple
four step process.

1 Select all object on the worksheet that are already nested.

2 Select the menu 'Effe cts  > R e m ov e  e ffe ct' which will remove the 'Sticker contour' of all selected
objects. 

3 With the objects still selected open the menu 'Effe cts  > T rue  sha pe  ne sting  > Pre pa re  T rue  sha pe
ne sting' and apply the 'Sticker contour' with the new settings.

4 Apply the 'True shape nesting' again using the menu 'Effe cts  > T rue  sha pe  ne sting  > T rue  sha pe
ne sting'.
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Tip

If you have multiple objects, with different cutting types and/or distances, that you want to use for Print & Cut, then
you can use them as they are. Just apply a 'Sticker contour' on them using a distance of '0' (or any distance you
desire) and a line type of 'Sign Blank'.

The objects in the image above both have a Print & Cut line applied to an Inline effect (represented by the green line)
and a 'Sticker contour' for 'True shape nesting' with a distance of '0' and 'Sign Blank' as line type (represented by the
red line).

The 'Prepare True shape nesting' dialog

1 Cutter-tool
here you can select the line type you want to use, you have several predefined options to choose from.

2 Data
Here you can set the distance between the object and the 'Sticker contour'. 

When using the first 'Corner shape' options the 'Miter limit' will become available which will determine
how far a corner will 'Overshoot'.

In the image below from left to right the 'Miter limit' is set to 11, 72 and 125.
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3 Line properties
Here you can choose the shape of the corners. In the image below from left to right the first, second
and third option.

The second option is the most widely used because it gives the best result for almost any shape.

The 'True shape nesting' dialog

1 Nesting quality
Here you can set the quality of the 'True shape nesting'. The most commonly used option is 'Normal'
which will give a very good result consuming four times less memory as the 'More detail' option. The
option 'Less detail' is extremely fast and gives a lesser, but still acceptable, result and it also consumes
the least amount of memory.

2 Rotation
Here you can set the rotation allowed when nesting.

3 Options
The most important setting here is 'Incremental'. When this option is checked the 'True shape nesting'
will take objects already placed on the worksheet into account when calculating the nesting result.

The option 'use objects extends for objects without unique cutline' does just as it says. It will use the
objects extends while calculating the nesting result and not the actual shape of the object.

4 Page/cropmarks margin
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'True shape nesting' uses the worksheet as 'work area' or, when present, the inside of the alignment
cropmarks area. Especially with alignment cropmarks, but also with a worksheet, you don't want to nest
your objects all the way to the edge. Here you can enter the space between the outer most nested
shapes and the edge of the work area.

Out of memory

'True shape nesting' is very memory intensive. If you have too many objects selected it can run out of memory. 'True
shape nesting' has an 'Incremental' option, this options works together with the objects already nested on the
worksheet. You can use this option to nest very large numbers of objects as follows.

1 Place all objects you want to nest outside the worksheet.

2 Select a lower number of objects. If for example you tried to nest a 1000 objects all at once and ran
out of memory, select only 100 of them.

3 Start the 'True shape nesting' with your preferred settings, the objects will be placed on the worksheet.

4 Select the next 100 objects and start the 'True shape nesting' with your preferred settings, only now
activate the option 'Incremental'.

5 Repeat step 4 until you have placed all objects.

Bitmap-Verzerrungen (effekte)

In EasySIGN können die meisten Spezialeffekte auch auf Bitmaps angewendet werden. Eine ganz besondere Eigenschaft besteht darin, dass die

Verzerrungen auf Vektorobjekte und Bitmaps gleichzeitig angewendet werden können.

Das folgende Beispiel soll dies veranschaulichen.

Importieren Sie eine Bitmap, und legen Sie darüber einen Text sowie optional einige weitere Vektorobjekte. Sie können diese Objekte außerhalb der

Bitmap-Begrenzungen anordnen.

Markieren Sie die Bitmap und die anderen Objekte, und klicken Sie im Menü "Effekte" auf die Option "Spezialeffekte".
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Wählen Sie den gewünschten Effekt aus, und klicken Sie auf die Schaltfläche "Übernehmen".

Sie können einen beliebigen weiteren Effekt, wie z. B. einen Rundsatz, über den Effekt legen.
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Wie bei den meisten Funktionen in EasySIGN werden die Originalobjekte durch diesen Effekt nicht verändert. Sie können Änderungen am Text,

an der Bitmap und den Vektorobjekten jederzeit  vornehmen und haben sogar die Möglichkeit, neue Objekte mithilfe des Objekt-Managers

hinzuzufügen. Das Endergebnis wird automatisch neu berechnet.

Dabei sollten Sie bedenken: Je größer eine Bitmap ist , desto länger dauert die Berechnung des Endergebnisses.

Einstellungen für Bitmap-Verzerrungen
Klicken Sie im Menü "Datei" auf die Option "Einstellungen" und dann auf die Registerkarte "Verschiedenes". Eine der verfügbaren Einstellungen

lautet: "Auflösung des Bitmap-Effekts während der Bearbeitung". Wenn Sie hier einen hohen Wert eingeben, müssen Sie entsprechend lange auf die

Anzeige des Endergebnisses warten.

Vektorisieren

Vektorisieren
V e k t o r i s i e r e n

Die Funktion Vektorisieren ist in EasySIGN sehr leicht zu bedienen, egal ob Mittellinie, Umriß, S/W oder Farbe. Sie
brauchen zum Vektorisieren ein Bitmap. Diese Bitmap könnnen Sie importieren oder durch Scannen in EasySIGN
laden. Vektorisierungen müssen immer abhängig von der Vorlage eingestellt werden. Eine ausgeführte
Verktorisierung behält ihre Eigenschaften, eine erneute Wahl des Befehls "Vektorisierung" ist also immer wieder
möglich. Andere Einstellungen können dann ausprobiert werden. 
Will man die einzelnen Details der Vektorisierung bearbeiten, ist es notwendig diese in Kurve zu wandeln. Wählen Sie
hierfür den Befehl ”Bearbeiten”, ”Umwandeln und ”Zu Kurve”. Die Kurven sind jetzt leicht zu bearbeiten (Knoten
bearbeiten).
Zur Vektorisierung der ”Mittellinie” oder ”Umriß” benötigt man eine schwarzweiß Bitmap, zur Farbvektorisierung eine
RGB-Farbbitmap.

Umriß
U m r i ß

Importieren oder scannen Sie hierzu bitte eine schwarzweiß Bitmap (1 Bit, Strichzeichnung) wie zum Beispiel die
eines Logos und markieren Sie diese.
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Wählen Sie aus dem Menü "Bitmap" den Befehl "Vektorisierung". Es wird folgender Dialog geöffnet.

Unter "Vektorisierungsart" (1) sollten Sie nun die Option "Umriß" aktivieren. Legen Sie dann unter "Staubfilter" (2)
den Wert fest nachdem EasySIGN "Staub" entfernt. Unter "Staub" versteht man nicht gewünschte Elemente wie
Schmutz auf dem Glas des Scanners, Fingerabdrücke auf dem Original und andere Fehler. Unter "Einstellungen" (3)
stehen verschiedene Voreinstellungen zur Auswahl.

Voreinstellungen
Hier ist die Auswahl zwischen mehreren Voreinstellungen möglich. Diese liefern abhängig der Bitmapart das beste
Ergebnis. In diesem Fall (eine schwarzweiß Bitmap) wählen Sie die Einstellung "S/W Text von hoher Auflösung”. Die
Schiebebalken unter dem Kombinationsfeld passen sich nun an die Voreinstellung an. Soll diese geändert werden,
wählt man aus dem Kombinationsfeld die Option "Benutzer definiert". Danach können Sie die Schiebebalken nach
Belieben ändern.

Zahl der Knoten

 

Mit dieser Einstellung können Sie die Genauigkeit bestimmen, mit der EasySIGN beim Vektorisieren die Vektoren
aufbaut. Je mehr Knoten verwendet werden, desto genauer ist die Form. Diese Regel ist jedoch nicht allgemeingültig.
Für sehr schlechte Originale ist es gegebenenfalls besser, weniger Knoten auszuwählen, da ansonsten auch jede
Abweichung vektorisiert wird. Eine geringere Anzahl Knoten führt in einem solchen Fall zu einem besseren Ergebnis.

Ecken schärfen

 

Da beim Scannen, je nach der verwendeten Auflösung, rechte Winkel meist runder werden oder weil bei gedruckten
Originalen rechte Winkel beinahe niemals präzise sind, bietet EasySIGN die Möglichkeit, dies zu korrigieren.
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Linien

 

Dieser Filter macht aus leicht gebogenen Kurven Linien. Je höher die Einstellung ist, desto mehr Kurven sind hiervon
betroffen.

Horizontaler / vertikaler Filter

 

Linien, die ungefähr horizontal oder vertikal verlaufen, werden durch diesen Filter vollkommen horizontal oder vertikal
gezogen. Die Anzahl der betroffenen Linien erhöht sich mit der Einstellung.

Nachdem Sie die entsprechenden Einstellungen vorgenommen haben, können Sie unter (4) auf die Schaltfläche
"Übernehmen" klicken, um sich das Ergebnis anzeigen zu lassen, oder aber sofort auf "OK", worauf der Dialog nach
dem Vektorisieren sofort geschlossen wird. Das Ergebnis sieht dann ungefähr so aus.

Mittellinie
M i t t e l l i n i e

Eine der angenehmsten Eigenschaften des Vektorisierens mit EasySIGN ist neben der stets möglichen Bearbeitung
auch die gleiche Funktionsweise aller Vektorisierungsarten. Bei der Mittellinienvektorisierung besteht der einzige
Unterschied zur Umrißvektorisierung darin, daß im Dialog unter "Vektorisierungstyp" (1) die Option "Mittellinie”
aktiviert werden muß.

Farbvektorisierung
F a r b v e k t o r i s i e r u n g

Bei dieser Art des Vektorisierens sind einige zusätzliche Einstellungen als bei der Kontur- und
Mittellinienvektorisierung vorhanden. Sie funktioniert aber ansonsten genauso wie die Umrißvektorisierung.
Farbvektorisierung ist nur bei RGB-Bitmaps möglich. Beim Einscannen einer zu vektorisierenden Abbildung müssen
Sie den Scanner deshalb erst auf RGB einstellen.
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1 Die Anzahl der Farben
 Hier kann die Anzahl der von der Vektorisierung betroffenen Farben eingestellt werden (max, 64).
2 Die Farbmischung
 Die Farbmischung macht von ähnlichen Farben eine Einzige. Dies hat den Vorteil, daß vage Übergänge

zwischen den einzelnen Farben verschwinden, denn diese führen bei der Vektorisierung meist zu sehr
unregelmäßigen Linien.

 

Verwenden der Outline-Funktion für Objekte

Bei Version 5 wurde diese Funktion erheblich erweitert . Es wurden neue Optionen hinzugefügt, und fast alle Optionen bieten die Möglichkeit,

mehrere Schritte in einem einzigen Schritt  zu kombinieren. Am besten lassen sich die aktuellen Funktionen anhand von Beispielen erläutern.

Markieren Sie ein Objekt, und klicken Sie dann im Menü "Effekte" auf eine der Optionen für Outline (Umriss). Je nach vorhandener Lizenz/

Version oder dem OEM-Typ stehen Ihnen die folgenden Optionen zur Verfügung:

Outline

Outline (Rechteck)

Outline (Kreis)

Doppelte Outline

Inline

Doppelte Inline

Linien expandieren

Stickerumriss

Gummiband
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1 Typ

Zusätzliche Daten

2 Abstand

3 Außenabstand

4 Gehrungslimit

5 Anzahl

Zusätzliche Optionen

6 Verschmelzungsergebnis(se)

7 Originale verbergen

8 Vorverschmelzung

9 Inline

Linieneigenschaften

10 Eckenform

11 Linienende

Linieneigenschaften

Bei allen Outlinetypen gibt es allgemeine Eigenschaften, die sich auf die Eckenform oder das Linienende beziehen.

Die jeweils zutreffenden Eigenschaften hängen vom Outlinetyp ab.

Eckenform (10)

Gestreckte Winkel

Mit dieser Option wird ein Gehrungswinkel gezeichnet, bei dem die äußersten Kanten zweier sich treffender Linien so

weit verlängert werden, bis sie sich schneiden. Um das Zeichnen derartiger Schnittpunkte in Fällen zu verhindern, in

denen diese Punkte von den Linienenden zu weit entfernt sind, können Sie das Gehrungslimit anpassen.
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A: Original

B: Gehrungslimit: 10

C: Gehrungslimit: 1

Abgerundete Linienenden

Mit dieser Option wird ein Kreis um das Linienende gezeichnet, dessen Durchmesser gleich der Linienbreite ist .

A: Original

B: Beispiel

Gehrungswinkel

Mit dieser Option wird der Schnittpunkt zweier sich treffender Linien durch Entfernen eines Teiles der Verlängerung

reduziert.

Dies ähnelt stark einem gestreckten Winkel mit einem Gehrungslimit von "0".

A: Original

B: Beispiel

Linienende (11)

Gehrung

Mit dieser Option wird die Linie an den Enden abgeflacht, sodass es keine Verlängerung über diese

Enden hinaus gibt.

A: Original

B: Beispiel

Rund

Mit dieser Option wird ein Halbkreis am Linienende gezeichnet, dessen Durchmesser gleich der

Linienbreite ist .

A: Original

B: Beispiel
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Gerade

Mit dieser Option wird die Linie über das Ende hinaus über eine Entfernung gezeichnet, die gleich der

halben Linienbreite ist , und dann das Ergebnis reduziert.

A: Original

B: Beispiel

Spitz

Bei dieser Option wird eine schmale Spitze an ein Linienende gezeichnet, deren Abstand zum

Linienende gleich der halben Linienbreite ist .

A: Original

B: Beispiel

 

Typ (1)

Hier können Sie den gewünschten Typ auswählen. Diese Wahl kann während der Effekterstellung erfolgen. Sie können Ihre Wahl aber auch zu

einem späteren Zeitpunkt ändern, wenn Sie die Eigenschaften eines Objekts mit einer bestimmten Outlineart ändern. Somit können Sie den

Outlinetyp jederzeit  ändern. Falls die Outline durch mehrere andere Effekte überlagert wird, werden diese Effekte automatisch neu berechnet.

A Ein Text mit einer Outline, die nacheinander durch die Effekte "Rundsatz", "Flache Perspektive" und "Perspektivischer

Schatten" überlagert wird.

B Der Typ wurde von "Outline" in "Doppelte Outline" geändert. Alle anschließend auf diesen Typ angewendeten Effekte

wurden an den neuen Outlinetyp angepasst.

 

"Typ", "Zusätzliche Daten" und "Zusätzliche Optionen"

Nachstehend werden anhand verschiedener Beispiele einige der Möglichkeiten aufgezeigt. Während Ihrer Arbeit mit Outlines können Sie viele

Kombinationen selbst erstellen. Dabei ist  es möglich, eine unbegrenzte Anzahl an Typen übereinander zu platzieren.
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Im vorstehenden Bild werden von links nach rechts verschiedene übereinander gestapelte Outlinetypen wiedergegeben. Wenn Sie den Text ändern,

werden sämtliche gestapelten Outlines neu berechnet (siehe das folgende Bild).

Klicken Sie im Menü "Effekte" auf einen der Outlinetypen, z. B. "Outline".

A: Original

B: "Originale verbergen" (7) ist  deaktiviert.

C: "Originale verbergen" (7) ist  aktiviert .
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Outline

"Abstand" (2) ist gleich "1", und "Anzahl" (5) ist gleich "1".

Identisch mit der ersten Option, jetzt aber mit abgerundeten Ecken.

Identisch mit der zweiten Option, doch jetzt hat die Option "Anzahl" (5) den Wert "3".

O utline
(Rechteck)
Outline (Kreis)

Zwei Varianten, bei denen die Outline nicht auf der äußeren Form der markierten Objekte, sondern auf den

äußersten Grenzen der Markierung basiert. Sie können zwischen "Rechteck" und "Kreis" wählen.
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Doppelte
Outline

"Abstand" (2) ist gleich "3", "Außenabstand" (3) ist gleich "5", und "Anzahl" (5) ist gleich "1".

Identisch mit der ersten Option, jetzt aber mit abgerundeten Ecken.

Identisch mit der zweiten Option, doch jetzt hat die Option "Anzahl" (5) den Wert "3".

Inline

"Abstand" (2) ist gleich "3", und "Anzahl" (5) ist gleich "1".

Identisch mit der ersten Option, doch jetzt hat die Option "Anzahl" (5) den Wert "3".
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Doppelte
Inline

"Abstand" (2) ist gleich "3", "Außenabstand" (3) ist gleich "5", und "Anzahl" (5) ist gleich "1".

Identisch mit der ersten Option, doch jetzt hat die Option "Anzahl" (5) den Wert "3".

Expandieren

"Abstand" (2) ist gleich "2", und "Gehrungslimit" (4) ist gleich "1".

Identisch mit der ersten Option, jetzt aber mit abgerundeten Ecken.

Stickerumriss Wie der Name besagt, können Sie mit dieser Option Schnittkonturen für Sticker erstellen, wobei die

Einsatzmöglichkeiten nicht auf diese Anwendungsart beschränkt sind.

Sie können den Abstand zu den Originalen entweder auf einen positiven oder einen negativen Wert (9) festlegen.

Es ist  sogar möglich, das Ergebnis für "Abstand" (2) auf "0" festzulegen, damit sich die Stickerkontur der äußeren
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Form exakt anpasst.

Gummiband Bei "Gummiband" handelt es sich um eine einzigartige Funktion. Sie können sich das Ergebnis als eine

Zusammenstellung von einem oder mehreren Objekten vorstellen, um die ein Gummiband gespannt wurde. Dies ist

beispielsweise eine geeignete Alternative zu "Stickerkontur", wenn Sie eine Schnittkontur ohne Einschübe

erstellen möchten. Folglich gibt es wesentlich weniger Schnittlinien.

Sie können die Entfernung zu den Originalen entweder auf einen positiven oder einen negativen Wert (9)

festlegen. Es ist  sogar möglich, das Ergebnis für "Abstand" (2) auf "0" festzulegen, damit sich das Gummiband der

äußeren Form exakt anpasst.

Diese Funktion ist  auch bestens geeignet, um Objekte miteinander zu verbinden.

Wenn Sie versuchen wollten, das vorstehende Beispiel von Hand zu zeichnen, wäre einiger Arbeitsaufwand

erforderlich, um die beiden Kreise perfekt zu verbinden. Mit dem Effekt "Gummiband" und einem Abstand (2) von

"0" lässt sich dieser Vorgang dagegen mit einem einzigen Mausklick erledigen.

Mittellinie

Ein objektorientierter Effekt, um die Mittellinie eines Vektorobjekts zu erhalten.

Wählen Sie ein Objekt, und klicken Sie anschließend im Menü "Effekte" auf "Mittellinie".
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In dem aufgerufenen Dialogfeld stehen Ihnen zwei Typen für Mittellinien zur Auswahl. Außerdem können Sie
festlegen, ob das Original ausgeblendet werden soll. Es wurde die erste Option ausgewählt und das Original
eingeblendet.

Da das Ergebnis objektorientiert ist, können Sie die Eigenschaften ändern. Klicken Sie hierzu im Kontextmenü auf
"Eigenschaften". Wählen Sie im Dialogfeld für die Eigenschaften die zweite Option.

Der Effekt wurde neu berechnet. Der Effekt wird auch dann neu berechnet, wenn Sie das Original ändern.
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Wenn Sie mit dem Ergebnis zufrieden sind, können Sie im Dialogfeld für die Eigenschaften die Option "Original
ausblenden" auswählen. Sie können anschließend das Objekt beispielsweise für eine Gravur verwenden. Wenn Sie
das Ergebnis ändern, müssen Sie das Objekt über die Tastenkombination STRG+Q in Kurven umwandeln. Sie können
zwar anschließend das Objekt bearbeiten, es ist dann jedoch nicht mehr mit dem Originalobjekt verknüpft.

Für Anwendung optimieren (Über-/Unterfüllung)

Besonders, wenn Vinyl bei einer Hintergrundbeleuchtung angewendet werden muss, können zwei Stücke (ohne
Überlappung und direkt gegeneinander) nicht kalt zusammengeführt werden. Auch wenn dies möglich wäre, hätte dies
eine Dehnung und Schrumpfung zur Folge, durch die nach einiger Zeit keine Übereinstimmung mehr besteht. Aus
diesem Grund muss hierbei eine Überlappung angewendet werden. Die Überlappung muss minimal sein und genau
passen, weil andernfalls dunkle Ränder an der Überlappung entstehen. Für diese Situationen hat EasySIGN eine
spezielle Funktion, den Befehl "Für Anwendung optimieren". Diese Funktion kann im Handumdrehen angewendet
werden und ermöglicht es Ihnen, an den Überlappungen einen Einschnitt vorzunehmen. Dieser Einschnitt ist von
Vorteil, wenn Sie zwei gleich große Objekte zusammenführen müssen. Wenn die Überlappung keinen Einschnitt hat,
besteht die Gefahr, dass das darunter liegende Objekt unter dem oberen Objekt herausragt.

Wählen Sie die Objekte, die Sie optimieren möchten. Um das Ergebnis deutlicher anzuzeigen, werden die Bilder auch
als Umriss angezeigt.

Klicken Sie anschließend im Menü "Bearbeiten" auf "Für Anwendung optimieren", um folgendes Dialogfeld aufzurufen:
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Sie können in diesem Dialogfeld unter "Optionen" (1) den Abstand für die Überlappungen angeben und das
Kontrollkästchen "Abgeschrägte Überlappungen" aktivieren oder deaktivieren. Unter "Anwendungsreihenfolge" (2)
können Sie den Radius der Kreisform eingeben. Wenn Sie die obigen Einstellungen anwenden, sieht das Ergebnis
folgendermaßen aus.

Da das Ergebnis objektorientiert ist, können Sie die Eigenschaften ändern. Um diesen Vorgang auszuführen, wählen
Sie im Kontextmenü des Objektes den Befehl "Eigenschaften". Ändern Sie die Anwendungsreihenfolge der Farben,
und klicken Sie auf "Übernehmen". Unten wird ein Beispiel für das Ergebnis angezeigt.

Sie können mit der Ziehfunktion die Breite der Überlappung auf dem Arbeitsblatt ändern.



262 EasySIGN

Für Inlay optimieren

Sie können über diese Funktion ein objektorientiertes Inlay erstellen. Wählen Sie eine Vektorform, und klicken Sie
anschließend im Menü "Bearbeiten" auf "Für Inlay optimieren".

1 Hier können Sie ein vorhandenes Werkzeug aus der Bibliothek mit einem numerischen Wert für den
Durchmesser auswählen.

2 Außenfräsen
3 Innenfräsen
4 Spiegelergebnis

Sie können mit der Ziehfunktion das Objekt direkt auf dem Fenster positionieren. Das Ergebnis gibt an, ob das
ausgewählte Werkzeug oder der Durchmesser für das Objekt geeignet ist.

1 Original
2 Korrektes Inlay
3 Ungeeignetes Werkzeug, der Durchmesser ist zu groß.

Numerische Eingabe von Linien

Aufgrund zahlreicher Anfragen wurde bei EasySIGN eine Möglichkeit zur numerischen Eingabe von Linien eingeführt.
Wer häufiger mit CAD-Programmen arbeitet, wird diese Möglichkeit zum Zeichnen von Linien besonders praktisch
finden. 

Wählen Sie im Menü "Einfügen" zunächst "Figuren" und dann "Linie". Damit wird der folgende Dialog geöffnet:
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1 Endpunkt
 Geben Sie hier die X- und Y-Koordinaten der Linie ein. 
2 Typ
 Geben Sie hier an, ob die eingegebenen Koordinaten einen "Anfangspunkt" oder eine "Linie" darstellen sollen.

Eine Linie besteht aus mindestens einem Anfangs- und Endpunkt (Linie). Wenn Sie nur Koordinaten mit der
Eigenschaft "Linie" eingegeben haben und dann auf "OK" klicken, erscheint in dem Dialog eine Fehlermeldung.
Sie haben dann die Gelegenheit, den Fehler zu korrigieren.

3 Hinzufügen
 Klicken Sie nach dem Eingeben einer Koordinate auf diese Schaltfläche, um sie der Liste "Objekt"

hinzuzufügen.
4 Bearbeiten
 Wenn Sie einen Eintrag in der Liste "Objekt" auswählen, wird dieser Eintrag im Bearbeitungsfeld der X- und Y-

Koordinaten angezeigt, und Sie können die Werte ändern. 
5 Objekt
 Sie können einen Eintrag in der Liste auswählen, um ihn zu bearbeiten oder zu löschen.
6 Löschen
 Durch Klicken auf diese Schaltfläche wird der ausgewählte Eintrag aus der Liste "Objekt" gelöscht.

Verknüpfen von Arbeitsblättern

Dem Importdialog in EasySIGN wurde die Option "Verknüpfung importieren" hinzugefügt. Diese Option wird
verfügbar, wenn Sie in diesem Dialog ein EasySIGN-Arbeitsblatt auswählen. Wenn Sie diese Option aktivieren, wird
das ausgewählte Arbeitsblatt als Verknüpfung importiert. Die importierte Verknüpfung wird dann im Arbeitsblatt als
Vorschau angezeigt. Dass es sich um eine Verknüpfung handelt, ist am Verknüpfungssymbol unten in der Vorschau zu
erkennen.

Wozu verknüpfen?

Diese Option ist sehr nützlich, wenn Sie ein Design, das sich regelmäßig ändert, in mehreren Arbeitsblättern
verwenden möchten. Anstatt das Design jedes Mal erneut zu importieren, zu skalieren, zu positionieren usw., können
Sie es als Verknüpfung importieren. Wenn das Original geändert wurde, werden beim Laden des Arbeitsblattes mit
der Verknüpfung die Änderungen im Original erkannt und der Verknüpfungsdialog automatisch geöffnet. 
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Dieser Dialog bietet die Option, die Verknüpfung durch Klicken auf die Schaltfläche "Aktualisieren" (4) zu
aktualisieren. 

Der Platzhalter befindet sich unten links neben der Verknüpfung. Wenn sich die Größe der Originaldatei geändert hat,
wird die Größe entsprechend neu berechnet.

Das Original des Arbeitsblattes kann durch Doppelklicken auf die Verknüpfung geöffnet werden. (Wenn Sie auf eine
verknüpfte Bitmap doppelklicken, wird der festgelegte externe Windows™-Editor geöffnet.)

Sie können ein verknüpftes Arbeitsblatt auch in das aktuelle Arbeitsblatt einbetten (d. h. die Verknüpfung aufheben
und eine Kopie des Originals einfügen). Verwenden Sie hierzu die Option "Verknüpfungs-Info" im Kontextmenü des
Objektes. Der Verknüpfungsdialog wird geöffnet, und Sie können die Schaltfläche "Trennen" (5) auswählen. In diesem
Dialog haben Sie mit der Schaltfläche "Neu verknüpfen" auch die Möglichkeit, das Original erneut verknüpfen (z. B.
wenn die Originaldatei an eine andere Stelle Ihrer Festplatte verschoben wurde). Die Schaltfläche "Exportieren" ist
nur für Bitmap-Bilder verfügbar.

Verknüpfungen innerhalb von Verknüpfungen

Wenn in verknüpften Arbeitsblättern verknüpfte Bitmaps (oder weitere verknüpfte Arbeitsblätter) enthalten sind,
dürfen Sie nicht vergessen, diese Verknüpfungen zu aktualisieren. Das Programm erkennt zwar, ob die Verknüpfung
zu einem Original-Arbeitsblatt aktualisiert wurde, es erkennt jedoch nicht, ob die Verknüpfungen innerhalb des
verknüpften Arbeitsblattes aktualisiert wurden. Überprüfen Sie daher immer, ob das Original-Arbeitsblatt aktualisiert
wurde.

Verknüpfungsoutput

Wenn Sie den Dialog "Plotten" öffnen, stehen Ihnen mehrere Optionen zur Verfügung. Die Option "Einschließlich
Farben verknüpfter Dokumente" (3) gilt für verknüpfte Arbeitsblätter.
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1 Nur Markierung
 Wenn Sie Objekte im Arbeitsblatt ausgewählt haben, wird diese Option beim Öffnen des Dialoges "Plotten"

aktiviert. Wenn diese Option aktiviert ist, wird die Liste "Nach Farbe" auf die Farben beschränkt, die im
markierten Bereich des Arbeitsblattes vorhandenen sind.

2 Nach Farbe
 Nur die in dieser Liste ausgewählte Farbe wird geplottet.
3 Einschließlich Farben verknüpfter Dokumente
 Diese Option ist nur verfügbar, wenn die Option "Nach Farbe" aktiviert ist. Die Liste enthält dann auch alle in

den verknüpften Arbeitsblättern enthaltenen Farben.

Überprüfen von Verknüpfungen

Beim Öffnen eines Arbeitsblattes werden alle enthaltenen Verknüpfungen daraufhin überprüft, ob sie aktualisiert
wurden. Wurden sie nicht aktualisiert, erscheint ein Dialog, in dem Sie dies nachholen können. Wenn Sie die
Verknüpfungen jetzt nicht aktualisieren, werden sie (wenn möglich) während des Druckens oder Plottens aktualisiert.
Um unangenehme Überraschungen zu vermeiden (Größe und Platzierung können in einer geänderten Verknüpfung
völlig anders ausfallen und zu Problemen führen), sollten Sie daher sicherstellen, dass alle Verknüpfungen in Ordnung
sind, bevor Sie den Druck- oder Plotterauftrag starten. Fehlt eine Verknüpfung, erhalten Sie vor dem Drucken oder
Plotten eine Warnung. Wenn Sie diese Warnung ignorieren, wird nur der niedrig auflösende Platzhalter der
Verknüpfung gedruckt, und die fehlenden Daten werden während des Plottens ignoriert.

Auto-Nummerierung

EasySIGN unterstützt die Verwendung eines Auto-Nummerierungsobjektes. Die Verwendung dieses Objektes ist ganz
einfach. Klicken Sie im Menü "Einfügen" auf "Figuren" und anschließend auf "Auto-Nummerierung". Daraufhin
erscheint ein Dialog, und ein Auto-Nummerierungsobjekt wird auf dem Arbeitsblatt platziert.
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Folgende Einstellungen sind in diesem Dialog verfügbar.

1 Nummer
- Mit "Titel" können Sie einen festen Text definieren, der der eigentlichen Auto-Nummer vorangestellt wird.
- Mit "Nummer" können Sie die Nummer festlegen, mit der die Auto-Nummerierung beginnt.
- Mit "Mindestlänge" können Sie die Anzahl der zu ergänzenden Nullen festlegen, mit denen die Auto-Nummer auf

eine einheitliche Länge gebracht wird. Wenn Sie nur eine Null festlegen, verwendet die Auto-Nummerierung die
tatsächliche Auto-Nummer ohne Nullen.

- Mit "Zusatz" können Sie einen festen Text definieren, der an die eigentliche Auto-Nummer angehängt wird.
2 Mit "Anordnung" können Sie festlegen, ob die einzelnen Bestandteile des Auto-Nummerierungsobjektes

nacheinander oder untereinander angeordnet werden.
3 Hier wird eine Vorschau der in diesem Dialog gewählten Einstellungen angezeigt.

Sie können jederzeit zu diesem Dialog zurückkehren und die vorgenommenen Einstellungen ändern. Verwenden Sie
dazu im Kontextmenü des Auto-Nummerierungsobjektes (rechte Maustaste) den Befehl "Eigenschaften". Um die
Einstellungen für das Auto-Nummerierungsobjekt zu übernehmen, klicken Sie auf "OK".

Das Resultat ist ein einfaches Auto-Nummerierungsobjekt. Wenn Sie ein Duplikat erstellen, beim Verschieben des
Objektes ein Original hinterlassen, den Befehl "Vervielfältigen" verwenden oder einen anderen Vorgang ausführen,
bei dem ein Duplikat des Objektes erstellt wird, können Sie den Wert des Auto-Nummerierungsobjektes ansteigen
lassen. Es spielt keine Rolle, ob das Objekt Teil einer Gruppe oder eines Designs, z. B. ein Aufkleber zur Beschriftung
eines Behälters, ist – die Nummer steigt automatisch an. Auch Objekte mit einem bereits erhöhten Wert der Auto-
Nummer können dupliziert werden. Die Nummerierung beginnt wieder bei dem betroffenen Auto-
Nummerierungsobjekt.
Sie können einen Auto-Nummerierungsbereich sehr schnell erstellen, indem Sie das Objekt verschieben und einmal
mit der rechten Maustaste klicken. (Dadurch bleibt beim Verschieben ein Original am Ausgangsort zurück.) Wenn Sie
anschließend mehrmals die Tastenkombination "STRG+R" (Wiederholen) verwenden, können Sie innerhalb weniger
Sekunden ein vollständiges Arbeitsblatt mit vielen Auto-Nummerierungsobjekten erstellen.

Die Texteigenschaften in einem Auto-Nummerierungsobjekt können bis auf wenige Einschränkungen ebenfalls
bearbeitet werden.
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1 Im "Titel" können Sie die Texteigenschaft und Farbe unabhängig von den einzelnen Zeichen bearbeiten. 
2 In der eigentlichen Auto-Nummer können Sie die Texteigenschaft und Farbe unabhängig von den einzelnen

Zeichen bearbeiten. Bei den ansteigenden Nummern beruht die Eigenschaft für die Auto-Nummer allerdings
weiterhin auf dem ersten Zeichen der Auto-Nummer. 

 

 
 
3 Im "Zusatz" können Sie die Texteigenschaft und Farbe unabhängig von den einzelnen Zeichen bearbeiten.

Es ist nicht möglich, ein Zeichen der oben genannten Komponenten direkt hinzufügen oder löschen. Dies ist nur im
Dialog "Auto-Nummerierungseigenschaften" möglich. Wenn das Auto-Nummerierungsobjekt über den Dialog
bearbeitet wird, erhalten alle Zeichen die gleichen Einstellungen wie das erste Zeichen.

 

 
 

Wenn Sie das Auto-Nummerierungsobjekt nicht mehr als Objekt verwenden möchten, können Sie es über das
Kontextmenü in ein Textobjekt umwandeln.

Speichern einer Auswahl aus einem Arbeitsblatt

Wenn Sie ein Arbeitsblatt erstellt haben und einen Teil daraus in einem neuen Arbeitsblatt speichern möchten, können
Sie jetzt eine Auswahl aus diesem Arbeitsblatt in einer neuen Datei speichern. Hierzu klicken Sie im Menü "Datei" auf
"Exportieren". Wählen Sie im Dialog das Format "EasySIGN", und aktivieren Sie die Option "Nur Markierung".

Objekt-Manager

Objekt-Manager
O b j e k t - M a n a g e r

Was ist ein Objekt-Manager?
Mit dem Objekt-Manager können Sie fast jedes Objekt wieder in seinen ursprünglichen Zustand zurückversetzen. Jede
Aktion, z. B. das Anwenden eines Effekts, das Verschmelzen von Objekten usw., wirkt sich dank des Objekt-Managers
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nicht auf das ursprüngliche Objekt aus. Jedes einzelne Objekt wird intern gespeichert. Um beispielsweise einen Text
zu bearbeiten, auf den mehrere Effekte angewandt wurden, müsste man normalerweise erst alle Effekte rückgängig
machen, dann den Text bearbeiten und anschließend alle Effekte neu anwenden. Mit Hilfe des Objekt-Managers
können Sie den Teil des Entwurfs, den Sie bearbeiten möchten, direkt auswählen; die übrigen Effekte werden dann
automatisch neu angewandt.

Wichtig
Wenn der Objekt-Manager aktiv ist, werden anstelle von Endergebnissen neue Objekte erstellt. Jedes Objekt
innerhalb dieses neuen Objekts verfügt noch über die ursprünglichen Eigenschaften, die es innehatte, bevor es Teil
dieses neuen Objekts wurde. Wenn Ihnen die Verwendung des Objekt-Managers am Anfang noch zu kompliziert
erscheint, und Sie sofort mit der Arbeit beginnen möchten, ohne sich mit allen Möglichkeiten des Objekt-Managers
eingehend zu befassen, können Sie einige Funktionen auch über das Menü Datei > Einstellungen > Objekt-
Manager deaktivieren. Jedes erstellte Objekt wird dann als endgültiges Objekt behandelt, wie Sie es auch schon aus
früheren Versionen kennen. Sie können diese Einstellungen dann ganz nach Belieben wieder aktivieren, ausprobieren
und – wenn Sie damit vertraut geworden sind – damit arbeiten.

Außerdem können Objekte, die mit aktiviertem Objekt-Manager erstellt wurden, über den Befehl Bearbeiten >
Umwandeln > Zu Kurven (STRG+Q) in endgültige Objekte umgewandelt werden (die einzelnen Elemente des
Objekts können nicht mehr angefasst werden).

Wie funktioniert der Objekt-Manager?
Die Vorteile und die Funktionsweise des Objekt-Managers können am besten anhand eines Beispiels erläutert werden.

Falls der Objekt-Manager noch nicht angezeigt wird, wählen Sie die Option Ansicht > Objekt-Manager. Dieses
Fenster (der Objekt-Manager) listet alle Objekte in einem Arbeitsblatt auf:

Jedes Objekt hat ein eigenes Symbol sowie eine Beschreibung:

Bei Text werden immer dieses Symbol in der Textfarbe sowie eine Beschriftung angezeigt, die aus den ersten
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Buchstaben des Textes besteht. Bei jedem anderen Objekt (z. B. bei einem Effekt) wird als Beschriftung nur der
Name des Effekts angezeigt.

Bei dem folgenden Beispiel beginnen wir mit einem leeren Arbeitsblatt.

1 Geben Sie einen Text ein, der einen Fehler enthält (z. B. “ERRAR” anstelle von “ERROR”). Die Schrift sollte
etwa 19 mm hoch und fett sein:

2 Wählen Sie Effekte > Expandieren, und aktivieren Sie im Dialogfeld die Optionen Objekte verschmelzen
und Original entfernen. Geben Sie in das Feld Abstand einen Wert von etwa 0,6 mm ein:

3 Wenden Sie einen Effekt an. In diesem Fall wurde der Effekt Rundsatz verwendet:

4 Wenden Sie einen weiteren Effekt an. In diesem Fall wurde der Effekt Schlagschatten verwendet:

Der Ausgangstext enthält aber immer noch einen Fehler, den Sie jetzt korrigieren müssen. Anstatt alle Effekte zu
entfernen, den Text zu korrigieren und zu versuchen, die Effekte wieder wie zuvor herzustellen, verwenden Sie nun
eine andere Methode. Wählen Sie das Symbol für diesen Text im Objekt-Manager aus:
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Der Text wird gleichzeitig auch auf dem Arbeitsblatt markiert:

Wählen Sie jetzt das Textsymbol, um diesen Text zu korrigieren:
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Klicken Sie, nachdem Sie mit der Korrektur fertig sind, auf das Auswahlwerkzeug in der Werkzeugpalette; alle Effekte
werden jetzt neu berechnet und an den geänderten Text angepasst. Um den Text inklusive aller angewandten Effekte
zu ändern, müssen Sie ihn nur im Objekt-Manager auswählen und bearbeiten:

Natürlich haben Sie mit dem Objekt-Manager noch mehr Möglichkeiten, als Rechtschreibfehler zu korrigieren. Wenn
Sie beispielsweise einen transparenten Text mit einer Füllung versehen möchten, können Sie folgendermaßen
vorgehen:

1 Wählen Sie im Objekt-Manager das Symbol für Umrisse aus:

2 Der Umriss wird auf dem Arbeitsblatt markiert:
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3 Klicken Sie dann in der Hilfsmittelpalette des Objekt-Managers auf das Symbol für Eigenschaften:

4 Deaktivieren Sie im Dialogfeld mit den Eigenschaften des Umrisses die Option Original entfernen:

5 Sowohl der Text als auch der Umriss sind nun gefüllt; wenn Sie den Text im Objekt-Manager erneut auswählen,
können Sie nur die Füllung des Textes ändern:
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Objekt-Manager und Verschmelzen
O b j e k t - M a n a g e r  u n d  V e r s c h m e l z e n

Jedes Objekt in EasySIGN profitiert vom Objekt-Manager. Eine Funktion wie Verschmelzen/Stanzen zeigt die
Vorteile deutlich. Zur Veranschaulichung ist das nächste Beispiel im Modus Umriss dargestellt.

1 Zeichnen Sie ein Rechteck und einen Kreis, und platzieren Sie sie übereinander:

2 Wählen Sie den Befehl Bearbeiten > Verschmelzen/Stanzen > Verschmelzen:

3 Wenn Sie eines der Objekte im Objekt-Manager auswählen, können Sie es auf dem Arbeitsblatt frei
verschieben:
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Sobald Sie das Objekt ablegen, wird der Effekt neu berechnet. Ohne den Effekt vorher zu entfernen, können Sie alle
Komponenten eines Entwurfs neu anordnen.

Sie können auch die Eigenschaften einer Verschmelzung ändern. Öffnen Sie das Dialogfeld mit den Eigenschaften,
und wählen Sie beispielsweise einen anderen Verschmelzungs- bzw. Stanztyp: 

Sie können nicht nur die Effekte ändern, sondern auch einem bereits vorhandenen Effekt neue Objekte hinzufügen.
Hier ein Beispiel:

1 Ändern Sie den Effekt wieder in Verschmelzen, und zeichnen Sie über dem vorhandenen Effekt einen Kreis:
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2 Wählen Sie den Kreis im Objekt-Manager aus, und ziehen Sie ihn auf die Verschmelzung:

Der Kreis ist nun ein Teil der Verschmelzung:

Auf den resultierenden Effekt können Sie nun einen beliebigen anderen Effekt anwenden, beispielsweise einen
Schatten:

Wenn Sie am Verschmelzungseffekt eine Änderung vornehmen, werden alle anderen Effekte automatisch angepasst:
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Objekt-Manager und Umrisse
O b j e k t - M a n a g e r  u n d  U m r i s s e

Jedes Objekt in EasySIGN profitiert vom Objekt-Manager. Eine Funktion wie Outline zeigt die Vorteile deutlich. Wie
oft haben Sie schon einen Umriss angewandt, der später noch einmal geändert werden musste, so dass Sie wieder
von vorne anfangen mussten? Wenn Sie mit dem Objekt-Manager arbeiten, müssen Sie nur die Eigenschaften
ändern; es ist nicht nötig, wieder von vorne anzufangen:

1 Zeichnen Sie ein beliebiges Objekt:

2 Wenden Sie den Effekt Expandieren an:

3 Wenn Sie die Ecken jetzt rund anstatt eckig dargestellt haben möchten, müssen Sie nur über die rechte
Maustaste das Dialogfeld mit den Eigenschaften öffnen und diese Einstellung anpassen:

4 Falls Sie mit der Breite des Umrisses nicht zufrieden sind, können Sie entweder wieder das Dialogfeld mit den
Eigenschaften öffnen oder die Breite direkt auf dem Bildschirm mit der Ziehfunktion ändern:
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5 Die Eigenschaft des Objekts kann jederzeit geändert werden. In dem folgenden Beispiel wird die Eigenschaft in
Doppelte Outline geändert:

Tipps zum Objekt-Manager
T i p p s  z u m  O b j e k t - M a n a g e r

Nicht für jedes vom Objekt-Manager verarbeitete Objekt ist die Option Bereit zum Schneiden verfügbar; dies stellt
jedoch kein großes Problem dar. Erstellen Sie einfach eine Arbeitskopie des Originals, und wählen Sie den Befehl 
Bearbeiten > Umwandeln > Zu Kurven (STRG+Q). Dadurch wird das Objekt in ein “Endergebnis” konvertiert. Für
dieses Objekt können Sie dann die Ausgabefunktion von EasySIGN verwenden. An dem Original können Sie weiterhin
Entwurfsänderungen vornehmen.

Da jedes Objekt auf dem Arbeitsblatt im Objekt-Manager dargestellt wird, ist es manchmal schwierig, die richtige
Unterkomponente (ein Objekt, das Teil eines Effekts oder einer Gruppe ist) auszuwählen. Am einfachsten geht dies,
wenn Sie das “Hauptobjekt” auf dem Bildschirm auswählen, wodurch es automatisch auch im Objekt-Manager
markiert wird; direkt darunter finden Sie dann die gewünschte Unterkomponente.

Manchmal führt die Änderung einer Eigenschaft nicht zum gewünschten Ergebnis, da innerhalb einer vorhandenen
Hierarchie von Objekten und Effekten nicht alle Aktionen möglich sind. Sie können im Objekt-Manager Objekte
auswählen, sie aus der Hierarchie herausziehen, Eigenschaften ändern oder hinzufügen und sie wieder in die
Hierarchie einfügen. Da das Ziehen von Objekten im Objekt-Manager keinen Einfluss auf die Platzierung im
Arbeitsblatt hat, bleibt das Objekt bezüglich der Hierarchie immer an der gleichen Position.

Wenn Sie ein Objekt im Objekt-Manager nicht auswählen können, sollten Sie prüfen, ob die Ebene, auf der sich das
Objekt befindet, vielleicht gesperrt ist.

Objekte im Objekt-Manager: Öffnen und Schließen
O b j e k t e  i m  O b j e k t - M a n a g e r :  Ö f f n e n  u n d  S c h l i e ß e n

Im Objekt-Manager (und im Menü Anordnen) gibt es zwei wichtige Befehle:

Objekt öffnen

Objekt schließen

Wenn Sie ein Objekt im Objekt-Manager bearbeiten, das Teil einer komplexen Hierarchie ist, könnte die Verarbeitung
sehr lange dauern, falls viele Änderungen nötig sind. In diesem Fall wäre es besser, das Objekt über die Schaltfläche
oder den Menübefehl Objekt öffnen zu öffnen, wodurch andere Elemente der Hierarchie vorübergehend ignoriert



278 EasySIGN

werden. Sogar komplexe Bearbeitungsschritte können dann schnell angewandt werden. 

Bei dem folgenden Beispiel handelt es sich um einen Text mit Schatten, nicht unbedingt um eine komplexe Hierarchie,
aber es veranschaulicht das Arbeiten mit geöffneten Objekten:

Wenn Sie das Kerning des Textes verändern möchten, würde der Schatten beim Loslassen der Maustaste jedes Mal
neu berechnet werden. Hier sehen Sie ein Beispiel, wie Sie das Objekt besser öffnen können. Wählen Sie das Symbol
für diesen Text im Objekt-Manager aus:

Wählen Sie nun den Befehl Anordnen > Objekt öffnen, oder klicken Sie auf die Schaltfläche im Objekt-Manager. Es
wird jetzt nur der ausgewählte Text angezeigt; alle anderen Elemente der Hierarchie sind unsichtbar und werden
vorübergehend ignoriert:

Sie können nun alle gewünschten Änderungen vornehmen, ohne dass die Hierarchie neu berechnet werden muss:

Die Berechnung der Hierarchie wird vorgenommen, nachdem Sie den Befehl Objekt schließen gewählt haben, und
nicht jedes Mal wenn Sie die Maustaste nach dem Verschieben eines Zeichens loslassen:
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STRG+KLICKEN oder Teilauswahl

EasySIGN unterstützt die Teilauswahl in Gruppen und Effekten. “Teilauswahl” bedeutet, dass Sie einen Teil einer
Gruppe oder eines Effekts auswählen können, ohne dabei den Effekt von demjenigen Objekt entfernen zu müssen,
das Sie auswählen und bearbeiten möchten. 

Angenommen, Sie stehen vor der folgenden Situation:

Die vier Kreise in der oben stehenden Abbildung bilden eine Gruppe. Darüber wurde ein dunkelrotes Quadrat
platziert, und anschließend wurde auf beide Elemente ein Schatteneffekt angewandt. Wenn Sie dem Quadrat nun eine
andere Farbe geben möchten, müssten Sie normalerweise zuerst den Schatteneffekt aufheben, dann eine neue Farbe
anwenden und anschließend den Schatteneffekt wiederholen. Am einfachsten geht es, wenn Sie bei gedrückter STRG-
TASTE das Quadrat auswählen:

Sie haben das Quadrat jetzt direkt ausgewählt. Bei einer Teilauswahl werden die Auswahlpunkte rund anstatt
quadratisch angezeigt.
Da STRG+KLICKEN entsprechend der Reihenfolge funktioniert, in der Effekte, Gruppen usw. angewandt wurden,
können Sie ein Objekt nicht immer direkt auswählen. Manchmal müssen Sie erneut klicken, um “durch einen Effekt
oder eine Gruppe hindurch” auszuwählen: 

Eine Teilauswahl (in diesem Fall das Quadrat) kann beinahe beliebig angepasst werden; Sie können die Farbe ändern,
die Ecken mit Hilfe der Ziehfunktion verschieben, eine Transformation anwenden usw.:
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Wählen Sie jetzt einen der gelben Kreise mit der STRG-TASTE aus:

Sie haben nun die Gruppe der vier Kreise als Teilauswahl markiert; die Farbe aller vier Kreise kann nun auf einmal
geändert werden:

Wenn Sie erneut klicken, ist nur noch einer der Kreise markiert (Sie haben "durch die Gruppe hindurch" ausgewählt);
jede neue Aktion wird jetzt nur auf den ausgewählten Kreis angewandt:

Beachten Sie, dass eine Auswahl mit Hilfe der STRG-TASTE immer entsprechend der Reihenfolge vorgenommen wird,
in der Effekte, Gruppen usw. angewandt wurden. Sehen Sie sich hierzu das folgende Beispiel an. Es handelt sich dabei
um eine Gruppe mit vier Objekten:
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Wenn Sie das gelbe Rechteck mit Hilfe der STRG-TASTE auswählen, können Sie es als Teilauswahl direkt auswählen:

In dem unten stehenden Beispiel haben wir die gleichen Objekte verwendet, aber noch ein Quadrat hinzugefügt, das
wir mit der vorherigen Gruppe verbunden haben, wodurch eine Gruppe innerhalb einer anderen Gruppe entsteht.
Wenn Sie jetzt das gelbe Quadrat auswählen möchten, müssen Sie zweimal klicken, um es “durch die zusätzliche
Gruppe hindurch” auszuwählen:

Wichtig: Positionierung mit der STRG-TASTE
Wenn Sie die Bewegung einer Gruppe oder eines Effekts mit Hilfe der STRG-TASTE einschränken möchten, müssen
Sie zuerst mit dem Verschieben beginnen und dann die STRG-TASTE drücken. Wenn Sie die STRG-TASTE zuerst
drücken und dann mit dem Verschieben beginnen, wird vermutlich nur die Teilauswahl der Gruppe oder des Effekts
verschoben.

Rundsatz

Mit dem Befehl "Effekte", "Rundsatz" können Sie Text (und Objekte) auf einem besonderen Kreisbogen platzieren.
Schreibschrift wie in der Abbildung unten und arabische Schrift haben den Nachteil, dass die einzelnen Zeichen beim
Platzieren auf einem Kreisbogen nicht verbunden werden. 

Mit dem Befehl "Rundsatz" werden die Zeichen bei Schreibschrift und arabischer Schrift genauso verbunden wie auf
einer geraden Zeile.
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In der Abbildung oben sind die Zeichen nicht verbunden. Um dies zu korrigieren, wählen Sie im Kontextmenü des
Objektes den Befehl "Eigenschaften".

1 Verzerrungstyp
 Sie können hier auswählen, wie sich auf dem Kreisbogen platzierte Objekte verhalten sollen.
2 Mittelpunkt
 Legen Sie hier fest, an welcher Stelle des Arbeitsblattes das Objekt platziert werden soll.
3 Kreiseigenschaften
 Legen Sie hier Radius, Anfangspunkt, Mittelpunkt und Endpunkt des Kreisbogens fest.

Damit die einzelnen Zeichen verbunden werden, wählen Sie die zweite Option und klicken auf "OK".
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Alle Zeichen sind jetzt miteinander verbunden. Dieser Effekt kommt dadurch zustande, dass alle Buchstaben leicht
verzerrt werden. Bei kurzem Text und kleinem Radius ist die Verzerrung stärker als bei längerem Text und großem
Radius.

Anpassen von Kreisbögen

Rundsatz wird am einfachsten direkt auf dem Arbeitsblatt mit der Ziehfunktion bearbeitet.

Das Ausgangsobjekt

Nach dem Befehl "Rundsatz"

Anpassen der Bogenspannung bzw. des Radius
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Anpassen des Radius

Anpassen der Breite
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A Objekt mit "I" als Ankerpunkt drehen und Größe ändern.
 Bei gedrückter STRG-Taste: Größe mit "J" als Ankerpunkt bei gleich bleibendem Winkel zu "I" ändern. 

B Länge und Höhe des Kreisbogens anpassen.
 Bei gedrückter STRG-Taste: Objekt um "J" ohne Änderung des Radius drehen.

C Gleicher Vorgang wie unter "A".
D Bogenspannung anpassen.
E Steuerpunkte verschieben.
 Bei gedrückter STRG-Taste: Objekt um "J" ohne Änderung des Radius drehen.
F Gleicher Vorgang wie unter "D".
G Objekt mit "A" als Ankerpunkt drehen und Größe ändern.
H Gleicher Vorgang wie unter "B".
I Gleicher Vorgang wie unter "G".
J Kreisbogen im Ziehmodus verschieben.

Auf einem Kreisbogen platzierte Objekte

Fit (Angepasst)

Die Abbildungen unten zeigen den Unterschied zwischen den Objekten auf einem Kreisbogen, für die die Verzerrung
"Fit" übernommen bzw. nicht übernommen wurde. In der Abbildung auf der linken Seite wurde die Option "Fit"
verwendet.
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Flache Perspektive

Sie können auf ein oder mehrere Objekte gleichzeitig eine “Flache Perspektive” anwenden. Sie haben hierbei die Wahl
zwischen einer Einpunkt- und einer Zweipunktperspektive. Dies bedeutet, dass ein Objekt zwei Fluchtpunkte haben
kann.

So wenden Sie eine flache Perspektive an
Markieren Sie das Objekt, auf das der Effekt angewandt werden soll:
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Wählen Sie dann das Menü Effekte > Flache Perspektive:

Um das Objekt herum werden acht Steuerpunkte angezeigt. Die Steuerpunkte an den Ecken werden für die
perspektivische Verzerrung verwendet. Wenn Sie zusätzlich zu den Steuerpunkten die STRG-TASTE verwenden,
können Sie die Bewegung auf horizontale und vertikale Verschiebung einschränken. 

Durch Ziehen an den Eckpunkten können Sie die Perspektive anpassen:
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Dank dieses Werkzeugs können Sie jede erdenkbare perspektivische Verformung erzeugen. Sie können damit
beispielsweise ein Logo in der richtigen Perspektive an einem Gebäude oder auf der Motorhaube eines Autos
platzieren. Es handelt sich hierbei also um das ideale Werkzeug zur Erstellung von Präsentationen des endgültigen
Entwurfs.

Alle Steuerpunkte rasten “magnetisch” auf den Hilfslinien und den Knoten anderer Objekte ein:

Wenn Sie an den mittleren Steuerpunkten ziehen, können Sie die beiden angrenzenden Knoten verschieben, ohne
dabei deren relative Position zueinander zu verändern:
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Wenn Sie einen Steuerpunkt auf eine Linie ziehen und dabei die UMSCHALTTASTE gedrückt halten, wird diese Linie
parallel zur gegenüberliegenden Linie ausgerichtet:

Wenn Sie mit der rechten Maustaste auf einen Steuerpunkt klicken, wird ein Dialogfeld angezeigt, in dem Sie die
Position des Steuerpunktes numerisch festlegen können:
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Eine flache Perspektive kann auf jedes Vektorobjekt angewandt werden:

 

Verformungseffekt

Mit Hilfe des Verformungseffekts können Sie jedem Objekt die gewünschte Form geben, ohne dabei das ursprüngliche
Objekt zu verändern. Das Verformungswerkzeug wird anhand des folgenden Beispiels erklärt.

Wählen Sie ein Objekt aus:
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Wählen Sie den Befehl Effekte > Verformungseffekt:

Das Objekt ist jetzt von vier Knoten umgeben. Diese Knoten können mit Hilfe der Ziehfunktion in jede beliebige
Richtung gezogen werden. Durch Drücken der STRG-TASTE können Sie die Bewegung auf horizontale und vertikale
Verschiebung beschränken:

Wenn Sie die Maustaste loslassen, nimmt das Objekt die Form dieses Effekts an:

Mit den Steuerpunkten der Knoten können Sie den Verformungseffekt noch genauer anpassen:

 

Wenn Sie den Verformungseffekt verwenden, wird das Dialogfeld zur Knotenbearbeitung angezeigt, da der
Verformungseffekt die normale Vektor- und Knotenbearbeitung (z. B. das Hinzufügen und Löschen von Knoten,
Ändern von Eigenschaften usw.) unterstützt.

So können Sie einen Knoten hinzufügen und ziehen:



292 EasySIGN

Wählen Sie jetzt alle Knoten aus, und wählen Sie dann den Befehl Nach Linie, um alle Kurven in Linien zu ändern:

Dies veranschaulicht die Möglichkeiten der Knotenbearbeitung bei einem Verformungseffekt. Den zuvor hinzugefügten
Knoten können Sie jetzt entfernen, indem Sie ihn markieren und die ENTF-TASTE drücken bzw. die Löschoption im
Dialogfeld für die Knotenbearbeitung wählen:

Markieren Sie dann die übrigen Knoten, und wählen Sie die Befehle Nach Kurve und Symmetrische Knoten:

Ein Objekt passt sich den Kurven eines Verformungseffekts immer nur ungefähr an. Es ist nicht möglich, den Kurven
hundertprozentig genau zu folgen. Sie können die Genauigkeit jedoch ändern, indem Sie im Kontextmenü eines
Verformungseffekts den Befehl Eigenschaften wählen. Legen Sie in dem angezeigten Dialogfeld dann die
Genauigkeit des Effekts fest:
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Wenn Sie die Genauigkeit erhöhen, folgt das Objekt den Begrenzungen des Verformungseffekts genauer, die
Berechnung dauert jedoch länger. Am besten gehen Sie so vor, dass Sie das Objekt zuerst ungefähr in die
gewünschte Form bringen und dann die Genauigkeit erhöhen sowie die letzten Änderungen vornehmen. 

Geringe Genauigkeit

Hohe Genauigkeit

Natürlich können Sie den Verformungseffekt auch auf mehrere und sehr komplexe Objekte anwenden:

Am effektivsten verwenden Sie den Verformungseffekt allerdings zur Textanpassung. Die Möglichkeiten hierzu sind
beinahe unbegrenzt:



294 EasySIGN

Mit dem Befehl Bearbeiten > Umwandeln > Zu Kurven (STRG+Q) können Sie einen Verformungseffekt in ein
Vektorobjekt umwandeln. Über den Befehl Effekt > Effekt entfernen können Sie das bzw. die ursprüngliche(n)
Objekt(e) beibehalten.

Mischen

Diese Option ermöglicht es Ihnen, zwischen Objekten und Farben zu mischen.

Während des Mischvorgangs werden die Form sowie Füll- und Linienstil (Farbe und Breite) berücksichtigt.

Vorgehensweise zum Erstellen einer Mischung

Markieren Sie mindestens zwei Objekte, und klicken Sie im Menü "Effekte" auf "Mischen".
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Die zuletzt verwendeten Einstellungen werden angewendet, und die Software wechselt  in den Ziehwerkzeug-Modus.

Durch Ziehen des rautenförmigen Knotens (1) können Sie bestimmen, ob die Farbmischung mehr dem ersten oder dem zweiten Objekt entsprechen

soll. Durch Ziehen des dreieckigen Knotens (2) können Sie bestimmen, ob die Mischungsformen dem ersten oder dem zweiten Objekt ähnlicher sein

sollen.  

Durch Klicken mit der rechten Maustaste auf die Mischung können Sie "Eigenschaften" im Kontextmenü aufrufen. Das Dialogfeld mit den

Eigenschaften der Mischung wird geöffnet. Hier können Sie beispielsweise die Anzahl der Schritte festlegen.

Mithilfe von STRG+KLICKEN auf eines der Originale (oder durch dessen Auswählen im Objekt-Manager) können Sie das Originalobjekt bearbeiten

(z. B. die Farbe der Form ändern). Im Anschluss daran wird die Mischung neu berechnet. 

Sie können der Mischung über den Objekt-Manager neue Objekte hinzufügen (oder diese entfernen), indem Sie sie in den Mischungseffekt hinein-

oder von ihm wegziehen.
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Wenn Sie im Dialogfeld mit den Eigenschaften auf die Option "Kreisförmig" klicken, können Sie das erste mit dem letzen Objekt verbinden.

Sie können sogar jetzt noch die Originalobjekte bearbeiten oder andere Effekte auf die Mischung anwenden.

Das Dialogfeld für Mischen
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1 Paar
Hier können Sie die verschiedenen Mischungspaare auswählen. Wenn die Mischung aus zwei Originalen besteht, gibt es nur ein

Mischungspaar; bei 3 Objekten gibt es 2 Mischungspaare usw.

Originale (1), Mischungspaare (2) und die Ergebnisse (3).

2 Anzahl der Schritte

Hier können Sie die Anzahl der Schritte pro Mischungspaar festlegen. Wenn Sie die Option "Auf alle Mischungspaare anwenden"

aktivieren, wird die Anzahl der Schritte auf alle Mischungspaare angewendet.

3 Kreisförmig

Hier können Sie festlegen, ob das erste und letzte Objekt ebenfalls ein Mischungspaar bilden sollen.

1 : Nicht kreisförmig

2 : Unten

3 : Oben

4 Abstand

Unter "Abweichung" können Sie festlegen, ob der Anfangspunkt des Objekts näher am ersten oder am zweiten Objekt liegen soll.

1: 0 %

2: -50 %

3: 50 %

5 Füll- und Stiftstil  der erzeugten O bjekte

Über die Kombinationsfelder unter "Mitte" und "Andere" können Sie festlegen, wie sich Beispielfarbverläufe in einer Mischung verhalten

sollen.
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1: Standard: Beide auf "Nicht automatisch anpassen".

2: "Andere" auf "Wie Startobjekt".

Unter "Abweichung" können Sie festlegen, ob der Anfangspunkt der Farbmischung mehr dem ersten oder dem zweiten Objekt

entsprechen soll.

1: 0 %

2: -75 %

3: 75 %

6 Relativer Startknoten

Mit dieser Option können Sie den relativen Startknoten für jedes Mischungspaar bestimmen.

1: Knoten 0 (Standard)

2: Knoten 1

3: Knoten 2

4: Knoten 3

7 Alle Objekte

Drehrichtung im Uhrzeigersinn. Mit dieser Option wird die Drehrichtung aller Objekte in einer Mischung angepasst, damit sie in dieselbe

Richtung gedreht werden.

Einige Beispiele für Mischungseffekte
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Streifen: Beim oberen Bild wurde die Einstellung "Gleiche Entfernungen – Mitten" und beim unteren Bild "Gleicher Abstand" festgelegt.

Das obere Bild weist einen Farbverlauf auf, und im unteren Bild ist  jedes Zeichen mit einer anderen Farbe formatiert .

Links werden die Originalobjekte und rechts dieselben Objekte mit einer Mischung gezeigt.

Eine Kombination aus der Mischung und anderen Effekten.

Entwurf eines Logos mit Mischungseffekten.
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Mischungseffekt bei Linien.

Vorgehensweise zum Erstellen eines Neoneffekts bei der Mischung

Geben Sie eine fett  formatierte Schriftart  ein. In diesem Beispiel wird Verdana mit einer Zeichenhöhe von 200 mm und einer Zeichenbreite von

150 % verwendet.

Formatieren Sie diese Objekte mit "Keine Füllung" und einem Linienstil von 6 mm Breite, Wenden Sie auf den Linienstil die folgende Farbe an: 

CMYK : 0-100-100-100

Klicken Sie im Menü "Bearbeiten" auf "Klonen" und dann auf "Ohne Verschiebung". Klonen ist  nicht unbedingt erforderlich, erleichtert den

Vorgang aber erheblich, wenn der Text später geändert werden muss. Legen Sie für den Linienstil 2 mm fest, und wenden Sie darauf die folgende

Farbe an:

CMYK : 0-100-100-0

Klicken Sie im Menü "Bearbeiten" auf "Duplizieren ohne Verschiebung". Legen Sie für den Linienstil 1 mm fest, und wenden Sie darauf die folgende

Farbe an:

CMYK : 0-0-0-0

Zeichnen Sie hinter den Textobjekten ein schwarzes Rechteck mit abgerundeten Ecken.
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Markieren Sie alle Textobjekte, und klicken Sie im Menü "Effekte" auf "Mischen".

Wenn Sie Klone verwendet haben, müssen Sie nur den "Kontrolltext" bearbeiten, damit der gesamte Effekt neu berechnet wird.

Klonen

Ein Klon ist eine Kopie eines Objekts, wobei alle Eigenschaften noch mit dem Originalobjekt verknüpft sind. Wenn Sie
jedoch eine Eigenschaft des Klons ändern, wird die entsprechende Verknüpfung zum Original getrennt. 

Dieser Vorgang kann am besten in einem Beispiel erläutert werden. 

Zeichnen Sie ein Rechteck.

Klicken Sie im Menü "Bearbeiten" auf "Klonen" und anschließend auf "Versetzt".

Kopieren Sie anschließend den Klon mehrmals. Ein kopierter Klon wird automatisch ein Klon des gleichen Originals.
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Wenn die Farbe des Originals geändert wird, wirkt sich dies auch auf den Klon aus.

Jetzt wird die Farbe eines Klons geändert. Die Color-Eigenschaft ist jetzt nicht mehr mit dem Klon verknüpft.

Wenn Sie jetzt auch die Farbe des Originals ändern, wird die neue Farbe von allen Klonen mit Ausnahme des Klons
übernommen, dessen Color-Eigenschaft von dem Original getrennt wurde.

Es wird jedoch nur die Farbe von der Verknüpfung zum Original getrennt. Wenn Sie jetzt beispielsweise die Form des
Originals ändern, wird diese Änderung von allen Klonen übernommen.
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Sie können die Color-Eigenschaft für die Farbe neu verbinden. Klicken Sie hierzu im Kontextmenü für den Klon auf
"Original wiederherstellen".

Das angezeigte Dialogfeld enthält eine Liste (1) aller getrennten Eigenschaften. Wählen Sie die Eigenschaft (in diesem
Fall die Farbe), die Sie erneut verbinden möchten, und klicken Sie anschließend auf "OK".

Wenn Sie die Form und Farbe des Originals jetzt ändern, wird diese Änderung von allen Klonen übernommen.

Das Original ist ein Rechteck. Wenn diese Form in Kurven umgewandelt wird, werden auch die Klone entsprechend
konvertiert. Jede mit der Ziehfunktion vorgenommene Korrektur wird auch von den Klonen übernommen. 
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Text klonen
Textklone haben eine spezielle Funktion. Wenn der Text geändert wird, werden auch die Klone entsprechend
geändert.

 

Effekte klonen
Sie können zwar keinen Effekt klonen, haben jedoch die Möglichkeit, einen Effekt auf einen Klon anzuwenden.

Der Klon in dem Effekt reagiert auf die beim Original vorgenommenen Änderungen und berechnet somit den Effekt
neu.
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Streifen

Mit dieser Funktion können Sie Vektoren, Effekte, Bitmaps und Kombinationen daraus in einzelne Stücke unterteilen.

Sie können sogar mehrere "Streifen" übereinander anwenden, um Ihre eigenen Effekte zu erstellen. Da es sich bei "Streifen" um einen Effekt

handelt, bleiben die Originalobjekte unverändert. Sie können die "Streifen" jederzeit  entfernen.

Die nachstehenden Beispiele zeigen Möglichkeiten zum Anwenden mehrerer Ebenen von "Streifen" auf mehrere Objekte.

Original

Mit horizontalen "Streifen"

Mit horizontalen und vertikalen "Streifen"

Mit horizontalen, vertikalen und radialen "Streifen"

Anwenden eines Streifens

Markieren Sie die Objekte, auf die Sie einen "Streifen" anwenden möchten. Klicken Sie anschließend im Menü "Effekte" auf "Streifen" und dann auf

eines der Untermenüs.
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Der zuletzt verwendete "Streifen" wird auf die markierten Objekte angewendet. Zum Anpassen dieses "Streifens" klicken Sie im Kontextmenü auf

"Eigenschaften". Sie können den "Streifen" auch mithilfe von Kontrollknoten direkt auf dem Bildschirm ändern; das Dialogfeld bietet Ihnen jedoch

mehr Optionen und ermöglicht eine bessere Steuerung.

Unter "Typ" (1) finden Sie drei Hauptkategorien des "Streifens". Beim Auswählen eines dieser Untertypen werden jeweils andere Optionen im

Dialogfeld aktiv.

Originalobjekt. Der zusätzliche schwarze Umriss bezeichnet die Grenze.

A Linear

2 Verschiedenes

A rbe itszyk lus

Diese Option bestimmt das Verhältnis zwischen Streifen und Lücken.

A rbe itszyk lus: 50 %
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Arbeitszyklus: 25 %

Arbeitszyklus: 75 %

Veränderlichke it

Diese Option bestimmt das Verhältnis zwischen der Breite des ersten und des letzten Streifens.

Veränderlichke it: 0 %

Veränderlichke it: 100 %

W inke l

Mit dieser Option können Sie den Winkel festlegen.

W inke l: 0°
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W inke l: 45°

4 Anzahl von

Stre ifen

Die Anzahl der Streifen, die verwendet werden sollen.

Stre ifen: 4

Stre ifen: 8

Lücken

Mit dieser Option können Sie festlegen, dass die Funktion "Streifen" eine Lücke hinzufügen
oder entfernen soll. So lässt sich besser steuern, wie "Streifen" ein Objekt füllt.

Lücke: 0 – d iese lbe  Anzahl von Lücken w ie  von Stre ifen
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Lücke: -1 – e ine  Lücke  wenige r

Lücke: +1 – e ine  zusä tz liche  Lücke

B Konisch

2 Verschiedenes

Weitere Informationen finden Sie unter "Linear".

Einige Beispiele:

A rbe itszyk lus: 50, Ve ränderlichke it: 0 % , W inke l: 0°

A rbe itszyk lus: 50, Ve ränderlichke it: 50 % , W inke l: 15°

A rbe itszyk lus: 75, Ve ränderlichke it: 0 % , W inke l: 0°
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4 Anzahl von

Weitere Informationen finden Sie unter "Linear".

Bei einem konischen "Streifen" können Sie hier nur die Anzahl der Streifen anpassen.

Stre ifen: 16

5 Mittelpunkt

Hier können Sie den Mittelpunkt des "Streifens" mit mehreren Optionen festlegen. Im
nachstehenden Beispiel liegt der Mittelpunkt bei x: -50 % und y: +50 %. Sie können
Prozentsätze für die Breite und Höhe der Markierung, numerische Werte sowie Koordinaten
eingeben, die absolut oder relativ zur Markierung sind.

C Radial

Diese Option kann in "Normal", "Vieleck" und "Stern" unterteilt werden.

2 Verschiedenes

Weitere Informationen finden Sie unter "Linear".

3 Radius

Hier können Sie Werte für den Außen- und Innenradius (vertikaler Radius) und auch für den
horizontalen Radius eingeben. Das Verhältnis zwischen Außenradius und horizontalem Radius
bestimmt das Seitenverhältnis.

Außen: 100 % , Innen : 5 % , Horizonta l : 100 %
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Außen: 100 % , Innen : 5 % , Horizonta l : 200 %

Außen: 200 % , Innen : 5 % , Horizonta l : 100 %

6 Stern/Vieleck

Wenn Sie "Stern" oder "Vieleck" ausgewählt haben, wird diese Optionsgruppe aktiv. 

Anzahl de r Ecken

Legt die Anzahl der Ecken fest.

Anzahl de r Ecken: 5

Anzahl de r Ecken: 10

Am plitude

Diese Einstellung beeinflusst die Innenform von "Stern" oder "Vieleck". 

Am plitude: 50 %
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Am plitude: 0 %

Am plitude: 100 %

"Streifen" ist  äußerst vielseitig und kann auf nahezu alle Arten von Objekten angewendet werden. Deshalb sind die Einsatzmöglichkeiten für diese

starke Vielzweck-Entwurfsfunktion bei weitem nicht auf Schnittaufgaben beschränkt.

Abrunden

Die Ecken von Vektorformen können abgerundet werden, ohne dabei die ursprünglichen Formen zu verändern. Beim Verbinden einer geraden Linie

mit einer Kurve wird die Linie ebenfalls abgerundet. Markieren Sie ein Objekt, dessen Ecken abgerundet werden sollen.

Klicken Sie anschließend im Menü "Effekte" auf die Option "Abrunden".
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Der Cursor wird zum "Ziehwerkzeug", und um das Objekt herum werden Kontrollknoten zum Abrunden eingeblendet. Die zuletzt verwendeten

Einstellungen für "Abrunden" werden automatisch angewendet. Sie können den Effekt "Abrunden" auch über ein Dialogfeld anpassen; dann steht

Ihnen eine zusätzliche Auswahl zwischen abgerundeten Ecken und "abgeschrägten" Ecken zur Verfügung.

Durch verstärkte Anwendung dieses Effekts können Sie sogar völlig neue Formen erstellen.

Der Effekt "Abrunden" lässt sich auf alle Vektorobjekte anwenden. Auf diese Weise können auch Standardobjekte, wie der "Stern", zum Erstellen

neuer Formen verwendet werden.

Da die Originalformen – wie es bei allen anderen Effekten zutrifft  – durch den Effekt "Abrunden" nicht verändert werden, können Sie das Original

mit STRG+KLICKEN oder über den Objekt-Manager anpassen.



314 EasySIGN

Vorlagen

Vorlagenassistent
V o r l a g e n a s s i s t e n t

Sie können mit den Vorlagenassistenten im Handumdrehen eine der im Lieferumfang enthaltenen Vorlagen oder eine
benutzerdefinierte Vorlage ändern. Sie können Text und Objekte in einer Vorlage ändern, indem Sie einen neuen Text
eingeben oder eine andere ClipArt-Datei auswählen. Sie können über den Vorlagenassistenten sogar Bemaßungen
und die Seitengröße ändern. Außerdem können Sie eine Seite vervielfältigen oder mit Kopien einer Vorlage füllen.

Klicken Sie im Menü "Datei" auf "Neu aus Vorlage", um den Vorlagenassistenten aufzurufen. Zuerst wird ein
Dialogfeld aufgerufen, in dem Sie über die Vorschau der Vorlagen zu einer Vorlagendateien navigieren können. 
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1 Favoriten. Wenn Sie auf das Pluszeichen (+) klicken, können Sie den derzeit ausgewählten Ordner Ihren
Favoriten hinzufügen. Wenn Sie das Dialogfeld das nächste Mal öffnen, können Sie direkt einen Ordner aus der
Liste der Favoriten auswählen.

2 Hier können Sie den Ordner auf Ihrem System durchsuchen.
3 Hier können Sie die Vorschau der Vorlagendateien im derzeit ausgewählten Ordner anzeigen.

Wählen Sie die gewünschte Vorlage, und klicken Sie anschließend auf "OK".
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Wenn Sie den Vorlagenassistenten zum ersten Mal öffnen, wird ein Begrüßungsbildschirm angezeigt. Es steht Ihnen
eine Option zur Verfügung, über die Sie festlegen können, dass dieser Begrüßungsbildschirm zukünftig nicht mehr
angezeigt wird (1). Die Anzahl der Seiten für den Assistenten hängt von Ihren Auswahloptionen und der Anzahl der
austauschbaren Objekte in der ausgewählten Vorlage ab.

Der Assistent zeigt für jeden Text eine Seite an, der die Replaceable-Eigenschaft enthält. Sie können auf dieser Seite
den Text und die Schriftart ändern.
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1 Zeigt in einer Vorschau die Textposition in der Vorlage an.
2 Der Text in der Vorlage.
3 Geänderter Text.
4 Stellt den ursprünglichen Text wieder her.
5 Ändert die Schriftart.

Wenn eine Schriftart auf Ihrem System nicht installiert ist, wird ein Fragezeichen in der Liste angezeigt. Sie sollten in
diesem Fall die fehlende Schriftart durch eine vorhandene ersetzen.

Wenn alle Textobjekte in der Vorlage verarbeitet sind, wird eine Seite mit austauschbaren ClipArt-Grafiken (falls
diese in der Vorlage vorhanden sind) angezeigt.
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1 Zeigt in einer Vorschau die ClipArt-Position in der Vorlage an.
2 Hier können Sie festlegen, ob die ClipArt ersetzt werden soll.
3 Öffnet ein Dialogfeld, in dem Sie ClipArt suchen und auswählen können.

Wenn Sie keine weiteren ClipArt-Grafiken auswählen, wird die ClipArt aus der Vorlage verwendet.
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1 Eine vordefinierte Bemaßung für die Vorlage auswählen.
2 Eigene vordefinierte Bemaßungen eingeben.
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1 Eine vordefinierte Seitengröße auswählen.
2 Eine benutzerdefinierte Seitengröße auswählen.
3 Seitengrößen von Ihren Ausgabegeräten abfragen.
4 Ausrichtung auswählen.

Wenn Sie keine Eigenschaft ändern, wird die Seitengröße und Ausrichtung aus der Vorlage verwendet.
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Hier können Sie die Vorlage vervielfältigen, indem Sie die Anzahl eingeben oder die benötigte Anzahl der Vorlagen für
die ausgewählte Seitengröße vom Programm berechnen lassen. Sie können außerdem den Seitenrand und den
Abstand zwischen den Vorlagen auswählen.

Wenn Sie keine Eigenschaft ändern, wird eine Kopie der Vorlage verwendet.

Erstellen eigener Vorlagen
E r s t e l l e n  e i g e n e r  V o r l a g e n

Sie können im Handumdrehen eigene Vorlagen erstellen. Jeder neue Text, den Sie in das Arbeitsblatt eingeben, ist
automatisch austauschbar. Sie können diese Funktion deaktivieren. Klicken Sie hierzu im Menü "Anordnen" auf
"Vorlagen" und anschließend auf "Nicht austauschbar". Wenn Texte oder Objekte grundsätzlich austauschbar werden
sollen, klicken Sie im Menü "Anordnen" auf "Vorlagen" und anschließend auf "Austauschbar machen".
Speichern Sie jetzt das Arbeitsblatt als Vorlage. Klicken Sie hierzu im Menü "Datei" auf "Speichern unter" und
anschließend auf "Vorlage". Wenn Sie diese Datei über den Befehl "Neu aus Vorlage" im Menü "Datei" öffnen, wird im
Assistenten jeweils eine Seite für die Texte und Objekte angezeigt, bei denen für die Replaceable-Eigenschaft TRUE
gilt.
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Spezielle Import- und Exportfunktionen

Adobe™ PDF-Export
A d o b e ™  P D F - E x p o r t

Sie können ein beliebiges Arbeitsblatt aus EasySIGN in eine PDF-Datei (Portable Document Format) exportieren.
Beachten Sie jedoch, dass nur die Objekte richtig exportiert werden können, die auf einer Seite platziert sind. Im
PDF-Format können keine Objekte außerhalb einer Seite eingefügt werden.

Klicken Sie im Menü "Datei" auf "Exportieren". Klicken Sie in dem Dialogfeld für den Dateityp auf den Filter "Portable
Document Format (*.PDF)", und geben Sie den Namen der PDF-Datei an, die exportiert werden soll. Wenn Sie auf die
Schaltfläche "Exportieren" klicken, wird folgendes Dialogfeld angezeigt:

1 Farbverläufe
Verwenden Sie die nachstehenden Vektoren.
PDF verwendet ein eigenes kompaktes Verfahren zum Verarbeiten von Farbverläufen. Diese Farbverläufe sind
wesentlich kleiner als Vektorfarbverläufe und nie mit den Farbverläufen in Ihrem Arbeitsblatt identisch. Wenn
diese Farbverläufe mit den Farbverläufen auf dem Arbeitsblatt identisch sein sollen, geben Sie einen Wert an,
der höher als die Inkremente für die Verlaufsfüllung Ihres Arbeitsblatts ist. Die Standardeinstellung von 300
Schritten ist ausreichend.

Farbverläufe konvertieren in
PDF erkennt nur die Farbräume RGB und CMYK. Wenn Sie eine HSB-Regenbogenfüllung in Ihrem Arbeitsblatt
verwenden, müssen Sie diese in einen der eingangs erwähnten Farbräume umwandeln. CMYK ist in der Regel
das beste und genaueste Verfahren.

2 Bitmaps
Komprimierung
Sie können entweder keine Komprimierung oder eine JPG-Komprimierung festlegen. Wenn Sie die PDF-Datei
an eine Druckerei weiterleiten, ist die Option "Keine" am besten geeignet. Die PDF-Datei ist wesentlich größer
als eine komprimierte Datei. Die Bitmaps in Ihrem Arbeitsblatt sind dann jedoch mit der Darstellung auf Ihrem
Arbeitsblatt identisch. Bei einer Komprimierung können Daten verloren gehen. 
 
Qualität
Hier können Sie den Komprimierungsgrad festlegen.
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E-Mail

E-Mail-Konfiguration
E - M a i l - K o n f i g u r a t i o n

Über das E-Mail-System von EasySIGN können Sie Ihrem Kunden schnell und mühelos ein aktives Arbeitsblatt  als Anlage zu einer E-Mail oder

aber eine Vorschau zur Genehmigung senden.

Bevor Sie diese Funktionalität jedoch nutzen können, müssen Sie einige Einstellungen anpassen. Klicken Sie im Menü "Datei" auf "Senden an" und

dann auf "E-Mail-Einstellungen".

Registerkarte "HTML-Einstellungen"

1 Hier können Sie festlegen, wann eine Warnung angezeigt werden soll, wenn die Anlagen zu groß sind. Denken Sie daran,

dass die meisten Dienstanbieter bei E-Mails eine Größenbegrenzung erzwingen und dass auch Ihre Kunden keine E-Mails

von mehreren MB Größe empfangen möchten.

2 HTML

Anlage :

Hier können Sie auswählen, ob Sie beim Senden des Arbeitsblattes als Anlage eine HTML-Vorlage verwenden möchten

und wenn ja, welche.

Vorschau:

Hier können Sie die Vorlage auswählen, die Sie beim Senden des Arbeitsblattes als Vorschau verwenden möchten.

Codierung:

Hier können Sie den Ländercode für Ihre Region auswählen.

Diese Auswahl muss der Einstellung in der verwendeten HTML-Vorlage entsprechen.

Sehen Sie sich dazu die Beispiele für die Standardeinstellungen und die mitgelieferten Vorlagen an.

3 Schnittste lle
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EML-kompatibel :

Mit dieser Option wird die E-Mail in der jeweiligen EML-kompatiblen Anwendung geöffnet. Bei den meisten Computern

ist dies Outlook Express™.

Die Option bietet den Vorteil, dass Sie den Inhalt der E-Mail vor dem Senden beliebig bearbeiten können.

Sie können die Einstellungen auf der Registerkarte "SMTP-Einstellungen" ignorieren, sollten jedoch die entsprechenden

Einstellungen in der EML-kompatiblen Anwendung anpassen.

Direkte SMTP-Verbindung:

Mit dieser Option wird die E-Mail in der Arbeitsumgebung von EasySIGN geöffnet. Sie können die Auswahl der

Vorlage vor dem Senden der E-Mail ändern. Wenn Sie diese Option wählen, müssen Sie auch die Einstellungen auf der

Registerkarte "SMTP-Einstellungen" anpassen.

4 Vorschau:

Geben Sie hier die maximale Breite in Pixel sowie die Auflösung für die Arbeitsblattvorschau ein. 

Registerkarte "SMTP-Einstellungen"

Passen Sie die Einstellungen auf dieser Registerkarte nur an, wenn Sie auf der Registerkarte "HTML-Einstellungen" die Option "Direkte SMTP-

Verbindung" gewählt haben.

Dies trifft  nur zu, wenn Sie keinen Zugriff auf einen EML-kompatiblen Client wie Outlook Express haben oder wenn Sie diesen Client nicht

verwenden möchten. Falls dabei Probleme auftreten sollten, wenden Sie sich an Ihren Dienstanbieter. Er kann Ihnen die erforderlichen

Informationen liefern.

Wenn Sie diese Software in einem Unternehmensnetzwerk mit Exchange Server einsetzen, wenden Sie sich an Ihren Netzwerkadministrator.

1 Absender

Name :

Geben Sie hier den Namen ein, der im Feld "Von" einer E-Mail angezeigt wird. Dies ist  häufig der Name des



325EasySIGN

Unternehmens.

 

E-Mail-Adresse :

Geben Sie hier Ihre E-Mail-Adresse ein.

Authentifiz ierungsmethode :

Das von Ihrem Dienstanbieter verwendete Anmeldungsverfahren.

Wählen Sie eine der folgenden Optionen:

NONE: Wählen Sie diese Option, wenn Ihr Dienstanbieter anonyme Anmeldung
unterstützt. Dies ist nur selten der Fall.

CRAM MD5: Diese Methode ist für die Anmeldung an einem LDAP-Server erforderlich.

AUTH LOGIN: Dies ist die gebräuchlichste Methode. Benutzername und Kennwort werden
verschlüsselt gesendet.

PLAIN LOGIN: Nahezu identisch mit AUTH LOGIN, außer dass Benutzername und Kennwort
unverschlüsselt gesendet werden. Von der Wahl dieser Option wird abgeraten.

Benutzername :

Geben Sie hier Ihren Benutzernamen ein. Diese Angabe ist  im Schreiben Ihres E-Mail-Dienstanbieters zu finden. Wenden

Sie sich andernfalls an den Dienstanbieter.

Kennwort:

Geben Sie hier Ihr Kennwort ein. Diese Angabe ist  ebenfalls im Schreiben Ihres Dienstanbieters zu finden.  Wenn Sie das

Kennwort dort nicht finden können oder es geändert haben, sollten Sie sich an den Dienstanbieter wenden.

2 Server

Hostname/-adresse :

Geben Sie hier den Namen des SMTP-Servers ein. Dies ist  häufig der Name 'smtp.domain.com', in dem Sie die Angabe

'domain' durch den Namen Ihres Dienstanbieters ersetzen müssen. Sehen Sie dazu das Schreiben des Dienstanbieters.

Wenn Sie in einem Unternehmensnetzwerk arbeiten, können Sie die IP-Adresse oder den WINS-Namen des Servers

eingeben.

Anschlussnummer:

Geben Sie hier die Anschlussnummer ein, die vom SMTP-Server für den Empfang von E-Mails verwendet wird. Dies ist

oft Anschluss 25. Falls Probleme auftreten, wenden Sie sich an Ihren Dienstanbieter.

3 Adressbuch

WAB:

Wählen Sie diese Option, wenn Sie das Windows™-Adressbuch verwenden möchten.

O utlook™-Kontakte :

Wählen Sie diese Option, wenn Sie die Kontaktliste in Outlook™ verwenden möchten.

4 Verbindung:

Aktivieren Sie diese Option, um festzulegen, dass Sie vom Programm automatisch bei Ihrem Dienstanbieter angemeldet

werden möchten, wenn noch keine geöffnete Verbindung vorhanden ist .

HTML-Vorlagen für E-Mails
H T M L - V o r l a g e n  f ü r  E - M a i l s

Für das E-Mail-System von EasySIGN werden HTML-Vorlagen verwendet. Mithilfe einer HTML-Vorlage können Sie alle
erforderlichen Unternehmensinformationen in die Präsentation eines Entwurfs bei Ihren Kunden einbeziehen.

Während der Installation von EasySIGN werden mehrere HTML-Beispielvorlagen im Unterverzeichnis "\HtmlTemplates" des

Programmverzeichnisses installiert . Diese Vorlagen enthalten so genannten 'Pseudotext ' (der als Platzhalter für Ihren eigenen Text dient) und ein

Beispiellogo. Bilder wie das Beispiellogo sind im Unterverzeichnis "\HtmlTemplates\images\" gespeichert. Vor ihrer Verwendung sollten Sie eine

Vorlage anpassen; andernfalls sind Ihre Kunden irrit iert , wenn sie den Pseudotext der Beispiele lesen müssen. Sie können einen Test ausführen,

indem Sie sich selbst eine vorhandene Vorlage per E-Mail senden.

Anpassen/Erstellen einer HTML-Vorlage
Eine HTML-Vorlage können Sie ganz nach Belieben anpassen oder erstellen. Sie muss mindestens den folgenden Text (wörtlich) enthalten:

<<|InsertWorksheetImageHere|>>

Mithilfe dieses Textes wird die Stelle in der Vorlage gekennzeichnet, an der die Arbeitsblattvorschau (Bild) vom Programm ersetzt werden soll.
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Es gibt eine weitere Kennzeichnung (Platzhalter), mit der Sie einer E-Mail vor dem Versand zusätzlichen Nicht-Standardtext hinzufügen können.

Dieser Text wird in der E-Mail immer an der gleichen Stelle angezeigt und in der Vorlage durch den folgenden Text (wörtlich) gekennzeichnet:

<<|InsertAdditionalBodyHere|>>

Zu beachtende Punkte
Zur Vermeidung von Problemen müssen Sie auf die Verwendung der korrekten HTML-Syntax achten. Der Einsatz eines professionellen HTML-

Editors, wie z. B. "Dreamweaver™", wird empfohlen. Falls bei der Konvertierung der HTML-Vorlage in eine E-Mail Probleme auftreten,

überprüfen Sie zunächst die HTML-Syntax. Falsche Syntax ist  nämlich meistens die Ursache für dieses Problem.

Da die HTML-Vorlage nur einmal erstellt  werden muss, können Sie ein externes Büro mit der Erstellung beauftragen, wenn Sie mit HTML nicht

genügend vertraut sind.

Falls Ihnen keine der vorstehenden Optionen zusagt, können Sie die HTML-Standardvorlage "basic.htm" verwenden.

Diese Vorlage enthält  nur eine Kennzeichnung (Platzhalter) für die Arbeitsblattvorschau und eine für den zusätzlichen Text. Im E-Mail-Dialogfeld

von EasySIGN können Sie diesen Platzhalter für jede neue E-Mail nach Belieben mit Ihrem eigenen Text ausfüllen.

Ich verwende bereits andere E-Mail-Vorlagen. Wie soll ich nun vorgehen?
Falls in Ihrem Unternehmen bereits andere E-Mail-Vorlagen , z. B. in Outlook™ (nicht zu verwechseln mit dem kostenlosen Outlook Express™)

verwendet werden, können Sie in die Vorlagen mühelos eine Arbeitsblattvorschau einbeziehen. Markieren Sie den Arbeitsblattabschnitt  (oder das

ganze Arbeitsblatt), den Sie als Vorschau in die Vorlage einbeziehen möchten. Klicken Sie im Menü "Bearbeiten" auf "Spezielles Kopieren" und

dann auf "Als Bitmap in die Zwischenablage". Damit wird die Markierung als Bitmap in die Zwischenablage kopiert und kann von dort in eine E-

Mail eingefügt werden. Ob Ihnen dieses Menü tatsächlich zur Verfügung steht, hängt von Ihrem Lizenztyp für EasySIGN ab.

Einrichten von E-Mail
E i n r i c h t e n  v o n  E - M a i l

Führen Sie die folgenden Schritte aus, um das E-Mail-System von EasySIGN einzurichten.

Schritt 1
Passen Sie die erforderlichen Einstellungen an. Dieser Vorgang muss nur einmal ausgeführt werden. Informationen hierzu finden Sie im Kapitel "E-

Mail-Konfiguration".

Schritt 2
Erstellen Sie eine HTML-Vorlage, die mit Ihrem Unternehmensstil übereinstimmt. Dieser Vorgang muss nur einmal ausgeführt werden.

Informationen hierzu finden Sie im Kapitel "HTML-Vorlagen für E-Mails".

Schritt 3

Senden Sie das aktive Arbeitsblatt  als Anlage

Diese Option empfiehlt sich nur, wenn der Empfänger ebenfalls ein lizenzierter Benutzer von EasySIGN ist . Andernfalls kann ein Benutzer, dem

Sie einen Entwurf präsentieren möchten, mit einer EasySIGN-Datei als Anlage zu einer E-Mail nichts anfangen. Verwenden Sie in diesem Fall die

zweite Methode für die Präsentation beim Kunden.

Klicken Sie im Menü "Datei" auf "Senden an" und dann auf "E-Mail-Empfänger (als Anlage)".

Wenn ein EML-kompatibler E-Mail-Client zur Verfügung steht
Der EML-kompatible Client wird mit dem aktuellen Arbeitsblatt  als Anlage geöffnet. Wenn Sie diese Option gewählt

haben, wird eine Vorlage für den Textkörper der E-Mail verwendet.

Wenn eine direkte SMTP-Verbindung zur Verfügung steht
In EasySIGN wird ein Dialogfeld für die Eingabe von E-Mail-Einstellungen (z. B. in den Feldern "An", "Cc" und "Bcc")

geöffnet. Hier können Sie auch eine Vorlage für den E-Mail-Text auswählen.

Das dafür erforderliche Verfahren wird weiter unten im Abschnitt  "Dialogfeld für SMTP" beschrieben.

Wenn Sie bei dieser Methode keine Vorlage verwenden, müssen Sie das Feld "Zusätzlicher Text" nicht ausfüllen, da dieses Feld nur im

Zusammenhang mit Vorlagen benötigt wird.

Senden Sie  das aktive Arbeitsblatt (oder e inen Teil davon) als Vorschau an Ihren Kunden
Verwenden Sie diese Option, wenn Sie Ihrem Kunden eine Vorschau zur Genehmigung senden möchten. Dann wird die Vorschau für jeden Benutzer

angezeigt, der über einen HTML-fähigen E-Mail-Client verfügt (was auf fast jeden modernen E-Mail-Client zutrifft).
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Klicken Sie im Menü "Datei" auf "Senden an" und dann auf "E-Mail-Empfänger (Vorschau in Vorlage)". 

Wenn ein EML-kompatibler E-Mail-Client zur Verfügung steht
Der EML-kompatible Client wird mit einer Vorschau des aktuellen Arbeitsblattes an der Position des Platzhalters für

Vorschauen (<<|InsertWorksheetImageHere|>>) geöffnet.

Wenn eine direkte SMTP-Verbindung zur Verfügung steht
In EasySIGN wird ein Dialogfeld für die Eingabe von E-Mail-Einstellungen (z. B. in den Feldern "An", "Cc" und "Bcc")

geöffnet. Hier können Sie auch eine Vorlage für den E-Mail-Text auswählen. In der endgültigen E-Mail wird der

Platzhalter für Vorschauen durch eine Vorschau des aktiven Arbeitsblattes ersetzt.

Das dafür erforderliche Verfahren wird im nächsten Abschnitt , "Dialogfeld für SMTP", beschrieben.

Dialogfeld für SMTP
Die nachstehende Abbildung zeigt das Dialogfeld für SMTP und die zugehörigen Komponenten.
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E-Mail-Priorität "Niedrig"

E-Mail-Priorität "Normal"

E-Mail-Priorität "Hoch"

Öffnet eine Vorschau der E-Mail in Internet Explorer™.

Speichert die E-Mail auf Datenträger als EML-Datei.

Leert das Feld "Anlage(n)".

Öffnet das Dialogfeld mit den Einstellungen.

1 Vorlage :

Hier können Sie die gewünschte Vorlage auswählen.

2 Anlage(n):

Hier können Sie mögliche Anlagen auswählen.

3 Informationen:

Hier können Sie E-Mail-Standardinformationen eingeben. Wenn Sie auf eine der Schaltflächen "An", "Cc" und

"Bcc" klicken, wird das Adressbuch geöffnet.

4 Zusätzlicher Text:

Dieses Feld ist  nur zweckmäßig, wenn Sie in Ihrer HTML-Vorlage den Platzhalter <<|

InsertAdditionalBodyHere|>> verwenden. Dann wird der Platzhalter durch den hier eingegebenen Text

ersetzt.

Transparenz

Transparenz bei Vektoren und Bitmaps
T r a n s p a r e n z  b e i  V e k t o r e n  u n d  B i t m a p s

EasySIGN bietet einige sehr fortgeschrittene, präzise Funktionen zum Anwenden und Verwalten von Transparenz. Transparenz kann auf

sämtliche Objekte in einem Arbeitsblatt , darunter Gruppen, Effekte und den Linienstil von Objekten, angewendet werden. Es stehen verschiedene

Transparenzmethoden zur Verfügung. 

1 Einheitliche Transparenz

2 Transparenz bei Farbverläufen

3 Transparenz bei Mustern

4 Transparenz bei Bitmaps unter Verwendung von Alpha-Channels

1: Einheitliche Transparenz

Diese Form von Transparenz kann mit dem folgenden Verfahren auf jedes beliebige Objekt angewendet werden:

Markieren Sie die Objekte, auf die Transparenz angewendet werden soll.

Klicken Sie anschließend in der Werkzeugpalette auf das Transparenzwerkzeug.
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Ein verschiebbares Dialogfeld wird eingeblendet, in dem Transparenz verwaltet werden kann.

Die Standardtransparenz ist  auf "Keine" festgelegt; ändern Sie sie auf "Einheitlich".

Auf dem Arbeitsblatt  wird die Transparenz des Objekts auf den Standardwert 50% geändert. Wenn Sie diesen Wert auf 20% reduzieren, wird das

Objekt weniger transparent. Dazu geben Sie den Wert "20" ein und drücken dann die EINGABETASTE.

Wenn Sie den Transparenzwert auf 80% ändern, wird das Objekt fast unsichtbar; beim Wert 100% wird es völlig transparent.

Klicken Sie nun in der Werkzeugpalette auf die Auswahlfunktion (oder drücken Sie die ESC-Taste). Das Dialogfeld für Transparenz wird

ausgeblendet und das Objekt erneut markiert.
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Wenden Sie als Nächstes einen Linienstil auf das transparente Objekt an.

Wie Sie sehen können, ist  der Linienstil ebenfalls transparent. Jetzt werden die Transparenzeigenschaften geändert. Dieses Verfahren umfasst

immer die gleichen Schritte: Markieren Sie zuerst das transparente Objekt, und klicken Sie anschließend in der Werkzeugpalette auf das

Transparenzwerkzeug.

Ändern Sie den Transparenzwert auf "50%" (1).

Klicken Sie im Kombinationsfeld (2) auf "Füllung". Damit ist  nur der Füllstil transparent.
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Klicken Sie im Kombinationsfeld (2) auf "Stift". Jetzt ist  nur der Stiftstil transparent.

Sie können die Transparenz von einem Objekt entfernen, indem Sie es markieren, dann auf das Transparenzwerkzeug und im ersten

Kombinationsfeld auf "Keine" klicken.

Links wird eine Gruppe komplexer Objekte ohne Transparenz und rechts dieselbe Gruppe mit Transparenz angezeigt.
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Transparenz kann auch auf eine Kombination aus Bitmap- und Vektorobjekten angewendet werden.

2: Transparenz bei Farbverläufen

Der Arbeitsablauf für das Anwenden einer Transparenz bei Farbverläufen ähnelt demjenigen für einheitliche Transparenz, weist jedoch einige

zusätzliche Funktionen auf.

Markieren Sie das Objekt, das transparent werden soll.

Klicken Sie in der Werkzeugpalette auf das Transparenzwerkzeug und dann auf eine der Optionen für Transparenz mit Farbverlauf: "Linear",

"Radial", "Rechteckig" oder "Konisch".

Genauso wie bei den normalen Farbverläufen können Sie Ziehpunkte ziehen, um die Richtung für die Transparenz festzulegen. Dies kann entweder

direkt auf dem Bildschirm oder über das Dialogfeld für Farbverläufe geschehen.
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Im Dialogfeld für Transparenz stehen die folgenden Optionen zur Verfügung:

1 Wählt verschiedene Transparenztypen aus.

2 Gibt die Anfangstransparenz in Prozent an.

3 Gibt die Endtransparenz in Prozent an.

4 Gibt an, worauf die Transparenz angewendet werden soll: "Füllung", "Stift" oder "Beide".

5 Zusätzliche Optionen. Bei einer transparenten Füllung wird das Dialogfeld für Farbverläufe
geöffnet.

Links wird eine Gruppe komplexer Objekte ohne Transparenz und rechts dieselbe Gruppe mit Transparenz angezeigt.

Transparenz kann auch auf eine Kombination aus Bitmap- und Vektorobjekten angewendet werden.
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3: Transparenz bei Mustern

Ein transparentes Muster kann ähnlich wie eine einheitliche Transparenz oder eine Transparenz bei Farbverläufen angewendet werden.

Klicken Sie unter (1) auf "Muster".

Wenn die Option "Muster" aktiviert  ist , wird standardmäßig eine schwarzweiße Bitmap als Transparenzmuster verwendet. Bei Verwendung einer

schwarzweißen Bitmap sind im Dialogfeld die Optionen (2) und (3) verfügbar. Damit wird die Dichte der schwarzen und weißen Pixel festgelegt. Im

nachstehenden Beispiel wird eine Transparenz von 50% für die weißen Pixel verwendet.

Klicken Sie auf die Schaltfläche für die zusätzlichen Optionen, um das Dialogfeld für Kachelfüllung zu öffnen und ein anderes Transparenzmuster

anzuwenden.



335EasySIGN

Bei der gewählten Bitmap werden Graustufen verwendet; deshalb sind die Optionen (2) und (3) nicht mehr verfügbar.

Sie können die Optionen direkt auf dem Bildschirm oder über das Dialogfeld für Kachelfüllung ändern.



336 EasySIGN

Links wird eine Gruppe komplexer Objekte ohne Transparenz und rechts dieselbe Gruppe mit Transparenz angezeigt.

Transparenz kann auch auf eine Kombination aus Bitmap- und Vektorobjekten angewendet werden.

4: Transparenz bei Bitmaps mit Alpha-Channels

EasySIGN unterstützt nicht nur den Import von Bitmaps mit Alpha-Channels, sondern ermöglicht es Ihnen auch, Alpha-Channels selbst zu

erstellen.  Ein Alpha-Channel kann von jedem nur denkbaren Objekt aus erstellt  werden.

Importieren Sie zuerst eine Bitmap. Dies kann eine Bitmap ohne Alpha-Channel sein.
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Erstellen Sie anschließend eine einfache Mischung zwischen zwei Rechtecken unterschiedlicher Breite. Diese Mischung muss nicht auf der Bitmap

platziert  werden, sondern kann sich an einer beliebigen Stelle des Arbeitsblattes befinden.

Markieren Sie die Bitmap, und klicken Sie im Menü "Bitmap" auf "Transparenz" und dann auf "Wählen". Der Mauszeiger ändert seine Form;

wählen Sie damit die Mischung aus.

1 Position

Unverändert

Diese Option kann verwendet werden, wenn sich die Objekte für den Alpha-Channel bereits an der richtigen Position auf

der Bitmap befinden.

Fit (Angepasst)

Mit dieser Option werden die markierten Objekte für den Alpha-Channel an die Breite und Höhe der Bitmap angepasst.

Ausrichten

Mit dieser Option werden die markierten Objekte für den Alpha-Channel an der Bitmap ausgerichtet. Dazu wird die in

der Ausrichtungspalette getroffene Auswahl verwendet.
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2 Vorschau

Mit dieser Option wird eine Vorschau des Endergebnisses angezeigt; Sie können zwischen "Vorher" und "Nachher"

wählen.

3 Anfangsfarbe für Alpha-Channel

Mit dieser Option wird das Verhalten des Alpha-Channels für die Stelle festgelegt, an der er von keinen Objekten bedeckt

ist . Sie können zwischen Schwarz und Weiß wählen.

4 Kombinieren

Invertieren

Mit dieser Option werden alle weißen Objekte in schwarze und alle schwarzen Objekte in weiße Objekte umgewandelt und

so die Transparenz effektiv umgekehrt. Außerdem werden Grauwerte berücksichtigt.

Ersetzen

Auf den Alpha-Channel kann eine unbegrenzte Anzahl von Objekten angewendet werden; wenn Sie jedoch diese Option

aktivieren, werden alle vorhandenen Alpha-Channels durch die aktuelle Auswahl ersetzt.

Hinzufügen

Wenn ein Alpha-Channel bereits vorhanden ist , ermöglicht es Ihnen diese Option, ihm die aktuelle Auswahl

hinzuzufügen.

Entfernen

Wenn ein Alpha-Channel bereits vorhanden ist , ermöglicht es Ihnen diese Option, die aktuelle Auswahl aus ihm zu

entfernen.

Überschneidung

Wenn ein Alpha-Channel vorhanden ist , wird er durch die aktuelle Auswahl überschnitten.

5 Verschiedenes

Gewählte Objekte entfernen

Mit dieser Option wird die aktive Auswahl entfernt, nachdem sie auf den Alpha-Channel angewendet wurde.

Glättung

Mit dieser empfohlenen Option werden 'T reppeneffekte' im Alpha-Channel vermieden. Wenn Sie nur horizontale und

vertikale Objekte (wie Rechtecke) verwenden, kann diese Option deaktiviert werden.

Ein weiteres Objekt wählen (1)

Wenn diese Option aktiviert  ist¸ kann ein weiteres Objekt für den Alpha-Channel direkt nach dem Klicken auf "OK"

gewählt werden.

Objekt(e) jetzt anwenden

Diese Option ist  verfügbar, wenn Sie "Ein weiteres Objekt wählen (1)" aktiviert  haben. Zuerst wird die aktuelle Auswahl

angewendet, bevor eine neue Auswahl getroffen werden kann.

Im nachstehenden Beispiel werden für den Alpha-Channel die folgenden Optionen gewählt:

1 Fit (Angepasst)

2 Weiß

3 Invertieren/Ersetzen

5 Glättung

Zeichnen Sie eine Ellipse, markieren Sie die Bitmap, und klicken Sie im Menü "Bitmap" auf "Transparenz" und dann auf "Wählen".

Klicken Sie auf die folgenden Optionen:



339EasySIGN

1 Fit (Angepasst)

2 Weiß

3 Invertieren/Hinzufügen

5 Glättung

Im Dialogfeld "Transparenz" des Menüs "Bitmap" stehen die folgenden Optionen zur Verfügung:

Anzeigen

Mit dieser Option wird die Verwendung des Alpha-Channels aktiviert  bzw. deaktiviert.

Invertieren

Mit dieser Option wird die Transparenz umgekehrt.

Schneiden

Mit dieser Option wird die Bitmap unter Verwendung der Begrenzungen des Alpha-Channels weitmöglichst verkleinert.

Wählen

Lesen Sie dazu die ausführliche Beschreibung weiter oben.

Abtrennen

Mit dieser Option wird der Alpha-Channel von der Bitmap abgetrennt.

Sie können auf diese Optionen auch über das Kontextmenü der Bitmap zugreifen.

Transparenzeinstellungen

Wenn Sie Transparenzformate drucken oder in andere Anwendungen exportieren möchten, überprüfen Sie dazu die Einstellungen. Klicken Sie im

Menü "Datei" auf "Einstellungen" und dann auf die Registerkarte "Ausgabe". Es wird das Gruppenfeld "Transparenz/Musterfüllung" mit den

folgenden Optionen angezeigt:

Berechnen als: RGB oder CMYK

Diese Option legt fest, ob die Transparenz als RGB oder als CMYK berechnet werden soll. Wenn Sie die

exaktesten Ergebnisse benötigen, klicken Sie auf "CMYK".

Auflösung DPI

Die optimale Einstellung ist  300 DPI. Bei großen Arbeitsblättern, wie denen für großformatiges Drucken,

genügt jedoch eine niedrigere Auflösung von 72 DPI. Dies gilt  insbesondere dann, wenn das Ergebnis über

eine größere Entfernung angezeigt wird, wie z. B. bei einer Reklametafel.

Vollständige

Überschneidung

als Bitmap

Wenn diese Option aktiviert  ist , wird die Transparenz optimal angewendet. Wenn die Option nicht

verwendet wird, können Farbunterschiede in komplexen Arbeitsblättern auftreten, in denen verschiedene

transparente Objekte einander überlappen.

Glättung Diese Option ermöglicht die beste Vorschau von Transparenz; die Ergebnisse werden geglättet. Wenn Sie die

Option nicht verwenden, kann es zu 'T reppeneffekten' kommen.

Die Transparenz in EasySIGN wird mit maximaler Genauigkeit berechnet, um die höchstmögliche Qualität beim Export in andere Formate zu

gewährleisten. Allerdings wird die Darstellungsgeschwindigkeit beeinträchtigt, wenn ein Arbeitsblatt  viele transparente Objekte enthält . In diesem

Fall können Sie die erforderliche Zeitspanne verkürzen, indem Sie beispielsweise eine niedrigere Exportauflösung wählen.
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Compatibility

Compatibility-Setup
C o m p a t i b i l i t y - S e t u p

Die Installation von "Compatibility" für jedes unterstützte Programm erfolgt während des Setups von EasySIGN. Dabei können Sie wählen, für

welches Programm "Compatibility" installiert  werden soll.

Nach der Installation

Sie können "Compatibility" über "Start, Programme, EasySIGN" oder direkt aus EasySIGN über das Menü "Datei, Compatibility" starten. 

Arbeiten mit “Compatibility”
A r b e i t e n  m i t  “ C o m p a t i b i l i t y ”

Klicken Sie in "EasySIGN" im Menü "Datei" auf "Compatibility", um das gewünschte Programm zu starten.

In der Windows™-Taskleiste wird ein Symbol angezeigt, und das ausgewählte Programm (in diesem Beispiel CorelDRAW™ 8) wird gestartet.

Wenn das gewünschte Programm nicht gestartet wird oder eine Meldung angezeigt wird, dass das Programm nicht gefunden wurde, starten Sie das

Programm manuell und dann "Compatibility".

Jedes Symbol für eine unterstützte Software weist eine andere Farbe auf. Das Symbol ist  nur sichtbar, wenn das ausgewählte Programm gestartet

wurde.

Nach dem Klicken auf das Symbol wird das folgende Menü angezeigt:

1 Abbrechen

Schließt das Menü.

2 Schließen

Schließt das Programm "Compatibility".

3 Wechseln zu EasySIGN

4 Sprache auswählen

5 Sign Center (nur in Kombination mit CorelDRAW™). Dieser Teil wird weiter unten erläutert.

6 Exportieren

Überträgt das aktive Arbeitsblatt (oder die aktive Bitmap) direkt in EasySIGN.

Ausnahmen
Bei Verwendung von Macromedia Freehand™ wird in der Taskleiste kein Symbol angezeigt. Die Verknüpfung zwischen EasySIGN und diesem

Programm erfolgt über das Menü "Xtras", "EasySIGN", "Exportieren".

In jedem Programm sollte ein zusätzliches Menü sichtbar sein. So bietet Adobe Illustrator™ beispielsweise die Möglichkeit zum Exportieren nur

ausschneidbarer Objekte.

Vektorsoftware

Wenn Sie "Compatibility" mit z. B. Illustrator™ oder CorelDRAW™ verwenden, wird eine Kopie des aktiven Arbeitsblattes optimiert, bevor sie
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in EasySIGN exportiert  wird.

Bitmap-Software

Wenn Sie "Compatibility" mit z. B. Photoshop™ oder Corel PhotoPAINT™ verwenden, wird eine Kopie der aktiven Bitmap optimiert, bevor

sie in EasySIGN exportiert  wird.

Einstellungen in CorelDRAW™

Wenn Sie CorelDRAW™ installiert  und die Exportfunktion für das Format Adobe Illustrator (.AI) nie zuvor verwendet haben, müssen Sie diese

Funktion einmal manuell ausführen, um die CorelDRAW™-Exportfilter zu initialisieren. Der Speicherort für den Export oder der Inhalt des

Arbeitsblattes ist  dabei bedeutungslos. Der manuelle Export muss nur einmal erfolgen.

Allgemeine Einschränkungen

Verwenden Sie niemals mehr als jeweils eine Instanz eines unterstützten Programms. Wenn z. B. zwei Instanzen von CorelDRAW™ 10 geöffnet

sind, kann nicht garantiert  werden, dass "Compatibility" funktioniert.

Einschränkung für Adobe™-Produkte

Es können nicht zwei verschiedene Versionen desselben Produkts gleichzeitig ausgeführt werden. So ist  es beispielsweise nicht möglich,

Illustrator™ 9 und Illustrator™ 10 zur selben Zeit auszuführen, wenn "Compatibility" für diese Produkte verwendet wird.

Gravur & Fräsen

Allgemein
A l l g e m e i n

Das Fräsmodul von EasySIGN enthält alle 2.5D-Arbeitsverfahren. Beim Plotten werden nur 2D-Informationen
verarbeitet. Bei 2.5D wird eine zusätzliche Tiefe hinzugefügt. 2.5D eignet sich allgemein für Gravuren, Fräsen oder
sogar für eine spezielle Anwendung. Es folgt eine kurze Erläuterung der einzelnen Begriffe.

Gravur
Hierbei werden Texte und Logos aus einem Material geschnitten. Diese Schnitte sind in der Regel nicht sehr tief und
durchdringen das Material nie. Zahlreiche Gravurmaterialien haben eine obere Ebene in einer anderen Farbe, wobei
nach dem Schnitt die darunter liegende Ebene angezeigt wird. Einige Beispiele sind Name-Tags und Type-Tags.

Fräsen
Beim Fräsen wird das Material durchschnitten. Das Fräsen beinhaltet auch das teilweise Entfernen von einem Material.

Ein Kurvenobjekt enthält genügend Informationen für einen Plotter. Für eine Gravur werden weitere Informationen
benötigt. Diese zusätzlichen Informationen werden "Produktionsstil" genannt. Sie können diesen Produktionsstil mit
einem beliebigen Vektorobjekt verknüpfen. Dieser Produktionsstil enthält unter anderem den Füllstil, die Tiefe und die
Geschwindigkeit. Für das Fräsen werden auch zusätzliche Informationen benötigt. Es ist beispielsweise von
Bedeutung, ob die Innenseite, die Außenseite oder die Geschwindigkeit bearbeitet werden soll. Diese Informationen
sind auch im Produktionsstil enthalten. 

Einen Produktionsstil anwenden
Es gibt zwei Möglichkeiten, um einen Produktionsstil zu einem Objekt zuzuweisen: manuell oder über einen
Assistenten.

Manueller Produktionsstil
Wählen Sie ein Vektorobjekt (das auch ein Textobjekt sein kann), und klicken Sie anschließend auf das Symbol für
den Produktionsstil.

Es wird folgender Ausschnitt angezeigt:
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Wählen Sie die erste Option (1).

1 Durchgänge
Jeder Produktionsstil besteht aus mindestens einem Durchgang. In vielen Fällen ist nur ein Durchgang
ausreichend. Bei einem dickeren Material sind jedoch mehrere Durchgänge erforderlich. Die verschiedenen
Durchgänge werden unter (1) angezeigt. Nachdem Sie einen dieser Durchgänge ausgewählt haben, werden im
Dialogfeld die Einstellungen für das ausgewählte Element angezeigt.

2 Durchgangstyp

A Durchgangstyp
Dieser bestimmt den Typ für den Durchgang. Jeder Typ erfüllt einen bestimmten Zweck. Mit
diesen Einstellungen bestimmen Sie, wie mit der Form verfahren werden soll. 

Linie
Ein Liniendurchgang folgt den Begrenzungen des Originalobjekts.

Außen
Dieser Durchgang wird an der Außenseite der Form ausgeführt. Das Ergebnis ist hierbei die
tatsächlich gezeichnete Form.
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Innen
Dieser Durchgang wird an der Innenseite der Form ausgeführt. Die tatsächliche Form wird
hierbei aus dem Material entfernt.

S-Füllung
Dieser Durchgang entfernt die Innenseite der Form und folgt einem S-förmigen Pfad durch das
Material. Die Form wird nur bis zu einer bestimmten Tiefe aus dem Material entfernt.

Linienfüllung
Die Form wird mit einer Gruppe aus geraden Linien gefüllt, die für Laser und andere Verfahren
geeignet sind, bei denen eine starke Hitzeentwicklung problematisch ist.

Linienfüllung, sortie rt
Identisch mit der Linienfüllung. Das Werkzeug wählt hierbei jedoch den kürzesten Pfad.

Inse lfüllung
Die Form wird von der Außenseite zur Mitte in konzentrischen Kreisen vollständig ausgehöhlt. 

B Winkel
Der Winkel der Fülllinien.

C Füllüberlappung
Die Größe der Überlappung, in der die sequenziellen Linien übereinander abgebildet werden.

D Rand
Der Abstand von der Außenseite einer Füllung zur Innenseite einer Form.

3 Werkzeug

A W erkzeug
Hierbei handelt es sich um ein Werkzeug aus der Bibliothek, die für diesen Durchgang
verwendet wird.
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B Tie fe , G eschwindigke it und Motorgeschwindigke it
Diese Optionen werden in der Regel in den Geräteeinstellungen festgelegt. Diese allgemeinen
Einstellungen können hier pro Form überschrieben werden. Führen Sie diesen Vorgang jedoch
nur aus, wenn sich eine Form von den Standardeinstellungen ableitet.

4 Vorlauf

Vorlauf
Wenn Sie eine Form fräsen, sollte das Werkzeug nicht an einer Kante der Form abgelegt
werden. Dadurch können kleine Verbeulungen entstehen. Durch den "Vorlauf" wird der
Durchgang von einer sicheren Position innerhalb oder außerhalb der Form gestartet und
anschließend zum Anfang geführt. 

Diese Option kann auch bei weichen Materialien verwendet werden. Wenn Sie für den Vorlauf
die Option "Nach Möglichkeit" festlegen, vermeiden Sie Verbeulungen an den Stellen, an denen
das Werkzeug langsamer ausgeführt wird. 

Produktionsstil über den Assistenten festlegen
Der Werkzeugpfadassistent unterstützt Sie bei der Führung bei einem komplizierten Werkzeugpfad. Dieser Assistent
enthält verschiedene Verfahren für Werkzeugpfade, die häufig angewendet werden. Sie können diesen Assistenten
über die Hilfsmittelpalette oder aus dem Dialogfeld für die Werkzeugpfadoptionen aufrufen.
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Der Assistent fragt Sie nach der gewünschten Vorgehensweise und veranschaulicht die Optionen durch entsprechende
Abbildungen. Beantworten Sie diese Fragen, und klicken Sie so oft auf "Weiter", bis die Schaltfläche "Übernehmen"
angezeigt wird. Wenn Sie den Assistenten über die Hilfsmittelpalette aufgerufen haben, wird der Werkzeugpfad auf
das ausgewählte Objekt angewendet. Wenn Sie den Assistenten im Dialogfeld für die Werkzeugpfadoptionen geöffnet
haben, wird der Werkzeugpfad in die Liste des Dialogfelds aufgenommen.

Werkzeugbibliothek
Sie können in diesem Dialogfeld eigene Werkzeuge definieren. Klicken Sie im Menü "Datei" auf "Werkzeugbibliothek".
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1 Werkzeugbibliothek
 Hier werden alle Werkzeuge angezeigt. Wenn Sie ein Werkzeug auswählen, können Sie dessen Einstellungen

unter "Werkzeugeigenschaften" (2) ändern.

2 Werkzeugeigenschaften

A Die Breite am Ende des Werkzeugschafts. Wenn der Schaft eine einheitliche Breite hat, ist
diese Option deaktiviert.

B Die Breite an der Werkzeugspitze.

C Die maximale Tiefe, die das Werkzeug in das Material eindringen kann.

D Der Winkel der Werkzeugspitze.

E Hier können Sie dem Werkzeug eine Farbe zuweisen. Die Werkzeugfarbe wird im Arbeitsblatt
als Unterscheidungsmerkmal für die jeweiligen Werkzeuge angezeigt.

3 Hier können Sie ein Werkzeug in die Bibliothek aufnehmen oder daraus entfernen. 
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Add an Engraver/Router
A d d  a n  E n g r a v e r / R o u t e r

To add an Engraver/Router select the menu 'File > Device Setup > 'Add Router Wizard...'.

Select from the dropdown for drivers (1) the desired device. Click 'Next'.

Select from the dropdown for Ports (1) the Port your device has been connected to. Click 'Next'.
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How this page will look depends on the selected Port from the previous page. On this page make your settings
according the manual supplied with your device.

To finish the installation of your device, click 'Finish'.
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Gerät einrichten
G e r ä t  e i n r i c h t e n

Select the menu 'File > Device Setup > Open...'. The following Window will become visible.

On the left open the folder 'Router/Engraver Settings' and click on 'Router/Engraver Setting 0'. On the right the
available Router/Engraver settings will become visible.

Es werden vier Symbole angezeigt. Wenn Sie auf eines der Symbole doppelklicken, wird ein Dialogfeld mit den
entsprechenden Einstellungen angezeigt.

A Sortierung und Optimierung

1 Kein Sortiervorgang
 Der Entwurf wird in der Reihenfolge graviert/gefräst, in der dieser gezeichnet wurde.
2 Geschwindigkeit
 Die Anordnung der Objekte wird entsprechend der optimalen Geschwindigkeit angepasst.
3 Vinyl
 Die Anordnung der Objekte wird entsprechend der optimalen Geschwindigkeit angepasst.

B Standardparameter
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1 Gleithöhe
 Die Höhe über dem Material mit Werkzeugbewegungen.
2 Sinkgeschwindigkeit
 Die Geschwindigkeit, mit der das Werkzeug in das Material eindringt.
3 Werkzeuggeschwindigkeit
 Die Geschwindigkeit, mit der das Werkzeug bewegt wird, wenn keine Materialberührung stattfindet.
4 Beschleunigung
 Die maximale Beschleunigung des Werkzeugs. Diese Einstellung ist besonders bei Ecken und Kanten von

Bedeutung.

C Standardparameter pro Objekt

Diese Einstellungen werden aktiv, wenn im Dialogfeld für die Werkzeugpfadoptionen für Werkzeugpfade keine
eigenen Einstellungen festgelegt sind. Dies ist der Fall, wenn die Option "Standardeinstellungen verwenden"
deaktiviert ist.

1 Tiefe
 Die Werkzeugtiefe.
2 Geschwindigkeit
 Die Geschwindigkeit für den Gravur- oder Fräsvorgang.
3 Werkzeugmotor
 Die Werkzeugumdrehungen pro Minute.

D Werkzeugzuordnung
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Sie können die Nummer und Position eines Werkzeugs festlegen, wenn Ihre Maschine mit einem Werkzeugwechsler
ausgestattet ist. Die Software wählt das geeignete Werkzeug während eines Auftrags aus.

Anzeigeeinstellungen
A n z e i g e e i n s t e l l u n g e n

Es wurden speziell für Gravur- und Fräsvorgänge zwei neue Anzeigeeinstellungen hinzugefügt.

Die Einstellung "Werkzeugpfad", die Sie im Menü "Ansicht" über den Befehl "Qualität" aufrufen können, gibt den
Werkzeugpfad und die Drehrichtung an.
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Die Einstellung "Pfad & Breite", die Sie im Menü "Ansicht" über den Befehl "Qualität" aufrufen können, gibt den
Werkzeugpfad und die Breite des Werkzeugs an. Hier können Sie überprüfen, ob das Werkzeug und die Fülltypen für
den Auftrag geeignet sind.

EasySIGN Print Server

EasySIGN Print Server, before you start
E a s y S I G N  P r i n t  S e r v e r ,  b e f o r e  y o u  s t a r t

Before you can start printing with the EasySIGN Print Server, either as stand-alone or as a supplement to EasySIGN,
you have to make some settings. In the following chapters we will explain what each setting does. Before you read
the following chapters, please work through the "Getting Started". As a prerequisite, you have to finish all the steps
that are explained in that manual. The "Getting Started" teaches you the basics of the EasySIGN Print Server. Also all
the necessary license tickets must have been entered, which is also explained in the "Getting Started".

We really can't emphasize enough that you have to finish the "Getting Started" to be able to understand the following
chapters. The EasySIGN Print Server is very easy to use, but you will have to gain some basic understanding first.

Note
If you've downloaded this software as a TryBuy, you can also download the "Getting Started" as a PDF file from the
download menu of http://www.easysign.com.

First use and Main screen
When you start the EasySIGN Print Server for the first time, the main screen will become visible, it will look
something like below. It might happen that you get a Wizard that asks you for a ticket. If so, please refer to the
“Getting Started” that came with the software. 
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Also, if you do not have a printer installed yet, a Wizard will come up to guide you through the procedure of installing
it. This wizard is described in the getting started and this manual assumes you have already installed a printer.

The components of this main screen are as follows. A more detailed explanation of each window will follow in the next
chapter.

Current jobs (A)
In this window all jobs will be placed that have been added, either by using a Hotfolder or by adding it manually. The
list will show a small preview for every job, as well as its name and some extra information. From this list, jobs can
be edited as well as dragged and positioned onto the prints.

Archived Jobs (B)
Once a job has been printed, it will be moved automatically to the archived jobs. This list behaves similarly to the
‘current jobs’ list, so you can place jobs, edited them and remove them. Only the name of the list, ‘Archived jobs’
signifies that the jobs have been printed already.

Installed Devices (C)
In this list, all installed printers will be shown, and you can edit every detail. A printer that is busy will shown a red
line through it, which means that the device cannot be edited at that moment.

Hotfolders (D)
A Hotfolder is a directory that is monitored by the software for files to be printed. By moving a file directly into this
directory, a new job will be created along with some default settings.

Logbook (E)
In the logbook, all significant events that occur in the print server will be shown, like starting and finishing a print, and
any error messages that might occur. The logbook has the option of being e-mailed to any mail account, enabling you
to monitor the progress from a remote location.

Print preview (F)
The most important part of the print server is the print preview which occupies the middle of the screen by default.
This preview shows an empty roll of material, ready for placement of jobs.

Print Properties (G)
This is where most of the interaction with the print server takes place. Here you will set the width and height of the
material, the stacking, start the print etc.
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User interface
U s e r  i n t e r f a c e

The user interface and placement of any window is customisable. Any window can be docked almost anywhere,
simply by clicking on its name, and dragging it to the desired position. By double-clicking on a docked window, it will
be floated above other windows. To dock a floating window, simply drag its title bar to another position. The window
placement will be shown by a blue, semitransparent box, and if it is to your liking, just release the mouse button to
dock the window.

Any Window can have the following situation: 

Floating The window is positioned over other windows, obscuring the underlying interface.
Double click the title of any window to float it.

Docked The window is positioned next to other windows. Drag any window by its title bar to
position it, a blue transparent box will show where it will be docked.

Auto Hide The window will be shown by a tab with its name on the left side of the main
window. By hovering the mouse over this tab, the window will be shown. To use this
feature, click the pin symbol in the title bar.

Hide A window can be closed by clicking the cross in its title bar. To re-enable it, use the
main menu "View > Toolbars" to re-check the menu item.
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It is also possible to change the entire look and feel of the windows in the print server. To do this, use the main menu
command "View > Icon style" and "View > Application look".

And if this does not provide you with enough customization options, you can now also customize the main menu and
toolbars. To do this, right-click the area to the right of the menu, and choose ‘Customize...’ The following dialog will
appear:

Through the tabs in this menu you can customize all menus and toolbars, or even create new ones to your liking. This
manual will not describe every option in detail, feel free to experiment until the interface is to your liking. Most tabs
have a ‘reset all’ button that will restore the original situation.

Working with jobs
W o r k i n g  w i t h  j o b s

The first thing to do when printing something is to add jobs. A job is a single file, like a PDF, JPEG or TIFF file. It has
many properties, which we will discuss in this chapter.

Adding a job
A job can be added in three different ways: by dragging it onto the job list, through the menu item "File > Add job", or
through a hot folder. Hotfolders will be discussed later on, in a separate chapter. 

To drag a file from the Windows explorer to the print server, simply drag and drop it onto the ‘job list’ or ‘Archived job
list’, like shown here:
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Or, click the main menu and go to "File > Add Job". Then, browse to the file you want to print and click it.

After a file has been added, a job will appear for it in the job list. The print server will then start to create a preview
for it, and collect some information like the size of the job and the number of pages.  It might be that the job does not
display a preview right away, as this process takes some time on larger jobs. During previewing, the job cannot be
edited, so please be patient.

After a while, the job will show ‘ready for printing’, and it will then be editable. To edit the job double-click it, or click
the edit icon.

which will show the following dialog:
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Options

A Nr of copies
How many times the current job should be repeated on the print.

B Print extra info
Select yes if you want extra info on the final print. This prints the setting, device, etc. at the bottom of
the print.

C Print cropmarks
Selecting Yes enables cropmarks on the final print.

D Cropmark type
Choose form ‘cropmarks’, ‘cropmarks and swatch bar’, or ‘Rulers’. If you are using paneling, you
should select ‘Rulers’, which will help you align the panels.

E Cropmark size
The size, around the print, of the printed cropmarks.
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Size  -  R o ta tion

A Width
The width of the current job in units. To change, type a number or use the spin buttons.

B Height
The height of the job in the currently active units.

C Width scale
The current width as a percentage of the original file size.

D Height scale
The current height as a percentage of the original file size.

E Scale proportionally
When ticked, the width and height of the job change proportionally.

F Rotation
Select the desired rotation in 90 degree steps from the combo box.

E Cropmark size
The size, around the print, of the printed cropmarks.
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Pa ne ling

A Paneling type
You can choose between ‘None’ and ‘User defined’, User defined switches the paneling to on.

B Number of panels
By changing this number, the job will automatically be divided in the specified number of panels.

C Carriage Panel size
Vertical panel line(s) in the preview. Type the positions where you want the panel lines to appear, for
example ‘50 100 150’.

D Carriage panel overlap
The overlap of the panels, these can also be negative. You can enter one value, which sets the overlap
for all panels, or multiple values if you want different overlaps. If you enter nothing or ‘0’ there will be
no overlap.

E Roll Panel Size
The position(s) of the panel lines in the roll direction.

F Roll panel overlap
The overlap of the panels in the roll direction.

G Active panels
If empty all the panels will be printed. When you enter one or more panel numbers separate by e white
space only these panels will be printed.

H Paneling In the preview window
You can manually add or remove panels by pressing the right mouse button in the preview window and
selecting a horizontal or vertical panel line from the menu. A double click will add a carriage panel line,
if you hold down the SHIFT key before double clicking, a roll panel will be added.

E Cropmark size
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The size, around the print, of the printed cropmarks.

Co lo r  co rre ction
All the different color corrections will be applied on top of the color management. As with all settings, you can see the
result in the preview window. This might take a few seconds, especially when the job file is large.

A Brightness
The brightness of the job, ranges from -100 to +100.

B Contrast
The contrast of the job, ranges from -100 to +100.

C Saturation
The saturation of the job, ranges from -100 (no color at all) to +100 (very bright color).

D Hue
The hue (color shift) of the job, ranges from -180 to +180.

E Color temperature
The temperature (‘warmth’) of the job, ranges from -4000K (very warm) to +4000K (very cold).

F Grayscale
Tick this box if you want the entire job to output in grayscale.

E Cropmark size
The size, around the print, of the printed cropmarks.
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Input ICC pro file
The following settings are color management related, and this manual is not intended as a complete guide. For a more
complete explanation of color management, see also the document “Calibration training”.

A CMYK bitmap input profile
A combo box from which you can select the desired input profile for CMYK bitmaps. All profiles on your
system, including the profiles from the EasySIGN "Shared" directory, are listed here.

B RGB bitmap input profile
A combo box from which you can select the desired input profile for RGB bitmaps.

C Grayscale bitmap input profile
A combo box from which you can select the desired input profile for Grayscale bitmaps.

D Bitmap render intent
The render intent for bitmaps. You can choose from the following:

Pe rce ptua l
All colors in a device’s gamut will be scaled to the output gamut, keeping the relation between the
colors intact. This method is recommended for reproducing scanned or imported bitmaps.

R e la tiv e  co lo r im e tr ic
This method will leave colors that fit into both gamut’s intact. Colors outside of the gamut of the output
device will be adjusted to fit, preserving brightness and color at the expense of saturation. This method
is preferred if accurate color representation is necessary, for example when printing spot colors.

Sa tura tion
Scales the source gamut to the destination gamut but preserves relative saturation instead of hue, so
when scaling to a smaller gamut, hues may shift. This rendering intent is primarily designed for
business graphics, where bright saturated colors are more important than the exact relationship
between colors.
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Abso lute  co lo r im e tr ic
Absolute colorimetric rendering reproduces in-gamut colors exactly, and clips out-of-gamut colors to
the nearest reproducible hue, sacrificing saturation and possibly lightness. This method also takes the
color of the paper into account when printing.

E Color manage CMYK bitmaps
Whether or not CMYK bitmaps should be color managed.

F Use embedded profiles when available
Whether or not you want to use the profile that was included in the source file for a job.

G CMYK vector input profile
A combo box from which you can select the desired input profile for CMYK vector data.

H RGB vector input profile
A combo box from which you can select the desired input profile for RGB vector data.

I Grayscale vector input profile
A combo box from which you can select the desired input profile for Grayscale vector data.

J Vector render intent
The render intent for vector data, see the description under "Bitmap render intent" for
the available types.

K Color manage CMYK vector
Whether or not CMYK vector data should be color managed.

L Suppress dirty Cyan
If enabled, dirty cyan is suppressed. use this if you want cyan to be printed as cyan, even after color
managing.

M Suppress dirty Magenta
If enabled, dirty magenta is suppressed.

N Suppress dirty Yellow
If enabled, dirty yellow is suppressed.

Working with Hotfolders
W o r k i n g  w i t h  H o t f o l d e r s

First of all what is a Hotfolders? A Hotfolder is a directory on your hard disk or network that represents a set of default
settings. By copying a job into a Hotfolder, the new job will be set up the same way as the Hotfolder, and then it will
be added to the job list, ready for printing. So if want to set up a way to print something that is always mirrored, or at
200% by default, a Hotfolder would be the way to do it.

Also, if you want to print something directly from the EasySIGN design software to the Print Server, a Hotfolder is
necessary to store the exported print job.

Adding a Hotfolder
To add a Hotfolder, first you have to find the window labeled Hotfolders. If it is not visible, just go to "View >
Toolbars" and make sure that ‘Hotfolders’ is ticked.

The Hotfolders window has the usual three-button icons, to add, remove and edit the Hotfolders that have been set.
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By clicking the ‘add’ button, a wizard will come up that guides you through the
process of installing a new Hotfolder.

Step 1. Choosing a device and a setting
Any Hotfolder will mark the incoming files with a device and setting, meaning that the jobs are intended to be printed
on the selected device and setting.

Please be aware that a Hotfolder is just a set of defaults. Any job that comes in through the Hotfolder, gets the same
setting but everything can be changed of course before committing to printing.

Check that you have chosen the correct printer and setting, and click ‘Next’ to continue. In the next page of this
Wizard, there is one important setting, the ‘Root directory’. You should choose one root directory and place all hot
folders in it. The root directory can then be shared over the network, for other computers to use.
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There are some extra settings to be made in this dialog:

A Input file processing
When you place a file in a Hotfolder it will be processed. When processing is done, you can choose
whether to remove the file or move it to a subdirectory called ‘Processed’ or ‘Error’.

B Job Processing
When a job has been printed, you can choose whether you want to keep it in the Archive. The following
choices exist:

R e m ov e
When the job has been printed, it will be removed immediately.

Archiv e  a s  spa ce  a llows
The job will be put in the archive, but it will be removed automatically if the software runs out of disk
space.

Archiv e  inde fin ite ly
The job is kept in the archive until removed by the user.

When you click ‘Finish’, your Hotfolder will be added and it will shown in the list.

Setting up Hotfolders
Every hot folder can have its own default settings, making it very easy to create Hotfolders, not only for every type of
material, but even for customer based hot folders. 
Make the default settings once, give it an appropriate name, very handy for returning jobs. Remember that these
settings are only defaults: an incoming job can always be changed before printing it. 

Editing the settings of a Hotfolder can be done in the following way: select the
Hotfolder itself, then click the ‘edit’ icon in the top of the toolbar.

The following dialog will appear:
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On the left side of the dialog are three icons that activate the following three tabs:

Hotfolder properties

A Name
The name and directory of this Hotfolder. You should change the name in something meaningfull.

B Folder
The actual directory that gets monitored for new files coming in. You can change this directory by
clicking the ‘Browse’ button on the right.

C Folder is active
Activates or de-activates the Hotfolder.

D After rendering
For some files, the RIP will render them, after which the original file will no longer be necessary, and
can be removed. Use ‘remove’ if you copy original files into the Hotfolder. Use ‘Move to processed’ if
you want to keep the original files for some reason. The file will then be moved to the ‘Processed’
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directory which is created in the Hotfolder directory.

E If an error occurs
Same as above, except the input file will be moved to the ‘error’ directory or deleted if it generates an
error while rendering.

F Job processing
When a job has been printed, it will be automatically moved to the job archive, where it will stay.

G Output settings
The default printer and setting that this job is meant to be printed with.

H Nr of copies
Number of times the job will be placed when dragged onto a print.

Sizing and paneling
This page gives you the opportunity to set up an incoming job for the correct size and paneling options. These settings
are similar in their function to the settings on an individual job, so please refer to the previous chapter on working
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with jobs for a more elaborate description.

Input profiles and color management
Again, these settings are the default settings for color management on the jobs that come in on this Hotfolder. As they
are similar to the settings on an individual job, please refer to the previous chapter on jobs for a detailed description
on how they work.

After pressing "OK" the Hotfolders tab will look like below:
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Working with prints
W o r k i n g  w i t h  p r i n t s

This is where it all comes together: a print is the centre where you place the individual jobs, arrange them, and send
them to your printer. The prints are shown like below:

A Print view
This view shows the print as it is going to come out of your printer: a long roll of material, which is
empty for now. To place jobs, you can simply drag them from the job list onto the print. If the job has
paneling activated, this will automatically show when dragging the job.

The print view has a number of drag able items itself:

Ma te r ia l s ize (B)
By dragging the small arrow on the lower right of the print view, the material size can be adjusted.

Ma rg ins (C)
The front end of the material, as well as the left and right side, can be dragged to set a margin. This
margin will be used when automatically placing items with the ‘stacking method’ option enabled.

Viewing around the print view can be done with the scrollbars around it, or by using the toolbar above it. The function
of the individual buttons are: 
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Wireframe
Shows placed jobs as a wireframe, with information as text.

Filled
Shows the jobs as a color preview.

Zoom sheet
Shows the entire length of the print, including empty space.

Zoom front
Shows the first side of the print, zoomed to maximum width.

Zoom jobs
Shows everything (every job) that has been placed on the print.

Select mode
Click this button to be able to select and move jobs.

Zoom in
Click this button, then drag across the print view to zoom to a specific area.

Zoom out
This button instantly zooms the view out by a predetermined amount.

Drag view
Activate this button, then click and drag to move the print view.

There can be an unlimited amount of individual prints at the same time, which enables you to work on a new print
while a previous one is processing. To do this, look at the top of the print where you will find a tab bar with the name
of your current print.

After adding a new print, just click back and forth between them to bring them to the front. The X in  prints name lets
you close and delete them, of course this will only work if the print is not being processed just yet.

When you create more than a few prints, they cannot be displayed all at the same time. In that case, a small arrow
on the right shows a menu of all available prints.

Print properties bar
On the right side of the print view you will find a large toolbar which enables you to control the active print. It has the
following options:
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A Device
The specific printer that this print will appear on.

B Setting
The setting you want to use for this device.

C Device mode
There are five different device modes available, hover the mouse over the icons to see a description:

Pr int

This is the default, it only prints even if cutline's are available.

Pr int a nd  cut

Immediately after printing, the job is also cut. Only available on Print & Cut hybrid machines.

Pr int & cut –  pr int only
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This will print a job with cropmarks, ready to be re-inserted on cut. Available on Print & Cut hybrid
machines only, and used in case you would want to laminate a Print & Cut job before cutting it.

Pr int & cut –  cut only

This will cut a print & cut job on a hybrid machine.

Cut only

This cuts a job on a hybrid print & cut machine without printing anything.

Be aware that the Print & Cut modes are only used on hybrid machines, meaning printers with an
integrated cutter. Please refer to the manual that can with the printer for the correct workflow.

Print & Cut workflows that use a separate cutter and printer can of course also be processed, however
the print server treats these as a normal print job (with crop marks of course) and they would be
printed in the default ‘print’ mode.

D Roll width/length
The size of the material in the printer. This size can also be changed by dragging the small black arrow
on the lower right of the print view.

E Stacking method
When placing jobs, it is possible to align the jobs automatically, a process called ‘nesting’. There are
three options available:

Sim ple

All jobs will be placed after each other, no other optimization Is performed.

Jobs  toge the r

Multiple copies of a job will be nested, but they will not be mixed with other jobs.

Sa v e  m a te r ia l

An optimal placement of jobs will be made, mixing copies of jobs and panels if necessary.

The selected stacking method will be shown by these buttons. However, when you move a job
manually, the stacking switches off and no automatic placement will be performed, until you click one
of these buttons again.

F Alignment

All stacking methods can have a left, middle or right alignment.  Click one of these buttons to choose,
the default is right-alignment.

G Margin
The distance between stacked jobs.

H Confidence strip
A strip can be enabled on the left and/or right side of the print. Enabling this ‘exercises’ the print heads,
which might help to keep open all inks in a print head. Width can be adjusted.

I Margins
A left, right and front margin can be entered here, this enables you to keep some extra material
around the print itself. This can be handy when doing Print & Cut for example.

J Number of copies
The number of times this print will be printed.

Print buttons
There are several ways of starting a print, you can choose to start printing right away, or to be a bit more careful and
render a print first. The buttons have the following functions:
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K Print now
Starts rendering, and as soon as a small portion of the render is ready the print will start. This can be
used when you have a fast computer and you know for sure that the computer can keep up with the
printer.

L RIP, then print
This renders the print data first, and when everything is ready the print will automatically be started.
Can be used on slower computers to make sure the printer will never need to wait.

M RIP only
Renders all data, but w ill not print until ‘Print now ’ is clicked.

N Triggers
It is possible to start any print that you have set up at a specific time. When you click the ‘Triggers’
button a new dialog appears:

Sta rt a t a  spe cific da te  a nd  tim e  (A)
This enables you to start the current print when you are away, for example when you want to print
during the night.
 
Sta rt whe n le ngth m ore  tha n (B)
This starts a print when there are enough jobs available.

Sta rt whe n e fficie ncy  m ore  tha n (C)
This starts the job when the stacking has produced a print with high enough accuracy.

Archive

Archive
A r c h i v e

Archive ist ein speziell für EasySIGN entwickeltes Dienstleistungsprogramm. Es hilft Ihnen , Ihre EasySIGN –
Arbeitsblätter und Ihre Kundendatenbank zu pflegen. In EasySIGN können Sie Arbeitsblätter pro Kunde abspeichern.
In Archive können Sie Kundendaten öffnen, importieren, pflegen und verarbeiten etc.

Erste Version 
Wenn Sie noch nie zuvor eine Version von Archive auf Ihrem System installiert hatten, erscheint ein "Assistent" auf
Ihrem Bildschirm, der Ihnen bei der Initialisierung des Programms zur Seite steht.
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Im ersten Dialog des "Assistenten", werden die von Ihnen zu beachtenden Schritte erläutert. Sie müssen sich
entscheiden, in welchem Modus Sie Archive laufen lassen wollen – dies hängt davon ab, ob Sie in einem Netzwerk
arbeiten. Sie müssen darüber hinaus den Ort angeben, an dem Archive die Arbeitsblätter, die Sie in EasySIGN
erstellen, speichern soll. Sie können diesen "Assistenten" stets erneut aufrufen, wenn Sie das Programm einmal
initialisiert haben. Wenn Sie dies tun und Sie bereits ein Archiv –Verzeichnis und EasySIGN – Arbeitsblätter erstellt
haben, ist es ratsam, eine Sicherungskopie anzulegen, bevor Sie mit dem "Assistenten" fortfahren. Wenn alles klar
ist, klicken Sie auf die Schaltfläche "Weiter" (2), um fortzufahren.

Auf dem nächsten Bildschirm des "Assistenten" können Sie den jeweiligen "Modus" bestimmen, in dem Sie arbeiten
möchten.
.



374 EasySIGN

4 "Einzelgerät"
 Verwenden Sie diesen Modus, wenn Sie nicht in einem Netzwerk arbeiten oder wenn Sie ein Netzwerk

verwenden, dessen Programm jedoch nur auf einem Computer verwendet wird.
5 "PTP - Server"
 In diesem Fall ist Ihr Computer als Server und darüber hinaus als Workstation eingesetzt.
6 "DS - Setup"
 Wenn Sie einen "Fileserver" verwenden wollen.
7 "Client"
 Wenn Sie bereits einen "Fileserver" verwenden.

 

Erklärung des jeweiligen Modus
E r k l ä r u n g  d e s  j e w e i l i g e n  M o d u s  

Einzelgerät
Wenn Sie diese Option im "Assistenten" gewählt haben, erscheint ein neues Fenster, nachdem Sie auf die Schaltfläche
"Weiter" geklickt haben.

4 In diesem Feld wird der Pfad zum Standardverzeichnis von Archive angezeigt. Es ist ratsam, diesen Pfad zu
verwenden. Wenn Sie einen anderen Pfad angeben wollen, können Sie dies tun, indem Sie den entsprechenden
Pfadnamen manuell eingaben oder indem Sie mit Hilfe der Schaltfläche ”Durchsuchen” (5) einen Pfad suchen. 

PTP - Server
Wählen Sie diese Option, wenn Ihr Netzwerk keinen "Dedicated File Server" enthält. Einer der Computer in dem
Netzwerk fungiert als Server.
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4 In dieses Feld müssen Sie den Pfad zum Verzeichnis von Archive eingeben. Sie können diesen Pfad auch mit
Hilfe der Schaltfläche ”Durchsuchen” (5) suchen.

6 Wenn sich das Archive – Verzeichnis auf Laufwerk C befindet, müssen Sie hier angeben, wie das Laufwerk C
über das Netzwerk gemeinsam genutzt wird.

S Server / Workstation
 Auf diesem Computer wird das PTP - Setup ausgeführt. Dies enthält den gemeinsam genutzten Ordner

"Archive" für die anderen Workstations (C) sowie eine Arbeitsversion von Archive.
C Workstation 
W Auf den Workstations wird das "Client - Setup" von Archive ausgeführt, der gemeinsam genutzte Ordner (A)

auf dem Server (S) wird als Quelle verwendet. 

DS - Setup
Verwenden Sie diese Option, wenn Ihr Netzwerk einen "Dedicated File Server" enthält, wie z.B. einen NT - Server. Die
Arbeitsblätter werden dann zentral auf diesem Server gespeichert.
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4 In dieses Feld müssen Sie den Pfad zum Archive – Verzeichnis eingeben. Sie können das Verzeichnis jedoch
auch mit Hilfe der Schaltfläche ”Durchsuchen” (5) suchen.

S Server
C Workstation
W Auf einer der Workstations wird das "DS - Setup" ausgeführt, der Server (S) ist als Quelle für den "Archive" -

Ordner (A) angegeben worden. Dieser Computer ist ebenfalls zu einem "Client" geworden. Auf den anderen
Workstations wird das "Client - Setup" von Archive durchgeführt. Der gemeinsam genutzte Ordner (A) auf dem
Server (S) wird als Quelle genutzt. 

Client - Setup
Diese Option verwendet ein Laufwerk, in dem sich bereits alle Ordner befinden. Es wird von der Annahme
ausgegangen, daß die Option "DS - Setup" oder "PTP - Setup" bereits einmal auf einem anderen Computer
durchgeführt wurde.
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4 In dieses Feld müssen Sie den Pfad zum Archive – Verzeichnis eingeben. Sie können das Verzeichnis jedoch
auch mit Hilfe der Schaltfläche ”Durchsuchen” (5) suchen.

Nachdem Sie die notwendigen Einstellungen vorgenommen haben, klicken Sie auf die Schaltfläche "Ausführen" (2).

Arbeitsumgebung
A r b e i t s u m g e b u n g

Wenn Sie Archive geöffnet haben, wird auf dem Bildschirm folgendes angezeigt: Wenn Sie sich während des Setups
von EasySIGN entschlossen haben, die Beispiele mit zu installieren, befinden sich diese jetzt in Archive. Sie sind unter
einem Kunden angelegt, der als Beispielkunde verwendet wird.
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1 Menü
 Die einzelnen Teile des Menüs werden nachfolgend noch detailliert erläutert.
2 Symbolleiste
 Hier finden Sie die am häufigsten verwendeten Menübefehle. Sie können direkt über eine Schaltfläche

ausgeführt werden.
3 Übersichtsfenster 
 Hier finden Sie alle Kunden, in einer Baumstruktur angeordnet.
4 Informationsfenster
 Hier können Sie die Kundendaten eingeben oder die Arbeitsblätter des jeweiligen Kunden anzeigen lassen.
5 Statusleiste

 

Menü
M e n ü  

Kunde

Sie finden dasselbe Menü auch als rechtes Maustastenmenü in jedem Teil der Baumstruktur vor.

Neu (CTRL+N)
Je nachdem, was Sie in der Baumstruktur ausgewählt haben, wird ein neuer Kunde auf eine gewisse Ebene plaziert.
Wenn Sie zum Beispiel die "Wurzel" ausgewählt haben, können Sie eine Gruppe mit dem Namen "Fußballclubs"
erstellen. Wenn Sie den neuen Ordner "Fußballclubs" dann anklicken und anschließend auf "Neu" klicken, wird der
neue Kunde / Ordner unter ”Fußballclubs" hinzugefügt. Auf diese Weise können Sie alle Ihre Kunden nach Art der
Arbeit kategorisieren.

Löschen (DEL)
Mit diesem Befehl löschen Sie einen ausgewählten Ordner. Wenn sich jedoch noch Arbeitsblätter in dem
Kundenordner befinden, können Sie den Kunden nur löschen, nachdem Sie zuvor alle Arbeitsblätter gelöscht haben.

Bearbeiten / Schreibgeschützt 
Wenn Sie das Untermenü "Bearbeiten" wählen, können Sie die Kundendaten ändern. In dem Augenblick, in dem Sie
die Kundendaten ändern, ist die Datenbank für andere Benutzer gesperrt. Dies geschieht, um sicherzustellen, daß
nicht zwei Benutzer gleichzeitig versuchen, denselben Kunden zu bearbeiten. Ein anderer Benutzer kann die
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Arbeitsblätter immer noch öffnen, er kann nur die Kundendaten nicht verändern. Um diese Sperre wieder aufzuheben
müssen Sie das Untermenü "Schreibgeschützt" auswählen. Wenn nach fünf Minuten keine Bearbeitung erfolgt ist, wird
die Sperre der Datenbank automatisch wieder aufgehoben und steht somit anderen Benutzern zur Verfügung.

Suchen
Mit diesem Befehl wird ein Dialog geöffnet, in dem Sie nach vorhanden Kunden suchen können.

1 Suche nach
 Hier können Sie die Suchkriterien eingeben.
2 Suchen in
 Hier können Sie festlegen, welche Felder durchsucht werden sollen.
3 Suchergebnisse
 Hier werden die Ergebnisse der Suche angezeigt. Wenn Sie auf einen der Teile in der Liste doppelklicken, wird

diese Datei aktiviert.
4 Suche starten
 Mit diesem Befehl wird die Suche aufgenommen.
5 Schließen

Beenden
Mit diesem Befehl wird das Programm geschlossen.

Bearbeiten

Rückgängig machen
Wenn Sie sich im Modus Ändern befinden, wird die letzte Änderung vollständig rückgängig gemacht und der
Originalzustand wiederhergestellt.

Löschen
Mit diesem Befehl werden die ausgewählten Arbeitsblätter gelöscht.

Alle markieren
Mit diesem Befehl werden alle Arbeitsblätter des Kunden, die geöffnet wurden, ausgewählt.

Markierung umkehren
Mit diesem Befehl wird eine bereits vorgenommene Auswahl umgekehrt.

Umbenennen.
Mit diesem Befehl können Sie den Namen eines ausgewählten Kunden in der Baumstruktur ändern.

Ansicht

Symbolleiste
Zeigt oder verbirgt die Symbolleiste.

Statusleiste
Zeigt oder verbirgt die Statusleiste.
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Kundendaten
Aktiviert die Kundendaten im Informationsfeld.

Große Symbole
Zeigt die verfügbaren Arbeitsblätter im Imformationsfenster mit großen Symbolen und dem relevanten Dateinamen
an.

Kleine Symbole
Alle Arbeitsblätter werden mit einem kleinen Symbol angezeigt.

Liste
Die Arbeitsblätter werden als Liste angezeigt.

Details
Zusätzliche Informationen werden um das Arbeitsblatt herum angezeigt, wie z.B. der Tag, an dem das Arbeitsblatt
zuletzt geändert wurde.

Vorschau
Alle Arbeitsblätter werden mit einer Abbildung des Arbeitsblattes angezeigt.

Aktualisieren (F5)
Mit diesem Befehl wird das Fenster aktualisiert.

Hilfswerkzeuge

Modusassistent
Mit diesem Befehl öffnet sich, wie bereits früher in dem Abschnitt ”Erste Version” beschrieben, der Modusassistent. 

Sicherungskopie
Dieser Menügegenstand bietet Ihnen Ratschläge zur Erstellung von Sicherungskopien.

Hilfe
In diesem Menü finden Sie alles über die Hilfe und das digitale Handbuch.

Informationsfenster
I n f o r m a t i o n s f e n s t e r  

In diesem Fenster finden Sie alle Arbeitsblätter, die zu einem bestimmten Kunden zugeordnet sind. Von hier können
Sie die Arbeitsblätter verwalten und pflegen.
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Mit der Steuerungstaste können Sie mehrere Arbeitsblätter gleichzeitig auswählen, um diese zu löschen oder Sie nach
EasySIGN zu importieren. Wenn Sie ein Arbeitsblatt ausgewählt haben, klicken Sie einmal mit der rechten Maustaste
darauf, um das rechte Mausmenü des Arbeitsblattes aufzurufen.
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In diesem Popup – Menü finden Sie die folgenden Befehle.

1 Öffnen
 Mit diesem Befehl wird das ausgewählte Arbeitsblatt in EasySIGN geöffnet. Wenn EasySIGN nicht offen ist, wird

es automatisch geöffnet. Diese Funktion kann auch durch Doppelklicken auf das Arbeitsblatt aktiviert werden.
2 Importieren
 Mit diesem Befehl wird das Arbeitsblatt in das aktive Arbeitsblatt in EasySIGN importiert.
3 Löschen
 Mit diesem Befehl werden die ausgewählten Arbeitsblätter gelöscht. Wenn Sie versehentlich das falsche

Arbeitsblatt gelöscht haben, können Sie den Papierkorb unter Windows™ verwenden, um die Datei
wiederzuholen.

Wenn Archive das Programm EasySIGN nicht finden kann, erscheint eine Meldung auf Ihrem Bildschirm, in der Sie
aufgefordert werden, den Speicherort des Programms anzugeben. Wenn Sie die Option "Ja" wählen, erscheint ein
Dialog, mit dessen Hilfe Sie das Programm suchen können.

Alle Dateien verschieben 

Wenn Sie das gesamte Archiv in ein anderes Laufwerk verschieben wollen, schließen Sie zunächst Archive 32.
Verschieben Sie das gesamte Verzeichnis "Archive" an den neuen Ort. Starten Sie Archive erneut. Sie werden
aufgefordert, die Datenbank erneut festzulegen. Geben Sie den neuen Speicherort an und alle Referenzen werden
automatisch geändert.

Drag & Drop

Aus Archive können Sie eine Datei in den Explorer ziehen und umgekehrt. Sie können darüber hinaus eine Datei
direkt von Archive nach EasySIGN ziehen. Wenn Sie die Datei loslassen, wird sie entweder geöffnet oder importiert.
In Archive können Sie mit der Ziehfunktion Dateien von einem Kunden zum anderen kopieren. Wenn Sie während des
Ziehens gleichzeitig die Umschaltetaste gedrückt halten, verschieben Sie die Datei (oder die Dateien).
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Archive via EasySIGN
A r c h i v e  v i a  E a s y S I G N

Mit dem Menü "Datei" können Sie Ihre Arbeitsblätter in EasySIGN archivieren. Hierbei stehen Ihnen drei Möglichkeiten
zur Verfügung.

1 Archivieren
 Wenn Sie ein Arbeitsblatt geöffnet haben, können Sie mit diesem Befehl alle Änderungen Speichern.
2 Archivieren unter...
 Mit diesem Befehl wird ein Dialog geöffnet, in dem Sie gefragt werden, ob Sie ein Archiv oder ein neues

Arbeitsblatt unter einem anderen Namen oder unter einem anderen Kunden speichern wollen.
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In der Liste unter (1) können Sie die Kunden in Archive sehen, und unter (2) finden Sie Informationen über einen
ausgewählten Kunden. In Feld (3) können Sie den Namen für das Arbeitsblatt eingeben. Klicken Sie anschließend auf
die Schaltfläche ”OK”. Das Arbeitsblatt wird dann in dem markierten Kundenordner gespeichert. 

Neue Kunden
N e u e  K u n d e n

Eine Liste der letzten zehn Kunden wurde dem Menü “Datei” hinzugefügt. Wenn Sie eine große Anzahl von Kunden mit
Hilfe von Archive verwalten, ersparen Sie sich das langwierige Durchsuchen des Archivs nach den Kunden, für die Sie
gerade arbeiten.

Tipps zum Erstellen von Sicherungskopien
T i p p s  z u m  E r s t e l l e n  v o n  S i c h e r u n g s k o p i e n  

Das Erstellen von Sicherungskopien stellt normalerweise kein Problem dar, wohl aber die Entscheidung, welche Daten
zu welchem Zeitpunkt gesichert werden sollen. Archive bietet die Möglichkeit festzustellen, wann eine Sicherungskopie
Ihrer EasySIGN-Archive-Dateien benötigt wird. Bei diesen Dateien handelt es sich in der Regel um alle wichtigen
EasySIGN- und Archive-Dateien, die beim Neuinstallieren normalerweise nicht ersetzt werden, z. B. manuell
hinzugefügte Programmdateien, Arbeitsblätter, persönliche Farbtabellen usw.

Sie können den Dialog für diesen Vorgang über das Menü "Hilfe", "Tipps zum Erstellen von Sicherungskopien"
aufrufen.
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1 +++Files to be backed-up
 Hier wird eine Liste aller Dateien angezeigt, von denen eine Sicherungskopie erstellt werden soll.
2 +++Show folders only
 Nach Aktivieren dieser Option werden nur die Ordner angezeigt, die die zu sichernden Dateien enthalten.
3 +++Print
 Über diese Schaltfläche wird eine Textdatei geöffnet, die alle im Dialog angezeigten Dateien enthält.
4 Schließen
 Hiermit schließen Sie den Dialog.

Arbeitsblattsuche
A r b e i t s b l a t t s u c h e

Dieser Befehl dient zum Suchen nach EasySIGN-Arbeitsblättern auf allen Laufwerken und Netzwerkverbindungen. Aus
dem Suchergebnis können Sie die gewünschten Arbeitsblätter auswählen und als neuen Kunden hinzufügen. Sie
können diese Suche über das Menü "Extra", "Arbeitsblattsuche" starten. Daraufhin wird der Suchstatusdialog
angezeigt.

Mit der Schaltfläche "Abbrechen" können Sie die Suche abbrechen. Wenn alle Laufwerke und Netzwerkverbindungen
durchsucht wurden, wird ein weiterer Dialog geöffnet. Darin werden alle Ordner angezeigt, die (alte und neue)
EasySIGN-Arbeitsblätter enthalten.
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In diesem Dialog können Sie eine Auswahl treffen und diese als neuen Kunden der Archive-Datenbank hinzufügen.

Verschieben von Kunden
V e r s c h i e b e n  v o n  K u n d e n

Im linken Feld von Archive können Sie Kunden an eine andere Stelle in der Datenbank verschieben. Der Speicherort
der Arbeitsblätter und Ordner auf der Festplatte bleibt nach dem Verschieben von Kunden unverändert. Es ist nicht
möglich, Kunden an eine andere Stelle zu kopieren.
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Vorschauen
V o r s c h a u e n

Wenn in Archive nicht nur die Standard-Arbeitsblätter, sondern auch Arbeitsblätter angezeigt werden sollen, die sich in Windows™ Explorer als

Vorschau anzeigen lassen, können Sie im Menü "Ansicht" die Option "Alle Vorschauen anzeigen" aktivieren.

Bedingungen und garantien

Bedingungen und garantien
B e d i n g u n g e n  u n d  g a r a n t i e n

Copyright ©2012 NCD Holding B.V. Alle Rechte vorbehalten.
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Die in dieser Publikation beschriebene Software ist unter Lizenz geschützt und darf nur in
Übereinstimmung mit den allgemeinen Bedingungen der NCD Holding B.V. kopiert oder verwendet werden.

Bestimmungen und Garantien
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vorherige Benachrichtigung geändert werden. Dies darf nicht als Verpflichtung seitens der NCD Holding B.V.
ausgelegt werden.
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Dokument enthaltenen Informationen werden regelmäßig geändert; diese Änderungen werden in neuen
Ausgaben dieser Publikation aufgenommen. Die NCD Holding B.V. kann Änderungen und/oder
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